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GOALS

Become familiar and 
comfortable with the 

Desktop and Finder

Get to know the Finder 
windows and how 

to use them

Create your own folders

Understand the Dock

Use the Trash basket

Know how and when to 
use keyboard shortcuts

Learn to watch for tool tips 
and other visual clues

Know where to go for 
more information
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LESSON 1

Introduction to the 
Mac OS X Desktop

If you have a Mac running Leopard (Mac OS X version 10.5), you’re 

ready to jump right in! In this lesson you’ll become familiar with 

using the basic features of your Mac and its Desktop/Finder.

Th is book assumes you are familiar with how to operate 

a computer—how to use a mouse, select items from menus, 

distinguish one icon from another, move fi les and folders and 

windows around, how and why to save the documents you create, 

etc. If you’re brand new to computers in general, I strongly suggest 

you use Th e Little Mac Book, Leopard Edition instead of this 

book—Th e Little Mac Book introduces you to using a computer 

in much more detail and at a much slower pace than this book.
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Get to Know your Desktop and Finder
When you turn on your Mac, you’ll always see your Desktop,.shown below. Th is is 
also called the              Finder, although technically the Finder is the application that runs 
the Desktop. Whenever you see a direction that tells you to go to the Desktop or to 
the Finder, this is where you need to go. 

Menu bar.

Application menu. 
This menu changes depending 
on which application is 

“active” at the moment.

Desktop. 
This whole 

background 
area is the 

Desktop.

Apple 
menu.

Finder window.
See pages 5–7.

Dock. 
See pages 20–21.

Hard disk 
icon.

Trash. 
See pages 22–23.

Finder icon. 
See the next two pages.

Spotlight.
See Lesson 19.

 Because of the way the computer works, you might see the Desktop 

but not actually be in the Finder. Get in the habit of checking the application menu (shown 

top-left and on the opposite page). When you are really in the Finder or at the Desktop, 

the application menu will show “Finder.” 
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Make sure you can get to the Desktop or Finder 
whenever necessary
As you work on your Mac, you will be using a number of applications in which you’ll 
create your documents, but you’ll often want to go back to the Finder, which is like 
home base. Th e name of the   active application, the one that’s currently open and 
available to use (including the Finder), will always be displayed in the application 
menu. Keep an eye on that menu.

To go to the         Finder at any time, do one of these things:

■ Single-click on any blank area of the Desktop. 

■ Single-click on any Finder window (shown below) that you see. 

■ Single-click the Finder icon in the Dock (shown on the opposite page). 

Check to make sure the application menu says “Finder,” as shown circled below.
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Get to Know your       Home and its Folders
When you open a Finder window, it usually opens to the Home window, as shown 
below. You can tell it’s Home because your user name and the little house icon are 
in the title bar. It can be confusing that the Home icon isn’t labeled “Home”—it’s 
labeled with the “ short name” that was chosen when the computer was first turned 
on and set up. In the example below, the Home icon is named “robin.”

■ To open a Finder window, single-click on the Finder icon (shown 
to the left) in the Dock (the Dock is that row of icons that is usually 
found across the bottom of your screen). 

If the window that opens doesn’t display your  Home folders, as shown below, 
single-click the Home icon you see in the Sidebar. 

Your Home window displays a number of special folders. Do not change the names 
of these folders or throw them away unless you are very clear on what you’re doing 
and why you’re making that choice! For now, just let them be. 

 If several people use your Mac or if you occasionally have a guest who 

wants to use it, you can create individual Homes for each user; everyone’s files will be 

perfectly safe from any other user. See Lesson 18 for information about multiple users.
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What each  folder in your Home window is for
          Desktop Th is folder holds any fi les that might be sitting directly on the 

Desktop (see page 4). Putting fi les on the Desktop is like keeping 
them on your office desk instead of putting them in a filing cabinet. 
Having this folder to hold the same fi les means you can get to them 
when you’re not actually at the Desktop, as when you want to open 
a fi le from within an application.  

 Documents At fi rst your Mac makes sure every document you create is safely 
tucked into this Documents folder. Later you can create your own 
folders (see pages 10–11) and store your documents in them.

   Downloads Th is folder holds most of the fi les that you download through Bon-
jour, iChat, or the Internet. Files that come to you through email 
will also end up here if you click the “Save” button in an email mes-
sage. Th e Downloads folder in the Dock holds the exact same fi les.

 Library Th is folder is used by the operating system. Do not rename this 
folder, do not throw it away, do not take anything out of it, and do 
not put anything in it unless you know exactly what you are doing. 
Just ignore it for now. For details, see page 37.

 Movies Th e iMovie application uses this folder to automatically store 
the files necessary for creating the movies you make. 

 Music Th e iTunes application uses this folder to automatically keep track 
of all the music files you buy and all of your playlists.

 Pictures Th e iPhoto application uses this folder to automatically keep 
track of all your photos and albums.

 Public You’ll use this folder to share files with other people who also use 
your Mac, as explained in Lesson 18.

 Sites You can create a web site, store it in this folder, and share it with 
anyone on the Internet. (Directions for that process are not in 
this book!)

 You can have as many  Finder windows open as you like. This makes it easier 

to move files from one window to another. To open another window, make sure you are 

at the Finder (see pages 4 –5), then go to the File menu and choose “New Finder Window.” 



Lesson 1 Introduction to the Mac OS X Desktop

8

Home icon. 
See page 6.

Smart 
Folders 

for quick 
searches. 

See page 336.

 Title bar. 
This is the name of the 
folder whose contents 

are shown in the window.
Toolbar. 

 Action button. 
See page 43 and 55.

View buttons. 
See pages 14–18.

  Quick Look button. 
See page 19.

   Sidebar. 
See pages 12–13.

Press-and-drag 
this bar to  resize 
the Sidebar.

Press-and-drag 
this corner to 
 resize the 
entire window.

Your hard disk. 
See page 36.

Sharing files on 
your network. 

See Lesson 21.

Spotlight. 
See Lesson 19.

 Press-and-drag any 
edge to move the 
window.

To change 
the view of 
a  window, 
see pages 
14–18.

Hide/Show.
See page 9.

 See the opposite page 
for these buttons.

Get to Know your  Finder Window
Below, you see a typical Finder window. Th is is called a Finder window to 
 distinguish it from similar (but diff erent) windows you will use in your  applications. 
Th e following pages go into further detail about this very important window.
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Use the buttons in the Finder Window
Th ere are several buttons in the Toolbar of every Finder window.

     Red, yellow, and green    buttons

● Single-click the     red button to close the window.

● Single-click the   yellow button to minimize the window, which 
sends a tiny icon down into the   Dock, on the right side. Try it.

  To open that window again, single-click its icon in the Dock.

● Single-click the  green button to resize the window bigger or smaller.

Back and Forward buttons

Th ese  buttons go back and forward through the contents of windows you have 
viewed (just like the back and forward buttons on web pages). Every time you open 
a new window, these buttons start over.

Hide/Show the Toolbar and Sidebar

In the upper-right corner of every Finder window is a small gray button. Single-click 
this button to hide the Toolbar and the Sidebar, as shown below. When you double-
click on a folder while the Toolbar and Sidebar are hidden, a new and separate 
window will open. Try it. To show the Toolbar and Sidebar again, click the small 
gray button again.

 If you always want a new 

and separate window to open, change your 

  Finder preferences; see pages 262–263.
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Create your Own Folders
At any time you can create your own   folders where you can store your documents 
and organize your files. For instance, you might want a folder in which to store all 
your financial documents. And another folder for all your newsletter files. And yet 
another for the screenplays you’re writing. All of these documents could go inside 
the Documents folder, but that’s like putting every document in your offi  ce in one 
big manila folder.

Use digital folders on your Mac as you would use manila folders in a metal filing 
cabinet. See pages 44–45 for tips on how to save files directly into your custom 
folders.

■ To make a new folder, go to the File menu and choose “New Folder.” 
Th e new folder appears inside the window whose name is in the title 
bar (shown circled, below). Th at is, if you want to put the new folder 
into the Documents folder, fi rst open the Documents folder before you 
make a new one.

In my Documents folder, I made a new folder called “The Shakespeare 
Papers.” Inside that folder, I made these six new folders. 
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■ To    rename a folder:

 1 Single-click on the folder to select it. 

 2 Th en single-click directly on the name to highlight the name 
(you’ll see a blue outline around the name). 

 3 Type to replace the existing name. (You don’t need to delete the original 
name fi rst.)

 4 Hit Return or Enter to set the name. 

This is a new, 
untitled folder. 

■ To open a folder, double-click on it. 

■ To go back to the contents of the previous folder, single-click the left-pointing 
  triangle, called the Back button (circled on the opposite page).

■ To move a folder, just drag it to another window or another folder. 

This folder is highlighted, 
or selected.

This folder is ready 
for a new name.

Click on any blank spot 
in the Finder window to 
unhighlight the folder. 

As in any other text, you can double-click a word 
to select the entire word, or use the Delete key 
to backspace and delete characters.
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Take Advantage of the Sidebar
Th e    Sidebar of every Finder window is customizable—you can add or remove any 
folder or document as often as you like. Items in the Sidebar are always  aliases, or 
icons that merely represent the real fi le. Th is means you can delete an icon from the 
Sidebar and it does not delete the actual fi le that it represents.

As shown below, each of the current icons in the Sidebar actually represents a fi le or 
folder somewhere else on your hard disk. 

Because a folder or document in the Sidebar is a picture (alias) of the real thing, you 
can put fi les into the icon in the Sidebar (just drag them in and drop them) or into 
the original folder and they go to the same place. Try it: Drop a fi le into the Docu-
ments folder in the Sidebar, then open the Documents folder in the Home window 
and you’ll see the new document.
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Add a folder or document to the Sidebar. Th is makes it easier to put other fi les 
into that folder, and it makes that document easier to open (just single-click on it). 
It’s easier, not only on the Desktop, but also when you are working in an application 
and want to open or save a file (as shown on pages 44–45). 

Remove folder or document icons from the Sidebar that you don’t use. Don’t 
worry—removing the picture of a folder from the Sidebar does not throw away the 
original folder nor anything in it!

■ To add a folder or    document to the Sidebar, simply drag the icon from 
any window or from the Desktop and drop it into the Sidebar.

 Use the Finder preferences to add hard disk icons and more; see page 265.

■ To remove an item from the Sidebar, simply press on it with the mouse  
and drag it out of the Sidebar. Let go when the mouse pointer is on the Desk-
top. As you can see below, the icon disappears in a puff  of smoke. Notice that 
although I removed the Pictures folder from the Sidebar, the original Pictures 
folder is still safe and sound in the Home window.



Lesson 1 Introduction to the Mac OS X Desktop

14

Change the View of the Finder Window
You can change how the items inside any window are displayed. Th at is, you can 
show them as icons, as a list of items, or in columns of information. You might 
prefer one view for certain things and a diff erent view for others—with the click 
of a button, you can switch    from one to the other. Experiment with the three 

different views and decide for yourself how you like to work.  

■ To change views, single-click one of the four little View buttons.

  

The Icon View
Obviously, this displays every file as an icon, or small picture.  

Home folders

Sidebar

From left to right, the View buttons display 
Icon View, List View, Column View, Cover Flow view. 

Icon View button

 In the  Icon View, double-click to open files:

 Folder icon: Double-click a folder to display its contents in the  window. 
(But not in the Sidebar; single-click those icons.)

 Document icon: Double-click a      document to open not only 
that  document, but also the application it was created in.

 Application icon: Double-click an application icon to open 
that  application, ready for you to create wonderful projects.
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The    List View
In the List View, you can organize the list of fi les alphabetically by names, by the 
dates the fi les were last modified, by what kind of items they are, and other options. 
You can also see the contents of more than one folder at once. 

Th e  blue column heading is a visual clue that the contents are organized, or 
“sorted,” by that heading. You can see, above, that the fi les in this window are sorted 
by “Name.” To organize the contents by the dates they were modifi ed, their size or 
kind, single-click that column heading (you might have to open the window wider 
or drag the blue scroll bar to the right to see the other columns and headings). 

Th e tiny   triangle in the column heading (circled above) is a   visual clue that tells 
you whether the information is sorted from first to last or last to first. Single-click 
the triangle to reverse the order. Try it.

In the List View, single-click vs. double-click:

  Folder icon: Single-click the  disclosure  triangle to the left of a folder 
to display its contents as a sublist, as shown circled above. You can 
view the contents of more than one folder at once. 

 Double-click a tiny folder icon to display its contents in the window, 
which will replace the contents you currently see in the window. 

 Document icon: Double-click a  document to open not only that  document, 
but also the application it was created in.

 Application icon: Double-click an application icon to open it. 

List View button
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The        Column View
Viewing a Finder window in columns allows you to see not only the contents of 
a selected  folder or hard disk, but you can easily keep track of where each file is 
located. You can also view the contents of another folder without losing sight of the 
first one. Th is view helps you understand where everything is kept in your computer. 

If you have photographs, graphic images, or movies in your folders, the last column 
displays previews of the items. You can even play a small movie in this preview 
column. Some documents can display previews as well. 

To resize an individual  column, drag one of these “  thumbs.” 

To resize all columns, Option-drag a thumb (hold down the 
 Option key while you drag with the mouse).

You won’t see a column to the right until you single-click a folder or a file—then a 
new column to the right appears to display the contents of that folder or a preview 
of the file. A  triangle indicates that file is a folder that can contain other files. 

In the example above, you can see that the “top level” folder is my Home folder, 
“robin.” In “robin,” I selected the folder “Pictures” (I clicked once on it) and in that 
folder I selected “Rosetta,” and in that folder I selected “Rosetta playing pool.jpg,” 
and the last column displays a preview of the selected fi le and information about it. 
(Th at’s my dog.)

Column View 
button
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In the Column View, single-click files to display columns:

 Folder icon: Single-click a folder to display its contents in the column 
to the right. If there is no column to the right, one will appear. 

 Document icon: Single-click a document to see a preview in the 
column to the right. Not all documents can provide picture previews, 
but the preview will at least give you information about that file.

 Double-click a   document to open not only that  document, but also 
the application it was created in.

 Application icon: Single-click an application icon to preview 
information about it, such as its version and date of modification.

 Double-click an application icon to open that  application. 

 You can customize many features about the Finder windows, such as the 

font size, the icon size, even the color inside the window. You can organize the List View 

by different columns of information, choose to turn off the preview in Column View, 

and more. See Lesson 15.

 No matter which view you are in, you can always open a folder into a 

new, separate  window: Hold down the Command key and double-click on any folder 

in any view.
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The Cover Flow View
Th e Cover Flow View displays your fi les graphically in a slideshow-like format at the 
top of the window. You can “toss” the fi les on either side of the center image to fl ip 
through them, or use the slider bar.

For the columns below the cover images, organize and use them just as you would in 
Column View, as described on the previous pages.

Double-click an icon here to open that 
document or application.

Single-click an icon here 
to display it in the Cover 
Flow view window above.

Double-click an icon here 
to open that document 
or application.

While in Cover Flow view, 
single-click on any item in 
the Sidebar to display it or 
its contents in the window. 

Cover Flow View button.
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Quick Look/Slideshow button
Th e button in the toolbar with an eyeball on it is the Quick Look/Slideshow 
button. Th is is a terrifi c feature that lets you preview any fi le, photograph, graphic, 
pdf, or whatever. An image appears immediately in front of you and no application 
opens. With the click of the mouse, the preview disappears.

If you preview a text fi le, you can actually scroll through the document. If you 
preview a Keynote presentation, you’ll see your slides and your notes. If you 
preview a pdf with lots of pages, you can scroll through the pages.

Once you have a Quick Look preview open, you can click on other fi les in the Finder 
and they will appear in that preview. 

Select more than one fi le and your Quick Look automatically becomes a Slideshow 
with back and forward buttons. 

There are three other ways to open a Quick Look:

■ Select one or more items and go to the File menu and choose “Quick Look.” 
■ Select fi les and press Command Y or hit the Spacebar 
■ Control-click (or right-click) and choose “Quick Look fi lename.”

To put away a Quick Look:

■ Press Command Y or hit the Spacebar.
■ Click the X in the upper-left corner of the Quick Look window.

Click these arrows 
to enlarge the 
preview to full 
screen or reduce it 
to the smaller size.
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Use the Dock
Th e      Dock is that strip of icons across the bottom of the screen*. Th e specific icons 
that appear in the Dock will change as you open and close applications, view photos, 
or customize what’s in the Dock.   “Hover” your  mouse over an icon (just position 
the pointer and hold it there, but don’t click) to see a label appear that tells you the 
name of the application or file.

■ To open an   application or document from the  Dock, single-click its icon.

Th e tiny blue light underneath an icon indicates that particular application is open 
and available. Even if you don’t see that application on your screen, you can single-
click the Dock icon and that application comes forward, ready for you to work in. 
Keep an eye on the application menu (as explained on pages 4–5) to verify which 
application is “active” at any moment.

You can rearrange any of the icons. You can add or remove applications from the 
left side of the dividing line (see callout, above), and you can add or remove folders, 
documents, and web page locations from the right side of the dividing line. Do all 
this by dragging:

■ To rearrange an icon, press the mouse on it and drag it left or right. 
Th e other icons will move over to make room.

■ To add an application, first open the Applications folder: single-click on the 
Applications icon in the Sidebar of any Finder window. Th en drag an applica-
tion icon down to the Dock, to the left side of the dividing line.

■ To add a folder or a document, drag it to the right side of the dividing line.

Finder 
See pages 4–5.

Mail 
See 

Lesson 5.

Time 
Machine 

See 
Lesson 20.

System 
Preferences 
See Lesson 15.

Address 
Book 

See Lesson 6.

Spaces 
See pages 
246–248.

Trash 
See the 
next page.

Documents 
Folder, or 
Stack. Same 
folder in Home.

Safari 
See Lesson 7.

iCal 
See 

Lesson 8.

Preview 
See 

Lesson 11.

iChat 
See 

Lesson 9.

 Downloads 
Folder, or 
Stack
See pages 7 
and 103.

iTunes 
See 

Lesson 10.

Dividing 
line. 

Dashboard 
See Lesson 16.



Lesson 1 Introduction to the Mac OS X Desktop 

21

■ To remove any icon from the     Dock, press on it with the mouse and drag it 
upwards, off  the Dock. Let go of the mouse and the icon will disappear in a 
poof of smoke. Th is doesn’t hurt anything! Never will you delete any original 
item by removing its icon from the Dock.

■ To add a web page, open your browser application, Safari (see Lesson 7 
about Safari). Go to the web page that you want to have easy access to in your 
Dock. Drag the tiny icon that you see on the left of the web page address in 
the location field (circled, below) and drop it in the Dock—on the right side of 
the dividing line. 

 Th e advantage of putting a web page icon in your Dock is that you can be 
using any application on your Mac, and if you click that icon, your web 
browser opens to that page—you don’t have to go fi nd your browser fi rst 
and then fi nd the bookmark.  

 *Is the  Dock missing?
Th e Dock can be customized in many ways. It might be along either side of the 
screen instead of at the bottom, or it might even be hidden. If you don’t see the 
Dock anywhere, push your mouse to the far left, the far right, or the deep bottom of 
the screen and the   hidden Dock will appear from one of those edges. See Lesson 15 
for details about how to customize the Dock to fi t your needs.
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Use the Trash
Th e Trash basket in the  Dock is where you throw away any files you don’t want. 

■ To put a file in the Trash, press on any file and drag it to the Trash basket. 
When the tip of the pointer touches the basket, the basket changes color—
this means you’re in the right place. Let go of the mouse button and that file 
is in the Trash. Remember, it’s the tip of the pointer, not the icon image, that 
selects the Trash basket.

■ To empty the Trash, press (don’t click) on the Trash icon and a little menu 
pops up with an option that says, “Empty Trash.” Choose that option, or go to 
the Finder menu and choose “Empty Trash.”

When you empty the Trash, you’ll get a warning asking if that’s what you really want 
to do. Some people like to have this reminder; others hate it. You can tell your Mac to 
stop reminding you about emptying the Trash (next page). 
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■ To turn off (or on) the Trash warning:

 1 From the Finder menu, choose “Preferences….”

 2 Click the “Advanced” icon in the toolbar at the top.

 3 Uncheck (or check) the box to “Show warning before emptying the Trash.”

 4 Click the red button in the upper-left of the preferences pane 
to put it away.

■ To take an item out of the Trash, click once on the Trash icon in the Dock 
to open its window. Assuming you have not yet emptied the Trash, you can 
drag the item you want to retrieve out of the window and put it back where 
you want it. 
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Take Advantage of Keyboard Shortcuts
Most actions that you can do with the mouse and menus can also be done with 
     keyboard shortcuts. Often this is not only faster, but more convenient because you 
don’t have to take your hands off  the keyboard to pick up and maneuver the mouse. 
You will see lots of keyboard shortcuts in the menus across the top of the screen, 
such as the ones shown below in the Edit menu. Use a keyboard shortcut 
instead of going to the menu.

Recognize the common  modifier keys 
Keyboard shortcuts work with modifier keys, which are those keys that don’t do 
anything by themselves. For instance, the Shift key doesn’t do anything when you 
press it down by itself, but it modifi es the behavior of other keys.  

Each key has a  symbol by which it is known. Th ese are the key symbols you will see 
in menus and charts:

 ⇧           Shift ⎋ Escape (esc)

 ⌘ Command ⇞ ⇟ PageUp or PageDown

 ⌥ Option ⌫ Delete

 ⌃ Control ↑↓←→ Arrow keys

 ↩ Return ⌤ Enter

 Fkeys are those  keys across the top of the keyboard that are labeled with the letter 
F and a number, such as F2 or F13. 

Th e  fn key (function key) is on a laptop in the bottom-left corner. It helps individual 
keys do more than one function. 

Keyboard shortcuts typically use one or more modifier key(s), plus one number, 
character, or Fkey, as you can see in the example of the Edit menu above: the key-
board shortcut to copy selected text is Command C, or ⌘C. 

Take careful notice of which modifier keys 
are used and which character keys are used. 
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Use a keyboard shortcut
Th e trick to using a keyboard shortcut is this: Hold down the modifier keys all 
together and keep them held down, then tap the associated letter, number, or Fkey 
just once for each time you want to perform an action. 

For instance, the keyboard shortcut to close a window is Command W, so hold the 
Command key down and tap the letter W just once. If there are three windows open 
on your Desktop, you can hold the Command key down and tap the letter W three 
times and it will close three windows.

Notice gray vs. black    commands 
When commands in a menu are gray instead of black, the Mac is giving you an 
important visual clue. Here’s a short exercise to demonstrate.
 1 Click on an empty spot on the Desktop. 

 2 Now take a look through the Finder menus and notice the shortcuts for 
diff erent actions, or commands. Notice how many commands are gray.

  If a command is gray, that means you cannot use that command at the 
moment. Often this is because you have not selected an item first, an 
item to which the command should apply. For instance, you can’t use 
the  command to close a window unless an open window is selected.

 3 Now open a Finder window (if there isn’t one already) and  select  a folder icon 
(click once on it).

 4 Look at the File menu again, and notice how many more commands 
are available (they’re in black, not gray). 

 5 In the File menu, fi nd the keyboard shortcut to “Open,” but don’t choose 
the command—just remember the shortcut (Command O). Click somewhere 
off  the menu to make the  menu go away.

 6 Make sure a folder is selected. Now use the keyboard shortcut, Command O, 
to open it. 
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Learn More About Mac OS X
Th ere are a number of ways to learn more about your Mac and how to use it, all 
available right from your Desktop. Keep these tips in mind as you spend time on 
your Mac—you will learn a lot from them. 

Tool tips
Most applications and dialog boxes provide little   tool tips that pop up when you 

“ hover” your     mouse over an item. Th ey tell you what the items do. Just hold the 
mouse still over a button or icon for about three seconds and if there is a tool tip, 
it will appear, as shown in the examples below.

TextEdit toolbar.

 Preview toolbar.

Font Panel toolbar.
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Hover tips
As mentioned in the previous paragraph, tool tips appear when you hover your 
mouse. For instance, you’ve probably already noticed that when you hover over 
an item in the Dock, the name of that item appears. Actually, all kinds of things 
appear when you hover—try it on everything! Below are some examples. Remember, 

“hover” means to hold your mouse still while pointing to an item—don’t click or 
press the button.

In Mail, hover over a name in an email to see 
what address it came from. 

In Safari (your web browser), hover over a link name to see exactly 
where it goes—the destination will appear in the Status Bar at the 
bottom of the window. (If you don’t see this Status Bar, go to the 
View menu in Safari and choose “Show Status Bar.”)

In iChat, hover over a 
name in your Buddy List 
or Bonjour List to see that 
person’s information.
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This flashing insertion point is 
a clue that if you type, the text 

will appear at that point.

This blue border 
is a clue that 
this edit box is 
currently active. 
If you type, the 
text will appear 
here. 

These little marks in the 
 corner are a clue that 
you can press on this 

 corner and drag to make 
the window larger.

Always watch the pointer! 
When it turns into something 

else, that’s a clue. Here it 
 indicates you can press-and-

drag to  resize the pane. 

Visual clues
Keep a constant eye out for the         visual clues that the Mac is always providing. Every 
little visual extra means something! When the pointer turns into a double-headed 
arrow, that’s a clue. When you see a little dot in a divider bar, that’s a clue. When you 
see a triangle anywhere, that’s a clue. 

You are probably already aware of visual clues such as the underline beneath text 
on a web page to indicate a link, or the line of little colored dots in your word 
processor that indicates a word is misspelled. Here are a few others that will help 
you start noticing what your Mac  is telling you.

A tiny  triangle on a blue background is 
a clue that you will see a menu appear 

when you click on it. Do you see the 
three menus in this toolbar?
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Sometimes our eyes glaze over because there is so much visual stimulation on the 
Mac screen. Just keep in mind that everything means something, and slowly get to 
know the visual clues.  

Below you see a typical     title bar of a document. Th ere are two visual clues in this title 
bar: the   red  button has a dark dot in it, and the tiny icon next to the title is gray. 
Both of these visual clues mean the same thing: this file has unsaved changes. Once 
you save the  document, the dark dot goes away and the tiny icon is no longer gray. 

  

You might see a dot next to a document name in an application’s         Window menu—  
that’s another visual clue that the document has not been saved recently. Th e 
checkmark indicates the  active document, or the one that is in front of all the 
others and that you’re currently working on. 

   

Everywhere on your Mac you will see buttons to save a document, to not save, to 
cancel a process, etc. One of these buttons is always   blue. Th e blue is a visual clue 
that you can hit the Return or Enter key to activate that button instead of picking up 
the mouse to click on it. 
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 Help files
No matter where you are on the Mac or what application you are working in, you’ll 
always find      Help just a click away. At the Finder, go to the Help menu to look up tips 
and techniques on just about anything.

Every application has a Help menu, and it’s always at the far end of the menu 
choices, as shown below. Choose the Help option for that particular application, 
then type in a word or two that you want to look up. You see two diff erent kinds of 
options available, “Menu Items” and “Help Topics.”

Menu Items Th is tells you where the item you’re looking for can be found in the 
menus. It doesn’t explain anything about that item. When you select 
an option in the “Menu Items” list, a menu drops down and a big 
moving arrow points to the item you’re looking for. 

Help Topics If Apple has written information in the Help fi le, you will see a list 
of the possible topics. Choose one and the Help fi le opens to that 
piece of information.

Enter text in this field.



Lesson 1 Introduction to the Mac OS X Desktop 

31

Support pages
Th e Apple web site has a huge number of support pages. Here you can find 
manuals that you can view on screen or download (copy) to your computer. 
Th ere are discussion pages where users talk about diff erent products and software 
packages on the Mac, ask questions, and answer questions. You can sign up for 
training at a local Apple store, read the product question-and-answer pages for 
hardware and software, and more. Go to www.Apple.com/support.

 .Mac Learning Center
If you are a .Mac (pronounced dot mac) member, take advantage of the .Mac Learn-

ing Center where you’ll find dozens of tutorials and movies to help you learn more 
about all sorts of features of your computer. Log in to your .Mac account and then 
find the link called “Learning Center.” 

A .Mac membership costs 99.95 a year and includes lots of perks. Check Apple’s 
.Mac web site for details, www.Apple.com/dotmac.

Although many of the tutorials are for .Mac members only, you’ll fi nd lots of great 
information for everyone. 

www.Apple.com/support
www.Apple.com/dotmac
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Become familiar with the 
various disk icons in your 

Finder windows

Understand the Library 
folders

Learn how to select 
multiple items in the 

different window views

Use Exposé to access 
a window easily

Take advantage of 
contextual menus

Use keyboard shortcuts 
to navigate Save As and 

Open dialog boxes

Access menus at the 
Finder without using 

the mouse
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LESSON 2

A Bit Beyond the Basics

If you’re feeling comfortable with the techniques and 

features described in the previous lesson, then carry on 

into this lesson and learn a few more advanced (but still 

everyday and useful) features. If anything overwhelms you 

in this lesson, feel free to skip it and come back later.
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Understand the Various Disk Icons
In the top portion of the        Sidebar, you probably see something similar to the 
example shown below—you might see more icons and you might see fewer. Th ese 
icons represent hard disks, networks, a cd, a dvd, an    iPod, or any other type of 
removable media. 

Display the contents of each media item the same way you do any of the items in 
the lower portion of the Sidebar: single-click the icon.

Th e Hard Disk is your computer, the disk that holds the operating system and all 
your fi les. You can rename your hard disk at any time, just as you rename a folder 
(as explained on page 11).

Th e iDisk is your personal storage space on Apple’s computers, which is something 
you get when you sign up for a .Mac account. A single click on the iDisk icon 
connects you to that storage space. If you don’t have a .Mac account, you don’t have 
any reason to display this icon.

“Chaucer” is a cd I inserted, as you can tell by the icon. To its right is the Eject symbol.

You can choose 
what gets 

displayed in this 
upper portion of 

the Sidebar; 
see page 265.
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When you see the  eject symbol to the right of an icon (the triangle with a bar under 
it), that means it is a removable disk of some sort. It might be a cd, a dvd, 
an iPod, or even another computer that you are connected to over the network. 
Click on the symbol to eject or disconnect the item.

 By default, your Desktop displays the same icons that 

appear in the upper portion of the Sidebar. If you want to clear some 

or all of these icons off your  Desktop, see page 262. 

Shared
Th e Shared section (if you have it in your Sidebar) displays any other computers or 
disks that you can connect to through your local network. A local network is one 
in which computers in a small area, such as a home or offi  ce, are all connected via 
wires or a wireless connection. 

Places
Th e Places section displays folders and fi les on your own computer. 

Search For
Th e Search For folders are “smart folders” that automatically keep track of fi les for 
you to make it easier for you to fi nd things. Please see page 336 for more details. 
Feel free to single-click on any icon in the “Search For” section to see the fi les it 
has organized for you.
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View your    Home folder from the hard disk
Below you see another way of looking at your Home folder, using the Column view 
(as explained on pages 16–17). 

You can tell by the highlight that in the top portion of the Sidebar I clicked on the 
hard drive icon labeled “Hard Disk”; the hard disk is where all your fi les are stored 
(although you might have renamed your hard disk). Th is click displays the folders 
stored on that hard disk; you can see them in the column to the right. 

Th en I clicked on “Users,” which displays my Home folder in the next column. If you 
make any other users, as explained in Lesson 18, you will see all of those users here. 

Th en I clicked on “robin,” which displays my Home folders in the next column. 

Do you see the  Applications folder in the screen shot below? Notice that it’s in the 
top level (fi rst column) of the Hard Disk. Your Applications icon in the Sidebar 
makes it easy to access this folder. 

Experiment with diff erent ways of getting to your Home folders until you feel 
comfortable about where things are stored on your Mac. 
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Understand the Various Library Folders
As you work with your Mac, you’ll run across a number of folders with the same 
name: Library. Do you see the two   Library folders in the illustration below? And 
if you open the “System” folder, you’d see another Library folder.

Library folders contain information that the operating system and certain applica-
tions need to function. Unless you have a really good reason and know exactly what 
you’re doing, leave the Library folders alone—don’t put anything in them and 

don’t take anything out. 

Th e Library folder you see above, the one directly to the right of the “Hard Disk,” is 
at the “top level” of your hard disk. It contains files that are critical to running your 
entire computer, and those files pertain to all users who use this Mac. For instance, 
this    Library folder has a folder inside called “Fonts,” and all fonts that are installed 
into this top level folder are available to all users. (For details about multiple users 
and how to create them, please see Lesson 18.)

Th e Library folder in the far-right column, above, is in my Home collection, my user 
folder. Th is is where all my  application  preferences, web page bookmarks, Address 
Book contact information, email, and other personal information is stored. Each 
user you set up will have her own Library folder with all her own data. Th ere is even 
a   Fonts folder in here; any fonts a user puts in her own Fonts folder will be available 
only to that user. 

Th at’s all you really need to know about your Library folders—and leave them alone 
for now!



Lesson 2 A Bit Beyond the Basics 

38

You can see that the 
rectangle I dragged is 
partially overlapping 
six files. When I let go 
of the mouse, all six of 
these files are selected.

Select Multiple Items in the Finder
To select an individual item in a Finder window, you simply single-click it, as 
you probably know. But often you’ll want to select more than one item at a time. 
To  select multiple items, there are two ways to do it, as explained below. Once 
items are a group, you can move, trash, or open all the selected fi les at once, 
change their labels (see page 264 about labels), and more.

In the    Icon View
To select multiple items in the Icon View, hold down the Command key or the 
Shift key and single-click on as many items as you want to group together. You can 
only select items from one window while in the Icon View. 

Or press on a blank spot in the window and drag the mouse around the items you 
want to select. Any icon that is completely or partially enclosed by the rectangle you 
draw with the mouse will be selected.

In the List View or Column View
In these views, using the Shift key is different from using the Command key.

Hold down the Command key and single-click on multiple items. 
In the List View, you can select items from several diff erent folders in the same 
window, as long as their contents are showing in the list. See the example on 
the opposite page. 
In the Column View, you can select multiple items from one column at a time. 
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Command-click to select 
non-contiguous items.

Shift-click to select 
contiguous items.

Th e   Shift key lets you select a group of items that are  contiguous, or next to each 
other in the list. Single-click on the first item you want to select in a list. Th en 
hold down the Shift key and click on the last item you want in the list. Everything 
between the two clicks will be selected. See the example below.

To  deselect an item from any  group in any view: Command-click it. 
To  deselect all items from any  group in any view: Single-click on any blank 
area in the window.
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Exposé
Some of us like to keep only one window or two open at a time; others have a clutter 
of windows all over the place all the time. If you like to keep lots of windows open 
(application windows, preference panes, Finder windows, etc.), Exposé is a feature 
you’ll enjoy because it helps you fi nd everything even if it appears to be a mess.

Your Mac is already set up to use Exposé. Open several windows on your Mac, then 
try it—press the F key at the top of your keyboard (on a laptop, you might need to 
hold down the fn key while you tap F). Don’t be scared if every window on your 
Mac disappears! Just hit the F key to bring them all back.

Th e keyboard shortcuts for Exposé are explained below, but if you need to change 
them, use the Exposé & Spaces system preferences, as shown below (go to the Apple 
menu, choose “System Preferences…,” and click on its icon). 

In the System 
Preferences 

pane, click this 
icon to get the 

preferences where 
you can change 

the shortcuts.
Use these right-
hand menus to 
assign an Exposé 
action to a two-
button mouse 
and/or a mouse 
with a middle 
button.

■ To show every window on the screen at once, as shown on the bottom 
of the opposite page, press F.

■ To show just application windows (no Finder windows), press F.
■ To hide every window so you can see your entire Desktop, press F.
■ To use your mouse to activate Exposé, assign the actions in the  preferences, 

as shown above.
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Above is my messy Desktop. Rather 
than move windows around to find 
what I want, I can hit F9 and they all 
line themselves up, as shown below. 
As my mouse slides over the top of 
each one, it turns blue (see below), 

the title of the document or window 
appears, and the pointer turns into 
a browser hand. The browser hand 
is a visual clue that if I click on that 
particular item, it will come forward 
and everything else will hide behind it.
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Look for Contextual Menus
Th ese are great. You can Control-click just about anywhere (hold down the Control 
key—not the Command key—and click) and a menu pops up right where you click. 
Th is is a   contextual menu that is specific to the item you Control-click on, meaning 
what you see in the pop-up menu depends on what you click on (as opposed to 
menus in the menu bar or in dialog boxes that always contain the same items). 

To display a contextual menu, hold down the Control key and click on an icon, a 
blank spot  on the Desktop, inside a Finder window, or just about anywhere. A little 
menu pops up, as you can see by the examples below. 

If you have a two-button mouse, you don’t need the Control key—just use 
the right-hand button to display a contextual menu. 

Th ere is no visual clue for a contextual menu—just keep checking. You’ll find them 
in applications, on web pages, in toolbars, in the Sidebar, and elsewhere. 

A contextual menu on a 
blank spot on the Desktop.

A contextual menu on a    folder.
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 In Finder windows, the   Action button 

does many of the same things as the contextual menu. 

Try it: Single-click to select an icon, then click the Action 

button to see what the contextual options are. 

A contextual menu 
on a     Toolbar.

This is an example of a 
contextual menu in an 
 application.

Control-click on a misspelled 
word to get a  contextual menu 
with possible spellings. Select 
the correct word, let go of 
the mouse button, and the 
misspelled word is instantly 
replaced with the correct one.

Try the “  Speech” option—your 
text will be read out loud to you.
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Use Keyboard Shortcuts in Dialog Boxes
When creating and working with documents, you can use   keyboard shortcuts in 
the Save As and Open dialog boxes. Use the Tab key to select diff erent areas of the 
dialog box and the Arrow keys to select items in the columns. When you Save As, 
you can title your document, select the folder in which you want it stored, and save 
it—without using the mouse. 

If you don’t see the full 
dialog box, as shown 
here, single-click this 
  disclosure       triangle. 

Visual Clues: Notice the blue 
border around this Save As edit 

box, and the blue highlight on the 
text; this means the edit box and 

text are selected. Simply type to 
replace the highlighted text.

Your file will be saved 
in whatever folder or 
disk is named in this 
menu. So if you want to 
save the file in another 
folder, you must first 
select the other folder 
before you click the 
Save button.

You can search 
for the folder in 
which you want 
to save your file.

You can create a new folder right now 
and your document will be saved inside 
of that new folder. But remember where 
you put that new folder!

 Extensions are the three- or four-letter abbreviations at the ends of file 

names. Your Mac needs these extensions so it knows what to do with the files. You can 

“hide” the extensions so you don’t have to see them, but it’s a good idea to get used to 

them. They will help you keep track of what kind of files you’re creating.

I suggest that you 
uncheck this box 

so the extensions 
are visible to you. 
See the tip below.
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Use the Tab key to select various parts of the Save As 

or Open dialog boxes: 

 1 If the insertion point is in the fi eld where you name the fi le, 
then the first Tab selects the Search fi eld. 

 2 Th e next Tab selects the Sidebar. Use the up and down Arrow keys 
to highlight the folder or disk you need.

  Th e next Tab selects the fi rst column. Use the up and down arrows 
to select a file in the first column, then hit the right Arrow to select 
the next column.

 4 When you select the folder into which you want to save the file, 
hit the Return key to activate the Save button. 

❸❷

❶

❹

❶

❷

❸

❹
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Navigate the Desktop and Finder Windows
If you so choose, you can get around your entire    Desktop and inside Finder 
windows using the keyboard. For instance, you can get to every menu across the top 
of the screen and choose commands, without ever touching the mouse. 

Access the menus on the   Desktop or in any application:

 1 Press Control F2 to select the  menu bar across the top of the screen
(on a laptop, you might need to press fn Control F2). 

 2 Use the left and right Arrow keys to select menu items across the menu bar, 
or type the first letter of the menu you want to select. When a menu is selected, 
you’ll see it highlight. 

 3 When the menu name you want is highlighted, press the Return key 
to drop down its menu.

 4 Press the down and up arrows to choose a command in the list, or type 
the first letter or two or three. (If there is more than one command that 
starts with the same letter, type the first two or three letters quickly to 
select a specific one.)

 5 Hit Return to activate the selected command.

  To put the menu away without activating a command, press 
Command Period (Command .).

Try these shortcuts in a Finder window: 

■ Type the first letter or two or three to    select files. 
■ When you’re in the List View or Column View, use the  Arrow keys to 

select the columns to the right or left, then use the letter keys to select 
files in that column. 

■ Select a document, hit Command O to open it, and get to work!

If you are interested in using more keyboard shortcuts, go to the “Keyboard & 
Mouse” preferences, as explained on pages 276. In that preference pane you see 
shown on the page, you’ll find an extensive list of keyboard shortcuts. Th e shortcuts 
are not printed here in this book—they’re in that preference pane on your Mac!
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Mac OS X Applications in Leopard



 

3
GOALS

Understand the 
common features  

of Apple applications

Realize what can not be 
covered in this book 
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LESSON 3

Introduction to 
Mac OS X Applications

One of the greatest things about Mac applications is that they 

are consistent, which makes them easy to learn and easy to use— 

what you learn in one application applies easily to just about any 

other application. 

In this short introductory lesson, I’m just going to present a brief 

overview of the major apps (applications) that you’ll find in your 

Applications folder and the Dock. All of the Apple applications 

are integrated with other apps, and they all share certain features 

and tools. In the following chapters I’ll go into more detail about 

individual programs, and in Lesson 13 of this section you’ll learn 

how to use the tools that all Apple applications share.
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Know your Applications Folder
In the Sidebar of any Finder window is an icon labeled         Applications. Single-click 
this icon to display the contents of the Applications window. Th ese are the programs 
you will use to create your work on your Mac.

At any time, you can put the application you use most often in the Dock so you’ll 
have easy access to it: Just drag the application icon from this window and drop it 
on the Dock. If you accidentally lose something from the Dock, you can always 
come back to this Applications window to drag the item back in.

Some applications that you 
buy will display their folders 
here in the Applications 
window instead of the 
applications’ icons (here, you 
can see the Mariner Write 
folder, the word processor 
I use). 

If you see an application 
in a folder, open that 
folder and find the actual 
application icon to drag to 
the Dock.
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Application Integration
All of the Apple applications share certain tools such as the Spell Checker and 
Grammar Checker, the Fonts palette, the Colors palette, the Special Character 
palette, and more. All of those common tool elements are explained in detail in 
Lesson 13.

Also keep in mind that all of these applications also work together in amazing ways. 
You can drag text and graphics from one app to another, save fi les into diff erent 
formats, save to-do messages from Mail directly into iCal, create a pdf in TextEdit 
that you can read and annotate in Preview, and more. See the individual application 
chapters and Lesson 14 for details.

And be sure to read the last page of each of the application lessons to learn how 
many ways each app is integrated with others!

What I’m not Covering!
I introduce iTunes in Lesson 10, but I don’t cover iPhoto, iWeb, iMovie, or iDVD 
because they are not part of the Mac operating system. John Tollett covers those, 
however, in a big fat book called Cool Mac Apps, which is essentially eighteen 
manuals in one book. Th ere you’ll fi nd much more information than I can provide 
in this introductory book about such programs as Mail, iCal, and iChat—48 pages 
on iChat alone, and 76 pages on Mail. You can see why I don’t cover all of that in 
this book!

Nor do I cover Pages, Numbers, or Keynote in this book because you have to buy 
those in the iWork package. If you have those programs, Peachpit publishes a book 
on iWork, plus the applications have pretty good Help fi les built right in. 
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Know the Common Features of Mac Apps
Most Mac           applications have these features in common. 

Windows and window controls 

When you open an application, you’ll actually be working in a 
window. If you worked through Lesson 1, you already know all 
about windows, even ones you haven’t seen before. You see the 
same red, yellow, and green buttons to close, minimize, and resize 
the window. Th e document name and a tiny icon appear in the title 
bar. You can drag the title bar or any edge to move the window. 

Application menu 

Th e application menu (directly to the right of the blue Apple menu) 
always tells you the name of the currently active application, the 
one you’re working in (even if there is no document window open 
on the screen). You’ll always find the Quit command at the bottom 
of this menu.

File and Edit menus 

You’ll always find File and Edit as the first two menus to the right 
of the application menu. 

Although each application includes specific features in its menus, 
in the File menu you’ll always find the commands to open an existing 
document or create a new one, save the document or save as 
with another name, close the active window, and print the active 
document. 

From the Edit menu, as shown below, you can always undo or redo, 

cut, copy, paste, delete, select all, check the spelling and grammar, and 
access the Special Characters.
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Preferences Every     application has its own preferences where you can customize 
the application to suit yourself. You’ll always open the   preferences 
from the application menu (see the previous page). Typically you’ll 
see a toolbar across the top of the preferences pane; single-click an 
icon in   that toolbar to set the preferences for that particular feature. 

 
Toolbars Many applications have a Toolbar across the top of the window. 

Usually you can  customize this Toolbar: check the View menu 
for a command called “Customize Toolbar… ,” or use the contextual 
menu (Control-click or right-click on the toolbar).  

Safari preferences. 
The Tabs pane 
is selected.

This is a typical 
sheet that drops 

down from a 
toolbar so you can 

customize it.
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Sidebars or drawers 

Many applications have a sidebar, a drawer, or some other sort of 
pane on the side of the window. Single-click the icons you see in a 
sidebar-like feature to display its particular contents in the  window.

Special collections 

Several applications use collection metaphors such as Albums 
in iPhoto, Playlists in iTunes, Bookmark Collections in Safari, 
Mailboxes in Mail, Groups in Address Book. Use these to store 
and organize your stuff . 

 Open and Save As dialog boxes 

Whenever you open an existing document or save a new one, the 
dialog boxes you see to open a new document or save a document 
always look familiar. See pages 44–45 for tips on how to get around 
these dialog boxes and save into particular folders.

Help files Every application has a Help menu with Help files specific to that 
application. You can either use the menu you see on your screen or 
press Command ? to bring up the files. You’ll find a search box where 
you can type in key words, then hit Return to display the answers. 
See page 30 for more details.

Here the iTunes 
Store is selected 

in the sidebar.
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Action button and menu 

In many applications, you’ll see the Action button (shown to the 
left) that displays the  Action menu. Every application has diff erent 
options—always click on it to see what is available.

Preview before you print 

At the bottom of the Print dialog box is a button called “Preview.” 
Click this to open your document in the Preview application where 
you can see what it will look like when printed. 

Search Just about every               application has a search feature. It’s usually in the 
upper-right corner of the window, as you can see in the iTunes 
window on the opposite page and in the Address Book below. Just 
exactly what the search feature searches depends on the application. 
See the individual overviews in the lessons for each application.

Smart Folders 

Many applications have some version of Smart Folders that 
automatically update themselves according to your specified 
criteria. See Lesson 19 on Spotlight to learn how to take advantage 
of this great feature. 

 Other applications have similar types of smart folders: Th e Address 
Book has Smart Groups that will add appropriate contacts to 
themselves; iTunes has Smart Playlists that will add music to 
themselves; Mail has Smart Mailboxes. See the individual lessons 
for each application. 

This Smart Group finds people in my Address Book who have birthdays 
coming up. iCal will add these birthdays to a calendar; see page 152.



 

4
GOALS

Learn how to open Microsoft 
Word documents and save 
TextEdit files as Word docs

Find and replace 
words or phrases

Create favorite styles for 
quick formatting

Take advantage of the 
“Complete” feature

Turn on typographer’s 
quotes

Become familiar with 
tabs and indents

Create lists and simple tables

Create live web or email links

Select non-contiguous text

Print page numbers
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LESSON  4

TextEdit for 
Word Processing

TextEdit is a small yet surprisingly powerful word processor. 

Use it for writing memos, letters, diaries, novels, grocery lists, 

memoirs, or any other text documents. In TextEdit you can create 

simple tables and automatically numbered or bulleted lists. You 

can put shadows on type, insert images, search and replace text, 

and more. But it’s not a full-blown word processor such as Apple’s 

Pages or MarinerWrite (MarinerSoftware.com). Although TextEdit 

can’t do all the fancy things a big word processor can, it’s excellent 

for many projects. 

You’ll find TextEdit in your Applications folder. If you use it 

regularly, drag its icon to the Dock. 

If you’ve never used a word processor before and you don’t know 

how to enter text, select text for formatting, cut/copy and paste, 

etc., please read Th e Little Mac Book fi rst! Th is chapter assumes 

you know the basics of working in a word processor. 
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Read   Microsoft   Word Files
Do you work with people who send you      Microsoft Word files, but you prefer to 
keep a Microsoft-free environment on your own computer? TextEdit can open 
Word files and save as Word files. Some of the advanced features will be missing, 
but this works great for basic text documents, including those with simple tables 
or numbered/bulleted lists. 

If you don’t have Microsoft Word installed on your Mac, fi le names ending with    .doc 
(which are usually Word fi les) automatically open in TextEdit when you double-
click them. 

To force a Word document to open in TextEdit (if it’s not your default), drag the 
file and drop it on the TextEdit icon. 

(If the TextEdit icon is not in your Dock, it’s in the Applications folder. If you want 
TextEdit in the Dock, drag it from the Applications folder and drop it in the Dock.)

Change the default application to open Word files
If you own Microsoft Word and want your .doc fi les to open in Word, not 
TextEdit, you can change the default application: 
 1 Control-click (or right-click) on the Word fi le icon to get its contextual menu.

 2 While the menu is visible, also hold down the Option key. Th is changes
the “Open With” command to “Always Open With.”

 3 Choose “Always Open With.” If Microsoft Word is on your Mac, 
you’ll see it listed in the top part of the pop-out menu. Select it, 
and your .doc fi les will now automatically open in Microsoft Word.

I don’t own Microsoft 
Word, so it doesn’t appear 
in my list of options. But if 
you own it and it’s installed 
on your Mac, you’ll see the 
option here to always open 
with Word.



Lesson 4 TextEdit for Word Processing

59

Save TextEdit files as Word docs
You can save any TextEdit fi le as a Microsoft Word document to send to people who 
insist on that format.

To save a TextEdit file as a Word document: 

 1 Go to the File menu and choose “Save As….”

 2 In the File  Format menu at the bottom of the Save As dialog box, 
choose “ Word 2007 Format (docx).” Th is automatically adds the Word 
extension,  .docx, to the end of your file name. 

  As you can see in that Format menu, you can also save your fi les 
in several other formats. Keep these other formats in mind!

  If you don’t see the extension at the end of the file name—and you 
want to—make sure there is no checkmark next to “Hide Extension,” 
circled below. 

If you don’t see the entire 
panel, as shown here, single-
click this   disclosure triangle.
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      Find and Replace Words or Phrases
Did you write your entire novel using your sweetheart’s name, Peter, as the hero? 
And now Peter’s abandoned you and you want to change the hero’s name to 
Heathcliff ? No problem:

 1 Go to the     Edit menu, slide down to “Find,” then from the pop-out menu, 
choose “Find…,” or skip all that and press Command F. 

 2 Find “Peter” and replace with “Heathcliff .” 

If you create a lot of text in TextEdit, it will be worth your time to experiment with 
the options you see in the Find dialog box, as described below. 

To replace: 

  Only the currently selected occurrence of the text, click “Replace.”

  All occurrences of the text in the document, click “Replace All.”

  All occurrences of the text in a block of selected text, hold down the Option key 
and click “In Selection” (it appears when the Option key is down).

To simultaneously select (but not replace): 

  All occurrences of the text, hold down the Control key; “Replace All” changes 
to “Select All.”

  All occurrences in a block of selected text, hold down both the Control key 
and the Option key; “Replace All” changes to “In Selection.”
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Paste Text to Match the Existing Text
Th is is one of my favorite features. Let’s say you’re writing a term paper and you 
copy a quote from a web page to add to your paper (properly cited, of course). 
Typically the copied text pastes in with the typeface, style, size, and color that were 
originally applied to it. But to add this quotation to your term paper, you want it to 
look like the rest of your page. Use this great feature instead of the regular paste:
  From the Edit menu, choose    Paste and Match Style, 

or use the keyboard shortcut, Shift Option Command V.

Th e pasted text will pick up all the formatting from the character to the left of the 
flashing insertion point. Th is technique works in Mail as well.

Use your Favorite Text Styles Easily
TextEdit doesn’t have the powerful  style sheets of a full-blown word processor, but 
it does make your writing life much easier by letting you create      favorite styles 
of basic type features so you can apply them quickly. A “style” contains all of the 
formatting information, such as typeface, size, color, indents, etc., so you can apply 
everything to selected text with one click of a button.

Th ese styles are saved with TextEdit, not with an individual document, so you can 
use the same styles in diff erent documents. 

To create your own favorite style:

 1 Type some text, any text, and set up the typeface, size, color, linespace, 
and the ruler the way you want it. 

 2 Click anywhere in that formatted text. 

 3 From the “Styles” menu in the toolbar, choose “Other…”

 4 Click the button, “Add To Favorites.”

 5 Name your new favorite style and choose your options. Click “Add.”

To apply a style, select the characters, then choose the style name from the Styles 
menu. All of the formatting that you saved with that style will be automatically 
applied with the click of that button.
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Complete your Word Automatically
Th e       Complete command in the Edit menu pops up a menu of possible completions 
for an unfinished word, as shown below. Th e list learns new words—type a word 
once, then next time you start to type it, that word appears in the list. Frequently 
used words appear at the top.  

 1 Start to type a word that you’re not sure how to spell or one that is long and 
you don’t want to type the whole thing. 

 2 From the Edit menu, choose “Complete,” or press Option Escape (the esc 
key in the upper-left of the keyboard). A menu like the one shown below 
will appear. 

 3 If the word you want is already highlighted at the top of the list, just hit 
Return. If not, use the Down arrow key to select a word and then hit Return, 
or double-click on the word you want.
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Typographer’s Quotes!
At last, in the year 2007, TextEdit fi nally gets automatic typographer’s quotes, or 
smart quotes. Smart quotes (and apostrophes) are the curly ones, not the lame, 
straight, typewriter quotes. Nothing will make your work look as amateurish as 
typewriter quotes.
 typewriter quotes smart quotes

 It's "Baby Doll." It’s “Baby Doll.” 
Th ere are two places where you can turn “Smart Quotes” on or off . In the TextEdit 
preferences (explained below), you can turn them on or off  for the application. But 
you can also override this application setting in individual documents.

To turn on Smart Quotes for every new TextEdit document:

 1 From the TextEdit menu, choose “Preferences….”

 2 Click the “New Document” tab, if it isn’t already blue.

 3 Check the box for “Smart quotes.”

To turn Smart Quotes off or on for an individual document:

 1 From the Edit menu, slide down to “Substitutions.”

 2 In the sub-menu, click “Smart Quotes.” A checkmark means they’re on, 
and no checkmark means they are off . 

Why would you want to turn them off ? So you can type the feet and inch marks 
without looking dumb. For instance, I am '" tall, not ’” tall. 
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Tabs and Indents
Th e tab and indent markers in TextEdit function as in any word processor. Drag tab 
markers from the Tab  box to the ruler; drag them off  the ruler to remove them. Drag 
the indent markers shown below to indent either just the fi rst line of text or both the 
left and right edges.

First lines of paragraphs start at 
this First Line Indent marker.

All other lines in the paragraph 
start at this Left Indent marker.

The right edge of text 
stops at this Right 
Indent marker.

These are your tab options:
Left Aligned

Centered

Right Aligned

Decimal

▼

◆

▼

● ●

Examples of tab and indent settings
Below are some examples of how to set up your tabs and indents to create certain 
eff ects. Remember, for a tab, fi rst set the marker, then hit the Tab key before you 
type the text. Once you’ve got tabs set up, you can move the tab and the text will 
follow; just make sure you select the text before you move the tab!

Follow the directions as explained in each window below to achieve the look you see 
in the window. Th e tab applies only to the selected paragraphs. Because of the way 
paragraphs work on the Mac, you need only click inside a paragraph to select the 
whole thing. To select more than one paragraph, press and drag to highlight several 
characters in each paragraph. 

This is a common 
setup. It might seem 
a little tricky at first, 
but once you get it, 
you’ll love knowing 

how to do it. 
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You can call this an 
outdent, where the first 
line is outdented further 
than the other lines. 

This is an example of an 
individual paragraph 
indented on both sides. 

Columns are easy to 
create. Just remember 
to hit ONE tab to get 
to the next column.
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Create Lists that Number Themselves
If you have a  list of items,  TextEdit can number them for you with numbers, capital 
or lowercase letters, or other options. When you add or delete items from the list, 
TextEdit automatically updates the numbering. 

When you click on the Lists menu (circled above) and choose a numbering option, 
the numbers apply to either of the following:

If you selected text on the page before you went to the Lists menu, your 
choice of list numbering will apply to the selected text. Each time you 
hit a Return, TextEdit considers that line to be the next item in the list. 

If there is no selected text, the fl ashing insertion point is “fi lled” with the list 
specifi cations, and everything you type from that point on will be in the list 
format. Th is is a good way to start a new list: Just make sure your insertion 
point is fl ashing where you want the list to begin, then go to the List menu 
and choose your numbering system, then start typing. 

Choose “Other…” in the Lists menu to set up the specifi cations of your choice. 

To end the sequencing of numbers in a list, hit the Return key twice at the end of 
the last item. 

To delete the list numbers, single-click anywhere in the list. Open the Lists menu 
and choose “None.” 
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Create  Tables
You can  create simple tables in TextEdit. Th is table feature also helps ensure that 
tables created in a Word document will open in some form in TextEdit.

To create a table in TextEdit:

 1 Position your insertion point where you want the table to begin.

 2 Go to the Format menu, slide down to “Text,” then choose “Table….”

 3 Th e Table palette appears, as shown below. Choose how many rows and 
columns you want in the table. You can determine how the text is aligned 
vertically as well as horizontally in each cell (use the “Alignment” icons), and 
more. Spend a few minutes to familiarize yourself with the tools.

  As you type in a cell, the cell expands downward to fi t the text. 

  Change the formatting of the text as you do on a regular TextEdit page: 
select the text fi rst, then choose formatting from the menus or palettes. 

 4 To resize  rows and columns, position your pointer over the edge of a cell. 
Th e pointer turns into a two-headed arrow. With that two-headed arrow, 
press-and-drag on a cell edge to resize it. 

If you don’t want any border, 
enter 0 (zero) in the “Cell Border” field.

Click on the color well 
to get the Colors panel.

To activate this color well, first choose 
“Color Fill” from the menu to its left.
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Create Live  Web Links and Email Links
It’s easy to create web links and email links on a TextEdit page. If you send someone 
the     TextEdit fi le, that person can click on a web link; her browser will open and go to 
the page you specify. An email link in the document opens her email program, pre-
addressed to whomever you specifi ed. 

If you make a pdf of your document (see page 71), the links will still work in the pdf. 

Create links as you type web addresses:

 1 Simply go to the Edit menu and slide down to “Substitutions.” 

 2 In the pop-out menu, choose “Smart Links.” If there is a checkmark 
next to “Smart Links,” it’s already on! 

 3 On your TextEdit page, just type the web address. It needs the www 
part of the web address. If your address doesn’t have www, then be 
sure to include the http:// in the address on the page. You’ll know if it’s 
working or not because the text will turn into an underlined link.

Sometimes the text on the page is not the actual address, but you do want the link 
to go to the address. For instance, perhaps you wrote, “Please visit our Mary Sidney 
web site,” and you want the link attached to “Mary Sidney” to go to MarySidney.com. 
Or you want to say, Email me! as a link to your actual email address. In either case, 
use the manual process. 

To manually create a web link on a TextEdit page:

 1 Type the text that you want to apply a web link to. Th is text can be anything—
it doesn’t have to be the web address itself !

 2 Select the text to which you want to apply the link.

 3 From the Format menu, slide down to “Text,” then choose “Link….”

 4 Enter the web page address. Make sure you include this code at the 
beginning of the web address:   http: // 

 5 Click ok.
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To create an email link on a TextEdit page:

 1 Type the text to which you want to apply an email link. Th is text 
can be anything—it doesn’t have to be the email address itself.

 2 Select the text you want to apply the link to.

 3 From the Format menu, slide down to “Text,” then choose “Link….”

 4 Type into the fi eld:   mailto:

 5 Immediately after the colon you typed (as shown above), enter the entire 
email address just as you would address it.   mailto:name@domain.com

 6 Click ok.

Select Non-Contiguous Text
Th is is really quite wonderful. “Contiguous” means “sharing a common border.” 
Very few applications allow you to select individual sections of text that are not 
physically next to each other (text that is non-contiguous). Th is technique lets you 
apply formatting or copy, cut, or delete separate sections of text all at once.

To  select non-contiguous text:

 1 Press-and-drag to select a section of text.

 2 Hold down the Command key. Press-and-drag to select some other text 
that is not contiguous! 
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    Print Automatic Page Numbers
You can add page numbers to a printed document (the numbers won’t appear on 
the screen). Th is feature also automatically adds the name of the document in the 
upper-left corner (including the extension, probably .rtf ), the date and time in the 
upper-right corner, and the words “Page ___ of ___” in the bottom-right corner. 
Th at is, in TextEdit you can’t choose one or the other of these—they all appear on 
the page, or none. 

To print the page numbers (and everything else), press Command P (or go to the 
File menu and choose “Print…”). In the Print dialog box, shown below, make sure 

“TextEdit” is chosen from the menu. Check the box to “Print header and footer.” 

       Extra Tips and Notes
Ruler: If the       ruler isn’t showing, press Command R. Without the ruler showing, 
you can’t set tabs, indents, or margins.

Formatting: If text won’t let you apply formatting, it’s probably using “Plain Text.” 
Go to the Format menu and choose “Make Rich Text.” 

   Wrap to Page: If the  text is stretching the entire width of the window no matter 
how wide you open it, you might want to switch to the option where the text wraps 
according to the page it will be printed on. To do this, go to the Format menu and 
choose “Wrap to Page.” 

When the TextEdit page is using “Wrap to Window,” your printer will reduce 
the size of the text on the printed page to match the line lengths on your screen. 
So   if your    text prints really tiny, follow the step above to “Wrap to Page.”
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Standard Mac OS X Application Features 
Don’t forget that TextEdit includes all of the standard Mac features as explained in 
Lesson 13, such as spell checking and grammar checking, creating shadows for text, 
applying color, using special characters, previewing before you print, making pdfs, 
and more. 

 TextEdit is Integrated With:
Safari: Web address links open in Safari.

Control-click on a word in TextEdit to search for it in Google.

Dictionary: Control-click on a word and choose “Look Up in Dictionary” from the 
pop-up menu to get that word’s defi nition and thesaurus entry. 

Mail: Email address links in TextEdit open a pre-addressed email message 
in Mail. 

Preview: Create a pdf in TextEdit (see below) that opens in Preview. You can 
also annotate the pdf in Preview (see Lesson 11).

Speech: Have your text read aloud to you. Select the text to read just the 
selected part, or select nothing and the voice (named Alex) starts at 
the beginning of the document. Th en go to the Edit menu, slide down 
to “Speech,” and choose “Start Speaking.” To turn the voice off , you 
have to go back to the menu and choose “Stop Speaking,” or use the 
contextual menu (Control-click or right-click in the document) and 
from the contextual menu, choose “Stop Speaking.”

Other Relevant Lessons for TextEdit
Search: Besides the search-and-replace feature explained on page 60, you can 

also do a Spotlight search, as explained on page 350. 

PDFs: All TextEdit documents can be turned into pdfs with the click of a 
button: just go to File and choose “Print…,” and in the Print dialog box, 
click the “pdf” button and choose “Save as pdf.…”

Fax: You can fax any TextEdit page with the click of a button. See Lesson 17.



 

5
GOALS

Set up an account in Mail

Read and send email

Be more productive 
by filtering junk mail 

from your inbox

Organize your mail 
with mailboxes and 

Smart Mailboxes

Use searches and Rules 
to find and organize 

your messages

Personalize your 
messages with signatures

Create To Do items 
that you can add to iCal

Use Notes to collect 
all your thoughts and ideas
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LESSON  5

Mail for Email, Notes, 
and To Do Lists

Mail is Apple’s application for sending and receiving email. If you 

have more than one email account on more than one server, Mail 

can check them all at the same time. You can send mail from any 

of your accounts right through Mail.

A really wonderful feature is “stationery,” where you can create 

fancy html email messages with special fonts, images, and 

design—all with the click of a button. 

And take advantage of the Notes and To Do lists in Mail. Th ey 

even coordinate instantly with your iCal information to expand 

their usefulness. 



Lesson 5 Mail for Email, Notes, and To Do Lists

74

New Account Setup Assistant 
It’s easy to add your email         account to Mail if you didn’t do it when you fi rst installed 
Leopard or turned on your new Mac. If your account is already set up, skip to 

page 78. 

 1 In Mail, go to the File menu and choose “Add Account….”

 2 A window, shown below, appears. If you enter your .Mac account name and 
password, you’re done—your Mac will fi ll in everything else and your email 
will appear in the viewer window. Skip the rest of these setup instructions 
(except take a look at the smtp info on page 76).

  If you have an email account that is not a .Mac account, enter the information 
required, then click “Continue.”

This is the name that will 
be visible to the people to 
whom you send email. 

 3 Th e next window asks technical details about your account. If you don’t 
know what kind of account it is, call your Internet Service Provider and ask. 
Generally speaking, this is how to choose the type of account:

Choose POP if you have an email account with your isp, or if you have a 
domain name that you paid for and you opted for an email account with it 
(regardless of whether there are actually web pages for that domain name). 
This is the most common.

Choose IMAP if your account is the kind that you can use on diff erent 
computers and always see your mail. Th is is usually with a paid service or 
a large company intranet (although most pops can be set up as imap if you 
ask your provider). 
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Choose Exchange if your company uses the Microsoft Exchange server 
and the administrator has confi gured it for imap access. See your system 
administrator for details.

This is what will appear 
in the Mail sidebar 
so you know which 
account it is.

  Each account type has slightly diff erent information to enter. 

  For instance, if you choose a pop account, Mail wants to know the   Incoming 

Mail Server. It’s usually something like pop.domain.com or mail.domain.com. 
Th e “domain,” of course, is to be replaced with the domain name of your email. 
For instance, I use mail.Th eShakespearePapers.com for my mail that comes 
from that web site. If you’re not sure, check your email host’s web site or call 
and ask for the “incoming mail server.”

  If you use a webmail account, such as Hotmail, GMail, aol, Yahoo, etc., it’s 
a wee bit trickier to set up Mail. It’s not diffi  cult at all, but you have to know 
certain information. Because this information changes all the time, check this 
great web site: www.EmailAddressManager.com. Go to the “Email Tips” and 
from there fi nd the information about incoming and outgoing mail servers and 
ports for your particular kind of account. 

  Th e User Name for a pop account might be diff erent from your email name, 
or it might be your entire email address (most often) or it might be something 
diff erent altogether. If your email address doesn’t work, ask your provider. 

  Enter your password as provided by your provider or set up by you when you 
opted for the email account.

  Click “Continue.”

See below.

See below.

—continued

www.EmailAddressManager.com
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 4 Th e Outgoing Mail Server, or SMTP, has a couple of options. For instance, 
your .Mac account will be automatically set up with a .Mac smtp. However, 
I’ve found that the most reliable smtp is the one provided by your Internet 
service provider. For instance, if you use Comcast, your best smtp is “smtp.
comcast.net.” Th at is, your most reliable outgoing mail server is going to be the 
company that you pay to connect you to the Internet. 

  Some providers, like Qwest here in the West, have a cheesy low-end 
broadband option that does not allow you to have an outgoing mail server. You 
are forced to go to Microsoft’s web page to check and send your mail. If that’s 
your situation and you don’t like it, call them and upgrade your service so you 
can get an smtp (or change providers). 

  Th e Description fi eld is just for you to name this smtp so you can choose it 
from menus. Enter something that will make it clear to you.

  Unless your provider insists, you usually don’t have to enter a user name and 
password for authentication, so for now you can leave those blank.

 5 Successful creation of a new account is announced as soon as you click 
“Continue.” 
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Check your Dock Icon
When email is received, your  Mail icon in the     Dock displays a little red tag telling 
how many messages are unread. 

Single-click on this Mail icon to bring the Mail window to the front. You don’t have 
to quit Mail when you’re fi nished working in it. 

Or press (don’t click) on the Dock icon to pop up a menu with options to get new 
mail and to create a new message (among other things).  

To   add another account or edit an existing account:

At any time you can add another account or edit an existing one by using the Mail 
preferences. 
 1 Go to the Mail menu and choose “Preferences….” 

 2 Click the “Accounts” icon in the toolbar.

 3 To add a new account, single-click the + sign at the bottom of the 
Accounts pane. Fill in the information on the right.

  To edit an existing account, single-click the account name in the pane, 
then use the pane on the right to edit.

 4 When fi nished, just close the preferences or click on another icon. 
A message will appear asking if you want to save these changes.
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Read and Send Email
Th e default in Mail is to automatically check your mail every fi ve minutes. Th is, 
of course, assumes you use a full-time broadband connection. If you use a dial-up 
connection, go to the Mail preferences (from the Mail menu), click the “General” 
tab, and change it to “Manually.”

As mentioned on the previous page, when you have messages in Mail that are yet 
unread, the Dock icon puts the number in red so you always know. 

To read mail that has arrived:

 1 If you have more than one account, your “Inbox” will have a disclosure triangle 
next to it. Click on the triangle to see the individual accounts (shown below).

 2 On the left, single-click on the account you want to see. Th e messages are 
displayed in the message pane to the right. Unread messages have a blue orb 

next to them. 

 3 To read a message, single-click on it and the message will be displayed in the 
lower pane. Or double-click on a message and it will open into a new window.

Single-click 
a message to 
read it in the 
pane below.

Double-click 
a message to 
open it in its 
own window.

This is the 
Mailboxes 

sidebar. Each 
of these icons 
is considered 

to be a 
“mailbox.”

Click “New Message” to   compose and send a message. 
Enter the recipient’s email address, plus a subject. 
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 If you can’t do format the text in a message, such as color it or even make 

 words bold, go to the Format menu and choose “Make Rich Text .” If it says “Make Plain 

Text” in that menu instead of rich text, that means you’re already working in rich text. If you 

still can’t make bold or italic text, then the font you chose does not have bold or italic ver-

sions. Check the Fonts panel (press Command T; see pages 234 –235 for details).

To send an email message:

 1 Click the “New Message” button in the toolbar, or press Command N.

 2 Enter an email address in the “To” fi eld. 

  Or if you have an address in your Address Book or if you’ve sent a message to 
this person before, as soon as you start typing, the rest of the email address 
appears. If there is more than one person with those beginning letters, you’ll 
get a list of possibilities. You can use the arrow keys to go up or down the list 
and select the addressee you want; hit Return to put that address in the fi eld.

  Or click the “Address” icon in the toolbar to bring up the Address Book pane, 
a limited version of your Address Book. Double-click on anyone’s name to add 
it to the “To” fi eld.

 3 Enter a subject in the “Subject” fi eld. Do not type something that might be 
construed as junk mail! For instance, don’t type “Hi” or “Th ought you might like 
to know” or “About last night” or “I’ve got a great opportunity for you—all I need 
is your bank account number.” Be specifi c so the recipient will actually open your 
message instead of immediately deleting it because it sounds like spam.

 4 In the message pane, type your message. Mail will automatically check your 
spelling and display suspect words with a red dotted underline. You can change 
the font, the color, the size, the alignment, and more—use the Format menu. 
You can use the Font panel, Colors panel, Spelling Checker, and all the other 
Mac OS features—see Lesson 13 for details. 

 5 If you want to send a fi le of some sort, just drag it into the message window 
and drop it (see pages 100–103 for more details). 

 6 When you’re ready, hit the “Send” button. Or click the “Save As Draft” button 
in the toolbar to save it for later. To open that letter later, go to the Drafts 
folder in the sidebar. 
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Customize the Message Window
It’s easy to customize the message headers, the toolbar, and to add or delete various 
columns of information. 

To add or delete columns of information in the message pane:

 1 Make sure the Mail viewer window (the main window) is open in front of you.

 2 Go to the View menu, slide to the fi rst item, called “Columns,” and slide out to 
the right. Choose the information that you want to see from that list. 

To customize the toolbar:

 1 From the View menu, choose “Customize Toolbar….”

 2 Drag anything into the toolbar from that pane. While the pane is open, 
drag anything out of the toolbar that you don’t want—drag it off  the toolbar 
and drop it on the Desktop. Drag icons left or right to rearrange them. 

  To reorganize the existing items in the toolbar at any time, hold down the 
Command key and drag icons to diff erent positions in the toolbar, or drag 
them completely out of it.

To customize the message headers:

 1 Open any new message (click the “New” button in the Mail toolbar). 

 2 Click the Action button (shown circled, below), and choose “Customize…” 
to get the pane shown below. 

 3 Check the boxes of the items you want to see in your messages. Click ok when 
you’re done.

Signatures, 
see pages 86–87.

 Priority, 
see page 104.
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Delete Junk Mail Without Ever Seeing It!
Mail has a  junk mail filter that can toss your spam automatically. Actually, while 
in “training,” it will put spam in a special  brown “Junk” folder where you can check 
to make sure messages really are garbage before you toss them. Once you are 
confident it’s doing a good job, use the rules described on page 85 to delete junk 
mail immediately.

To turn on Junk Mail filtering, go to the Preferences pane (in the Mail menu), 
click the “Junk Mail” icon, and check the box to “Enable junk mail filtering.” 
Carefully read the other choices in the pane and choose your options.

To prevent having to display  junk 
mail before you throw it away, drag 
this bar all the way to the bottom. 

Do Not Display Junk Mail!
Some junk mail sends an invisible message back to its sender as soon as you open 
it, telling the despicable junk mailing scum that this is a working email address. 
To prevent opening and displaying that mail at all, get rid of the message pane, as 
shown below. Th en when you click on a message to delete it, it doesn’t automatically 
appear in that pane. When you want to read a message, double-click on it and it 
will open in a separate window.
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Use Stationery to Send Fancy Mail
    It’s actually called “html” mail, not “fancy” mail. html just means it has html code 
written into the message for you that creates the layout, the space for photos, the 
fonts, etc. You don’t have to write one single piece of code. All you do is choose the 
stationery template, type your message, and drag photos to replace the existing ones. 

To create an email with stationery:

 1 Open a new email message (Command N).

 2 Single-click the button on the right side of the message toolbar called “Show 
Stationery.” (If you don’t see that button, open the message window wider, or 
click on the arrow you see where the button should be—that will pop out a 
menu with “Show Stationery” on it.)

 3 A row of stationery templates appears, as shown below. Single-click on a 
category on the left to show the template options on the right. 
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Save as stationery
You can save your own designs as stationery. You can’t use the templates that Apple 
provides, but you can set up an email message with the fonts you like to use, as well 
as colors, links, and images that you want to appear in the message. When you’ve 
got it the way you want it, go to the File menu and choose “Save as Stationery.” 

A new category appears in the list of stationery, called “Custom.” Click on that new 
category and you’ll see your own stationery.

To delete stationery you made, position your mouse over it and a little X appears 
in the upper-left corner. Click the X to delete the stationery.

 4 To replace the text, click on it and it automatically selects all the text in that 
section. Whatever you type will replace that text, but will retain the font.

 5 To add photos, you can do several things.

  Click the “Photo Browser” button in the toolbar. Th is opens the 
Photo Browser and displays all the photos you have in iPhoto, 
Aperture, or Photo Booth. Just drag an image from the Photo 
Browser and drop it directly on top of the image you want to replace.

  Drag an image from anywhere on your Mac and drop it on an 
existing image.

  Open iPhoto and drag an image directly from iPhoto onto an 
existing image.

 6 To resize photos, double-click on an image and a little slider bar appears, as 
shown on the previous page. Drag the slider right or left to enlarge or reduce 
the image.

 7 To reposition the image within the frame, double-click on the image 
(as above). Th en press-and-drag on the image to reposition it within its frame 
(you can’t reposition the frame itself ). 

You can change templates at any point—if there are fewer photos in the new 
template, some of them will disappear. Your text will reappear in the new template. 

Click the “Hide Stationery” button to put the row of templates away so you have 
more room in which to write. 
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Create Mailboxes to Organize your Mail
Organize your mail with mailboxes in the same way that you make folders in a 
Finder window to organize all the files on your Mac. (In fact, most of the mailboxes 
look just like folders.) Use the “Mailbox” menu to create new ones, or Control-click 
in the Mailboxes sidebar. If you Control-click directly on an icon in the sidebar, the 
new mailbox will be a subset of that icon . 

Once you’ve got your mailboxes set up, use the fi lters (called Rules; see the next 
page) to automatically send incoming mail to the diff erent folders/mailboxes. Also 
check out pages 89–91 about Smart Mailboxes.

You can see here that I’ve got: 

• Three email accounts in my Inbox.

• Folders that Mail has created for 
Drafts, Sent messages, and Trash.

• A Reminders folder for my To Do lists 
and Notes.

• Mailboxes that I created so I can store 
messages on my Mac (instead of on an 
email server somewhere else).

• Mailboxes that .Mac has created for 
my .Mac account.

• An RSS folder that was created when 
I chose the option to receive RSS feeds 
in Mail (see Lesson 7 on Safari).
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Filter your Incoming Mail with Rules
Create  rules, or filters, to  sort  incoming mail into the appropriate mailbox. First, 
create the mailboxes you want for organizing (see opposite page). Th en:

 1 From the Mail menu, choose “Preferences….”

 2 Single-click on the “Rules” icon. Single-click “Add Rule.”

 3 Choose your parameters for the type of mail coming in and what to do with it. 
(If you forgot to make a special mailbox for something, you can actually do it 
while the Rules pane is open on your screen; use the Mailbox menu. Th e new 
mailbox will immediately appear in the drop-down menu.)

  In the example below, I first made a new mailbox called “NancyD” 
(although you can make one while this dialog box is open).

  Th en I created a new rule to find any incoming mail from my editor,  
Nancy Davis. 

  When found, I want that message to move straight into the “NancyD” 
folder and play a little sound so I know it arrived. 
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Add Signatures to your Messages
 An email     signature is the little blurb you can automatically add to the bottom of 
your messages. A signature might include your contact information, promotion for 
your upcoming art show or book publication, your favorite quote, or even a small 
graphic. You can make more than one signature, then choose which one you want 
for an individual email message, as a default signature that automatically appears, 
or you can let Mail randomly choose one for you.

 
To  create a signature:

 1 From the Mail menu, choose “ Preferences….”

 2 Single-click the “Signatures” icon. You’ll see the window shown on the 
opposite page.

 3 At the top of the left-hand pane, single-click on “All Signatures.”

 4 In the middle pane, single-click the plus sign (+). Th e new one is probably called 
“Signature 1.” Double-click on it to name it something more relevant.

 5 Single-click in the right-hand pane and type your signature. You can use 
the formatting menus at the top of your screen to choose a font, size, style, 
alignment, and color. You can use Returns and Tab keys.

  Don’t choose a font that you have bought or acquired along the way because 
most of your recipients probably won’t have that same font installed. Use one 
of the fonts that came with your Mac.

 This is a signature.

If you have created 
more than one 
signature, you 
can choose which 
one to use in the 
message—see the 
opposite page.
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 6 If you want an   image to appear in this signature, drag the image from the 
Finder and drop it into the right-hand pane. Keep in mind that this should 
be a very small image, both in fi le size and in visual size!

If you like, drag an 
image from the 
Finder and drop it 
in this pane.

 7 Drag a signature from the middle column and drop it on the account name 
in the left column to add it to that email account. You can have lots of signa-
tures, yet have only certain ones available for diff erent email accounts. 

 8 Each email account can have its own default  signature that automatically 
appears in each email message you write: First select the account in the 
left-hand pane, then use the “Choose Signature” menu circled above. 

To use a signature, put the “Signature” menu in your message window:
 1 Open a new message as if you’re going to write a letter.

 2 Single-click on the  Action button to get its menu; choose “Customize….”

 3 Put a checkmark in the box next to “Signature.”

 4 Click ok. Now you will see the  Signature menu in every new mail  message, as 
shown below. Choose the one you want to use for each individual  message.

You won’t see 
an option to add 
signatures if you 
haven’t made any yet!

Action button.
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Search your Mail
In Mail, Spotlight searches very thoroughly. It’s very simple.

 1 If you want to limit the search to a particular mailbox or to Notes, select that 
mailbox or the Notes mailbox. Or click the “Inbox” to search all mail.

 2 Enter a word or phrase in the search fi eld; results immediately appear. 

 3 A new bar also appears, as shown below. In this bar you can choose which 
account to search, and choose which part of the email to search. 

Choose “All Mailboxes” 
or click on one in the  

sidebar, then choose it 
here in this header.

“Entire Message” includes not only 
the message, but the From, To, 
and Subject lines as well.

 4 To display all your messages again, click the gray X in the search fi eld. As 
long as there is even one character in the search fi eld, you will see the search 
results instead of your mail.
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Smart Mailboxes
You can create   Smart Mailboxes that will hold all the email messages that meet 
certain search criteria. If you are familiar with the Rules (fi lters), as explained on 
page 85, you’ll notice there are a couple of diff erences between    Rules and Smart 
Mailboxes.  

■ A Rule is an action that is applied to incoming messages, such as fi ltering 
certain email into a certain folder. Th e original email is moved into the folder.

■ A Smart Mailbox contains messages that match search criteria. No action is 
taken on the messages. 

■ A Smart Mailbox does not contain the original message, thus the same 
message can be “stored” in a number of Smart Mailboxes. 

■ A Smart Mailbox automatically updates itself as messages come in 
or are deleted.

■ A Smart Mailbox applies the search rules to mail that is already in your box, 
not just on future incoming mail.

Below you see an example of several Smart Mailboxes in the sidebar. Th e ones 
named “Understanders” and “Th e Shakespeare Papers” are actually   Smart Folders 
that each contain Smart Mailboxes. Th e folder is just for organizational purposes. 
Both are explained on the following page.

A Smart Folder has a 
disclosure triangle to its 

left, indicating it holds 
other mailboxes.

These two folders are 
Smart Mailboxes 

that I created. 

This Smart Mailbox 
is one that Apple provided.
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Create Smart Mailboxes
Th ere are several ways to create a Smart Mailbox. One is from the Mailbox menu 
(below) and another is with the Save button, as shown on the opposite page.

To create a Smart Mailbox from the Mailbox menu:

 1 If you go to the Mailbox menu, you’ll see there are two similar options, 
“New Smart Mailbox Folder…” and “New Smart Mailbox….” 

  Th e Smart Mailbox Folder creates a folder with no search parameters; 
it is simply for organizing other Smart Mailboxes inside (as shown on the 
previous page). If you choose to make a Smart Mailbox, you will only be 
asked to name the folder and click ok. 

  If you want your Smart Mailbox to be inside of an existing Smart Folder, fi rst 
select that folder in the Mailboxes sidebar; if not, make sure that folder is not 
selected. 

 2 When you choose “New Smart Mailbox…,” the search box shown below 
appears. Choose your parameters and click ok.

 3 If you need to edit the parameters of your new Smart Mailbox, select it, then 
either Control-click, right-click, or go to the Mailbox menu and choose “Edit 
Smart Mailbox….”
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To create a Smart Mailbox from the Save button:

 1 Do a search as usual, as explained on the previous pages. 

 2 If the search gives you what you need and you think you’ll want to use 
the same search again, click the “Save” button. 

 3 Th e saved search is automatically named with the search phrase you just used. 
You can refi ne your search in the edit box, if you like. When ready, click ok. 

 4 If you need to edit the parameters of your new Smart Mailbox, select it, then 
either Control-click, right-click, or go to the Mailbox menu and choose “Edit 
Smart Mailbox….”

 If the command to make a Smart Folder is gray, it’s probably because 

something is selected in the sidebar and Mail can’t put a Smart Folder inside of whatever is 

selected. Click on an empty space in the sidebar, and the option to create a Smart Folder will 

become available.



Lesson 5 Mail for Email, Notes, and To Do Lists

92

This blue selected text 
becomes the To Do item.

To Do Items
Mail is no longer just an email program—it’s the message center for your digital 
lifestyle. When you use Mail to create To Do lists and Notes, you stay organized and 
can fi nd all your information quickly and easily. Mail keeps track of everything and 
even integrates with iCal to make sure you never miss a date. 

To create a To Do item from text in an email message:

All you do is select the text in a message you’ve received, then click the “To Do” 
button in Mail’s toolbar (or Command-click and choose “New To Do”). You can 
create as many To Dos from one message as you like. 

Your To Do items also appear in Mail’s sidebar, and they have their own viewer pane 
with their own columns of information. Control-click on any column header to see 
the other columns you can add. 
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Click this arrow to 
open the “To Do 
Options” menu. 

The due date gets 
inserted into your 

To Do text.

Click the X to 
delete the item.

Check the box 
when the To Do 

is completed.

Click this arrow 
to show the 
original email 
message.

To create a To Do item related to an email message: 

Control-click in a blank area of the message. From the pop-up menu that appears, 
choose “New To Do.” A To Do graphic slides down from the top of the window. 
Type a brief note.

To create a To Do item without using an email message: 

Just click the “To Do” icon in the toolbar. Type your message in the fi eld provided. 
Control-click on the message to get options for setting priorities, due date, etc. Th is 
To Do item will be associated either with the last email account you made a To Do 
in, or the one you choose in the Mail preference, in the Composing pane.
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To Do items in Mail’s sidebar
To Do items are in their own section of the sidebar, as shown below. If you have 
more than one .Mac account, the To Dos are sub-categorized into the diff erent 
accounts. All non-.Mac mail accounts go into a category called “On My Mac.” 

You won’t see those categories in your sidebar until you make a To Do item, and 
then they appear automatically.

The title bar tells you how many 
To Do items are incomplete.

The numbers indicate how 
many To Dos are incomplete.

 The Mail To Dos are intimately connected with iCal (another Apple applica-

tion on your Mac). Dates will be inserted as events on the appropriate day, and you can send 

email invitations out from iCal. Please see Lesson 8 for details.

Click the gray circle/
arrow to open the 

original message.

You can add or delete columns of 
information: Control-click on any 
column header to see the options.

If there is no gray circle/arrow, 
you created this To Do without 
selecting text from an email 
message (as explained on the 
previous page). 
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Notice the gray 
dotted line around 
the date. It appears 
automatically when 
you mouse over 
a date, month, or 
even a word like 

“tomorrow.”

When creating an 
event (as opposed 
to a To Do), you 
will have a choice of 
adding the event to 
any calendar in iCal, 
not just to the Mail 
calendar for that 
email account.

Automatic date detection for events
Th is is amazing. If you hover your mouse over a day or date in an email message, it 
highlights with a gray dotted outline and adds a menu button. If you click the menu 
button, you can choose to immediately open iCal and see what’s going on for that 
date, or choose “Create New iCal Event….” Notice this is not creating a To Do item, 
but an event in iCal.

A dialog box opens in which you set all the information, then click “Add to iCal.” 
In this example, even though a numerical date was not available (just the word 

“Monday”), iCal automatically assumed the message meant the next Monday 
following the date of the email. 
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About the calendars
To Do items and events are automatically sent to iCal. If you have already set up iCal 
with a number of calendars, you can send events and certain To Dos to any of those 
pre-existing calendars. 

If your email account is a .Mac account, Mail/iCal makes a special Mail group for 
you in iCal with a default calendar in it cleverly called “calendar.” You can rename 
it, of course. Any To Do item you create from your .Mac email account will be 
assigned to a calendar in this Mail group only; you cannot assign a To Do item to 
any of your other calendars. Any To Do items in this Mail calendar will be available 
to you automatically anywhere in the world through your .Mac account online. 

To Do items from any other email message or in any other email account besides a 
.Mac account can be assigned to any calendar in the Calendars group.

From within Mail, you can create new calendars; these calendars instantly and 
automatically appear in iCal. 

■ If you make a new calendar from a 
.Mac account, the calendar goes into 
the .Mac group, as shown above.

■ If you make a new calendar from any 

email account that is not .Mac, that 
new calendar goes into the Calendars 

group, as shown above.

To make a new calendar in Mail, Control-
click on a To Do account in the sidebar. 

These are the calendars I made in iCal. 
They’re in the Calendar group.

The instant you make your 
first To Do item in Mail in a 

.Mac email account, this 
.Mac group is created for you. 

Events (as opposed to 
To Do items) that you 
create in Mail can be 
assigned to any calendar, 
regardless of which email 
account it originated from. 
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The little menu arrows 
appear when your mouse 
hovers over the column.

Use the columns to assign options
Take advantage of the information you can display and change in the columns of the 
To Do items. Control-click in the column header area and you’ll get a list of possible 
columns you can add, or you can delete ones you don’t need. You can also use the 
View menu (the “Columns” sub-menu) as long as you are showing the To Do pane 
when you go to the View menu. (Th at is, if you’re looking at email messages, the 
Columns sub-menu shows you column headings for email, not To Dos.)

To set a due date for items that don’t have one, move your pointer over the “Date 
Due” column; a small triangle appears. Click that triangle to get the pop-up menu 
shown below. To set a specifi c date, click “Other….”

You can also assign a calendar to a particular To Do item from the Calendar 
column, or switch the item to a diff erent calendar. Just click in the Calendar column 
for that To Do item. A little menu pops up with the calendars available to that 
particular email account, as explained on the opposite page. 
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Notes
While the To Do items are great for tracking things that need to get done, Notes are a 
handy place to store ideas, thoughts, or any other information you want to keep track 
of. Mail becomes a central location for information—messages, Notes, and To Do lists. 

Create a new Note
To create a new Note, click the “Note” button in Mail’s toolbar. (Th is button is only 
available when you’re in the main viewer window, not when an email message 
is open and active. To Do items can be created from email messages, but not Notes.)

A “New Note” window opens in which you can type a brief or lengthy note. Mail 
uses the fi rst line of text as the subject of the note (keep that in mind as you write 
the note), and shows the fi rst line in Mail’s list of Notes. 

If you want an automatically bulleted or numbered list, go to the Format menu, down 
to “Lists,” and choose the type of list you want. Type your list, hitting a Return after 
each item. To stop the list so you can type regular text, hit the Return key twice.

When fi nished, click “Done.”  

If multiple Mail accounts are active, the note is added to the Mail account that 
was selected in the Mailboxes category in the sidebar, unless you have specifi ed 
otherwise in the Composing pane in the Mail preferences.
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Format and add attachments to a Note
You can format the text in a Note just as you do in an email message, and you can 
add attachments and To Do items. Just click the appropriate buttons in the Note 
toolbar. When you choose to “Send” a Note, an email window opens with this note 
inside the message area. 

View Notes in Mail
Th e Mail window includes a Notes mailbox in the sidebar, which displays all your 
notes, as shown below. But you’ll also see the Notes appear in your list of email 
messages when viewing an inbox. Notes are identifi ed by an icon in the “Message 
Status” column on the far left, as you can see below.

These buttons work just 
as they do in your email 
messages.
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Attachments
One of the greatest things about email is the ability to send fi les and photos back 
and forth. Mail has some great features for attachments, making it easier than ever 
to share fi les. 

To send an    attachment:

 1 Open a new message window and type your subject, message, etc.

 2 To attach a fi le or photograph, single-click the “Attach” icon. 

  Th is opens the standard Open dialog box. Find your fi le, select it, and click 
“Choose File.” You can hold down the Command key to click on and select 
more than one fi le to attach.

  Or drag a fi le or photo from a window on your Desktop and drop it directly 
into the message window.

 3 A fi le icon appears in your window. If it’s a one-page pdf or a photo, the actual 
image will probably appear, as shown below, instead of a fi le icon.

 4 If the fi le in the window appears as the actual image, you can change it into an 
icon if you like (you don’t have to): Control-click (or right-click) on the image. 
From the menu that pops up, choose “View as Icon.” Th is does not determine 
how the person who receives the fi le will view it. 

 5 Send your email.

If the photograph is too large, 
you can choose to send a 
smaller version right here. 
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To receive and  download an attachment:

 1 An attachment appears in someone’s Mail message, or yours, as an actual image 
or as a fi le icon, shown below. 

—continued

 2 Th ere are several ways to deal with this fi le:
  If it’s a photograph and you can see it in the window, then you see it and 

maybe that’s all you want to do with it. So you’re done. Or . . .

  If it’s one fi le or photograph, you can do any of several things:

  Either drag the fi le to the Desktop or directly into any window or folder 
on your Mac. 

  Or single-click the “Save” button in the header information at the top of the 
message; the fi les are instantly added to the Downloads folder; see page 103.

  Or save the image directly into iPhoto (if you have iPhoto installed): Press 
(don’t click) on the “Save” button and choose “ Add to    iPhoto” (shown on 
the following page).

  Or Control-click (or right-click) on the photo or fi le icon and choose any 
of several options, shown below.
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This is the Quick 
Look button. 
Check it out!

  If you have a series of photographs in your email message, you have even 
more options. You can do everything mentioned above, plus:

  Save only one fi le from the collection. Press (don’t click) on the “Save” 
button and a menu appears, as shown below. Choose the fi le you want 
to save. 

  You can view a full-screen  slideshow of the photos. Simply click 
the “Quick Look” button in the header information. 



Lesson 5 Mail for Email, Notes, and To Do Lists

103

Downloads Folder
When you click the “Save” button in an email to save the fi les that someone sent 
you, the fi les are automatically stored in the   Downloads folder in your Home 
folder; a copy of this Downloads folder is in the Dock. Open either folder to get 
to the fi les. Th ese folders in the Dock are also called “stacks” because of the way 
their contents sprays out into a stack, as shown below.

You can see that the files in the 
Downloads folder above are 
exactly the same as the ones in the 
Downloads folder in the Dock. 

The picture on the folder in the Dock 
changes all the time, depending on 
what’s in it.

Single-click on this Dock icon to 
display the files, as shown to the left. 

Single-click on any image to display 
it in an application.

Single-click the arrow at the top 
to open the Downloads folder in 
a Finder window, as shown above.  
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Priority Options
You can set one of three   priority options in Mail messages so your recipient under-
stands how urgent (or not) a particular message is—provided the recipient’s email 
program can display the priority marker. If someone sends you a message marked as 
high or low priority, Mail will mark it as such. 

To set a priority:

    With an email compose window open, go to the Message menu in the 
menu bar, slide down to “Mark,” and choose the priority option you want 
for this message.

If you would like to have 
the priority options 
handy, put this tiny menu 
in the message window. 
See page 80.

To check the priority of an incoming message:

  If the Flag column is visible in Mail (if it isn’t, see page 80), you will see two 
exclamation marks to denote a message that has been labeled High Priority. 

A dash indicates Low Priority. (One exclamation point means the message is 
Normal Priority, but you won’t see any symbol for this kind of message.)
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Use the Standard Application Features 
Mail includes all of the standard Mac features as explained in Lesson 13, such as 
spell checking, text with shadows, text in color, special characters, creating pdfs, 
previewing before you print, reading text aloud, and more. 

Th e “Complete” feature, as explained on page 62, can be used in email messages. 
Any styles you created in TextEdit, as described on page 61, are also available in Mail 
messages—from the Format menu, slide down to “Style,” then out to “Styles….”

 Mail is Integrated With:
Parental controls: See Lesson 18 to make another “user” for your child or children 

and have full control over their email access. 

Address Book: Click the “Address” icon to bring up a minimalized 
Address Panel. See page 79.

iChat: A      green dot in a column in your Viewer window indicates 
an iChat Buddy is online and available. If you don’t see that 
column, go to the View menu, select “  Columns,” then choose 

“Buddy Availability.”

iCal: Email announcements to all attendees of an event. All To Do 
items can go straight to iCal. Calendars created in Mail appear 
instantly in iCal.

 .Mac Sync: Synchronize your .Mac account with the .Mac mail web site so 
you have access to your mail on any computer in the world.

TextEdit: Click an email link in TextEdit to open Mail and automatically 
address the email. 

Safari:  Safari will email complete web pages or just the links, as well as 
send email from email links.



 

6
GOALS

Make and edit 
contact cards

Add photos 
to your contacts

Designate your own card 
for automatic fill-in 

on web pages

Create mailing lists (Groups) 
and Smart Groups

Search your Address Book

Share your contacts 
with .Mac members

Print envelopes, a list 
of contacts, and more
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LESSON  6

Address Book 
for Contact Info

Th e Address Book is a great contact list integrated with so many 

other parts of your Mac. It’s much more complete than its simple 

appearance might lead you to believe—take the time to explore its 

possibilities!
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How you’ll Use your Address Book
Before I explain how to do specifi c tasks, such as create new address cards, add a 
photo to a person’s card, send email, etc., fi rst let me briefl y describe how you can 
use this great application .

You can customize individual cards and/or add new fi elds (those places where you 
type in information) to all of them. For instance, you can add a “birthday” fi eld or a 
nickname fi eld. You can change the labels, add a photo or image, and customize the 
address for another country. 

You can create Groups of addresses to make a mailing list so you can mail everyone 
in the Group with one click. 

In Mail, all the contacts you put in your Address Book will be available via the 
Address Pane (see page 79). (In the Address Pane in Mail, you can’t add or edit 
or delete or group addresses—you can just access them for emailing.) 

While in Mail (not Address Book) you can automatically add an address from 

an email you receive: open the email in Mail and press Command Shift Y. 

Your iPhone will synchronize with all the addresses or with certain Groups that 
you specify. As you add contacts to your iPhone, they will automatically be added 
to your Address Book on your Mac next time you connect and sync your phone. 
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Make and Edit New Cards
To make a new   card, (sometimes called a   vCard), click the + sign at the bottom of 
the “Name” pane, which displays the new card in the right pane, ready for you to 
add information.

▼

▼

Click the green button to add another field for that particular type of 
information, like another phone or email address. You won’t see this green 
button until you have fi lled in the blank area and are ready for another one.

Click the red button to delete that field. 

Click these tiny double triangles to change the existing field labels.

To edit an existing card, select the card in the “Name” column, then click the “Edit” 
button (circled above). Edit the card to your heart’s delight. When you’re finished, 
click “Edit” again.

 Only the fields that contain information will be visible on the card. 

Also, be sure to check out the preferences for Address Book (under the Address Book 

application menu). Use the “Phone” preferences to automatically format phone numbers, 

and use the “General” preferences to customize your contacts and several other features. 

If you don’t 
see three 

columns, click 
this button.
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Add a photo to a card
You can add a photo to any contact card. Th at photo will appear in email that you 
receive from that person; it will be transferred to your iPhone so you can see his 
handsome face when he calls; and you can print it with his contact info. 

To add a photo to a contact card:

 1 Go to that card in your Address Book and click the “Edit” button (if it isn’t 
already).

 2 Double-click the empty photo space to the left of the name. A sheet appears:

 3 Drag any type of image into the pane, or click “Choose…” to find a photo on 
your hard disk, or click the camera icon to take a picture of someone, even 
someone you are  iChatting with. (If there is no camera attached to your 
computer, your camera icon is gray.)

 4 Drag the blue slider bubble to the right or left to enlarge or reduce the image. 
Press on the image to drag it around inside the space.

  Click the eff ects button to choose from diff erent weird eff ects.

 5 Click “Set” when you like it.

Add photos via your iPhone

If you have an iPhone, next time you are with someone whose contact information 
is in your Address Book (or whose contact info you are adding into your iPhone), 
edit her contact info in your phone and take her photo. Th e next time you sync your 
iPhone to your Mac, this photo will automatically apppear in your Address Book 
and when you get email from this person, it will include her photo in the upper-
right corner of the message. 

Effects button.

The empty photo 
space on the card 

looks like this, 
a ghost.
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Designate your Own Card
In your Address Book, you can designate the card with your contact information on 
it as “My Card.” Other applications,   Safari and iChat in particular, will use that infor-
mation in various ways, such as filling in forms online, accessing your email address, 
displaying your photo. 

Enter a    card for yourself in the Address Book (Apple might have done that for you 
already). Th en go to the Card menu and choose,  “Make Th is My Card.” (Apple might 
have already done that for you too). 

To keep some of the information  private so it won’t show up if you send your vCard 
(virtual card) to someone else (as explained on page 122): 
 1 Go to the Address Book preferences (under the “Address Book” menu). 

 2 Click the “vCard” icon in the toolbar.

 3 Check the box to “Enable private me card.” Close the preferences.

 4 Go to your own card and click the “Edit” button. You’ll see a blue checkbox for 
each item on your card; the checkmark means it is public information. Uncheck 
the boxes that you want to be private. 

Your card name has a little human 
silhouette next to the name.
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Customize One Card or All Cards
Th e fields for data only appear on the card if there is data in them; otherwise the 
fi elds disappear, which is kind of nice. Select a card and click the “Edit” button to 
see what fi elds you might have on a card that are not fi lled in. 

You can add a number of other fi elds to an individual card or to all cards.

To add a field to ONE card: 

 1 Select that card. 

 2 From the Card menu in the menu bar across the top of your screen, 
slide down to “Add Field,” and make a choice from the pop-out menu.

To add a field to EVERY card: 

 1 From the Card menu, slide down to “Add Field” and then choose “Edit 
Template….” 

  Or go to the Address Book menu and choose “Preferences….” From that 
toolbar, click on the “Template” button.

 2 Click the “Add Field” button to display its menu. All the fi eld names in gray are 
already on the card template. Choose any fi eld name that is in black and it will 
be added to all of your cards. Until you enter information into that fi eld, you’ll 
only see it when you click the “Edit” button on individual cards.  
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Check Out the Options 
Th ere are lots of hidden options in the Address Book. Single-click or Control-
click on the small labels to the left of the fi elds on a card. You’ll get little menus, 
depending on which key you’re holding down and what you click on. Check them 
out! Below you see where I chose the option “Large Type” to display a fax number. 
(Th is option only shows up on phone or fax numbers, but you could put a love note 
instead of a phone number to surprise your sweetheart.) You can send text messages 
to cell phones, dial numbers with your Bluetooth-enabled cell phone, send email, 
chat, and more. If you have Skype installed, even more options will appear.

Map It
You can instantly get a Google map of any address in your Address Book. (You must 
be connected to the Internet, of course.)  

Click on the label to the left of an address in Address Book. A little menu pops up 
where you can choose “Map Of.” Safari opens to Google Maps and displays the 
location of that address. Freaky.
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Create Group Mailing Lists
After you’ve made a Group mailing list, you can send email to the name of that 

Group and your message will go to everyone in the Group. 

To make a new group: 

 1 Click the + sign at the bottom of the “Group” column. 

 2 Change the existing name of the Group to something you’ll recognize.

 3 Click the “All” group. 

 4 Drag names from the “Name” column of the “All” group and drop them on 
the Group name. You can put the same name in many diff erent Groups. 

To email a message to a Group:

 ■ In the Address Book, Control-click (or right-click if you have a two-button 
mouse) on the Group name and choose “Send Email to Group.”

 ■ OR in the Mail application, type the name of the Group in the “To” fi eld of an 
email message.

To prevent all the addresses from appearing in everyone else’s email:

 1 Open Mail (not Address Book).

 2 From the Mail menu, choose “Preferences….”

 3 Click the “Composing” icon.

 4 Uncheck the box, “When sending to a group, show all member addresses.”

 Option-click on a person’s name to highlight all the Groups he is included in.
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Create Smart Groups in     Address Book
A Smart Group is a list of contacts that automatically updates itself as contacts meet 
its criteria. For instance, you might want a Smart Group that automatically adds 
people who work for a certain company or who are part of your literary salon. You 
can create a Smart Group that tells you when someone’s birthday or anniversary 
is approaching. Or you might want to gather a list of everyone in a particular city 
without having to fi nd them all in your Address Book—a Smart Group will fi nd 
existing contacts and automatically collect them.

Most of these searches require, of course, that you have a particular fi eld on your 
card and that it has data in it. For instance, you can’t have a Smart Group that tells 
you when a birthday is coming up if you don’t have the Birthday fi eld on your cards. 
For directions on how to add new fi elds to individual cards or to all cards, please 
see page 112. 

To create a Smart Group:

 1 From the File menu across the top of the screen, choose “New Smart Group….”

 2 In the sheet that drops down, as shown below, choose your parameters.

 3 If you need more parameters to narrow down or open up the possible items 
in the Group, click the + sign (circled above). 

 4 If you want to see a visual clue when a new item has been added to the Smart 
Group, be sure to check the box to “Highlight group when updated.” Th en 
when a new item is automatically added, the Smart Group will change color 
to let you know someone’s been added to it.
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 Search your Address Book
You can do a standard, simple search for anyone or any information in your 
collection of contacts. And you can do a Spotlight search of anyone in your    Address 
Book that searches your entire hard disk for everything related to that person. 

To  search your Address Book for a contact:

 1 To search for a contact within a Group, single-click the Group name 
you want to search. 

  To search your entire database of contacts, click the “All” group, 
as shown below.

 2 Single-click in the search fi eld.

 3 Type the fi rst couple of letters of the name of the person you want to fi nd, 
either fi rst or last name or the business name. As you type, results will appear 
in the center “Name” pane. 

 4 Type more letters to narrow your search, or single-click one of the contacts 
in the “Name” pane.

 5  To display all of your contacts again, click the X in the search fi eld,
and single-click on the “All” group.

Click this X to 
delete everything 
in the search 
field.

If there is even 
one character 
in this field, you 
won’t see all of 
your contacts.
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To search for a person or business in Spotlight:

 1 Find the person you want to Spotlight, as explained on the previous page.

 2 Control-click (or right-click) on the person’s name; from the pop-up menu 
that appears, choose “Spotlight ‘Th is Person’ ” (where ‘Th is Person’ is the name 
of the contact you just searched for; that name automatically appears in the 
menu). See the  illustration below. 

 3 You will get the Spotlight window (a Finder window), as explained in 
Lesson 19. It will show you every fi le on your computer that is connected 
with this person, such as email she’s sent, fi les she’s mentioned within, 
documents she has created and sent to you, images of her, and more.
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 Share your   Address Book Contact List
If you are a .Mac member (see www.Apple.com/dotmac), you can share your 

entire contact list with other .Mac members. Th is can be useful for families, teens 
and their friends, organizations, businesses, and others. And you can subscribe to 
someone else’s shared Address Book, provided that person has already put you on 
their shared list. 

Remember, you must have a .Mac account to share, and the only people who can 
share your Address Book are other .Mac members running Tiger (Mac OS 10.4) or 
Leopard. Th e people you want to share with must already be in your Address Book 
as contacts, so if they’re not there yet, add them before you follow these steps!

 1 From the Address Book menu, choose “Preferences….” 

 2 Single-click the “Sharing” icon.

 3 In the window that appears, check the box to “Share your address book.”

 4 You must choose who is allowed to access and share your Address Book: 
Single-click the + sign at the bottom of the window.

 5 Th is drops down a sheet displaying the people who are in your Address Book, 
as shown at the top of the next page. Select the names you want to share with; 
hold down the Command key to select more than one name.

www.Apple.com/dotmac
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 6 Click OK. After you add names, you can send an email inviting someone to 
share your Address Book: Single-click a name (or Command-click several 
names), then click “Send Invitation.”

  Subscribe to someone’s Address Book
You can only subscribe to an Address Book that someone else has already set up 
as shared, as explained above. And that person must have already chosen you as 
someone who is allowed to access her Address Book. Once that’s done:

 1 In your own Address Book, go to the File menu and choose “Subscribe 
to Address Book….”

 2 Enter the .Mac account name of the person whose Address Book you want 
access to. After you enter the account, click ok. 
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You can save the job as a PDF and then 
send that PDF to someone else to print.

  Print in a Variety of Ways
From Address Book you can  print       mailing labels, envelopes, customized lists, and 
even pages that fit into a standard pocket address book. 

 1 First, in Address Book, select the names or the Group that you want to print.

 2 Press Command P to get the Print dialog box. If you don’t see the full window 
as shown below, click the small blue triangle to the right of the “Printer” 
pop-up menu. 

 3 From the “Style” pop-up menu, choose what you wish to print—lists, 
envelopes, mailing labels, or pocket address book pages. Each “style” has 
diff erent parameters to experiment with. Whatever you choose will be 
displayed in the preview window. 
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Spend some time poking around this dialog box so you know what all your options 
are. As you can see below, you can add an image to your return address, choose 
diff erent fonts and colors for the text, choose diff erent envelope sizes, and so much 
more that it’s just amazing. 

Th e Address Book automatically uses your “Me” card for the return address. If you 
want it to use another card, go back to the Address Book, choose that other card, go 
to the Card menu, and choose “Make Th is My Card.” You can switch it back when 
you’re done printing. Of course, you can uncheck the box so it doesn’t print any 
return address at all. 

To add an image to your return address, click the “Label” tab above. 
You’ll have options to change fonts, colors, add an image, and more.
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 Backup your Entire Digital Database
Th ere are few things more annoying than losing your entire Address Book that you 
have carefully created over the past year or two. You have a couple of options for 
backing up your entire Address Book. 

■ One way is to select everyone in the Name column (or just select the 
important names), then drag that block of names to the Desktop. Th is 
creates a vCard fi le, shown below, that you can then store on another 
disk for safekeeping. 

 

 You can send this vCard to someone else on a Mac; she double-clicks 
on it and the addresses get automatically entered in her Address Book.

■ Or go to the File menu and choose “Export,” then “Address Book Archive….” 
Your Mac will make a fi le for you and ask you where to store it. When you 
want to restore your Address Book, double-click this fi le or use the Import 
option in the File menu.

  

Remember, a backup is only useful if it’s not in the same place as the original. Th at 
is, don’t keep it on your hard disk—if your hard disk goes bad, it will take both the 
original and the backup! Copy the fi le onto a disk, upload it to your iDisk if you have 
a .Mac account, or email it to a colleague for safekeeping.
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     Address Book is Integrated With:
Dashboard: Pop up a mini-version of your Address Book for quick and easy access. 

See Lesson 16. 

Safari: Put your Address Book in the Bookmarks Bar and you have instant 
access to any web sites listed in the Address Book. To do this, open 
Safari, and in the Safari preferences, in the Bookmarks pane, check the 
box to “Include Address Book.”

 Th e AutoFill feature in Safari uses the data you enter in your “Me” card.

iCal: iCal can create a Birthday calendar from your Address Book so 
everyone’s birthday is automatically placed on its appropriate day; 
see page 152. 

Mail: Send email to a selected contact email address with a contextual menu. 
Th e photos you put in the Address Book will appear in other Mac 
users email messages when they send you mail. 

 To automatically add someone’s email address to your Address 
Book, select a message in Mail, then press Command Shift Y.

iChat: iChat will pick up the data and picture you add in Address Book. 
And when a Buddy is online and available, his address card displays 
a   green dot.

 With a camera connected, you can add a photograph of someone 
you are chatting with through iChat. 

.Mac: Synchronize your other Macs and your .Mac account so you have your 
entire Address Book accessible on the web, anywhere in the world. 

Spotlight: Send your Address Book search out to your entire computer through 
Spotlight. See page 117.

Bluetooth: Beam a contact card to a mobile device with one click. 

  iPod:  Transfer your entire contact list to your iPod using iSync.

  iPhone: Transfer your entire contact list or selected Groups to your iPhone 
using iTunes.



 

7
GOALS

Search a web page for a 
word or phrase

Learn how to let Safari 
fill in forms for you

Block pop-up windows

Use SnapBack so 
you don’t lose a page

Become a more efficient 
web surfer with tabs

Organize your bookmarks

Save or email entire 
web pages

Create web clip widgets

Browse privately

Become a master 
of RSS feeds
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LESSON 7

Safari for Web Browsing 
and News

Safari is Apple’s beautiful web browser for viewing web pages 

on the Internet. You’ve probably already used it, but you might 

be surprised at the tips and tricks it off ers that you haven’t taken 

advantage of yet.

Safari also includes its own “news reader” that brings in rss feeds. 

RSS stands for    Really Simple Syndication. It’s an Internet technol-

ogy that “feeds” you news and information of your choice from 

a huge variety of sources. Safari can gather the rss feeds you are 

interested in and display the headlines from many sources in one 

place—a web page. You’ll have access to them with one click of 

a button, and you can  organize the information, fi lter the feeds, 

automatically update them, and more. 



Lesson 7 Safari for Web Browsing and News

126

Safari Web Browser
Below is a brief overview of the main features of the Safari window. Although it 
looks simple, it holds a lot of power in subtle ways.

Enter a new web address quickly
Th is is one of my favorite features in Safari: If you double-click between www and 
.com, it selects just the domain so you can change it. Th is means you don’t have to 
drag the mouse across tiny little letters when you want to change the address. Try it. 

And don’t forget you never need to type “http://.” If it’s a .com address, all you need 
to type is the main word. For instance, to go to www.apple.com, just select every-
thing in the location bar, type apple, then hit Return. 

Customize what you see in the 
toolbar; use the command from 
the View menu or Control-click.

Enter a web address here, then hit the 
Return or Enter key to go to that page. 
You do not need to type http://.

This is the 
Bookmarks Bar.  

 Status Bar. If you 
don’t see this in 

your browser, 
go to the View 

menu and choose 
“Show Status Bar.”

Drag this corner to 
resize the window.

Enter a Google 
search right here!

www.apple.com
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Find a Word or Phrase on the Current Page
To   find a  word or phrase on the page you are looking at (as opposed to searching the 
Internet for it), press Command F. Th en just type—Safari knows to put the search 
term in the search fi eld. 

To make it easy for you to see the found word or phrase, Safari dims out the rest 
of the page and highlights every instance of what you’re looking for, as you can see 
below. Just click on the page to un-dim it. 

To make Safari put the strong yellow highlight on successive results, press 
Command G. Each time you hit that shortcut, Safari puts the yellow highlight 
on the next result.

Safari holds onto that search. You can go to another page and hit Command G 

again—Safari will search for the last word or phrase you requested. In fact, you can 
close or even quit Safari and the next time you open it, Command G will fi nd results 
of the last word or phrase you were looking for. 

This field appears 
when you press 
Command F to 
find something.

It will stay there 
until you click the 

“Done” button.
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Fill in Forms and  Passwords Automatically
Th is is wonderful. Safari will fill in              online forms with the information you have 
entered into your Address Book; it takes the data from the card you have designated 
as “My Card” (use the Card menu in Address Book to do that; see page 111). You can 
also tell Safari to remember your user ID and password for specific sites, which is 
great if no one else uses your Mac or if you have set up diff erent users. 

To enable Safari to fill in forms and passwords, go to the Safari Preferences and 
click the “AutoFill” icon. Check the appropriate boxes. 

Next time you start to fill in a form, Safari will fill it in for you. Next time you go to a 
page that needs an ID and password, go ahead and fill them in, then Safari will ask 
if you want to save that information. Try it on your .Mac page.

To delete saved user names, passwords, or forms, go back to the  AutoFill 
 preferences. Click the “Edit…” button. Select and remove items.

AutoFill is turned off  when you turn on private browsing, as explained on page 136.

  Block Pop-Up Windows!
Go to the Safari menu and choose “Block Pop-Up Windows.” Woo hoo! Only 
pop-up windows that you click on will appear—none of those obnoxious ads.

Occasionally, however, this can cause a problem. You might run across a web site 
where you click on a link for extra information and nothing happens. Th is might 
be because the extra information appears in a pop-up window. If so, go back to the 
Safari menu and choose “Block Pop-Up Windows” again to take the checkmark off . 

Notice the “edit” buttons. 
You can delete the 
information from any web 
page that was hanging on 
to your info or passwords.
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 SnapBack to a Results Page or Other Page
Do you see those little  orange arrows in the location field and the   Google search 
field below? Th ose indicate “SnapBack” pages. 

When you do a search in Google, either at Google.com or through the Google 
search field in the upper-right corner of Safari, you get a page of results. As soon as 
you click on a link on that page, the SnapBack arrow appears. Wherever you surf, 
you can always click the SnapBack arrow to return to the original results page. 

You can mark any page you want as a SnapBack page: Go to the History menu and 
choose “Mark Page for SnapBack.” As soon as you leave that page, the arrow appears 
in the location field, ready for you to click to return. You’ll also see the SnapBack 
arrow anytime you type in a web address yourself (as opposed to getting there from 
a link or bookmark). 

Quickly Enlarge or Reduce Text
Make the text on a web page larger or smaller with Command + (larger) 
or Command – (smaller). You don’t have to select anything first.
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Tabbed Browsing
When you click on a link, of course, Safari takes you to another page and thus you 
lose track of the one you were on. Besides taking advantage of the SnapBack feature 
described on the previous page, you can also choose to open web pages in tabs.

Instead of losing your original page, a tabbed page gets loaded and displays as a tab, 
as shown below. To open any link into a tabbed page, Command-click the link 
(hold down the Command key and click on the link).

Command-click on lots of links and they will all load themselves into individual 
tabs. Th en when you’re ready, click any tab to display that page, while leaving your 
original page still available.

Tabs. 

Click a tab to 
display that page. 

Click the X to 
close that page.

Option-click the 
X to close all the 
open tabs.

To use   tabbed browsing, go to the Safari preferences and click the “Tabs” icon. 
Take a few minutes to check out the options. For instance, if you check the second 
box, shown below, the tabbed window will immediately come to the front instead of 
lining up behind the current page.

Also see pages 140 and 144 
about displaying all bookmarks 
in a folder as individual tabs, all 
at once.
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Bookmarks
Th e bookmarks in Safari are powerful and easy to use. 

Th e Bookmarks Menu, shown above, is what drops down from the menu bar 
across the top of your screen. 

Th e Bookmarks Bar is that strip in the browser window, just below the address 
field, as shown on the opposite page. To show it (if it isn’t already showing), go to 
the View menu and choose “Show Bookmarks Bar.”

Th e   Bookmarks Library and the various  Collections you create let you organize 
hundreds of bookmarks, but you don’t have to put them all in the Bookmarks Menu, 
which would make your list a yard long. Click the “Show all bookmarks” button 
( ) at the far-left of the Bookmarks Bar when you want to open the Bookmarks 
Library and make new folders for organizing your bookmarks. 

When you hit Command D to create a bookmark, a little sheet drops down and 
asks you where you want to store it. You can rename the bookmark at that point and 
choose to store it in any folder you have already made in the Bookmarks Library.

Organize your bookmarks with folders
You can organize all your bookmarks in the   Bookmarks Library. 
 1 From the Bookmarks menu, choose “Show All Bookmarks,” or click the 

bookmarks icon on the far left of the Bookmarks Bar.
 2 In the bottom-left of the window, click the + sign. Th is puts a new bookmark 

folder, called a Collection, in the left-hand pane. 
  When you make bookmarks, as mentioned above, you can choose this folder 

in which to store the bookmark. 
 3 To put this folder in the Bookmarks Menu so you can access it in that menu, 

fi rst click on the “Bookmarks Menu” item in the Library. Now drag the folder 
from the left pane and drop it into the large right pane, which is the list that 
will appear in the Bookmarks Menu. You can drag the items into the order 
you want them listed. You can also drag folders or bookmarks directly into 
the Bookmarks Bar.

Choose this to display 
the Bookmarks Library.
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Email the Contents of or a Link to a Web Page
Safari makes it especially easy to  email an entire web page to anyone, complete 
with images and links. 

 1 Open the web page in Safari. 

 2 From the File menu, choose “Mail Contents of Th is Page.”

 3 Th e  Mail application opens with the name of the web page as the subject. 
Th e entire web page is in the body of the email. All you have to do is add 
the recipient’s address and click the “Send” button. 

Or you can email just the link. Follow the steps above, but choose “Mail Link to 
Th is Page.”

View PDF Documents
To view a PDF document right in Safari, just drag the pdf fi le and drop it into the 
middle of any Safari page. 

To enlarge or reduce the size of the pdf on the screen, Control-click (or right-click) 
anywhere on the pdf page. From the menu that appears, choose “Zoom In” to enlarge 
or “Zoom Out” to reduce.

If the pdf has more than one page, but all you see in Safari is one page, Control-
click (or right-click) and choose “Continuous.”
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Save a Page and Everything on It
 Safari lets you save a web page and all the images and links and text on the page. 
It creates one fi le, an archive, that you can open at any time; all the links will work 
(as long as the destination pages haven’t changed). Th is is particularly handy for 
pages that you know aren’t going to last long, such as online newspaper articles or 
purchase receipts. Keep in mind that some web pages can prevent you from saving 
items on the page.

 1 Open the web page you want to save.

 2 From the File menu, choose “Save As….”

 3 In the Format menu in the dialog box, choose “Web Archive,” as shown.

 4 Choose the folder you want to save into, then click “Save.”

To save a frame of a web page, Control-click (or right-click) on the frame. From the 
menu that pops up, chose “Save Frame As.…”

You can also save a page as 
“Page Source,” which saves 
the source code. This is 
handy if you want to study 
that code or use it in a web 
page of your own.



Lesson 7 Safari for Web Browsing and News

134

Make a Web Clip Widget
Th is is pretty cool. Th ere’s a button in the Safari toolbar that lets you make a 
Dashboard widget of any section of any web page. Any buttons, fi elds, or links that 
are captured in that widget will work in Dashboard. If you delete this widget, you’ll 
have to remake it from scratch to get it back. 

To make a web clip widget:

 1 Go to any web page in Safari.

 2 Click the Web Clip Widget button in the toolbar. (If you happen to have 
removed the button, right-click on the toolbar and choose “Customize 
Toolbar” so you can drag it back in.)

 3 Th e page grays out, except for a clear box that follows your mouse around. 
Click in the area that you want to capture as a widget. Immediately eight 
handles appear on the clear box. You can drag any of these handles to reshape 
the box. Press and drag inside the box to move it.

 4 When you like where it’s positioned, click the “Add” button in the upper-right.

 5 Immediately Dashboard opens up, displaying the new widget. 

  Click the tiny i that appears in a bottom corner to fl ip it over and add a fancy 
border, if you like. 

The selected area 
above became this 
Dashboard widget. 

The links work.

With this Wikipedia clip, 
I can go to Dashboard, 
enter a search term, click 
Go, and I’m there.



Lesson 7 Safari for Web Browsing and News

135

Print Web Pages
You can see a preview of how your web page will print. You can tell the background 
not to print, and you can make sure the web address and date appear on the page. 

To print a web page:

 1 Just go to the web page you want to print, then press Command P to get the 
Print dialog box, as shown below (or go to the File menu and choose “Print…”).

 2 If you don’t see the expanded box shown below, click the blue disclosure 
button.

 3 Make sure the “Safari” option is chosen in the menu in the middle of the pane, 
shown below. You’ll see the preview on the left.

 4 Check or uncheck the boxes to print the background or the headers and 
footers, shown below. 

 5 If the web page needs more than one piece of paper to print, the preview 
will show you every page; use the arrows to go back and forth.

 6 Click “Print.” Click this disclosure 
button to show or 
hide the large pane 
you see here.
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   Private Browsing
You may have noticed that Safari keeps track of where you’ve been and what you’ve 
entered into search fi elds and what web pages you’ve asked to see. Safari’s  AutoFill 
feature even keeps track of user names and contact information you’ve entered on 
sites, as well as passwords and credit card numbers. If there are other people who 
use your computer, or if you are using Safari on someone else’s Mac or at a school or 
an Internet cafe, you probably don’t want Safari keeping track of all that information. 
Th at’s where private browsing comes in handy.

When you turn on private browsing:
■ None of the information you enter on any page is saved. 
■ Any searches you do will not be added to the pop-up menu in the Google 

search fi eld.
■ Web pages you visit are not added to the History menu. However, you can 

still go back and forward to pages you’ve viewed.
■ If you downloaded anything, those items are automatically removed from 

the Download window when you quit Safari or turn off  private browsing. 
■ Cookies are automatically deleted when you turn off  private browsing 

or quit Safari.

To turn ON private browsing, go to the Safari menu, choose “Private Browsing.”

To turn OFF private browsing, fi rst close all Safari windows. Th en go to the Safari 
menu and choose “Private Browsing” again to remove the checkmark.

When you quit Safari, private browsing is automatically turned off, even if you 
left it on before you quit. So each time you open Safari, you need to turn private 
browsing on again if you want to use it.

To further secure your privacy, when you 
are fi nished go to the Safari menu and choose 

“Reset Safari….” You can eliminate any trace of 
your whereabouts from the options you see 
listed here. Th is, however, will remove every-
thing from that feature in Safari, not just the 
ones you used today! 
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Parental Controls
If you have a young child (or anyone acting like a young child), you can set up some 
serious     parental controls to limit access to web sites. It involves multiple users, 
which are explained in detail in Lesson 18. You’ll need an admin user (you) to set 
up another user for the child. Th e child will be able to view only web sites you 
have placed in the Bookmarks Bar. He won’t be able to enter web addresses in the 
Address fi eld, modify any bookmarks, or use the Google search fi eld in the toolbar. 

To limit web access to a young user:

 1 Using the Account preferences, set up another user (details in Lesson 18). 
In the “New Accounts” menu, choose “Managed with Parental Controls.”

 2 In the next pane, click the button to “Open Parental Controls….” 

 3 Choose the account to which you want to add parental controls.

 4 Click the tab labeled “Content.”

 5 Click the button to “Allow access to only these websites.”

 6 Select any site listed in that pane and delete it with the – button.
  Click the + button to type in web addresses of your choice.

 7 Log in to that users account, open Safari, and make sure it’s what you expect. 
Safari puts the web sites chosen in Step 6 into the Bookmarks Bar, as shown 
below, and the user will not be allowed to go anywhere else.

Bookmarks Bar.

  Note: Th is does not prevent the user from surfi ng the web with any other 
browser. If you want to limit the applications this user can use, do so in the 
Parental Controls, as above. 
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So What is RSS?
All major news organizations, as well as thousands of personal   web logs (blogs) and 
individual web sites, off er article summaries and headlines in the form of rss feeds. 
Below is a sample of what an rss feed from Apple looks like in Safari. 

You can drag the “Article Length” slider (shown below, on the right) to display more 
or less of an article. Use the categories to organize the information. 

At any time you can add more feeds to Safari, delete ones you don’t want to view, 
search through feeds for particular information, and even bookmark searches to 
which you want to return. 

You can separate the various feeds into your own folders so with the click of 
a button you can view all the headlines from each particular area of your life. 
For instance, you might want to see just the technology headlines or just the 
screenwriting headlines or just the personal blog headlines.  
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View the existing feeds in Safari
Apple has provided an   rss feed to get you started. Experiment with it for a while 
and then start building your own collection of rss bookmarks, as described on the 
following pages.  

To see the RSS feed/s:

 1 Open Safari, your web browser. 

 2 If the Bookmarks Bar is not showing, press Command Shift B, 
or go to the View menu and choose “Show Bookmarks Bar.”

 3 Open the Bookmarks Library: Single-click on the little book icon 
at the far-left end of the Bookmarks Bar (circled, below).

 4 In the  Collections pane, which appears on the left side of the Bookmarks 
Library, single-click on    “All RSS Feeds.” Th e list will appear on the right. 
You’ll see the blue RSS icon for each web site that has a feed.  

Notice that a large news site might have separate 
RSS feeds for different sections of the news.

This is the 
Bookmarks Bar.

This entire 
window is the 
Bookmarks 
Library.

 5 Double-click any link to open its feed page. 
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View the  RSS Collections Apple has made for you
Apple has placed a number of folders, or  Collections, of bookmarks in the 
Bookmarks Bar for you, including an rss “News” folder, as shown below. 

If you click on a folder in the Bookmarks Bar and choose   View All RSS Articles 
from the menu that appears, as shown below, every headline from every feed in this 
folder appears on the page. You can organize the information as explained on the 
next page.

If you  choose   Open in Tabs, each bookmark in the list will open as a separate tab 
(see page 144) and each page will display just the headlines for that source. 

The number tells you 
the total number of new 

headlines in this Collection.
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   Customize the information display
Once you display an rss feed page, you can adjust how information is shown. Use the 
options on the right side of the window to sort the headlines by date or by title, by 
the source of the headline, or whether it’s unread. You can view headlines by relative 
time; for instance, you can view all articles from yesterday or from last month.

 In the illustration below, notice that the “ Article Length” slider is almost all the way 
to the left so only the main headline for each article is shown. 

To display an entire article, single-click on any headline.  

Click these links to sort the headlines.



Lesson 7 Safari for Web Browsing and News

142

Find other feeds
    When you come across a web site that has an rss feed, Safari will display an rss 
icon in the address fi eld, as shown below.

To   view the actual  RSS feed, click the icon in the  address fi eld. 

To fi nd a   directory of rss feeds, go to your favorite search tool, such as Google.com. 
Search for directory RSS feeds or directory XML feeds.

This little menu might 
or might not appear, 
and it might have 
different items in it. 
If “RSS 2.0” is a choice, 
select that one. 
Otherwise, most 
any choice will work.
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 Bookmark your favorite feeds
Th ere are at least three ways to   bookmark a feed you want to keep track of. 

If you plan to categorize your bookmarks, fi rst make folders in the    Collections 
pane in the Bookmarks Library (click the plus sign at the bottom of the pane, then 
rename the folder). You can create a folder for an eclectic collection of headlines 
in a number of your favorite interests so you will have your own customized 

“newspaper.”

To bookmark a feed, do one of the following:

■ Click the rss icon in the address fi eld, as shown on the opposite page. Th is 
takes you to the news feed page. Bookmark that page; in the little sheet that 
drops down, choose the folder (one you previously created in the Bookmarks 
Library) in which to save the bookmark or choose “Bookmarks Bar” to put 
that rss feed bookmark directly into the Bookmarks Bar.

■ Look on the web site for a little RSS or XML logo,  icon, or note (or also check 
for “    Atom”). Single-click it, which takes you to the news feed page. Bookmark 
that page and choose the folder in which to save the bookmark.

■ If you fi nd a link to RSS or XML on a web page, Control-click on it (or right-
click). From the menu that appears, choose “Add Link to Bookmarks….” 
Be sure to give it a name that will describe what it is.
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 4 When you click on a folder in the Bookmarks Bar that has the tiny   square, 
every page in that folder opens, each with a diff erent tab (which indicates a 
diff erent page), as shown below. Single-click a tab to go to that page.

  Auto-Click to view all pages or feeds in tabs
Safari has a nifty little feature called “ Auto-Click” that lets you load all the pages in 
a Collection into diff erent      tabs with the click of a button. Instead of going to each 
individual page one at a time and then losing the previous page, you can peruse 
them all while they are all open, each in its own tab. 

To view all pages in tabs automatically:

 1 In the Bookmarks Library, single-click on “Bookmarks Bar” in the Collections 
pane, as circled below. 

 2 Put a check in one of the “Auto-Click” checkboxes that you see next to each 
folder. (Of course, if there are no folders, you won’t see any checkboxes!)

 3 As soon as you check the “Auto-Click” box, you’ll notice that the tiny triangle 
in the Bookmarks Bar has changed to a tiny square. 

Click this button 
to open or close 
the Bookmarks 

Library.

Tabs.

Note the visual 
clues:

A triangle gives you 
a menu.

A square opens all 
pages into tabs.

A number in 
parentheses means 
you have new RSS 
feeds.
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Change the    RSS preferences
In the Safari preferences, you can tell Safari rss how often to check for updates, 
what     color to highlight new articles, when to get rid of old articles, and more. 

To open the RSS preferences, go to the Safari menu and choose “Preferences….” 
Th en click the “rss” tab to get the rss options.

If you choose to “Automatically update articles,” Safari will put a number after the 
feed or folder of feeds to tell you how many new and unread articles there are. You 
can see that  number in the Safari illustrations on the previous pages.

View RSS feeds in Mail
To make it even easier to get your info fi x, you can send the rss feeds directly to 
Mail so whenever you check your email, you can see if you have news waiting. 
To send the RSS feeds to Mail, make a bookmark (press Command D) of an rss 
feed and in the sheet that drops down, check the box to add the bookmark to “Mail.”
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Send an RSS feed to a friend
If you want to share a feed with someone, simply open that rss 
feed page in Safari. On the right-hand side of the Safari window, 
at the bottom of the pane, is a link called “Mail Link to Th is 
Page.” Click on it, and your    Mail program will open with the link 
to the page already in the message area and a subject line already 
written. Just add an  address and send. 

Use     RSS Feeds as a screen saver
Ha! Th is is very clever. You can let the current headlines from your favorite rss feed 
become your screen saver. It’s sexier than it sounds.
 1 From the Apple menu, choose “System Preferences….”

 2 Click on “ Desktop & Screen Saver,” then click the “Screen Saver” tab.

 3 In the left-hand pane, choose “ rss Visualizer.”

 4 Click the “Options…” button to choose your favorite feed. After you have made 
all the setting changes, close the pane.
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Safari is Integrated With:
Address Book: Put your Address Book in the Bookmarks Bar and go to the web 

site of any contact in your Address Book. In the Safari preferences, 
in the Bookmarks pane, check the box to “Include Address Book.”

 Th e   AutoFill feature uses the Address Book contact you have 
designated as “My Card.” 

Mail: Email a web page or just the contents to someone; see page 132.
 Email links open a pre-addressed message in Mail.
 RSS feeds can show up in Mail.

TextEdit: Web links on a TextEdit page will open in Safari; see page 68.

iCal: Web addresses in events open in Safari.

Dock: Drag the tiny icon that you see to the left of a web address 
and drop it on the far right side of the Dock to create a web 
location. No matter which application you’re in or which Space, 
you can click that icon in the Dock and Safari instantly opens to 
your favorite page. 



 

8
GOALS

Create calendars

Add events and 
create To Do lists

Send email notifications 
of events

Publish your calendar and 
subscribe to others

Print data in useful ways
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LESSON  8

iCal for Organizing 
your Life

iCal is a calendar program that keeps track of events, creates a 

digital To Do list, and pops up reminders to you, among other 

things. You can publish your calendar over the Internet for other 

iCal users (publicly or privately), and they can subscribe to it and 

get automatic updates. Or publish it to a web page and anyone on 

any computer can view it. 

iCal is a great tool for keeping track of family activities or for 

coordinating corporate events. And you can do it all in one 

application because you can create separate calendars for separate 

parts of your life. 

If you have an iPhone, iCal syncs selected calendars to it so you 

always know what’s going on. 



Lesson 8 iCal for Organizing your Life

150

Every calendar has its own 
events and To Do list.

Choose the view from 
these buttons.

Click this pushpin to display 
the To Do list, above.

Click this + to create 
a new calendar.

The        iCal Window
Th e iCal window is in a familiar calendar format, but because it’s digital you can 
switch to diff erent views with the click of a button. View a month at a time, a week, 
or a day; go back in time or forward into the future. Set recurring events to happen 
every fi rst Friday or every three months. Create To Do lists that are attached to 
certain calendars. Turn calendars on or off  so you can view just individual ones, or 
view several at a time to see how they overlap.  

Uncheck a 
calendar to hide 

its events and 
To Do lists.

These are called 
Mail calendars. 

They are created 
when you first 
make a To Do 

item in Mail for a 
.Mac account. You 
cannot add events 
to these calendars, 

just To Dos.



Lesson 8 iCal for Organizing your Life

151

I made this Group calendar.

Click the disclosure triangle 
to the left of a Group 

calendar to tidy up your list.

Create a Group of Calendars
Create calendar groups to organize related calendars. You might want to group 
together the calendars that all have to do with your children. Or perhaps a partic-
ular project has several diff erent calendars associated with it.

To make a group, go to the File menu and choose 
“New Calendar Group.” Or Shift-click on the + sign 
in the bottom-left corner of the iCal window. 

Name the new group, then drag 
other calendars into it. 

Create Calendars
To create a new calendar, go to the bottom-left corner of the iCal window, click 
the + sign, then name the calendar. 

You can have lots of diff erent calendars. Th e checkmark next to a calendar name 
indicates those events are displayed. Th us you can have a calendar for each one of 
your kids’ activities, plus your work calendar, and choose to see all the events at 
once or just selected ones. You’ll have a visual display of just how crazy your life is.

To change the color of the calendar or to give it a description, Command-click 
(or right-click) on the calendar name. You’ll see the pane below where you can 
change the color or add information. 

Click this color box to 
choose another color 
or to make up one of 
your own.
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Automatic  Birthdays Calendar
iCal can work with your Address Book to create a Birthdays calendar that automati-
cally updates itself. 

 1 First you must add the Birthday fi eld to your Address Book, as explained on 
page 112. 

 2 Th en, in iCal, go to the iCal menu and choose “ Preferences….” 

 3 Click the “General” icon.

 4 Check the box to “Show Birthdays calendar.” Th e calendar will appear in the 
“Subscriptions” group. If you don’t have a Subscriptions group in your calendar 
list, iCal will put it there now. 

Double-click any birthdate showing in the calendar to open its Info pane. Th ere 
you can click the link to go straight to that person’s contact information in Address 
Book, from which you can send a birthday email. 

You can’t make any changes to the Birthdays calendar in iCal; in fact, you can’t even 
add alarms to notify you of upcoming birthdays. 
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These little icons 
indicate there is a file 
associated with this 
event, plus there is a list 
of attendees who have 
not all responded yet.  

Double-click the event 
to show the Info pane 
with the information 
about that event. 

Create Events
An event is what you’d expect it to be—something that happens on a particular day. 
You can create     events in a variety of ways. 

First select the calendar in which you want the event to appear. Th en:

■ In the “Month” view, double-click on a day to create a new event. A little tag 
appears on that day and you can add your information. Double-click on the 
tag to get the Info pane where you can add more information; click anywhere 
outside the Info pane to put it away. iCal arranges multiple events on one day 
according to the times you enter. 

■ In the “Week” or “Day” views, press-and-drag over the times for your event. 
Double-click the event to open the Info pane and add information; click 
anywhere outside the Info pane to put it away.

■ To stretch the event out across  multiple days, be sure to click the “all-day” 
button in the Info pane.

■ To create a recurring event, use the “repeat” feature in the Info pane. iCal 
automatically repeats the event at a time interval you specify. For instance, 
the Shakespeare readings I hold repeat the first Friday of each month.

You can press Command I to open 
the Info pane for a selected event. 
Press Commend E to open it ready 
to edit.
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Create To Do Lists
Each calendar can have its own     To Do list. As you check and uncheck the calendar 
checkboxes, their attendant To Do lists show and hide accordingly.

To create a To Do item: 

 1 If the To Do pane isn’t showing on the right side of iCal, click the pushpin 
button in the bottom-right corner.

 2 Select a calendar from the calendar pane on the left. 

 3 In the To Do pane on the right, double-click in a blank space. Or Control-click 
(or right-click) and choose “New To Do” from the contextual menu. 

 4 Double-click directly on a To Do item to open its Info pane. 
You can prioritize your item, add a note, give it a due date, change 
the calendar, and more. 

 5 When the item has been completed, check the tiny box to its left.

Email a To Do item
You can email a To Do item, and if that person has a Mac, she can choose to click 
the link in the email to add the To Do item to her iCal. 

To email the To Do from iCal: 

 1 Control-click the item in the To Do pane, and from the menu that pops up, 
choose “Mail To Do.”

 2 Th e Mail application opens with the To Do included as an attachment. 
Address the email form and click Send.

 3 Th e recipient of the email clicks the link and the To Do is added to the 
calendar of his choice. 

You can also email To Do items 
from Mail and they will be 
added to iCal. 
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Email Notifications
You can send someone an email invitation to an event, and she can send one to you. 
Mail automatically puts a notifi cation in iCal and adds the new event to the calendar.

To send an invitation/notification:

Command-click (or right-click) on an event in a calendar. From the pop-up menu 
that appears, choose “Mail Event.” Address the message and send it. 

To respond to an email notification:

 1 When you get an email message from someone  inviting you to an iCal event, 
the Notifi cations box appears in the bottom-left corner of iCal. 

  If the box isn’t showing and you want to see it, single-click the Notifi cations 
button, as shown below.

 2 When an invitation comes in, the Notifi cations button displays a red arrow. In 
the Notifi cations box, shown below, click the button to indicate your response. 
An email message is immediately sent to the person who notifi ed you. 

 3 If you accept the notifi cation, that event is added to your calendar on the 
appropriate day. 

Notifications 
button.
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Link Events and To Dos
To turn an Event into a To Do item, drag the Event from the calendar grid to the 
To Do pane. Th e event stays put, but now you also have a To Do item relating to it.

To turn a To Do item into an Event, drag a To Do item to a date in the calendar 
grid. Th e To Do item stays put, but now you also have an event attached to it. 

Sort (organize) your Information
Automatically sort your To Do list by due date, title, calendar, or priority. Just click 
on tiny arrows in the heading of the To Do list and choose your option. 

No matter how you’ve chosen to automatically sort items, once you manually drag 
an item into a diff erent position (which you can do at any time), the sort order 
returns to “Manually” and is no longer an automatic arrangement. 

  Backup the Entire Calendar of Information
To make sure you don’t lose the valuable information you have entered into your 
calendar, go to the File menu and choose “Back up iCal….” You will be asked where 
to save the fi le. If you have a lot of information you don’t want to lose, you should 
save that fi le onto a cd and store it in a safe place.
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Publish your Calendar
If you have a .Mac account (or a private server), you can publish your calendar of 
events, including the alarms and To Do list if you choose, to a web page and anyone 
in the world on any computer can view it. It’s really remarkable.

To publish, just select the calendar in the list, then go to the Calendar menu and 
choose “Publish….” A little dialog box (shown below) drops down. Make your 
choices, then click “Publish.”

A message appears telling you the web address and asking if you want to email 
people with the address. 

To notify other people at any time, select the calendar, go to the Calendar menu, 
and choose “Send Publish Email….” 

   Subscribe to Calendars
Th ere are many public calendars you can subscribe to, such as calendars for the pga 
tours, nascar races, musician’s tour dates, and many more. 

To subscribe to a public calendar, go to the Calendar menu and choose “Find 
Shared Calendars….” Th is takes you to an Apple web site with dozens of public 
calendars (mostly sports).

To subscribe to a private calendar, go to the Calendar menu in iCal and choose 
“Subscribe… .” Enter the web address you have been given.
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  Print in a Variety of Ways
Check out the great features in the Print dialog box. Each “View” (Month, Day, Week, 
or List) you choose changes the options, so spend a few minutes here exploring the 
possibilities for each view. You can choose to print the data from as many or as few 
calendars as you like. Th ey are all color-coded, so just as in iCal itself, you can see 
how diff erent events overlap.

Slide this bubble to 
 resize the preview.

Change the view here; the preview 
will immediately change.

Turn 
calendars 
on or off 
here.
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iCal is Integrated With:
Address Book: Use the cards and groups to invite people to events.
 Any birthdays you enter in Address Book can automatically appear 

in iCal (go to the  iCal preferences and check “Show Birthdays 
calendar”).

 When you enter attendees names in the Info pane, iCal picks up 
their email addresses from the Address Book.  

 Open the Address panel from the Window menu. Quickly add 
people to the  attendee list—drag them to the “attendee” button.  

Mail: iCal will mail invitations and notifications of calendar updates, and 
Mail can automatically send notifications to iCal. 

 You can create iCal calendars in Mail and add events to them 
from Mail. 

 To Do items you create in Mail can be automatically added 
to the To Do list in iCal. 

 iPhone: Sync your iCal information to your iPhone.

iSync: Synchronize the calendar on one computer with all the other 
computers in your office, as well as with your .Mac account. 



 

9
GOALS

Set up iChat

Text chat with one person 
or a group of people

Audio chat with others 

Video chat with up to 
three other people

Create effects on your 
image or change your 

background

Share files and even your 
iPhoto with others 

through iChat Theater 

Connect to users 
on your local network 

through Bonjour

Share the computer screen 
of someone else 

in the world
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LESSON 9

iChat for Text, Audio, 
and Video Messaging

Using      iChat you can communicate with others around the world 

using text messages, audio chatting, or video conferencing—free. 

You can text-chat with one other person or with a group of people, 

exchange fi les, and save printable copies of your chats. With a fast 

Mac and iChat, you can have audio chats with up to ten people 

at a time. You can have video conferences with up to three other 

people. You can even have one-way video chats where someone 

can see you but you can’t see her (or vice versa). Amazing.
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Set up iChat
When you first open iChat, it will ask you to fill in certain information to get started. 
You need a chat account of some sort.

If you already have a  .Mac account, that will be your “screen name” 
or “buddy name.” Include the @mac.com part of your name when you 
tell others your buddy name.

In the setup process, you can click the button labeled “Get an iChat 
Account….” Th is takes you to Mac.com where you can get a free iChat 
buddy name with a 60-day .Mac trial account, and you can keep the buddy 
name after the free trial is over even if you cancel the trial account. 

Or go to www.AIM.com and sign up for a free  AIM account; you can use 
that as your buddy name. Th is buddy name does not include @aim.com.

If you already have a   Jabber account, you can use that name as well.

You can get a free Google Talk account at www.Google.com/talk. 
Th is is also a Jabber account. Include @gmail.com in your Buddy name 
in the iChat setup.

If you skipped the initial set up the fi rst time it asked, just open iChat (single-
click its icon in the Dock) and it will ask you again to set it up. Follow the simple 
instructions. 

www.AIM.com
www.Google.com/talk
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This is a Buddy List. Double-
click a buddy name to open a 
text chat. The people whose 
names are grey are not 
available at the moment.

This is a text chat.

A sample Buddy List and chat 
So you’ll know what to expect after you’ve gone through the process, below you see 
a typical Buddy List and text chat.

Customize your chat view 
through iChat preferences 

(from the iChat menu); 
use the “Messages” pane.
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Create a Buddy List
To iChat with people, first set up a Buddy List of names. If you’re using a Google 
Talk account or other Jabber account, your Buddy List is called Jabber List. 

 1 If you don’t see the Buddy List when you open iChat, go to the 
Window menu and choose “Buddy List.”

  If the title bar of the Buddy List says you are “Offline,” click on the 
tiny  triangle and choose “Available.” 

 2 To add a new buddy, single-click the + sign at the bottom of the list 
and choose “Add Buddy.”

 3 In the dialog box that appears, enter the person’s screen name or buddy name 
in the “Account Name” fi eld. Choose whether it’s an aim account or a .Mac 
account. If you choose .Mac, it will enter the @mac.com part for you.

  Or click the disclosure button to display your Address Book, then choose a 
buddy from your list of contacts.

 4 Choose a Group in which to organize this buddy. Apple has provided 
several groups for you, and you can create your own.

 5 Click the “Add” button. 
  Th is account is automatically entered in the Address Book for you, 

if s/he wasn’t already there. 

Click this disclosure 
button to display 
your Address Book 
contacts, as shown 
here.
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Chat with One Other Person
To have a text   chat with someone around the office or around the world, simply 
open your Buddy List and double-click the name of the person you want to chat 
with. Double-click on the person’s name or icon, not on any camera or phone icon 
that might be visible. A chat window opens. Type a message, then hit Return. Or 
select a buddy name, then single-click the “A” at the bottom of the Buddy List. 

Chat with a  Group of People
You can text chat with at least twenty-three diff erent people around the world in 
one Chat Room. 

 1 From the File menu, choose “Go to Chat Room.” 

 2 In the window that appears, type a name that will become the name of this 
chat room. Make it something distinctive because if anyone else around the 
world types the same word, they’ll end up in your chat room.

 3 A Participants drawer pops out to the side of the chat room window. 
Click on the + sign and invite someone. 

 4 Click the + sign again and again to invite as many people as you like. 

Or tell people ahead of time to all meet in a chat room called, say, “dogfood,” at a 
certain time. At the prescribed time, tell everyone to do this:

 1 Open iChat and go to the File menu; choose “Go to Chat Room….” 

 2 Enter the chat room name (in this case, dogfood) and click “Go.” Everyone 
around the world who does so will end up in the room together. Remarkable. 

Here I’ve started a Chat 
Room and invited my 
sweetheart, John, and 
my mother, Pat.
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This Mac has no camera 
attached, nor does it have 
a microphone. We can only 
text chat with each other.

Audio Chat with One or More
Talk, literally talk, with other people. Make sure you have a microphone built 
in or connected to your Mac, or an iSight or other video camera attached. Newer 
iMacs and laptops, of course, have built-in cameras. Your buddies will display little 
telephone icons next to their pictures if they are able to audio chat back to you. 

To audio chat with someone, she has to be in your        Buddy List (see pages 163–164). 
In the list, as shown below, you can have a one-on-one audio chat with anyone who 
displays a telephone icon next to her name.

If a buddy shows multiple telephone icons, like “jtratz” and “roadrat,” below, that 
means you can invite him to an audio chat that involves more than one person. 

To   audio chat, double-click directly on that person’s phone icon. Or single-click his 
name and then click the phone icon at the bottom of the Buddy List.

If your Buddy doesn’t have a microphone to chat back with you, select his name, 
then go to the Buddies menu and choose “Invite to   One-Way Audio Chat.” Your 
friend will hear you, but will have to send typed instant messages back.

 iChat picks up your 

photo from the Address Book; you 

can change the photo there. 

 To add a photo to 

a buddy, select any buddy name and 

press Command I to get the Info 

window (or Control-click on a buddy 

name and choose “Show Info” from 

the menu that pops up). Drag any 

image into the image well.
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Open an audio chat and invite others to join you
To initiate an audio conference with more than one other person, you need a more 
powerful machine than you do to join an audio chat. Any machine purchased within 
the last couple of years is powerful enough to initiate an audio chat. 

 1 Single-click a buddy name that displays multiple phones, then single-click the 
phone icon at the bottom of the Buddy List (or just double-click directly on 
the phone icon next to the buddy’s name).

 2    Th at person hears a little phone ringing and sees a message on his computer; 
he clicks the message to see who it is, then clicks “Accept.” Th is begins the chat. 
Your window looks like this:

 3 Now click the + button to get a little menu that lists the other people in your 
Buddy List who are capable of joining an audio conference. Select a person, 
then add others in the same way. 

 

 4 To delete someone from the audio conference, move your pointer up towards 
his icon. A red x appears; click it and that person is gone. 

 5 To terminate an audio session, click the red close button in the upper-left of 
the little window.

Although it says “with 
2 People,” there are 
really three people 
in this chat—I’m the 
third person. 

Click the microphone icon to mute the 
session. The green bar and the microphone 
will turn orange as visual clues that the 
sound is muted.
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Video Chat with up to Three Other People
 See other people on your screen while you talk (not type) with them. To        video chat, 
of course you must have a video camera attached to your Mac. All of the newer 
iMacs and laptops have built-in video cameras. You can use Apple’s cute little iSight 
 camera if you already have one (they’re not sold anymore), or you can attach any 
FireWire video camera to your Mac, or one of the new USB cameras. 

With whom can you  video conference?
A video conference with more than one person takes a powerful Mac and a good 
broadband connection. If you are able to participate in a video conference with 
more than one person, the camera icon in your Buddy name shows multiple 
cameras. If someone in your Buddy List is able to participate, she shows multiple 
cameras, as well. And it takes a very powerful Mac to initiate a video conference 
with up to four people.   

iChat AV preferences
You can make some minor adjustments in the Audio/Video pane of the iChat pref-
erences. You might try changing the “Bandwidth Limit” to see if it aff ects your video 
chat one way or another. Depending on your Internet connection and how many 
other people use it, a diff erent setting can work better (or worse). 

I can do a multiple 
video chat with two 
of my buddies, the 
two with multiple 
camera icons.



Lesson 9 iChat for Text, Audio, and Video Messaging

169

Open a video chat and invite others to join you
To initiate a video conference with more than one other person, you need a more 
powerful machine than you do to join a video conference.   

 1 Single-click on a buddy name that shows multiple video camera icons. Th at 
person hears a little phone ringing and gets a message on her screen inviting 
her to a video chat. When she clicks “Accept,” she appears in your video 
window instead of you. 

 2 To add    two more people to your video conference, click the + sign; a menu 
drops down with the names of the people in your Buddy List who are capable 
of joining you. 

If your Buddy doesn’t have a camera with which to video chat with you, select her 
name, then go to the Buddies menu and choose, “Invite to One-Way Video Chat.” 
Your friend will see you, but will have to send instant messages back.

This machine 
doesn’t have 
a camera 
attached, but 
that person 
joined the audio 
portion of the 
video chat. 
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iChat Effects
iChat Eff ects are useless but grand fun. You can distort your image, add artistic 
touches, and even add new backgrounds so it looks like you’re somewhere else. 

To preview the various effects: 

 1 Go to the Video menu and choose “Video Preview.” 

 2 Now from the same menu choose “Show Video Eff ects.” 

 3 Select an eff ect from the palette (shown below) to see what it will do.

To apply an effect during a video chat: 

 1 During a video chat, click the “Eff ects” button in the bottom-left corner 
of the chat window. Th is opens the “Video Eff ects” palette shown above. 

 2 Th e original, non-eff ect version appears in the middle of the palette. 
Click an eff ect to apply it as you chat. 

 3 To return to the original, non-eff ect image, click the “Original” image 
in the center of the palette.



Lesson 9 iChat for Text, Audio, and Video Messaging

171

Add backgrounds
In addition to distorting your video image with various eff ects, you can add a 
photo or a movie to replace the existing background that’s really behind you. Th is 
background replacement feature works best if you have a simple, uncluttered, 
single-color background. We got the best results (but not perfect) by using a 
background wall that was smooth and almost white. Although you can do this in 
the middle of chatting, you might want to get it all set up before you call someone 
on a video chat and surprise them.

 1 In the Video Eff ects palette, click the right arrow button until you get to the 
palette of background images. Th ey’re photos, not your picture.  

  To add your own background photos or movies, click through the eff ects 
until you fi nd an empty well. Drag your image or movie into that well. 

 2 Click on a background image to select it. A text prompt appears and asks you 
to move yourself out of the video frame. Th e prompt notifi es you a few seconds 
later with a “Background Detected” message. 

 3 Move back into the picture. iChat replaces the original background with the 
photo or movie you selected and puts you in front of it. 

  If you want to change to another background, iChat will not ask you to step 
out again—it will just replace the existing one. 

John’s holding 
his nose, you 
see, because he’s 
under water.
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When you drag a file to 
the video chat window, the 
buddy’s image minimizes 
to the bottom-left corner 
to make room for an image 
of the file. Your buddy sees 
you as a thumbnail video 
and sees the same file 
image that you see. 

iChat Theater
Once you’ve initiated a video chat, you can use iChat Th eater to show fi les, photos, 
slideshows, or movies while you continue your chat. Th is is amazing.

To share a file with iChat Theater:

 1 Start a video chat with a buddy.

 2 From the File menu, choose “Share a File With iChat Th eater….”

 3 In the Finder window that opens, select a fi le, photo, or movie you want 
to share, then click “Share.”

Or simply drag any fi le, photo, or movie from your hard disk and drop it onto the 
video chat window.  

This is the file window for 
a PDF in iChat Theater. 

Click here 
to end an 

iChat Theater 
session.

iChat Th eater also opens a fi le window on your screen (shown below). It allows you to 
scroll through a shared multi-page document as your buddy watches, play or pause a 
movie, or show previous or next fi les in the chat window. 
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Share iPhoto with iChat Theater
You can also share entire iPhoto albums as a slideshow.

 1 Start a video chat with a buddy.

 2 From the File menu, choose “Share iPhoto With iChat Th eater….”

 3 In the iPhoto window that opens, select an album, then click “Share.”

iChat Theater opens this file window 
so you can control the slideshow.

Select an album or select multiple photos to show 
as a slideshow in the video chat window.

iChat Theater movie. The file window for multiple files. 

If the shared fi le is a movie, the fi le window displays a Play/Pause button and a 
scrub bar to drag the clip backward or forward.

To share multiple fi les of the same or diff erent types, Command-click to select the 
fi les on your hard drive, then drag the fi les to the video chat window. Th e fi les play 
as a slideshow.    
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If you select “Send text as I 
type,” the recipient of your 
message will see the text as 
you type it. If you leave this 
unchecked, the recipient sees 
an empty little message cloud 
until you finish your message 
and hit Return.

Turn Bonjour on or off.

Bonjour on your Local Network
Bonjour is an integrated component of    iChat. If you have two or more Macs 
connected through a local area network (an Ethernet network, wireless network, 
or a combination of both), Bonjour automatically detects and connects all of the 
computers on the network. You can send Instant Messages or fi les to Bonjour 
buddies on your local network. You can have audio or video chats with others on 
the local network (if a microphone or digital video camera is connected to your 
computer, of course). And you can use Screen Sharing to share your computer with 
others or to see another buddy’s computer (see the following pages).

You don’t have to have a .Mac account or aim account or any other kind of special 
account—just computers that are connected in some way.

To set up Bonjour:

 1 Open iChat, then from the iChat application menu, choose “Preferences.”

 2 Click the “Accounts” button, then click “Bonjour” in the Accounts pane on the 
left side of the window. 

  Or you can just open iChat, go to the Window menu and choose “Bonjour List.” 
It will give you a button to login to Bonjour.
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Bonjour automatically detects a local network and connects you to it. If you’re in a 
public space, such as an Internet cafe, you should quit iChat and turn off  Bonjour 
when you’re not using it to ensure privacy and security. 

To send a fi le to anyone on the Bonjour List, just drop the fi le on a buddy’s name. 
Your buddy will get a message asking if he wants to accept the fi le. 

Or drag a fi le into the message fi eld where you type to chat. Hit Return and off  it 
goes. If the fi le is an image, the image itself will appear in the chat window, and your 
buddy can drag it to his Desktop. 

Th e Bonjour List looks just like a Buddy List—except it’s labeled Bonjour List. Your 
chat windows look similar too.

 If you’re interested in sharing files on your network or sharing computer 

screens (where you can actually manipulate the other person’s monitor wherever she is in 

the world), please see Lesson 21 on connecting and sharing files.
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Record Chats 
When an audio or video Chat is in progress, you can record the chat. Recorded 
video iChat fi les require a lot of storage space, approximately one megabyte for 
every fi ve seconds of video.

 1 Start an audio or video chat with a buddy.

 2 From the Video menu at the top of the screen, choose “Record Chat.”

 3 Th e buddy’s audio or video chat window reveals a “Recording Request” sheet 
(below-left). When the buddy clicks “Allow,” the chat begins.

 4 A red Record light alerts both participants that recording is in progress. 

A red Record button means the 
audio chat is being recorded. 

To stop a video recording, from the Video menu choose “Stop Recording.” 

To stop an audio recording, click the red Record button. 
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Find recorded chats
To locate a video or audio chat fi le, go to the Home folder, open the Documents 
folder, then look in the iChats folder. 

Th e fi les are also found in iTunes. Look in your iTunes sidebar for a playlist named 
“iChat Chats.” Click that playlist to show any recorded iChats.

iChat is Integrated With:
Address Book: Th e photo you put in Address Book appears in your Buddy and 

Bonjour List, and the photo you put in the Buddy or Bonjour List 
appears in the Address Book. 

 When an iChat buddy is online, a   green dot appears on her card. 

Mail: You can send   email to a buddy through your Buddy List—Control-
click (or right-click) on a buddy name, then choose “Send Email….” 
And when a buddy in your list is online, a  green dot appears in the 

“Buddy Availability” column in Mail.

iTunes: Let others know what music you are listening to; in the Buddy List, 
click on the word right beneath your name (it’s a menu). Choose 
the option “Current iTunes Song.” 

iSight camera, built-in camera, attached video camera: 
You video conference with this camera, of course, but you can also 
click a button to take a picture of the person on the other end to 
use for his buddy image (“Show Info” on a buddy, and drop a new 
photo in the well).

Drop a photo or graphic image in 
this well. If you want this image to 
 override the one your buddy uses, 
check the box to “Always use this 
picture.”
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GOALS

Buy music, movies, 
music videos, 

or television shows.

Create Playlists and 
Smart Playlists of 

selected music.

Burn your own CDs 
of music.

Watch movies or shows 
right in iTunes.

Listen to radio from 
around the world. 

Print covers 
for your own CDs.
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LESSON 10

iTunes for your 
Listening Pleasure

Import music into iTunes, create Playlists of your favorite songs, 

copy the Playlists to cds so you have your own discs of customized 

music, or stream your music from your offi  ce down the hallway 

to hear it in the kitchen. You can buy music directly through the 

iTunes Store with the click of a button and download it right to 

your computer.

If you have an iPhone, your phone automatically opens iTunes 

to sync music and data to it. And of course your iPod gets its life 

from iTunes.
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     The iTunes Window
Below is an overview of the iTunes window. Th is short chapter is only an overview; 
if you want an entire manual about iTunes, please see John Tollett’s book called 
Cool Mac Apps (which contains entire manuals about all the other cool apps that are 
available from Apple). Th ere is so much to iTunes! I encourage you to explore the 
menus and all the buttons. 

All of your 
songs, books, 

shows, etc., are 
imported into 

the Library. 

Click the Play button and all the 
checked songs in the window will play.

Click these view buttons to display 
your collection in various ways.

Click this arrow to send this 
album to someone as a gift or 
to post your Playlist to iTunes.

Click one of these arrows 
to find more of this artist’s 
songs in the iTunes Store.

You only see these arrows on items that you 
have selected (single-click to select).

The Playlists 
help you 

organize all the 
music in the 

Library. 

Apple has made 
a number of 

Smart Playlists 
for you (see 

pages 182–183 
about Smart 

Playlists).
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You can add your own art to this well—select 
a song, then drag any graphic into this spot.

Buy Music, Movies, or Television Shows
To buy music, movies, or television shows, click on “iTunes Store” in the sidebar. 
You can search for music: use the search fi eld in the upper-right. 

Th e first time you click a “Buy” button, you will be asked to set up an account. If 
you have a .Mac account or email address, use that. You’ll be asked for a credit card 
number and contact info. After you’ve got an account, you can buy and download 
music, movies, and television shows with the click of a button. To watch a show or 
movie, see the next page.

Download Album Art
When you buy music through iTunes, you automatically get the       album art with it. 
If the art is not showing at the bottom of the sidebar when you select a purchased 
song, click the artwork and video-viewer button (shown to the left, circled below). 
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The purple Playlists that you see already in your 
sidebar are ones that Apple has created for you. 
They display the songs their labels describe—the 
recently played songs, the 25 you play most 
often, etc. These are purple and have a different 
icon because they are Smart Playlists, which 
are Playlists that automatically add items to 
themselves based on chosen parameters; see the 
next page.

Create a Playlist
A Playlist is a collection of songs from your iTunes music Library. You might 
create one Playlist of your favorite jazz, another of Scottish folk songs, and another 
of a particular artist. Th e same song can be in any number of Playlists. You can take 
two songs from this cd, one from that cd, etc., to create your own personal 
collection, then burn that collection to a cd of your own. 

 1 Playlists are made from songs in your iTunes Library, so first import songs 
from cds (see the following page) or buy songs at the iTunes Store (see the 
previous page).

 2 Th en click the + sign at the bottom of the sidebar. A new, untitled Playlist label 
appears in the sidebar.

 3 Name this new Playlist. 
 4 Single-click on the Music collection in the Library section of the sidebar.
 5 Drag songs from the Library window to the Playlist name. 
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Create a Smart Playlist
A regular Playlist holds the songs or music videos that you add to it by dragging 
items into it. A Smart Playlist automatically adds certain music all by itself. 

It’s really great. Remember, buy the songs or import the songs to iTunes first.

 1 Hold down the Option key; the + sign at the bottom of the sidebar turns 
into a gear wheel; click the gear wheel. Or go to the File menu and choose 

“New Smart Playlist… .”  
 2 In the dialog box that appears, click the menus from left to right and make 

your choices. Click the + sign to add more parameters. Click ok.
 3 Th e Smart Playlist appears in the sidebar, waiting for you to rename it. 

  Import Songs from a CD
Put an audio CD in your drive and iTunes automatically opens. If you’re online, 
iTunes goes to an online database and (if it can find the cd in the database) gets the 
artist, album title, song names, times, and more, and displays that information in 
the iTunes window. 

Single-click the checkboxes to check or uncheck songs—checked songs are the ones 
that will be imported. (Command-click to check or uncheck all boxes.)

A button in the bottom-right appears called “Import CD.” Click that button, and the 
checked songs will import into the Music library.

Share the Wealth
Share your Library of music with other computers in your office. Open the iTunes 
preferences. Click the “Sharing” tab, and then check “Share my library on my local 
network.”

To find music that other computers are willing to share with you, check the box to 
“Look for shared music.”

Adjust the Sound
Use the powerful equalizer for        sound quality. From the Window menu, choose 

“Equalizer.” Experiment with the controls.
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Watch Movies in iTunes
You can buy movies or television shows and watch them directly in iTunes. If you 
buy an Apple TV device and have a wireless system and widescreen tv in your 
home, you can stream the movies and shows from your computer to your television. 
(To do so, you’ll have to read the directions that come with the Apple TV!) 

To watch a movie in iTunes:

 1 Go to the iTunes Store and buy a movie or television show. After it’s 
downloaded, it will appear in the “Movies” or “TV Shows” list.

 2 Select “Movies” in the Library section of the sidebar, then double-click on the 
name of the movie or show. Th e fi lm immediately opens in the iTunes window, 
as shown below.
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Tune in to Visual Effects
To see     visual effects that change depending on the music you’re playing, go to the 
View menu and choose “Turn on Visualizer,” 
 Or press Command T to turn on the visualizer. 
 Press Command F to view the eff ects full screen.
 Press the letter R to randomly change the eff ects.
 Press the Escape key (esc) to turn off  the visualizer.

Below are samples of the 
variety of visual effects 
that iTunes produces, 
based on the music 
playing and the effect.  

Add a Ringtone to your iPhone
If you have an iPhone, you can buy ringtones and add them to your phone. You 
must fi rst buy the song, and the ringtone costs another 99. 
Add the “Ringtone” column to your window: Control-click (or right-click) on any 
column header; from the pop-up menu that appears, choose “Ringtone.” 
Any song that is authorized for ringtones has a little bell in that column. Single-
click on the bell and you get an option to select whatever section of that song you 
want as a ringtone, up to 30 seconds. Drag either end of the blue clip, then click 
the “Preview” button to hear it. You can choose how long of a gap you want to hear 
before the sound repeats 
(loops). Keep repeating 
that until you get exactly 
the clip you want, then 
click the “Buy” button. 
Plug in your iPhone 
and the ringtones are 
automatically synced to 
your phone.
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Burn a CD of your own Collection
To  burn a CD of your own collection, first import the songs and make a   Playlist, as 
described on the previous pages. You can’t just select songs in the music library to 
burn to a cd—you must make a Playlist. Th en:
 1 Insert a blank cd-r (newer Macs can also burn to cd+r discs).
 2 In iTunes, select a Playlist. You can only burn one Playlist onto a cd, so make 

sure it’s got everything you want in it. You can burn about 600 mb onto one 
regular cd, so add as many songs from as many diff erent artists and albums 
as you like. Check the status bar at the bottom of iTunes to know how many 
megabytes are in the selected Playlist.

 3 Click the “Burn Disc” button in the lower-right of iTunes (this button only 
appears when there is a burnable disc loaded in your Mac). iTunes immediately 
begins the process of burning the songs to disc.

 4 When it’s fi nished, you’ll see the name of the cd in the sidebar, along with 
an eject symbol. Eject the cd and enjoy!

 You can make a huge Playlist that holds many more songs than will fit on 

one CD. When you put in the first disc and click the “Burn Disc” button, iTunes will warn you 

that it will take more than one disc. You click OK and iTunes will tell you when the first disc 

is full, will eject that completed disc, and ask you to insert another one.
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With this small frame, I can see what I’m 
listening to at the moment, start and 
stop the music, and change the volume.

Listen to Radio from around the World
Th is never ceases to amaze me. You can listen to radio from around the world—all 
you do is click a button. 

In the sidebar, click the “Radio” icon, as shown circled below. Th en double-click on a 
category to see the variety of stations available in that genre, and double-click on the 
radio you want to listen to. Amazing.   

Once you’ve got the radio on, click the green minimize button in the upper-left of 
the iTunes window. Th at will reduce iTunes to just a tiny little window so it’s out 
of your way, but the radio will continue playing. (Click the green button again to 
enlarge iTunes to its full size.)
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Print a CD Cover Insert
You can print in a variety of ways from iTunes. 

 1 Select a Playlist. 

 2 Hit  Command P to print.  
 3 Experiment with the options. Choose diff erent “Print” options and then choose 

diff erent “themes” within that print option. For instance: 
  To print a cover with the original album art that slips into your cd case, 

choose “cd jewel case insert,” then choose the theme “Single cover.”  
  Th e option to print a “Mosaic” theme will print a song list and a collage 

of all the album covers that belong to songs in your Playlist. 
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iTunes is Integrated With:
iPhoto Choose a song from your iTunes collection to play during a 

slideshow.

iChat iChat Buddy List and  Bonjour List windows can display the songs 
you’re listening to: In either window, click the tiny triangle under 
your name in the title bar; choose “Current iTunes Track.”

Screensaver Your screen saver can display album art you’ve downloaded. 
Go to the System Preferences, click on “  Desktop & Screen Saver.” 
Click the “Screen Saver” tab, and then select “iTunes Artwork.”

iPod Transfer all your songs to your iPod.

iPhone Use iTunes to synchronize all your songs, contact information, and 
other data from your Mac to your phone and back again.

Wireless connections 

Th e  AirPort Express wireless device includes built-in AirTunes 
software. Plug the AirPort Express brick into any electrical outlet 
in your house and you can stream   iTunes from your Mac to that 
other room. Way cool. Of course, your Mac has to be connected 
to a wireless network or have a wireless card inside.

.Mac account Use your .Mac account to purchase music with one click.

Dashboard Display a small controller; see page 286.
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GOALS

Learn to crop, color adjust, 
and resize images

Learn how to annotate 
and mark up a PDF

Search PDFs and create 
bookmarks for easy 

retrieval

Copy text from a PDF 
to paste into another 

document as editable text

Fill in PDF forms

Make screenshots

Print images 
or documents in a 

variety of ways

Save files into other 
formats
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LESSON 11

Preview for Viewing 
Images and PDFs

Th e small picture-viewing application called Preview does a 

great deal more than merely display photographs for you. It’s 

actually quite a powerful program in which you can open and 

annotate pdfs, change fi le formats, crop images, adjust the 

color, make screen shots of what you see on your screen, and 

more. Take a few moments to explore the possibilities. 
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Open an Image or Folder of Images
If you haven’t changed the settings, you can just double-click on images or pdfs and 
they open in Preview. Preview is in your Dock (if it isn’t, see page 20 to put it there). 

To open an image or multiple images in Preview, do any of the following: 

■ Double-click the fi le.
■ Drag-and-drop an image or pdf onto the Preview icon in the Dock. 

You can drag an entire folder of images to the Preview icon and they will 
all open and display themselves in the sidebar, as shown above. 

■ Drag an image or a collection of images from your Desktop or a window 
and drop it in the Preview sidebar. 

■ Control-click on an image, select “Open With,” and choose “Preview.”

Be sure to check the Preview preferences (under the Preview menu) for options on 
displaying your images.

     Sidebar.

  Click this button 
to show or hide 
the sidebar.

Enlarge or 
reduce the size 
of the images 
in the sidebar.
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Sort the Images or        Email Them
To sort the images (arrange them in a particular order), use the Action button, 
as shown above. You don’t have to select anything fi rst. You can also email a 
selected image from this menu, as you can see above (or use the File menu).

Rotate, Reduce, or Enlarge the View
If an image appears sideways, press Command L to rotate it to the left, or 
Command R to rotate it to the right. Or use the commands in the Tools menu. 
From the Tools menu you can also fl ip an image horizontally or vertically. If you 
want to keep it that way, save the image (go to the File menu and choose “Save”).

If an image looks bitmapped, blurry, and too large, reduce its view: click on 
the –  sign in the Zoom button.  Enlarge an image, of course, with the  + sign. 

View a   Slideshow 
Th is is a fun feature: Drag a selection of images and drop them on the Preview icon 
in the Dock. Th is opens all of them at once in Preview. Th en click the “Slideshow” 
button in the toolbar. Each image appears for three seconds, then switches to the 
next image. If you don’t see the control bar in the slideshow, click in the middle of 
your screen. To stop, press Command Period or click the x in the control bar.
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 Display Facing Pages or Continuous Pages
You can display facing pages of documents, as in a book (the fi rst page will always 
display alone, like the fi rst page of a chapter). Th is works whether or not the person 
who created the pdf saved the fi le in the “Spreads” format (which combines facing 
pages in the pdf). In fact, if someone did create the pdf pages in spreads, you can 
view them in Preview as individual pages. Th is comes in very handy when you need 
to print the document because otherwise the entire spread would print on one page.

To switch back and forth from single pages to facing pages, go to the View menu, 
slide down to “PDF Display,” then choose your option.

Continuous means the pages run 
continuously in the viewer pane, 
rather than as individual pages. Scroll 
up and down to see your entire file.
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 This is a handle. If you look carefully, 
you’ll see eight of them. Drag any 
handle to resize the cropping area 
in that direction.

Crop a Photograph or Other Image
You can crop any photograph or image very easily in Preview. Keep in mind that 
when you crop an image, the part you get rid of is gone from the original image 
forever. You might want to make a copy of the fi le before you crop. (Cropping a 
PDF, however, is “non-destructive”; see the following pages.)

To crop a photograph or other image:

 1 Open the image in Preview.

 2 Choose a cropping tool from the “Select” button in the toolbar (you have to 
press on that menu to see the options; a click selects the option you see in the 
button). You can crop into a circle, oval, rectangle, or use the Lasso tool to 
draw a shape.

 3 To  resize the cropped area, press on any of the tiny square “handles” 
that you see around the edges. Drag any handle to resize.

 4 To move the cropped area to a diff erent part of the image, press in the 
middle of the cropping box and drag.

 5 When you are ready to crop, go to the Tools menu and choose “Crop.” 
Or press Command K. 
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Crop a PDF
You can    crop any part of a pdf. When you crop it, Preview actually keeps track of 
the part of the document you deleted and hangs on to it in case you want to uncrop 
the fi le, even after you’ve saved it . 

To crop a PDF:

 1 Open the pdf in Preview.

 2 Single-click on the “Select” tool, circled above. If the little tools are not visible 
in the toolbar, drag the bottom-right corner of Preview to widen the window. 
Or go to the Tools menu and choose “Select Tool.” 

 3 Starting in an upper corner, drag diagonally downward across the pdf to select 
the part of it you want to save. Th e light area is the part you’re going to keep.

 4 If you need to  resize the cropped area, position the mouse directly over one 
of the eight “handles” you see on the corners and edges of the cropped area 
(see the previous page). Drag a handle to resize.

 5 If you need to move the cropped area to another part of the page, position 
the pointer in the middle of the crop box. You’ll notice the pointer turns into 
a gloved hand. Press the hand in the middle of the crop box and drag.
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 6 If you have a multi-page document, it looks like the cropping will apply to 
every page. But don’t worry—you’ll have a choice about that in a minute. 
When you have the cropped area fi nalized, go to the Tools menu and choose 

“Crop,” or press Command K.

 7 You will be asked if you want to crop just the current page or all pages. 
Click the button of your choice. 

To switch between displays of the full page or the    cropped page:

 ■ Display the entire contents of the PDF: Go to the View menu, choose 
“PDF Display,” and choose to see the “Media Box” (as shown below). 

 ■ Display the cropped image: Go to the View menu, choose “PDF Display,” 
and then choose to see the “Crop Box.” 

  When you re-open a  cropped fi le, it might open in the uncropped version. 
Just use the technique above to view the cropping again.
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 Search a PDF
Th e search feature in Preview is quite amazing. Use the standard keyboard shortcut 
for “Find,” Command F. Once you have found an instance on the page, press 
Command G to fi nd the next instance. Th ese are the same shortcuts you’ve probably 
used in Safari to fi nd text on a web page or in TextEdit to fi nd text in your document. 

To  search a PDF:

 1 With the pdf document open in front of you, press Command F. 
Or go to the Edit menu, slide down to “Find,” then choose “Find….”

 2 A search drawer appears on the side of the document window, as shown below. 
Type your search word or phrase into the search fi eld. 

 3 As you type, Preview starts fi nding words that match. Th e more you type, 
the narrower the search becomes and the fewer words it fi nds. 

 4 In the list of results, double-click any one to go directly to that result. 
Preview will outline the word briefl y, and then the outline fades to a 
highlight so you can see the word. 

 5 To fi nd the next occurrence of the word or phrase, press Command G, 
or double-click any other result in the list.

Single-click the X to delete 
everything in the search field.
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Create Bookmarks
Th e  bookmarks in Preview are not stored in the document itself. A bookmark puts 
the name of a fi le in the Bookmarks menu of Preview so you can open the document 
or photograph immediately without having to go look for it—just open Preview 
and choose the bookmark and the fi le opens from your hard disk and displays that 
particular page. It’s like having a list of bookmarks in your web browser so you can 
instantly go to a favorite web page. 

To make a bookmark for an open document or image, press Command D 
(the same shortcut as in Safari). You will be asked to name the bookmark. 
Give it a name that you’ll recognize in a list.

 If the pdf is a   multi-page document, you can make several bookmarks 
for the same document, each one to a diff erent page. Just make sure you are 
viewing the page you want to bookmark before you press Command D.

To open a bookmarked fi le, open Preview, go to the Bookmarks menu, 
and choose the fi le from the list in the menu. 

To edit the name or to remove a bookmark, go to the Bookmarks menu 
and choose “Edit Bookmarks….” In the dialog box that appears:

 To delete a fi le, single-click the fi le name, then click the “Remove” button. 
 To edit the fi le name, double-click on its name, then edit. 
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   Annotate a PDF
You can add comments, highlights, shapes, and more to pdfs to call out items for 
other readers. Th e note symbol completely obscures the text and cannot be moved 
once the pdf is saved; the note itself will be in a sidebar. Th ey print in exactly the 
same places as they appear on the screen, so be judicious about where you place 
your notes! 

Th ere are two sets of tools available for    annotations. By default, they are not in 
the toolbar but only accessible through the Tools menu. If you fi nd you use them 
regularly, put them in the toolbar: Go to the View menu, choose “Customize 
Toolbar…,” and drag them into the toolbar. 

Press on a toolbox to make the little menu appear 
so you can choose other tools. (A click will not open 
the toolbox; you need to press and hold it down.)

To create a text note on a PDF:

 1 In an open pdf, go to the Tools menu, slide down to “Annotate,” and choose 
“Add Note.” If you have added the annotation tools to your toolbar, as above, 
then select “Add Note” from the “Annotate” toolbox button.  

 2 Click anywhere on the page. Preview creates a tiny note marker on the page 
and immediately opens an area to the side with the actual note. 

 3 To type the note, just start typing and the text will appear in the note on the 
side. Th e preferences (from the Preview menu) tell it to also add your name. 
If you want to add more to that note later, double-click on it. 
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 4 To move a note symbol, double-click on the note symbol on the page. Th en 
press-and-drag. Th e note itself (on the side) will move along with the symbol. 

 5 To delete a note, double-click on the symbol to select it. Hit Delete.

To draw a  red oval or an orange rectangle annotation:

 1 In an open pdf, go to the Tools menu, slide down to “Annotate,” and choose 
“Add Oval.” (Or if you added the annotation tools to your toolbar, as on the 
opposite page, select “Oval” from the “Annotate” toolbox button.) You can add 
an explanatory note next to the oval (see the opposite page). 

  Of course, if you want an orange rectangle, choose “Add Rectangle.”

 2 With the tool, press-and-drag anywhere on the page to create a shape.

 3 To resize a shape, single-click on the “Text” tool in the toolbar. Th en double-
click on the shape and you’ll see a grey box in the bottom-right corner. Drag 
that dark corner to resize. 

 4 To move a shape, single-click on the “Text” tool in the toolbar. Th en double-
click on the shape. Press inside of it and drag.

 5 To delete an oval, single-click on the “Text” tool in the toolbar. Th en double-
click on the shape to select it. Hit Delete. 

To highlight, underline, or strike through text:

 1 Choose the “Text” tool from the toolbar.

 2 Press-and-drag over the text you want to annotate.

 3 Go to the Tools menu, slide down to “Mark Up,” and choose your annotation 
method. (Or if you added the annotation tools to your toolbar, as on the 
opposite page, then select the method from the “Mark Up” toolbox button.)

  To delete all or part of a mark up, press-and-drag over the text whose 
mark up you want to delete. Th en select that method again from the menu or 
toolbox button (that is, if you want to remove a highlight, select the text with 
the Text tool and then choose “Highlight” from the “Mark Up” toolbox menu). 

 Once you have chosen a tool from the Annotate or Mark Up toolbox 

buttons, it becomes the default. When you want to use that tool again, just single-click 

on the button (it should be showing your tool of choice), then drag on the PDF page. 



Lesson 11 Preview for Viewing Images and PDFs

202

Create a link on an exisiting PDF
You can create a workable link on any pdf. Send the pdf on to someone else and the 
link still works. Th e link can go to any web page, in which case clicking on it opens 
Safari to that page. Or the link can go to another page in the same document. For 
instance, you might have a report with a table of contents. If there are no links from 
the table of contents to the actual pages in the existing pdf, you can add them.

To create a link:

 1 In an open pdf, click on the Text tool in the toolbar. 

 2 Press-and-drag over the existing text to which you want to apply a link. What 
the text says on the page has nothing to do with what you will enter as a link.

 3 Go to the Tools menu, slide down to “Annotate,” and choose “Add Link.” 
  Or if you have added the annotation tools to your toolbar, as on the previous 

pages, you can select “Link” from the “Annotate” toolbox button instead 
of using the menu. 

 4 Th e “Inspector” (shown below) automatically opens up to the “Annotations” 
pane, as shown below. (If it doesn’t show up, go to the Tools menu and choose 

“Inspector.”)

  If you don’t see the same pane shown below, click the red oval to display the 
“Annotations” pane.
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 5 In the little “Action” menu inside this pane, you have a choice of linking 
to a “url” on the web or to a “Link within pdf.”

  If you choose to link to a url, type in the entire web address including 
http://. Click the “Set url” button.

  If you choose to link to another page in the pdf, you’ll get a list of pages 
to choose from. Choose the page and click the “Set Destination” button 
that appears.

 6 On the page, the link appears as a gray-lined box, as shown below. 
Mouse over it to see a tool tip appear with the name of the link. 
You can click on the link in Preview to make sure the link works. 
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To copy any part of a PDF as a graphic, see page 195 to select a cropping area. 
Th en, instead of cropping, go to the Edit menu and choose “Copy.”

Now you can go to any document in any application and paste that graphic in. 
To paste it once you open the other document, press Command V, 
or go to the Edit menu and choose “Paste.”

Copy Text from a    PDF to Paste Elsewhere
You can copy text from a pdf fi le (as long as the person sending it to you hasn’t 
locked it) and paste it into any other document as editable text. Or you can copy 
a section of text as a graphic and paste it into another document as a graphic image 
that can be resized as a unit.

To  copy  text:

 1 Select the Text tool, shown circled below, or press Command 2.

 2 Press-and-drag over the text you want to select. 

  To select just a vertical portion of text, as in one column, hold down the 
Option key before you start to drag, and keep it held down as you drag.

 3 From the Edit menu, choose “Copy,” or press Command C. Open your other 
document and paste it in (Command V).
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Above-left is the original image. 

Straight above you can see where I 
randomly adjusted the sliders until 
I got an image that looks like what 
I remembered when  Laura took 
the shot, shown to the left. 

Edit a Graphic
You can do some editing in graphic images such as photos. You can crop, as 
explained on page 195, resize, and resample (change the pixels per inch). And you 
have some pretty powerful color adjustments available. Th e only way to learn how 
to use them is to experiment! Always save a copy of the original photo before you 
start messing with it.

To adjust the color of an image:

 1 Open an image in Preview.

 2 From the Tools menu, choose “Adjust Color.” You’ll see the panel shown 
below-right. 

 3 Move the sliders left and right to see what all the options do. Th e image 
will immediately change as you adjust the sliders. You can always click 
the button, circled below, to “Reset All” and restore the image to the way 
it looked in the fi rst place. 

 4 If you like the changes at any point, press Command S to save. Th en you 
can carry on with more changes that you can choose to save or not. 
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Fill in PDF Forms
If you download    forms from the web, you can actually fi ll them in by typing. Th en 
you can print the fully completed forms, instead of printing them fi rst and fi lling 
them in by hand. Th e pdf must have been created and saved in such a way that it 
has fi elds ready for you to enter data. Th at is, you just can’t start entering data into 
any old pdf—it must be an actual form format. 

After you save a form that you have fi lled in, you cannot edit any of the information 
you entered! You might want to save a clean copy of the fi le before you fi ll in the form. 

To fill in a PDF form:

 1 Open an appropriate pdf form in Preview. Th e example below is a tax form 
downloaded from the irs site. 

 2 Click on the Text tool, as shown circled below.

 3 Click in the area where you are supposed to enter data. An insertion point 
appears and the fi eld displays a border, as shown below.

 4 Type! Be sure to save regularly (or don’t save in case you want to edit later).
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Make Screenshots using Preview
A screenshot is a picture of what your screen looks like at that moment. It’s useful to 
send to someone who’s trying to help you or to show someone something cool that’s 
only on your Mac. Preview uses the Grab utility to take pictures of items on your screen. 

To make a  screenshot:

 1 Open Preview. You don’t have to have any window open. 

 2 Go to the File menu, slide down to “Grab,” then choose either:
  Selection: A crosshair icon appears. Press-and-drag around an area to 

take a screenshot of just that area. When you let go, it makes the shot.
  Window: A camera icon appears, shown below. As you move the camera 

icon on top of diff erent windows on your screen, it highlights each one. 
When the window you want is highlighted, single-click. It takes a picture 
of the entire window, whether or not you can see the whole thing.

  Timed Screen: Preview gives you ten seconds to get your screen set up the 
way you want it for a screenshot. For instance, you might want a picture 
of a particular menu and submenu. After ten seconds, Preview snaps a 
screenshot of the entire screen. 

A fi le icon whose name begins with “Snapshot” appears on your Desktop, and it 
immediately and automatically opens in Preview.

Also see page 431 
to learn how to 
take screenshots 
with keyboard 
shortcuts.
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Print or Fax from Preview
     You can print any image or document from Preview, of course. But you can also 
print groups of photos or entire folders of images. 

If you have multiple images open in Preview, select the ones you want to print: 
choose them from the sidebar. Th en press Command P to print. You’ll get the dialog 
box shown below. Be sure to spend a few minutes looking through all the options.

Above you see a preview of what the page will 
look like when printed with the specifications 
chosen in the dialog box. 

To the left, you see a preview of what the 
printed page will look like with the option 
of “Fill Entire Paper” selected.



Lesson 11 Preview for Viewing Images and PDFs

209

To fax an image or selected images:

Not all computers today have an internal modem installed, and you can’t fax 
without one. You must have a phone cable connected to a telephone outlet—
you can’t fax from your Mac over the Internet or through your broadband 
connection. 

If your Mac has a modem that is connected to a phone line, it is automatically 
confi gured to send faxes. If you use your dial-up modem to connect to the Internet, 
your Mac will wait until you log off , then send the fax. 

 1 From the File menu, choose “Print….”

 2 Click the button in the bottom-left corner named “PDF.”

 3 Choose “Fax PDF….”

 4 Enter the fax number you want to send this to. Make your choices in this 
dialog box, similar to your choices when printing (as explained above).

 5 Click the “Fax” button. 

Also see Lesson 17 on printing and faxing.

Save as Another  Format
If you know you need a particular image in another file type, go to the File menu 
and choose “Save As….” Click the “Format” menu, as shown below, and make a choice. 
Each choice will give you diff erent specifi cations for that particular fi le format.
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Use the Burn Folder to 
collect files for burning to 

CD or DVD

Create clips and bookmarks 
in DVDs

Create a PDF from any file

Use Font Book to install 
and preview fonts

Keep track of your life 
with Stickies

Learn to use PhotoBooth 
to take still shots and 

movies of yourself



211

LESSON  12

Miscellaneous 
Tools on your Mac

Your Mac has a number of great tools in the form of small 

applications, some of which get overlooked. Th is lesson 

introduces you to some features and possibilities that you 

might not be taking advantage of yet.
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Burn a CD or DVD with a Burn Folder
You’ll want to burn backups of your important work. Be sure to burn backups of any 
applications or fonts or other files that you download straight from the Internet. 

Th e steps below describe how to burn data files (as opposed to music or movies) 
onto a disc. A cd holds about 650 megabytes; a dvd holds about 4.3 gigabytes, even 
though the package might tell you it holds 4.7. (To burn a music cd, see page 186.)

Th e   Burn Folder is the easiest way to burn a cd or dvd. Drag items into this special 
folder, and when you’re ready, burn the contents to a disc. Your Mac automati-
cally creates  aliases of those fi les (see page 430 for details on aliases). Th is means 
that after you burn the disc, you can throw away the entire Burn Folder without 
destroying any original fi les. 

Th e wonderful thing is that you can collect items you want to burn without having 
to actually burn the disc at that moment—you can collect fi les over the period of a 
project and when fi nished, you have a folder ready to back up onto a disc. 

To create a Burn Folder, put files inside, and burn it:

 1 Open a Finder window and select the window in which you want the Burn 
Folder to appear. For instance, single-click on your Home icon in the Sidebar, 
or single-click the Documents folder icon. Or click on the Desktop, if you want 
the folder to appear there. (You can always move the Burn Folder to wherever 
you like, of course.)

 2 From the File menu, choose “New Burn Folder.” 

 3 A folder with the “Burn” icon on it appears in the selected window.

I put this Burn 
Folder in my 

Home folder. 
Then I dragged it 

into my Sidebar 
so it’s always 

available to me. 
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It says there is no device 
available, even if there is 

one ready to burn.

 4 To put a fi le in the folder so you can burn it later, just drag the original fi le 
and drop it into the Burn Folder. Your Mac will put an alias of the fi le into the 
Burn Folder and the original will stay right where it was, safe and sound.

 5 To burn the folder onto a CD, fi rst insert a blank cd-r or dvd. 

 6 Then single-click the Burn Folder; a bar across the top of the window appears 
with a “Burn” button, as shown on the opposite page. 

  You will be asked to name the disc, which of course you should do.

  Click the “Burn” button in the dialog box. 

 If you drag the Burn Folder into the Sidebar, it displays a burn icon next 

to it. You can just single-click that burn icon to start the process.

 You can make as many Burn Folders as you want. Rename them as you 

do any other folder. This makes it easy to have a separate Burn Folder for each project.

To check the amount of storage space used in the folder:

 1 Single-click the Burn Folder icon.

 2 Press Command I to display the Info window.

 3 Click the disclosure triangle next to “Burning.”

 4 Click the “Calculate” button to see how much 
you have collected in the folder.

  If you change your mind and want to take an  unburned disc out of the 

Mac,     Control-click (or right-click) on the disc icon and choose “Eject ‘_____ CD.’”
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  DVD Player
Besides playing your dvds and allowing you to control things as you do on your 
television, the DVD Player has several special tricks.

Display the thumbnail bar and controls
A video starts playing automatically in full screen. 

To see the controls, push your mouse down to the bottom of the screen 
and they appear. 
To see the thumbnail bar that displays chapter markers, bookmarks, 
and video clips, push your mouse toward the top of the screen. 
To show the DVD application menu bar, push your mouse all the way 
to the top of the screen.

Create  bookmarks to find specific points in the video
A bookmark lets you skip immediately to certain points in the video that you choose. 
Th at is, you are not limited to the chapter markers that were created when the dvd 
was made. 

To create a bookmark:

 1 Play a dvd. Th en . . . 

 2 Go to the Window menu and choose “Bookmarks.” A palette appears. When 
you get to the point in the dvd where you want to insert 
a bookmark, click the + sign at the bottom of the Bookmarks palette.  

  Or when you get to the point in the dvd where you want to insert a 
bookmark, press Command = (or go to the Controls menu and choose 

“New Bookmark…”).

 3 A sheet drops down where you can either leave the time code as shown, 
or you can rename the bookmark so you know exactly which one this is.

Once you have created bookmarks, you can go to the Go menu and choose 
to skip straight to any bookmark you made. If you make more than one bookmark, 
use the Bookmarks palette to choose one of them to be the “default” bookmark. 
Th ese bookmarks are not stored with the dvd; that is, if you loan the dvd to anyone, 
it will not include your bookmarks. Th ey are stored only on your Mac. 
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Create your own clips with endpoints
Amazing. You can create individual video clips of selected segments of a dvd and 
then choose to play just those clips. Th is feature and the bookmarks feature are 
terrifi c for teachers or trainers who want to separate segments or start a scene in 
a dvd at a particular point. Or maybe there’s a specifi c section of your dance or 
exercise video that you want to view over and over again—this makes it so easy!

To make a video clip:

 1 While viewing the dvd, view until you get to the beginning of the section 
you want to save as a clip. Th en press Command – (hyphen).

 2 A special frame appears. Single-click the upper “Set” button, as circled below.

 3 Click the triangle button (“Play”) under the main picture to continue playing 
the dvd (or hit the  Spacebar to play). When you get to the end of the clip that 
you want to mark, click the lower “Set” button. Click “Save” when you’ve got it.

  Th e movie continues playing from the beginning of the clip and carries right 
on, but your clip has been saved. You can fi nd it in the Video Clips window 
from the Window menu, or from the Go menu, and in the Video Clips pane 
of the thumbnail bar across the top of the screen. 

Make adjustments
To  adjust video color, sound, and zoom controls, go to the Window menu. Choose 
the adjustment you want to make and use the sliders.
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    Create your own personal disc jacket on the screen
Th is is great—you can add your own image to the dvd so whenever you stop the 
dvd, it displays the image of your choice.

To add your own disc image: 

 1 Open a dvd in the DVD Player. 

 2 Go to the File menu and choose “Get Disc Info.” 

 3 Click the “Jacket Picture” icon in the toolbar, shown circled below.

 4 Drag any image from your hard disk and drop it into the well. Click ok. Cool.

Remember, changes like this don’t really apply to the actual dvd—they are stored 
on your Mac. So the disc jacket will only appear if you show this dvd from the 
computer on which you added it. 

Go back to the Finder
Push your mouse to the top of the screen, go to the Go menu, and choose “Switch to 
Finder.” Or press Command Option F.
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 Create  PDF Files
A PDF ( Portable Document Format) is a fi le created in such a way that most people 
can open and read it, no matter what kind of computer they use. Th e graphics, the 
images, the fonts, and all the formatting are held intact in the document. And it’s 
usually compressed into a smaller fi le size (not physical size) so it can travel through 
the Internet quickly. 

To make a PDF in most applications, have the document open in front of you. From 
the File menu, choose “Print…,” then click the “PDF” button. 

—continued

Save as PDF Saves a regular pdf that you can share with others. Th e graphics are 
at full resolution and the fonts are embedded. When you choose to 
save as a PDF, you’ll get a window with a “Security Options” button 
where you can choose to require a password to open, copy, or print.
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   Save as PostScript 

Th is saves the document as a PostScript Level 2 fi le in ascii format, 
meaning if you open it, you’ll see a lot of code. But you can send it 
directly to a Postscript printer or run it through Acrobat Distiller. 
Don’t choose this option unless you know you need it. 

Fax PDF If you have set up your fax specifi cations as explained in Lesson 17, 
then your Mac will make a pdf of the document and open the fax 
dialog box where you can enter the fax number and a message. 
Remember, you must have a phone line connected to the Mac. 

Mail PDF Th is creates a pdf of the fi le, opens Mail, creates a new message, 
and puts this pdf in the message ready to send. Th is is a great 
time-saver, but I’ve noticed that people using aol or pcs often 
can’t read these. 

Save as PDF-X 

Th e pdf-x standard from Adobe is designed for high-end printing. 
I don’t suggest you choose this option unless you know you need 
a pdf-x fi le, and even then it would be best to create it in a high-end 
application.

Save PDF to iPhoto 

Your Mac will turn this document into a pdf, open iPhoto (if you 
have it installed, of course), ask you which album to put it into (or 
ask you to create a new one), and then put the pdf in that album. 

 If you have an  iPhone, this is a great way to get pdfs onto it. You 
might have tried putting a pdf directly into iPhoto and discovered 
that iPhoto won’t accept it, says it’s an unacceptable format. But 
iPhoto will take pdfs through the method described above. Next 
time you sync your iPhone in iTunes, go to the “Photos” tab in the 
sync pane and choose the album in which you’re keeping the pdfs. 
Th ey’re kind of blurry, but if you need the info to take with you, it’s 
an option.
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Save PDF to Web Receipts Folder 

I love this. Have you ever bought something on the web and you 
got that page that says, “Th is is your receipt”? And you know you 
should print it but maybe the printer isn’t turned on at the moment 
or it’s three pages long and you know they’re going to send you 
an email receipt anyway, but what if they don’t send you the email 
receipt and you need this web page receipt? Well, this is a great 
solution: Th e Mac will save this web page as a pdf and it will make 
you a folder in your Documents folder called “Web Receipts” and it 
will store this pdf (and all others you make like it) in that folder. 

 Be careful, though—if you make a web receipt from the same site 
more than once, it will probably write over itself with the same 
name. I wish Apple would give me an option to give the fi le a name 
I’ll remember. 
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     Font Book
Font Book allows you to install new  fonts you acquire, disable fonts in your font 
menus that you never use, and view fonts before you install them.

Preview fonts you haven’t installed
If you acquire new  fonts or if you just have some fonts on a disk and you don’t know 
what they are, simply double-click on the font file. Font Book will open automati-
cally and display the font. If you want to install it, click the “Install Font” button.

Install fonts
You can use the step above to install fonts. You can also: 

 1 Open Font Book (it’s in your Applications folder).

 2 In the Collection pane, single-click on “User” (if you want the fonts  available 
only to you as the user) or “Computer” (if you want the fonts available to every 
user of this particular computer). 

 3 Go to the File menu and choose “Add Fonts….”

 4 Find the font you want to install and double-click it. Font Book moves the 
font from its enclosing folder and puts it in the Library Fonts folder. If the 
fonts don’t appear in your application’s Font menu, you might have to quit 
the application and reboot it so they’ll show up.

  Th e default location for installing fonts is determined in the Font Book 
preferences.
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 Preview fonts you have installed
Single-click on any typeface name in the Font pane of Font Book. A preview appears 
on the right. Use the slider to enlarge or reduce the typeface, or type in a point size.

Go to the Preview menu and choose: 

“Sample” to display the upper and lowercase letters, as well as the numbers.
“Repertoire” to see every glyph (letter, number, punctuation, etc.) in the font.
“Custom,” and then type your own words to see them displayed in this typeface. 
Use the slider bar on the right to enlarge the font.

  
To   disable an individual font, find it in the Font list. Single-click to select it, then 
click the little checkmark button at the bottom of the Font list.

Create your own  Collections
A  Collection is simply an easy way to look at fonts you like instead of having 
to grope through a lengthy font list of typefaces you don’t know or want. 

To make a new Collection, single-click the + sign at the bottom of the Collection 
pane, then name it. Click the “All Fonts” collection, then drag font names from the 
Font pane to the new Collection name.

To disable (turn off) an entire Collection, select it in the Collection pane. 
Th en go to the Edit menu and choose, “Disable ‘CollectionName.’” 
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Stickies
Th e Stickies application lets you put little Stickie notes all over your screen, just 
like you’d stick them around the edge of your monitor (my kids tell me my monitor 
looks like a giant   daisy). 

Notice in the examples above you can see these features:

■ Th e grocery note is a bulleted list. To make such a list, Command 
Option–click on the note (or Option-right click) and choose “List…” from the 
contextual menu that appears. You can choose from a variety of bullets and 
numbers, plus you can add a prefi x and suffi  x to the bullet. Th us you could 
create a numbered list that uses  (1) or Act 1: or •A• or any other combi-
nation. Th e list options even include Greek characters and Asian characters.

 To start the list, hit Option-Tab before you type the fi rst item in the list. 
To continue the list, just hit a Return after each item. You can hit Option-
Tab-Tab to indent an extra level.

 To end the list, hit Return twice. 
 You can change the bullet formatting at any time—just use the List options 

from the contextual menu as explained above.

■ You can change fonts, size, color, etc., just as in any other Mac application, 
using the Font dialog box (press Command T). See pages 234–235.
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■ Double-click in the title bar of any Stickie note to “roll it up” so just the title 

bar shows, as you can see on the opposite page. Th e fi rst line of type appears 
in the title bar. Double-click the title bar again to unroll the note.

■ Mouse over any note to display a tool tip that gives you information about 
the note, as shown on the opposite page.

■ Drag a graphic image from anywhere on your Mac and drop it into the 
Stickie note. 

■ A note can hold many pages of text and graphics. You won’t see scroll bars, 
but you can drag the mouse through the text and it will scroll, or use the 
arrow keys or the PageUp or PageDown keys. Resize a Stickie note just as 
you would any other window—drag the bottom-right corner. 

■ Notice the red dots under the name Brianna. Th is is a visual clue that the 
spell checker is on and working. 

■ If you prefer working with a certain font and a certain size and a certain color 
note, you can set a default so all your notes look like that without having to 
select your favorites specifi cations for every note. Just set up one note they 
way you like it, then go to the Note menu and choose “Use as Default.”

■ If you want your Stickie notes to automatically open and appear every time 
you turn on your computer, add Stickies to the Login Items for your user 
(see page 321).

In the File menu there are two print options:

■  “Print Active Note” prints the Stickie that’s in front of all the others. 
Be careful! If a Stickie note is rolled up so only its title bar is visible, it still 
might be the active note. To make sure, click on the note you want to print.

■  “Print All Notes” prints all of your Stickie notes one after another. Each one 
is not on a separate piece of paper—they are all run together.
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Photo Booth
Photo Booth is a convenient and fun way to take snapshots or movies of yourself 
for use as an iChat buddy picture or as your user account picture. You can email the 
photos or movie clips to friends, upload them to web pages, open in Preview to save 
in other formats, or view as a slideshow.

Take a still picture 
 1 Open Photo Booth (it’s in your Applications folder). 

 2 Click the still picture button (the fi rst button in the row of three).

 3 Th en click the red camera button. 

  A red timer replaces the toolbar (right-middle) and starts a countdown, 
including audible beeps. Your screen fl ashes when the picture is taken, and 
a thumbnail version of the picture is placed at the bottom of the window. 
You can take several pictures and they’ll all line up in that thumbnail strip.

 4 Click a thumbnail to display it in the main window. As soon as you do this, 
a new toolbar replaces the fi rst one, as shown below. Click an icon in this 
toolbar to send the photo in an email message, place it in iPhoto, set it as your 
user Account photo, or use it as an iChat buddy picture.

To delete a snapshot, click the 
circled X on a thumbnail. Or 
select a thumbnail, then hit the 
Delete key. 
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Make a movie clip
 1 Click the movie clip button (the fi lm strip icon, shown to the left). 

 2 Th e camera button in the center of the toolbar changes to a red video button 
(left). Click it to begin recording. 

  While recording, the toolbar shows a timer and the red video button changes 
to a Stop Recording button (below). When you stop recording, a video 
thumbnail appears at the bottom of the window. 

 3 When you’ve stopped recording, select the movie clip thumbnail that appears 
in the thumbnail strip, then use the toolbar to choose how to use the movie 
clip. You have the following options:

■ Click “Email” to attach a QuickTime version of the clip to a message in 
Mail. Movie fi les are large, about 1mb per second, so keep your clips short.

■ To save the clip as a QuickTime movie, drag the video thumbnail to your 
Desktop or to any folder on your computer.

■ To use a single frame of the movie clip for your user Account photo or 
Buddy photo, select the movie thumbnail. Next, use the scrubber bar under 
the video (shown below) to select the frame you want, then click “Account 
Picture” or “Buddy Picture” in the toolbar.

This thumbnail strip holds both still 
photos and movie clips. The movie 
clips have a tiny camera icon.

This is the scrubber bar. Drag this 
diamond back and forth to view 
individual frames of your movie.
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Click one of the four gray squares to jump to 
another pane of effects.

Or click the arrows on either side of the Effects 
button to cycle through the panes.

Add effects to snapshots
Photo Booth includes a gallery of special eff ects that you can apply as you take a 
snapshot or record a movie clip. Th at is, you can’t apply these eff ects after you’ve 
taken the photo—you have to choose an eff ect before you snap the photo.

 1 Click the Eff ects button to show a pane of eff ects (below-left). Th e center 
image always shows a Normal preview (no eff ects) that you can select to 
remove all eff ects and return the image to normal. 

 2 Click the arrows on either side of the Eff ects button to see all of the possibilities. 

 3 Click on the eff ect you want. A full-size preview displays in the window 
(below-right).

 4 Click one of the snapshot buttons to choose the type of snapshot you want 
(still picture, 4-up to make an animation, or movie clip), then click the red 
camera button. Th e special eff ect snapshot appears in the row of thumbnails. 

 5 Select the image in the thumbnail strip, then use the tools in the toolbar to 
share it (as explained on the previous pages).
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  To preview all of your snapshots that are lined up in the thumbnail 

strip, go to the View menu and choose “Start Slideshow.” Press the Escape key to exit 

the slideshow.

Create a special effects backdrop
In the gallery of special eff ects (opposite page), the last pane is empty. In the empty 
spaces on that pane, you can add your own photos or movie clips to be used as a 
special eff ects backdrops for other still photos or movie clips.

To take a photo or movie using a special backdrop:

 1 In the toolbar, click the extreme-right gray square to show the pane 
of blank spaces. 

 2 Drag one of your own photos or movies into a blank space.

 3 Select your image to use as a special eff ects backdrop. 

 4 When you take a snapshot, a message fi rst instructs you to move out of the 
view so Photo Booth can patch the special backdrop into the background. 
So move out of the way.

 5 A message appears to tell you the background has been detected and it’s okay 
to move back into the frame. Move back in and click the red camera button to 
take the photo.
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Special characters
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LESSON 13 

Common Tools in 
Mac OS X Applications

Every Apple application that comes on your Mac uses certain 

tools—the spelling and grammar checker, the Colors panel, the 

Fonts panel, the Dictionary, and a few others. Rather than tell you 

how to use each one within a certain application, included here are 

explanations of how to use each tool regardless of which applica-

tion you’re using it in. 

Many applications from other vendors also take advantage of these 

Apple tools, so look for them—they will make your computing life 

easier and more fun.
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 Spell Checker
Options for the     spell checker are found at the bottom of the Edit menu in Apple 
applications. You have several choices, each of which are explained here.

Show Spelling and Grammar 

Th is brings up the dialog box shown below. Th is spell checker runs 
through your entire document and gives you options for each word it 
thinks is misspelled.  

 If you want the spell checker to also alert you to possible grammar 
mistakes, check the box to “Check grammar.”

 To replace a misspelled word with an alternative, fi nd the word 
you think is correct in the lower pane, then double-click on it. Or you 
can type the correct spelling yourself in the top edit box, then click the 

“Change” button.   

You can check spelling 
in a number of different 

languages. Choose a 
different dictionary here.
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 Ignore the spelling temporarily. If the spell checker keeps telling you 
the same word is misspelled, but you like the word spelled the way it 
is, click the “Ignore” button when that word is highlighted by the spell 
checker. Th e spell checker will ignore it for this document, but will 
correct you again in the next document.

 Teach your spell checker new words. Spell checkers typically don’t 
 recognize most people’s names, as shown below, or jargon specifi c to 
diff erent specialities. If you often use a particular word that the spell 
checker thinks is a mistake (because it’s not in the dictionary it’s using), 
click the “Learn” button in the dialog box and the word gets added to 
the current dictionary. It will never bother you again.

 Or if you’re not using the spell checker dialog box at the moment, 
Command-click (or right-click) on a word that the spell checker thinks 
is a mistake (it probably has little red dots under it). In the contextual 
menu that pops up, click the “ Learn Spelling” option while the word is 
selected. Th e spell checker will add that word to its dictionary and not 
whine about it being misspelled again. 

—continued
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Check Document Now 

Use this keyboard shortcut (Command ;) to skim through the spelling 
in your document without opening the dialog box. It will stop at 
each word it thinks is misspelled. Well, the dictionary might think it’s 
misspelled, but it might be your Grandmother’s name that you don’t 
want to change.

Check Spelling While Typing 

Th is marks words that are misspelled as you type them—little      red  dots 
appear beneath words it thinks are misspelled. Any words not in its 
dictionary are considered misspelled, such as many names of people or 
towns and most specialized jargon.

Check Grammar With Spelling 

Choosing this option automatically checks the box in the dialog 
box, “Check grammar.” It does what it says it does—applies standard 
grammatical rules to your text and lets you know if you’re breaking 
any of those rules. 

 Instead of red dots that indicate a misspelled word, the grammar 
checker puts green dots under a word or phrase. Mouse over the word, 
pause to the count of three, and you will see a tool tip appear that tells 
you what the problem is. It’s up to you to fi x it. 
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To change a misspelled word quickly without bringing up a dialog box: 

 1 Control-click (or right-click) on a misspelled word (you don’t need to highlight 
the word first). 

 2 A  contextual menu appears, as shown below. At the top of this menu 
is a short list of alternative spellings for the word you clicked on. 

 3 Just single-click on the correct spelling in the menu—the word is instantly 
corrected and the menu automatically disappears. 

  If the correct word is not off ered, you can either type the correction yourself, 
or slide down to “Spelling and Grammar” in this menu and then choose 

“Check Document Now” from the sub-menu to run a spell check.
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  Fonts Panel
Press Command T in any Mac OS X  application and the        Fonts panel appears, as 
shown below. If yours doesn’t look like the one below, it might be because the 
Preview or the Eff ects are not showing.

Preview
■ To display the Preview and/or the Effects if they’re not already visible, 

single-click on the  Action  button (circled, below). Choose “Show Preview.” 
Click again on the menu and choose “Show Eff ects.”

Drag this dot 
down or up 
to show or 
hide the Preview. 

If the window is too narrow, 
the effects toolbar disappears.

Action menu.

In any Apple application, open this Fonts panel to choose the typeface family, the 
particular style (called “Typeface,” above, hidden beneath the tool tip), and the 
size of type. Whatever you choose here will change the selected characters in your 
document. Note that you must first select the text you want to change, then 
choose the font and size. Or position the insertion point (the fl ashing bar in the 
text) where you want to start typing, then select the font and size right before you 
start typing.

 Preview your own words 

Well, for years you have been able to double-click the preview word 
shown at the top, then type your own words. You could choose a 
diff erent family, typeface, and size to see how your text looks in a 
diff erent font. In my version of Leopard, it doesn’t work anymore. 
But try it and see if it got fi xed. I hope it did.

Don’t forget 
about the tool tips.

Preview.

Effects.
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Effects
You can apply     shadow     effects to selected text with these five controls, as shown 
below. Select text on the page, click the “Text Shadow” button (the button with the 
T), then experiment with the sliders on the other four tools. 

When this button is blue, that’s 
a visual clue that the selected  text 
has a shadow effect applied to it.

Collections
Th e Fonts panel has a number of  collections, which are simply sub-groups of fonts 
from the main list. Making a collection does not disable or enable any fonts, it just 
makes it easier for you to choose a typeface—you don’t have to scroll through a long 
list of fonts you don’t care for. 

To create a Collection, single-click the plus sign at the bottom of the Collections 
pane. Rename the Collection. Drag font families from the “Family” pane into the 
new collection—drop the family name directly on the collection name.

Favorites
If you find you often use a particular family, typeface, point size, and color, turn 
that combination into a Favorite and keep it in the Favorites collection for easy 
access. Just select the text on the page that is formatted as you like it, or choose your 
favorite combination in the Fonts panel. Th en go to the  Action button and choose 

“Add to Favorites.” 

When you want to use that typeface, single-click on the collection called  Favorites 
to display the combination. Select your text, then choose your favorite.

Action button options
Color: See the following page. 
Characters: Th is displays the Character Palette; see pages 236–237.
  Typography: Choose sophisticated options for certain typefaces.
Manage Fonts: Th is opens the Font Book; see pages 220–221.
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   Character Palette
Many fonts have a lot of characters you don’t know about but might like to use if 
you did. And diff erent fonts have diff erent sorts of extra characters. 

For instance, these are the ampersands available in the font Zapfino:

& & & & & & & 
How do you know which characters are available? Use the Characters palette.

At the bottom of most       Edit menus is an option called “Special Characters….” Th is 
displays the Characters palette, as shown on the opposite page. 

Add special characters to your document:

 1 Open TextEdit (it’s in the Applications folder). A new, blank document appears 
on your screen. You’ll see the insertion point flashing—that’s where new 
characters will appear. Type what you need until you get to a point where 
you want to enter a special character.

 2 From the Edit menu, choose “Special Characters….”

 3 From the “View” menu on the palette (circled on the opposite page), 
choose “Glyph.”

 4 Make sure the “Glyph Catalog” tab is selected.

 5 From the two “Font” menus, choose the typeface family and the individual 
style that you want to look at. In the example on the opposite page, you see 
the font “Skia.” (Later, experiment with Zapfino!) 

 6 Scroll through the character pane to find the glyph you want. (“Glyph” refers 
to any individual variation of any character. For instance, above you see seven 
diff erent glyphs for the ampersand character.)

 7 Double-click the glyph you want to see on your page. 

 To reduce the Character Palette to a tiny box that is out of the way, but 

accessible, click its green Zoom button. 
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Hoefler Text Regular Hoefler Text Italic Hoefler Text Ornaments

This box displays 
other glyphs for a 
selected  character, 
if there are any.  

If you don’t see 
this portion 

of the  palette, 
 single-click 

this disclosure 
 triangle.
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 Colors  Panel
When you click on one of the color buttons (as shown directly below) in the Fonts 
panel or the “Colors” icon in a toolbar, you get a deceptively simple     Colors panel. 
Select text in Mail, TextEdit, and other Apple applications, then choose a color.

■ Click one of the icons across the top of the panel to choose a color mode.

■ Click the magnifying glass and your pointer turns into a magnifying glass. 
Drag it around the screen and when you find a color you want to “pick up,” 
click on it and that color is added to the panel.

■ In the “Color Wheel” mode, drag the dot around the circle to choose 
a color, and drag the slider up and down to change the tone. 

■ In the “Image Palettes” mode, shown below-right, click the “Palette” menu, 
choose “New from File…,” then choose a graphic or photo. You can also drag 
any image from the Finder and drop  it on this palette. Move the cursor around 
the photo to pick up colors you need.  

Text color Paper color behind the text

To save a 
color, drag it 

from here and 
drop it in one of 

the squares at 
the bottom.

Experiment 
with the 
different ways 
you can select 
colors. 
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 Speech
In applications where there is typically a lot of text, your Mac can  read selected 

text to you. You’ll find a command for “Speech…” towards the bottom of the 
Edit menu in applications such as Mail and  TextEdit, and you can use the Services 
menu option for “Speech” in iChat and Safari. (Th e Services options are in the 
application’s menu.) Also, you can Control-click (or right-click) on text, and in the 
contextual menu that appears there is often a command under the “Speech” option 
to “Start Speaking.”

Have your email read out loud
 1 Open an email message in Mail.

 2 Click in the main body of text.

 3 Go to the  Edit menu, slide down to “Speech…,” and choose 
“Start Speaking.”

 4 Th e entire text message will be read aloud to you. 
  If you want just a portion read out loud, select that portion before 

you go to the Edit menu.

 5 Th e voice that’s used is the one selected in the  “ Speech” preferences. 

To use the  Services menu, first select the text in iChat or on a web page in Safari, 
then go to the application menu and choose the Speech option.
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Preview your Page before Printing
You can preview any page that you create or plan to print. Just open the document 
and choose to print (Command P, or choose “Print” from the File menu). 

If the small dialog box appears, as shown below, click the “Preview” button. Your 
Mac will create a preview of the document, open the application called Preview (see 
Lesson 11), and display the document. You can then print directly from the Preview 
application.

If you see the big dialog box (click the disclosure triangle circled below to show it), 
the Preview button is missing because the expanded dialog box displays the preview 
right there. 

Make a PDF of a Page or Document
Notice in the Print dialog box above, there is a button labeled “PDF.” Click that 
button to see many options for creating a pdf of the open document. For details, 
please see Lesson 12.

Either click the disclosure 
triangle or the Preview 
button to see a preview 
of the document.
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Dictionary Panel
I keep the Dictionary application in my Dock because I use it so often. It’s not only 
a dictionary, but also a thesaurus, an Apple resource, and it links directly to 
Wikipedia (if you’re connected to the Internet). Th e Dictionary is in your Applica-
tions folder, and if you want it in your Dock so it’s always accessible with the click of 
a button, just drag its icon from the Applications folder and drop it in the Dock.

But this Dictionary has a special little feature that extends its use out to all other 
Apple applications. Go to its Preferences (from the Dictionary menu when it’s open) 
and check the button to “Open Dictionary panel” (circled, below-left)

Now in every other Apple application (and those that follow Apple standards), 
Control-click (or right-click) on a word you want to look up in the Dictionary. 

When you Control-
click on a word, 
you’ll see this menu.

The Dictionary 
panel appears right 
on the document 
page. You can use 
the tiny menu 
(circled, left) to 
switch to the 
Thesaurus.

Click “More…” to 
open the Dictionary.



 

14
GOALS

Switch between open 
applications with a 
keyboard shortcut

Quit or hide applications 
with keyboard shortcuts

Discover Spaces to 
organize lots of open 

windows

Drag-and-drop text or files 
between applications

Take advantage 
of the page proxy

Don’t forget about 
the Services 
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LESSON 14

Working between 
Mac OS XOS X Applications

Now that you’ve had an overview of the main applications that 

come with Mac OS X and how they are all integrated, let’s carry 

it one step further and work between all the applications—pop 

between windows, drag-and-drop content and fi les, take 

advantage of the Spaces feature, use the Services, and more. 

Once you realize how easy it is to move data between applications 

and windows, you’ll fi nd more and more uses for it. Plus you’ll feel 

like a Power User. 
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Work with Multiple Applications at Once
In Mac OS X, you can keep lots of applications and windows open at once so they’re 
always accessible. You can just single-click an application icon in the   Dock to switch 
to it, but there are also a couple of great shortcuts to switch between multiple 
 applications quickly and easily.

Switch between all applications
No matter which application you are currently using, you can bring up a fl oating 
palette like the one shown below, then select the application you want to switch 
to—without ever having to reach for the mouse. 

To get the Application Switcher that displays icons for all the open applications, 
press and hold down the Command key, then hit the Tab key once. Keep the 
Command key down. You’ll see something like this:

To cycle through the icons from left to right, tap the Tab key (keep the 
Command key down).
To cycle through the icons in the other direction, right to left, keep 
the Command key down, but also hold down the Shift key while you 
tap the Tab key.
Or press Command Tab to display the Application Switcher, then use the 
mouse to select an icon (you don’t have to actually click on the icon—just 
hover over it to highlight it).

However you choose to select an icon, when the application icon you want is high-
lighted in the palette, let go of the keys and that application will come forward as 
the active program. 

If there is no window open in that particular application, it might look like nothing 
happened—always check the application menu (explained on pages 4–5) to see 
which one is currently active! You might need to hit Command N to open a window 
in that application once it’s active. 
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Switch back and forth between two applications
Most of us probably spend the greater part of our time between our two favorite 
applications. Th ere’s a shortcut that will switch you back and forth between just 
those two, instead of having to bring up the Application Switcher. 

While in one of your favorite applications, switch to another one using the method 
on the previous page, or just click on its icon in the Dock. Now press Command Tab 
to switch between those two applications. I know it sounds too similar to the 
shortcut for switching between all applications, but the trick is to hold down the 
Command key, hit the Tab key just once, then let go of both keys right away. 

Quit or hide  applications
Don’t forget that Command H will   hide all of the windows of the active application, 
and Command Q will quit the active application. Use these shortcuts in combi-
nation with the switching shortcuts to quit or hide selected applications. 

To hide all other applications except the one you’re currently using, press 
Command Option H.

To switch to another application and hide the windows of the current one, 

hold down the Option key when you click on the other application icon in the Dock.

Keyboard Shortcuts

Command Tab Tab Tab . . . Select the open applications

Command Tab Switch between two open applications

Command H Hide the currently active application

Command Option H Hide all the other applications except the active one

Command Q Quit the active application
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Spaces
And here’s yet another way to hide and show diff erent applications if the Command 
Tab shortcut and Exposé (explained on pages 40–41) aren’t enough! Spaces gives 
you up to sixteen separate Desktops. You can keep all the windows for one project 
open in one Space, perhaps your Mail application open in another, and iChat and 
Safari windows in another. Th is allows you, for instance, to work on a particular 
project without having to constantly move browser windows and email out of the 
way—just switch to your project space and everything else disappears. Yet every-
thing is still accessible—you will know if an iChat message comes in even if you’re 
not in the iChat Space at the moment. 

You must fi rst enable Spaces. Th e fi rst time you click the Spaces icon in the Dock it 
will ask if you want to enable it and will open the “Exposé & Spaces” system prefer-
ences, as shown below.

Put a check in “Enable Spaces,” and put a check in “Show Spaces in menu bar” so 
you can keep track of which space you’re in at the moment.

Choose a numbered 
space for each 
application.
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To create or delete spaces, just click the + or – buttons for “Rows” or “Columns.” 
Even though you can have up to sixteen spaces, you might want to start with just 
four or six until you get used to working this way. 

To assign applications to specifi c spaces, click the + button under the “Appli-
cation Assignments” pane. Th is opens your Applications folder. To select more 

than one application, hold down the Command key and click on the ones you 
want to assign.

To choose the specifi c space in which you want an application to appear, use the 
menus on the right side of that pane, as shown on the previous page. 

Once you have Spaces set up, it might be a little confusing at fi rst, but you’ll fi nd that 
you get used to it and wonder how you did without it. Th ere are several shortcuts 
for getting back and forth between spaces:

■ To display all your spaces, as shown above, press F. (On a laptop, you might 
need to press fn F8.) Single-click on the space you want to bring forward. 

■ To cycle through the actual spaces (instead of a picture of them all, as 
above), hold down the Control key and hit the left and right arrow keys. 

■ To go directly to a specifi c space, press Control Number, where “Number”
 is the number of the space you want to go to, such as Control 2.

■ If you checked the box to “Show Spaces in menu bar,” you’ll see a number in 
the right-hand side of the menu bar. Click on this number and you’ll get a 
menu of all the spaces you have set up. Select the one you want.

—continued
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You can drag and drop items from one space to another. Even if you can’t see the 
application to which you want to drag something, drag it to the Dock and drop it on 
that application’s icon. Th at space will appear.

Here I selected the Sticky note text and am dropping it on the Mail icon in the 
Dock. It will immediately switch to that space, created a new email message, 
and put that text in the message. 

You can drag items from one space to another while viewing all the spaces at once, 
as shown on the previous page. 

And take advantage of the Services options in every application menu to move items 
from one application to another while they’re in diff erent spaces. See page 256 for 
information about Services.
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Simplify your Work with Drag-and-Drop
You probably have lots of applications open on your Mac. Often you’ll need to move 
data from one open application to another. Your Mac makes this so easy with   drag-

and-drop: drag the information you want from one application and drop it into the 
other application. Below are some examples. Experiment with these, and then try 
dragging and dropping in all sorts of other ways! If it doesn’t work, nothing bad will 
happen—it just won’t work.

Move     text around in a document window
In TextEdit or Mail messages, you don’t have to cut-and-paste to move text, you can 
simply drag-and-drop it. 

 1 First select the text you want to move: with your mouse, press-and-drag over 
the text so it is highlighted. Let go of the mouse button.

 2 Once the text is highlighted, press anywhere in the text and hold it for a 
second or two, then drag. 

 3 Watch for the insertion point! It’s that thin, fl ashing, vertical bar. As you move 
the mouse and pointer, the insertion point moves too. When the insertion 
point is positioned where you want the new text to appear, let go of the mouse 
button. Text will aways drop in or paste in at the  fl ashing insertion point! 

  Don’t forget to use that great option in the  Edit menu to “Paste and Match 
Style,” as explained on page 61.

To move a copy of the selected text to somewhere else in the same document, 
press the  Option key and hold it down while you drag the text. 

If you drag text from one document window to another, you don’t need to hold 
down the Option key because it will automatically make a copy.

 Often you’ll find it works best to select the text or items, then press and 

hold and count to three before you drag. 
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Move text from one  application to another
Not only can you drag-and-drop within one application, you can drag text from 
one application window and drop it in another. Let’s say you wrote a nice essay in 
TextEdit—select it and drag it into an email message in Mail. 

Th is automatically makes a copy of the text (instead of deleting it from the first 
application), so you don’t need to hold down the Option key.   

Make a   text clipping on the Desktop
Have you ever wanted to save a quote from a    web page or a statement from an email 
message? Just select the text, then drag-and-drop it onto the Desktop or into any 
folder or window. Th is makes a small file on your Desktop with an extension called 

“.textClipping” (if your extensions are visible; see pages 44 and 430–431). 

Anytime you want to see what the text clipping says, just double-click on it. And you 
can drag-and-drop that clipping file into most text windows, such as TextEdit or a 
Mail message, and the actual text will drop onto the page.

Add email addresses to Mail message
Drag a person’s name from the  Address Book or the  Address Panel and drop it into 
any of the “To” fields in an email message to automatically address a message. You 
can drag addresses from one field to another. 

To add more than one name at a time, select more than one name in the  Address 
Book or Panel: Hold down the Command key and click on the names you want to 
add. Th en let go of the Command key and drag one of the names to the email “To” 
field—all of the selected names will come along. 

To add a Group name, drag the Group name and drop it into one of the “To” fi elds.

The clipping names itself with 
the first few words of the text.
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Send contact information through email
You can send a person’s Address Book data (his card information) to anyone who 
uses Mac OS X. Drag a person’s name from the    Address Book or Address Panel and 
drop it into the body of a Mail message. You’ll see a “vCard” icon, as shown below.

Th e  recipient can then drag the vCard to her Address Book where it will be added 
automatically. Or she can double-click the icon in the email message and all of the 
Address Book data will be added to her Address Book. 

Make a   web location file
In Safari, you can make a   web location file that will take you to a specific web page. 
Th ere is a tiny icon that   appears in the location field, directly to the left of the web 
address, shown circled, below. Drag that tiny icon and drop it in the    Dock (on the 
right side of the dividing bar), onto the Desktop, or into any folder. Th is creates 
a web location file, shown below. It has two diff erent appearances, depending on 
where you drop it.

If you drop the icon in the Dock (shown below), it looks like a spring. You can 
single-click it to open Safari and that web page. 

If you drop the icon in the Finder, it looks like a document fi le. Double-click the 
icon, or drag-and-drop it into the middle of any open web page (don’t drop it in 
the location fi eld—drop it in the middle of the open page).
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Send a file to a Buddy
Drag a   document to a Buddy name in the Buddy List of  iChat and drop it. Hit 
Return or Enter and the file will go straight to that person. Th is is a great way to 
quickly send a  photo or a document. 

You can also use your iChat instant message window—just drag the file into the field 
where you type your message. Hit Return and both your text message and the file 
will go to your Buddy. All he needs to do is click the link in the iChat window and 
the file downloads to his Desktop.   

Also send   Address Book data this way—to send the information from a person’s 
card, drag his name from your Address Book and drop it on the Buddy List name or 
in the message field (see the previous page for more Address Book information).

Invite people to an   iCal event
 Drag a person’s name from the Address panel or   Address Book (from the Window 
menu) to an iCal event to automatically add that person as an “attendee.” Be sure to 
drop it in the “attendees” fi eld in the Info pane. You can drag a Group name as well. 
Once you have the names in here, you can click the “Send” button at the bottom of 
the Info drawer to send everyone on the list an email update of the event.

Drag addresses or files and drop 
them into these iCal fields.
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Save into a particular folder
When you are saving a file, drag a  folder from the Finder and drop it in the window of 
the  Save As dialog box. Your Mac will save the document into that particular folder. 

Take advantage of the     page proxy 
You may not have noticed the tiny page icon that is in the   title bar of every 
document you create (it appears after you save the document). It’s called the 

“page proxy.” You can do a lot with this tiny icon.

Make sure the document has been saved recently before you experiment with any of 
the following techniques. If there is a   dark  dot in the  red button or if the page proxy 
is gray, that means you need to save the document first. 

To create an alias of the document on the Desktop or in any folder or window, 
drag the page proxy and drop it on the Desktop, on top of any folder icon, or 
directly into any window. You’ll see the telltale sign of an alias’s tiny curved arrow as 
you drag the page proxy. (See page 430 about aliases.)

  

To create a copy of the document, hold down the  Option key and drag the proxy. 
Drop it on the Desktop, on top of any folder icon, or directly into any window. You’ll 
see a plus sign as you drag, indicating your Mac is making a copy of the document.

To send the      document through    iChat or Bonjour, drag the page proxy and drop it 
on a Buddy name in your iChat  Buddy List or on any name in your Bonjour list. 

Or drag the page proxy into the text field of an iChat instant message. Th e recipient 
will get a message with a button to “Save File.”

This tiny arrow indicates 
this icon is an alias. When 
you double-click it, it will 

go open the real file.
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To email the    document, drag the page proxy to an email message and drop it 
anywhere in the body of the message. 

To drop the entire document into another application, drag the page proxy and 
drop it into the window of the other app. For instance, you can drag a   Microsoft 
Word page proxy into a TextEdit page or onto a web page. Remember to watch for 
the insertion point (well, not on a web page)—that’s where the new text will drop in.

Open documents in other applications
Drag documents (or page proxies, as explained above) onto application icons in the 
Finder or Dock to open those documents in the targeted applications; if an appli-
cation is capable of opening the document, the application icon will highlight. Th is 
is great for when you want to open a document in something that isn’t the default.

For instance, open Microsoft Word files in  TextEdit—just drag and drop the file 
onto the TextEdit icon, either in the Dock or in the Applications folder. 

Or drag a  PDF and drop it in the middle of a Safari window or directly on the Safari 
icon and Safari will open and display the pdf. 

Take advantage of    spring-loaded folders
Combine drag-and-drop with  spring-loaded folders to organize the Finder. A 
spring-loaded folder opens as you hover your mouse over it. You can use this 
technique to dig down into folders with a file you are dragging: Hover over a folder, 
its window pops open, hover over the next folder, its window pops open, etc. As 
soon as you drop the file, all of the previous folder windows close. 

You can set the parameters for how long you have to hover the mouse to open a 
 spring-loaded folder—use the Finder preferences (in the Finder menu). Or you 
can always use the  Spacebar instead, even if the option for spring-loaded folders is 
unchecked: Whenever you want a folder to open instantly, hover over the folder and 
hit the Spacebar.
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Drag content, images, or files between applications
Try dragging anything and everything! 

Drag an image from the         web onto a TextEdit page or an email message.

Drag a graphic file from the Desktop or a folder and drop it into the text area of your 
application. Th is works in lots of other applications, not just the ones from Apple. 
For instance, I’m using Adobe InDesign to create this book—I dragged the image 
you see below from the Finder and dropped it on this page (and it’s linked):

Drag text content and/or images from any application and drop them into other 
applications. Not everything will work, or it might work but not quite as you expect, 
but you will discover some wonderfully useful ways for working in your favorite 
applications. 

You don’t even have to open the other application fi rst if you want to drag text from 
one place into a new fi le in another application. For instance, you can select and 
drag text from a web page and drop it on the Mail icon in the Dock—Mail will open 
a new message window with that text pasted in the message area. Or drag text and 
drop it on the TextEdit icon (which I keep in the Dock)—TextEdit will open a new 
window with that text in it. Or drag text from Mail and drop it on the Safari icon— 
Google will immediately do a search on the text and display the results. Amazing.

Mac
Booda
Dakota
Jane
Reilly
Maximus
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Take Advantage of System Services
Every application in its application menu has an item called “Services.” Exactly 
which services are available at any moment depend on which application you have 
open and what you have selected within that application, if anything. 

You might fi nd some text in a fi le that you want to keep in your Sticky Note 
collection—select the text (and a graphic, if you like) and choose “Make New 
Sticky Note” from the Services options. 

Or you might be viewing a photograph in Preview and decide you want to email it 
to someone—go to Services, choose “Mail,” and then choose “Send To.” 

Perhaps you are reading the synopsis of a Shakespeare play online and you want to 
have the synopsis in TextEdit—select the text, go to Services, choose “TextEdit,” and 
then choose “New Window Containing Selection.”

Perhaps the synopsis is lengthier than you care to read at the moment, and you’d 
like to skim it—select the text, go to Services, and choose “Summarize” to open 
a new window where you can view as much or as little of the summary as you 
like. Th en don’t forget about drag-and-drop—drag the selected summary into 
a TextEdit page. 

Keep the Services menu in mind while you work. You’ll be surprised how often 
it comes in handy!



Make it Your Own Mac
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GOALS

Customize your Dock

Set up your Finder 
windows to the way 

you like to work

Use spring-loaded folders 

Color-code your files 
with labels

Customize your 
Sidebar and Desktop

Learn to use the 
System Preferences to 

customize many features 
of your Mac
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LESSON 15

Personalize your Mac 
to Meet your Needs

Now that you’ve learned all the basics of the various applications 

and system settings on your Mac, discover how to customize them 

to suit your particular way of working. Would you prefer to have 

your Dock on the side of the screen instead of at the bottom? Do 

you like a brightly colored Desktop? Do you want to customize the 

insides of certain windows? Color-code your fi les? Make the icons 

and text bigger? It’s all do-able—and more.
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Customize the Dock
When you first turn on your Mac, the    Dock is sitting along the bottom at a certain 
size. But like everything else on the Mac, you can  customize it to suit yourself. 
Would you prefer the Dock along the side of your screen? Would you like it to 
disappear altogether and only appear when you need it? Are the icons too small 
or too big? You can adjust everything. 

Th ere are three ways to customize the Dock: You can use the System Preferences, 
the Dock options in the Apple menu, or the secret pop-up menu in the Dock itself. 

Customize the Dock using the System Preferences
1 Single-click on the System Preferences icon in the Dock, or go to the Apple 

menu and choose “System Preferences….”

 2 Single-click on the Dock icon. You’ll get the Dock preferences.

 3 Here you can resize the Dock, turn “Magnification” on or off  (see the 
next page), adjust the size of the magnification, reposition the screen, 
and other options. 

Magnification 

If you turn on “Magnification,” then the icons in the Dock will 
enlarge as you run your mouse over them, as shown above-right. 
Just how big they enlarge is up to you—move the slider to “Max,” 
then hover your mouse over the Dock (don’t click) and see how big 
the icons get. 
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Minimize using 

Th is option has two choices, Genie Eff ect and Scale Eff ect. All it 
does is change how windows float down into the Dock when you 
click the yellow Minimize button in a window. Choose one of the 
options, then minimize a window to see the diff erence. (Hold the 
Shift key down when you click the yellow button to see the eff ect 
in slow motion.)

 Animate opening applications 

Th is is what makes the icons in the Dock bounce up and down 
when you click to open them. You can turn it off .

Automatically hide and show the Dock 

Click this and the Dock disappears. It reappears whenever you 
move your mouse into that edge where it disappeared. As long as 
your mouse is hovering over the Dock, it stays visible. Move your 
mouse away, and the Dock hides itself again.

Resize the icons and the whole   Dock
■ Press-and-drag on the dividing line. Try it!

Customize the Dock with the Apple menu or Dock menu
■ From the Apple menu, select “Dock,” then choose your options.

■ In the Dock itself, hold down the Control key and single-click on the 
dividing line, as shown below. A menu pops up; make your choice.
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Customize the Finder
Th ere are a number of features you can  customize in the          Finder. You might expect 
to find these in the System Preferences, but because the Finder is actually an appli-
cation (it runs the Desktop), its preferences are in the  Finder application menu.

Customize the General preferences
 1 From the Finder menu, choose “Preferences… .” Click the “ General” icon.

 2 Because your Finder window can display the hard disk icons, removable disc 
icons, and servers in the top portion of the Sidebar, you can choose that these 
items do not also show up on the Desktop. Or if it makes you feel better to 
see the cd icons on the Desktop, you can choose to show only those. Whatever 
makes you happy. 

 3 Every time you open a new     Finder window, it starts over—that is, it doesn’t 
remember the last window you opened. From this menu, choose the  window 
you want to see whenever you click the Finder icon in the Dock or press 
Command N to get a new window. For instance, I want to see my Home 
window every time I open a new Finder window. You might prefer to see your 
Hard Disk, the Documents folder, or perhaps a project folder. 
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 4 If it bothers you to have only one    Finder window open to work in, you 
can choose to have a new window open every time you double-click a 
folder icon. Usually people who are recently converted from Mac OS 9 
like to use this feature for a while, until they get used to working in one 
window.

  Don’t forget that you can always open a separate window for any  individual 
folder: Command–double-click on it. 

 5 If you turn on      spring-loaded folders and windows, then a folder will 
automatically pop its window open as you hover a fi le over that folder. Th at is, 
just hold the fi le on top of the folder but don’t click (“hover”); the folder will 
“spring” open. Th is is great when you are dragging a file somewhere—you don’t 
have to put it down to open the folder. And when you let go of the fi le to put it 
in the window, the Mac immediately takes you back to where you started.

  Th e “Delay” refers to how long your mouse has to hover before the folder 
pops open. If you find  folders popping open when you least expect it, make 
the delay longer.

  Even if you turn off  spring-loaded folders, you can always hit the Spacebar to 
make a folder pop open, as long as your mouse is holding a fi le over that folder. 
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Create       labels for files and folders
Labels are colors that you can apply to any file or folder or application as a tool for 
organizing and searching. 

 1 From the Finder menu, choose “Preferences… .” Click the “Labels” icon.

To add the 
“Label” column 
to your List View 
windows, see 
page 268.

 2 Change the label names for any color label you want. You don’t need to use 
them all. 

 3 To apply the labels, select a file, then go to the File menu and at the very 
bottom choose a “Label” color. As you mouse over the color dot, a tool tip 
appears to tell you the label name. 

  Or Control-click (or right click) on a file of any sort. From the  contextual menu 
that pops up, choose a color label; choose the x to take a label off . 



Lesson 15 Personalize Your Mac to Meet Your Needs 

265

Choose what appears in your Finder window        Sidebar
 1 From the Finder menu, choose “Preferences….” Click the “Sidebar” icon.

 2 Check the items you want to see in the 
Sidebar of your Finder windows, and 
uncheck the items you don’t want to 
see. Coordinate this with the “General” 
Finder preferences shown on page 
262—you don’t want to eliminate the 
hard disk icon, for instance, from both 
the Desktop and the Sidebar!

Choose file extensions and turn off the Trash warning
 1 From the     Finder menu, choose “Preferences….” Click the “Advanced” icon.

 2   File extensions are those three- or four-letter abbreviations at the ends 
of file names; see pages 44 and 430–431. 

 3 If that warning you see whenever you empty the Trash makes you crazy, 
turn it off  here.
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Customize the Inside of   Finder Windows
Are the icons too big? Th e text labels too small? Do you want more columns of 
information available? Fewer columns? In the List View, would you like to rearrange 
the columns? In the Column View, do you want to turn off  the preview column? You 
can do anything you want. 

Customize the    Icon View
 1 Open a Finder window. Click the “Icon View” button, as circled below.

 2 From the View menu, choose “  Show  View Options.”

 3 You can choose for this particular window to always open in icon view.

  Notice the title bar of the preferences pane shows you the name of the 
 currently active window, the one to which these changes will apply.

Choose this and every window in Icon View 
will have these specifications.



Lesson 15 Personalize Your Mac to Meet Your Needs 

267

 4          Experiment with these options.
  Use the sliders to change the size of the          icons and how far apart they 

will be spaced (the grid spacing). 

 If you hold down the Command key as you move an icon in a 

window, it will snap to the nearest spot on this grid. Whenever you go to the 

View menu and choose “Clean up,” the icons get arranged according to this grid.

  Use the Text size menu to change the size of the text that labels each fi le. 
  And use Label position to put the labels (fi le titles) to the right side of the 

icons (they’re generally on the “Bottom”).

 5 Show item info: Th is displays information about some icons. For instance, 
the window will display how many items are in each folder. It will also  display 
the size (in pixels) of      graphic files. 

  Show icon preview: Th is displays tiny versions of the actual images for 
graphic files and photos.

   Arrange by: You can choose two options from this list. To make every icon in 
the window snap into that underlying grid, choose “Snap to Grid.” 
Th en, open this menu again and choose an arrangement for all 
those items. For instance, choose “Name” and any file you drag or 
save into this window will automatically snap to the underlying 
grid and   alphabetize itself. Choose “Kind” and all items will be 
grouped by what kinds of files they are—applications, folders, text 
files, etc. “ Label” is also an option, but in this case it refers to the 

colored labels, as explained on page 264, not the labels (titles) mentioned in Step 4!

 With “Snap to Grid” chosen, you can’t reposition icons——they 

will always jump to the nearest spot in the grid. To override this, hold down the 

Command key as you drag an icon.

 6 Background: Click the “Color” button to make a tiny color box appear; click 
the color box to get the Colors Panel to choose a background color for the 
window, as shown on the opposite page.

  Click the “Picture” button to select a graphic image. 

  Click “White” to remove all color and images from the window background.  
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Customize the List View
 1 Open a Finder window. Click the “List View” button, as circled below.

 2 From the View menu, choose “Show View Options.”

 3 Choose whether you want this particular folder (my Home folder, in the 
example above) to always open in List View. 

 4 Choose the            icon size you want, the text size for the labels, and which columns 
you want visible. Th is is where you can choose to display the “Label” column if 
you like to use labels (see page ).

  See the next page for the option to show “Comments.”

 5 Use relative dates: Under the “Date Modified” and “Date Created” columns, 
you will see “Today” or “Yesterday” instead of the actual date. 

  Calculate all sizes: With no checkmark in this box, the Size column will 
display the file sizes of documents and graphic images, but not folders. 
Displaying the sizes of folders can take an extra minute. 

Choose this and every window in List View 
will have these specifications.
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Add comments and show the Comments column
Th is is a great feature that not many people take advantage of because they don’t 
know it exists. In the List View options, shown on the opposite page, you see that 
you can show the Comments column. But where are those comments?

You can add comments to the Info window of any fi le, as shown below.  You might 
add notes to someone who will be receiving this fi le, or notes to yourself, or details 
about the fi le, or a reminder about what to do with it. Th is is the same fi eld in which 
you can add keywords for Spotlight to fi nd, as mentioned on page 341. 

To open the Info window and add comments, select a fi le and press Command 
I (I for Info). Or Control-click or right-click on a fi le and choose “Get Info” from 
the contextual menu that appears. Add whatever text you want in the “Spotlight 
Comments” fi eld, as shown below.

Once you do that, those Comments will appear in the Comments column in the List 
View, as shown below. 

 If you want to add comments to more than one file, you don’t have to select 

them one at a time to open their individual Info windows. Do this: Select one file, but instead 

of pressing Command I to open the Info window, press Command Option I. This opens 

the “Inspector” window. Now when you click on any other file, that file’s info automatically 

appears in the already-open Info/Inspector window. 

 If you like to use the contextual menus, Control-click on a file, then hold 

down the Option key; you get the option to “Show Inspector.”
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Organize the columns in         List View
 1 To organize the items in your list by any column, just click on a column 

heading to organize everything by that. For instance, if you want all the 
diff erent sorts of files grouped together so you can clearly see which ones are, 
say,  Photoshop files, organize by the “Kind” column.

  Th e column heading under which everything is organized is the blue one. 
For example, in the example below, the items are organized by “Name.”

 2 To alphabetize, or sort, the items in the list backwards or forwards, click the 
heading triangle. Th at is, perhaps you want the items in the “Name” column to 
be listed alphabetically backwards: First click on the “Name” column heading. 
Th en single-click the tiny triangle (the “sort” triangle, or arrow) you see on the 
right side of the column heading. 

  If you would like your items to be sorted by “Size” in ascending or descending 
order, first click on the “Size” column heading. Th en, if necessary, single-click 
the tiny sort arrow to reverse the current order. 

 3 To horizontally rearrange the order of the columns (except the “Name” 
column), press on any column heading (except “Name”) and drag it to the right 
or left. You will see the other columns move over to make room. Drop the 
column (let go of the mouse button) when it’s positioned where you want it. 

 4 To resize the width of the columns, just press on the dividing line 
between any column; the pointer changes to a double-headed arrow. 
Drag the double-headed arrow to the left or right. 
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Customize the Column View
 1 Open a Finder window. Click the “Column View” button, as circled below.

 2 From the View menu, choose “Show View Options.”

 3 Choose the text size of the labels.

  You can choose not to show        icons at all—just a nice, clean list of items. 
Uncheck the box to remove the icons. (But keep in mind that the icon 
can tell you a lot about a file! If you can’t see it, you’ll miss its visual clues. 
Th is might not matter in a folder that contains nothing but photographs or 
nothing but text documents.)

  If you uncheck Show preview column, the last column will not display 
a preview image of the selected file, such as a photograph. 
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Customize the Cover Flow View
 1 Open a Finder window. Click the “Cover Flow View” button, as circled below.

 2 From the View menu, choose “   Show View Options.”

 3 You can’t change the actual view of the covers. But you can choose the 
text size of the labels.

  You can choose not to show the icon preview in the list part of the window. 
You’ll still see icons, but graphic image icons will just display a document icon, 
not a preview of the actual image.

Choose this and every 
window in Cover Flow View 

will have these specifications.
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Customize the   Desktop View
 1 Click on a blank spot on the    Desktop to make sure no Finder window 

(or any other window or icon) is selected.

 2 From the View menu, choose “Show View Options.”

  Th ese are the same options you have for Finder windows in Icon View; please 
see pages 266–267 for details about these options. You can resize the icons or 
the text labels, reposition the labels, show extra file information, display an 
icon preview, snap the icons to a grid, or always keep the icons arranged by 
your chosen criteria, such as alphabetized (“Name”), Kind,  Label, etc. 
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Take Advantage of the       System Preferences
Th e System Preferences control dozens of features on your Mac. Don’t like the 
picture on your Desktop? Do you want your Mac to go to sleep sooner or later or 
never? Do you need to change the time because you moved? Would you like a whiny 
voice to yell at you every time you make a mistake? You can customize these and 
many other things through System Preferences. (Remember, every application has 
its own preferences, as explained on page 53.)

To open System Preferences, click on its icon in the Dock. Or go to the Apple 
menu and choose “System Preferences….”

If you would rather see these preferences in alphabetical order 
(as shown below) instead of grouped in categories, go to the 
View menu and choose “Organize Alphabetically.”

This is the System 
Preferences icon.
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How to use the System Preferences
Once you open the System Preferences pane, single-click an icon to display those 
particular preferences. Most things are self-explanatory—poke around and see what 
your options are. We’ll look at a couple of examples. 

 1 Open System Preferences as described on the previous page. Single-click the 
Keyboard & Mouse icon. If the System Preferences is already open to some 
other preference, click the “Show All” button, and then click the “Keyboard & 
Mouse” icon.

 2 What you see in this preferences pane depends on your computer. For 
instance, a laptop will have a “   Trackpad” pane. A Bluetooth-enabled computer 
will have a “Bluetooth” pane. If a mouse is attached, you’ll have a mouse pane, 
as shown on the next page.

  Single-click any tab to see the preferences for that feature.

Global versus user-specific preferences
If you have set up more than one user, as explained in Lesson 18, individual users 
will discover there are some preferences they can’t change because they will aff ect 
other users; these preferences are “global” and only the master administrator can 
change them. Individual users can change the preferences that are “user-specific” 
because they aff ect only that one user. So if you run across a System Preference that 
you can’t change, it’s probably because you are not the main administrator (please 
see Lesson 18 for details about users and administrators).

 1  

—continued

This is an 
option for a 
  laptop; you 

won’t see it on 
a desktop Mac.

See the following page 
for information about 
these options.
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 3 In the “Keyboard” pane shown on the previous page, you can adjust how fast 
any key    repeats across the page as you press it down. 

  Th e Delay Until Repeat refers to how long your fingers can linger on the keys 
before they start repeating. If you find you type lots of double letters or spaces, 
choose a longer delay here. If your fingers are really heavy on the keys, slide the 
blue slider all the way to “Off ” and the keys will never repeat automatically. 

 4 Click the other tabs to see what preferences you can set for those options.

The “Tracking Speed” 
refers to how far your 
mouse travels as you 
move your hand across 
the screen. The faster the 
tracking speed, the less 
distance you have to move 
the mouse. Try it. 

Check out this pane of 
keyboard shortcuts. 
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Th is is another fun and useful System Preference—use it to change the color or 

image on your       Desktop.

 1 Open System Preferences as described on page 274. Single-click the “Desktop & 
Screen Saver” icon. Or if the preferences are still open, go to the View menu 
and choose “Desktop & Screen Saver.”

 2 Single-click the “Desktop” tab, as circled below.

 3 In the list on the left, single-click each folder to see what’s in it, displayed in 
the pane on the right. 

 4 Single-click any image you see in the pane on the right to immediately view it 
on your Desktop. 

  When you choose your own photo, a little menu pops up, as shown below. Use 
the pop-up menu to adjust the image to your screen. As soon as you choose 
something, it’s displayed on your Desktop.

 5 To use your own photo, first put it in the “Pictures” folder that’s in your Home 
window. Th en you can choose a photo from the “Pictures Folder” option. 

  Or click the + button, then find the folder where your photos are stored and 
add that folder. Th e folder will be placed in the list for easy access. 
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Correct the date and time on your Mac, change it when you go to a diff erent time 
zone, make a regular clock float on your Desktop, and more.

 1 Open System Preferences as described on page 274. Single-click the “Date 
& Time” icon. Or if the preferences are still open, go to the View menu and 
choose “Date & Time.”

 2 Click each of the three tabs in the preference pane and see what your options 
are. You can’t hurt anything, so poke around and experiment.

 1  

2

  Th e option to “Set date & time automatically” is useful if you have a full-time 
broadband connection (don’t bother if your connection to the Internet is a 
dial-up). Th is keeps your Mac in touch with a satellite so your time is always 
correct—it will even switch to daylight savings time for you.
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Find the right   System Preferences for your task
Sometimes you know you need a    System Preference to customize a particular Mac 
feature, but you’re not sure which one has the option you need. Th at’s where the 
Mac’s Spotlight feature can help.

Just type what you’re hoping to find in the System Preferences search field. As you 
type, you’ll see certain System Preference icons highlight, and you’ll see a list of 
possible options. Th e more you type, the more specific the results will be. 

Try the example shown below. I was looking for all the preferences that give me an 
option to speak or use sound. 

Choose an option in the list, and the appropriate System Preference will slowly flash 
twice at you and then open.

And don’t forget about other features on your Mac that let you customize and 
personalize your machine! Check out Exposé & Spaces, plus all the individual 
application preferences. Th is is your Mac!



 

16
GOALS

Learn about the different 
kinds of widgets available

Show and hide 
the widgets

Display the widgets you 
want to have available 

Remove a widget from 
your display or from the 

widgets bar

Flip widgets over and 
customize them

Display more than one of 
any widget

Change the keyboard 
shortcut that displays 

your widgets

Get more widgets
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LESSON 16

Dashboard—Important 
Information at your 
Fingertips

Ever want to know what time it is right now in London? Or what 

the weather is like where you mother lives? Do you need to track 

the plane your daughter is taking to Istanbul—including whether 

it’s going to leave on time and from what terminal—and then 

follow the fl ight path across the world in real time? 

Th ese are just a few of the many things you can do with literally 

the click of one button, using Dashboard. Th e information appears 

to you in the form of widgets. Some widgets are already on your 

Mac, but many others are being created by people and developers. 

Oh, the things we will see!
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Take a Look at Dashboard
     Dashboard provides quick access to information customized just for you, displayed 
in the form of  widgets. Dashboard pops up in a split second, but only when you 
want it. With the click of a button, it goes away just as quickly. Below is an example 
of my Dashboard, with the Widgets Bar showing (the Widgets Bar doesn’t appear 
until you ask for it; see page 284). 

When you activate Dashboard, the widgets instantly appear on top of a greyed-out 
Desktop, on top of any windows or applications you have open. Do what you need, 
then click in any blank area to send them all away. Use the Widgets Bar to add and 
delete items, as explained on page 284. 

Single-click any widget in the  Widget 
Bar to make it appear on your screen. 
You can display more than one of any 
widget, as shown on page 287.

Single-click the tiny arrow on 
either end of the Widget Bar 
to view more widgets that 
are in the bar.

This is the 
Dashboard.

This is the 
Widget Bar.

Each of these items is a widget.
This is a web clip that I made 
myself in Safari; see page 134.

Click this + 
or x to show  

or hide the 
Widget Bar.
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Discover Different Kinds of Widgets
Th ere are three diff erent kinds of widgets, although they are all so interesting and 
easy to work with, you won’t really care which is which!

■ Information    widgets work with data from the Internet. You can check 
external events such as the weather anywhere in the world, the fl ight status 
of any plane, or current prices of your favorite stocks. You must be connected 
to the Internet to get the information for these widgets.

■ Application widgets work with applications on your Mac. Th ey typically 
provide a small and easy way of displaying the critical features of the main 
application. For instance, the iTunes widget is a small controller that gives 
you buttons—start, stop, play songs, and more—to listen to your Playlists or 
Internet radio without having the iTunes interface take up your whole screen. 
If the main application requires the Internet to function, so will its widget.

■ Accessory widgets are self-contained little utilities that provide a variety of 
features. Widgets such as clocks, calculators, notes, or timers are  accessories. 
Some of these do need Internet access, but they are not dependent on any 
application on your Mac. 
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Activate Dashboard and the Widgets
Dashboard is built into your Mac—just single-click the  Dashboard icon in your 
Dock to make it appear, or press the F key. 

 

Add Widgets to Your Dashboard
To add widgets to your onscreen Dashboard, fi rst open Dashboard and bring up the 
Widget Bar: Single-click on the plus sign you see in the bottom-left of your screen. 
(Th e plus sign then turns into an X to close the Widgets Bar; see page 282.)

 To add a        widget, single-click on it. Th e widget appears on your screen.
 To see other  widgets that are already installed, single-click one of the 

tiny arrows that appear at either end of the Widgets Bar.

Organize widgets on the screen in any arrangement you like—simply press 
anywhere in a widget and drag it around. Th ey will stay where you put them, even 
after you put away Dashboard.

Remove Widgets from Your Dashboard
Hold down the Option key and click the X that appears on the upper-left of the widget.

Or  remove widgets from the Dashboard when the Widget Bar is visible. So fi rst 
display the Widget Bar: Single-click the plus sign shown above. Now you see an X 
in the upper-left corner of each widget. To remove a widget, click that X. It stays 
in your Widget Bar until you want it again.

If you’re using a laptop, you might not have an F12 key, 
or it might be used for something else. You can change 
Dashboard’s keyboard shortcut; see page 288. 
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Put Dashboard Away
To put  Dashboard away, single-click outside of any widget, or press your keyboard 
shortcut again (probably F). When you reopen Dashboard, your widgets are right 
where you left them.

Work with Widgets
Diff erent sorts of  widgets have diff erent sorts of features. Experiment with them all! 
For instance, open the Unit Converter and check all the diff erent sorts of conver-
sions you can make. 

Many widgets (not all) have a tiny i in a corner, the   info button. It’s not in the same 
corner for all widgets, and it won’t even appear until your pointer gets close to it. So 
hover over the corners of a widget to see if an i appears, then click on it—the widget 
turns over so you can change preferences.

Single-click the info 
button to flip the widget.

On the back side of many widgets are 
preferences for that particular item. For 
example, this information tells the Phone 
Book widget where to look.

 Enter information into a field, then be sure 
to hit the Enter key to enter that data. 

Click “Done” to flip the widget back over.



Lesson 16 Dashboard—Important Information at Your Fingertips 

286

Experiment with Your Widgets!
Lots of diff erent people create widgets and I can’t explain here all the diff erent 
things they will do. So be sure to pay attention to the sometimes-subtle  visual clues 
that are built into widgets. 

In the  iTunes widget shown below, notice the tiny dot in the outer circle. Th at’s a 
clue! Drag that tiny dot around to change the volume.

Notice the info button that appears (the i )—click on it to fl ip the widget and see 
what options are available on the other side. In this case, you can choose which 
 iTunes Playlist to listen to.

In the  Dictionary widget below, there are several  visual clues, as shown.

The double-arrows are a 
clue that there is a menu 

hidden here. Click on it to 
see the options.

Now “Thesaurus” is the visible 
menu option, indicating you are 
looking at the thesaurus entry.

Back and forward 
arrows indicate you 
can return to panes 

you previously viewed.

This little visual clue indicates you can 
drag this corner to resize the widget.

As in other search fields on your Mac, click 
the X to delete everything in the field.



Lesson 16 Dashboard—Important Information at Your Fingertips 

287

Display More than One of a Widget
You can display multiple copies of any kind of  widget. For instance, you might like 
to know the weather in several diff erent places, view the fl ight paths of a number of 
diff erent fl ights, open several diff erent dictionary widgets to compare words, or view 
a number of diff erent conversions at the same time. 

To display more than one of any kind of widget, open the Widget Bar (when 
Dashboard is showing, click the + sign in the bottom-left corner of your screen). 
Th en just single-click the widget as many times as you want, one for each display on 
your screen. Each new widget shows up in the center of the screen. Just drag it to 
any position and it will stay there. 

Here I can see at a glance what the weather is like (and whether 
it’s day or night) in the different cities where my  kids live.

 To change the picture in the tile puzzle 

widget, do this: When    Dashboard is open, put the tile 

puzzle on your screen. Close Dashboard.

In the Finder, find the picture you want to use in the tile 

puzzle. Start dragging it to nowhere in particular. While 

you are dragging (don’t let go of the mouse), press F12 

(or whatever your shortcut is, if you’ve changed it) to 

open Dashboard. Drop the picture you’re dragging onto 

the tile puzzle.  So now my dog Rosetta is in 
the puzzle.
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Change Dashboard’s Keyboard Shortcut
If you don’t like the default shortcut that opens   Dashboard, you can change it.
 1 At the Finder, when Dashboard is not active, go to the Apple menu and 

choose “System Preferences….”

 2 Single-click “Exposé & Spaces.”

 3 In the preferences pane, as shown below, make sure the “Exposé” tab is 
selected (it will be blue; if not, click on it). 

  Choose an Fkey from the “Hide and show” menu (circled, below) to use as 
your shortcut.

  To add one or more of the modifi er keys to your shortcut, just press 
that key(s) while the menu is open. Th e menu will change to refl ect the key 
combination you are pressing. For instance, you might want to use Control F1 
to activate Dashboard. So hold down the Control key and click the Dashboard 
menu, then choose this option in the menu: ^F1 (^ indicates the Control key).

Options for 
a two-button 
mouse.

 2 

 3

  If you have a two-button mouse attached to your Mac, you will see a second 
column of menus, as shown above, where you can choose to use the middle or 
right mouse button to activate Dashboard. Th is is great for a laptop—I can’t 
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always use a shortcut like F7 without holding down the fn key also. Th is means 
it takes two hands to open Dashboard. But with the middle mouse button 
assigned to Dashboard, I can click the button once and Dashboard instantly 
appears. It’s great. 

Manage your Widgets
If you become a Widget junkie and start collecting lots of them, you’ll want some 
way to get rid of the ones you don’t want anymore, or at least remove them from the 
Widgets Bar. Use the Widget Manager. Open it from the Widgets Bar, as shown 
below, then click on the Widgets you don’t want. Hold down the Shift key to select 
more than one at a time. 

Th e selected widgets will be removed from the Widgets Bar, but they’re still hidden 
away on the Mac somewhere so you can always turn them back on. 

Both the button and the icon 
open the same thing, the 
Widget Manager, shown 
to the right.

Hold down the Shift key to select 
more than one item. Uncheck any 
widget that you want to turn off. 

To get more widgets, click the “More Widgets…” button in the Widget Manager, 
shown above. Th is takes you to the Apple web site where you can download lots of 
free widgets that do cool things. 

To make your own Web Clip widgets from Safari web pages, see page 132.
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LESSON 17

Set Up Printing 
and Faxing

Printing gets easier and more reliable with every new operating 

system. Th e Mac recognizes and automatically sets up more print-

ers, individual applications can apply so many special parameters 

to your print jobs, and sharing one printer with many computers 

gets easier all the time. 
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Set Up your Printers
If you’re already printing to your printer, then skip a couple of pages and go straight 
to the section about accessing special features of your printer, just in case you’re not 
familiar with what it can do.

If your Print dialog box says, “No Printer Selected,” see “Add a printer,” below. 

Be sure to install the software
If you bought a fancy printer of some sort, meaning it cost more than a hundred 
dollars, be sure to install the software that it came with. What you particularly 
need to install is the latest “printer driver.” If you don’t have the software that was 
originally shipped with the printer, or if you need an updated printer driver for 
your older printer, go to the manufacturer’s web site. Th ey always have the drivers 
available to download, free. 

You can often print pages without the latest driver, but the more expensive your 
printer is, the more important it is that you have the proper driver. If not, you will 
lose some of the most valuable features of the machine. If you have an inexpensive 
little printer, the drivers that Apple includes will probably work just fi ne. Try 
printing and see what happens.

Add a printer
Your Mac automatically fi nds printers that are directly connected to the computer 
or that are on your local network. If you’ve installed the software for your expensive 
printer or if you have an inexpensive printer, the process is generally really easy. 

Try to print something for the fi rst time (press Command P or go to the File menu 
and choose “Print”). If you see your printer listed in the menu in the Print dialog 
box, then you’re all set up. 
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Often, however, the fi rst time you try to print, the Print dialog box tells you there is 
“No Printer Selected,” as shown below. Your Mac just needs to be told to go fi nd the 
printer and add it to its list. So:

 1 Make sure the printer is connected to your Mac, that all the cables are secure, 
and that the printer is turned on.

 2 Press on that menu that says “No Printer Selected” and choose “Add Printer….”

 3 Th is brings up a window listing all printers your Mac can fi nd, shown below. 
If everything is connected properly and the printer is on, you should see the 
name of the printer in the pane. Single-click on its name.

 4 When the name of the printer appears in the bottom portion of the pane, all is 
well. Click the “Add” button. Th e Print dialog box, shown above, reappears and 
you can carry on. 
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Use the Print & Fax Preferences
Usually the steps on the previous pages to add a printer work just fi ne. But some-
times you might want to set up printers here in the Print & Fax system preferences 
before you begin or use this to troubleshoot printing problems.

 1 Make sure your printer is turned on and tightly connected to your Mac 
with the proper cables.

 2 Go to the Apple menu and choose “System Preferences….”

 3 Single-click on the “Print & Fax” icon to get the pane shown below.

If you choose the 
name of a specific 
printer here, that 
printer becomes 
the   default.

 3   

 4 If you don’t see the name of your printer in the list on the left, click the + 
button. (Also check again to make sure the cable between the Mac and the 
printer is snug on both ends, and that the printer is turned on.)

  When you click the +, it opens an unnamed window, a printer browser, 
shown on the opposite page, that lists every printer that is turned on 
or that your Mac is aware of. 
If you see your printer listed, single-click its name to select it, then click 
the “Add” button. 

If you don’t see your printer listed, it has most likely lost its connection. 
If you’re sure it’s plugged in properly, then you might want to try a diff erent 
cable—they can go bad all by themselves.
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  Laser printers (as opposed to inkjet printers) usually want AppleTalk turned 
on. If your printer is connected through an Ethernet port (as opposed to the 
usb or FireWire port), it probably wants AppleTalk. If so, the Mac will usually 
turn on AppleTalk for you, with your permission; if it doesn’t, you can do it 
yourself (if you don’t have a real laser printer, skip this!):

  a. Close this window by clicking the red button in the top left.
  b. Click the “Show All” button.
  c. Click the “Network” icon.
  d. Click the “Ethernet” option on the left, then click the “Advanced” button 

on the bottom-right.
  e. Click the “AppleTalk” tab.
  f. Check the box to “Make AppleTalk Active.” Click ok. 
  g. Close the preferences and try printing again.

 5 After you click the “Add” button in Step 4, the “Print & Fax” preferences pane 
reappears. Close it, then try to print. 

If you did not see your printer listed in the “Printer Browser,” maybe you didn’t 
install the printer software that came with the printer. Install it now, then try these 
steps again.
Not all printers must have the software installed. Generally, the more expensive 
the printer, the more likely your Mac needs the software and the more likely it has 
special features that you’ll want to access through its own driver.
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Access the Special Features of your Printer
   If you installed the software that came with your printer, then you probably have 
special features that allow you to choose the correct paper, the quality settings, 
adjust the colors, and more. Th e diff erence in output between a setting for inkjet 
paper as opposed to glossy   photo paper is quite amazing. 

To access the specifi c printer settings: 

 1 Start to print the job (press Command P). 

 2 If you see a small Print dialog box as shown on page 293, click the blue 
disclosure button (see below).

 3 In the expanded Print dialog box, click on the menu circled below. 

  Depending on the printer you have selected, you’ll see such labels as “Print 
Settings” or “Image Quality.” Here you will have lots of options, diff erent 
options for each printer you choose, and for some printers you can select 
specifi c paper/media (of course, you should have that particular paper loaded 
in your printer).

Click this 
disclosure 
triangle 
to see the 
options.

The printer 
selected above 
determines 
what the 
options are for 
that printer. 
Check carefully.
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Buy     ink cartridges for your printer
Apple makes it very easy to buy new ink  cartridges for most printers and to buy 
them from Apple. Just single-click on the “Supplies…” button you see at the bottom 
of the Print dialog box (shown above). Th is takes you to an Apple web site where 
you can buy the cartridges for your specifi c printer. 

You can do the same thing in the “Print & Fax” preferences pane shown on page 
294: Single-click the button called “Options & Supplies….”

Access the Special Features of your Software
Not only does your printer off er special printing features, but most software appli-
cations also have special features. 

In the Print dialog box, be sure to check the menu (circled below and on the 
opposite page) to see if there is an option for the particular software you’re using.

Below you see the print settings for  Keynote, which is software from Apple for 
creating multimedia presentations. 

Applications 
often have 
specialized 
features.
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Having Trouble Printing?
 1 If the printer has been chosen but isn’t responding when you try to print, open 

the “Print & Fax” pane: Go to the Apple menu, choose “System Preferences…,” 
then single-click the “Print & Fax” icon. 

 2 Make sure you choose the correct printer to print to; its name should be 
highlighted on the left.

 3 On the right side of the pane, click the button to “Open   Print Queue….” Th is 
brings up the list of jobs waiting to be printed, as shown below. Th ese are the 
jobs that are lined up to print to that particular printer. 

 1   

2

 4 Check to make sure the jobs are not on hold or paused. Th e buttons should 
look like the ones above: “Hold” should be clear (not gray), “Resume” should 
be gray, and the green button should say “Pause Printer,” not “Resume Printer.” 

  If either of the “resume” buttons are available, that means a job is on hold. 
Select a job in the list and click “Resume” or “Resume Printer” to start the 
printing process. Or select a job and click “Delete” to get rid of it.

 If you send a job to  print and nothing happens, often your initial reaction is 

to send it again. And again. And again. Then when you remember to look at the Print Queue, 

you notice there are a dozen copies of the same job lined up waiting to print because the 

printer’s been on hold. So just remember, if you send a job to print and it doesn’t come 

out, do not send it again! Go to the Print Queue and see what the problem is! If you have a 

dozen of the same jobs lined up to print, select each one and delete it.

You can also get to this 
print queue by clicking 
on the printer’s icon 
that appears in the Dock 
when you print. I like 
to keep that icon in my 
Dock at all times. 
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  Share your Printer with Other Macs
Any printer can be set up to share, meaning any other computer in your offi  ce 
or home network can print to it without having to be directly plugged in to the 
printer. Th is is great because until Mac OS X came along, you had to buy a special 
networkable printer. Now you can have one little, inexpensive color Epson in your 
offi  ce and everyone can print to it. 

If the printer you want to share is plugged directly into the router or switch for your 
network, anyone can print to it no matter which other computers are turned on. 
Typically, that means it’s an Ethernet printer, probably a laser printer. 

If the printer is plugged directly into a particular computer, that computer must be 
turned on for others to print to its connected printer. 

To share a printer:

 1 Turn on the printer that you want to share. Th e computer it’s directly 
connected to must also be on, of course.

 2 On the Mac that is directly connected to the printer, go to the Apple 
menu and choose “System Preferences….”

 3 Click the “Sharing” icon.

 4 In the pane on the left, check the box for “Printer Sharing.” Th en you should 
see the printer that is connected to your computer in the box on the right. 
Make sure there’s a checkmark next to the printer you want to share.

—continued
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 5 At the bottom-right of the Sharing pane, click the button to “Open Print & Fax 
Preferences.” 

 6 In the “Print & Fax” preferences, shown below, select the printer in the pane 
on the left, and then in the pane on the right you should see a checkmark next 
to “Share this printer.” All is well. 

Actually, you could 
skip Steps 3 and 4, 
and just go straight 
to the “Print & 
Fax” preferences 
to turn on Sharing. 
But I think it’s 
important to know 
about the Sharing 
preferences.
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To print to a shared printer:

 1 Th e Mac that is directly connected to the shared printer must be turned on. 
Th at computer must have chosen to share the printer, as explained on the 
previous page. Th e printer must be turned on. 

 2 On your other Mac, open your document. Press Command P to get the Print 
dialog box.

 3 In the “Printer” menu, the shared printer’s name should appear and you can 
print to it. If the printer name is not in the menu list, see below.

  If you don’t see the printer in that list, click the “Add Printer…” option in 
the menu and add the shared printer just as you would add any other printer, 
as explained on pages 292–293. 

  If you don’t have an “Add Printer…” option in the menu, go to the “Print 
& Fax” preferences as explained on the previous pages and add the shared 
printer. You might have to quit the application you’re trying to print from and 
open it again to see the added printer. 

  Once you have added it, that printer will be in your Print dialog box whenever 
that printer and its connected Mac are turned on. 

 4 After you choose the shared printer, click the “Print” button.
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   Fax From and To your Mac
If your Mac has a modem built in or attached to it, you can fax from any application 
and you can receive faxes. But many Macs today do not have modems built in! 

If you use a dial-up modem with a phone cable to connect to the Internet, then 
you are all ready to fax, as explained below. 

But if you have a broadband connection to the Internet, you must fi rst get a 
phone cable (a standard  rj11  phone cable like you use for your telephone). Plug it 
into the phone port on your Mac (if you have one!) and into a phone jack in the 
wall—you cannot fax over a broadband connection.

 Send a fax from your Mac
 1 Make sure you have a telephone cable connecting your Mac to a working 

phone outlet. (Th is assumes you have a modem built in to your Mac.)

 2 Open the document you want to fax.

 3 From the File menu, choose “Print….”

 4 In the standard Apple dialog box, click the “pdf” button in the bottom-left 
corner and choose “Fax pdf… .”

If you’re using an application that has its own print 
dialog box, such as Adobe InDesign, you’ll usually 
find a button at the bottom of the dialog box that 
says something like “Printer….” Click that button, 
and there you should find the “Fax PDF” button.
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 5 A dialog sheet appears (shown below) where you type in the fax number of the 
person you want to send the fax to. 

  If necessary, the “    Dialing Prefi x” is where you enter any number that gets you 
“out” of the offi  ce building. Typically it’s 9. If you need to wait a couple of 
seconds after the 9 before the phone starts dialing, put one or two commas 
after the 9. Each comma makes the Mac wait two seconds.  

 6 If you want a cover page, check the box to “Use Cover Page,” then enter the 
subject and message. Th e preview pane on the left displays what you’re sending.

This button opens 
your Address 
Pane so you can 
automatically enter 
the fax number. See 
the steps on the 
following page.

 7 Click “Fax” and off  goes your page. You’ll see the Fax icon in the Dock.
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Enter fax numbers in your    Address Book
You must enter the fax number into your Address Book properly before the 
Address Pane shown on the previous page can supply it for you. 

To enter a fax number into your Address Book:

 1 Open your Address Book. 

 2 Find the person whose fax number you want to enter.

 3 Single-click the “Edit” button at the bottom of the pane, as shown below.

 4 Th ere are two fi elds at the top of the card, both pre-programmed for phone 
numbers. Th is is where you will enter the fax number. 

 5 Single-click on the tiny double arrows next to the fi eld where you will enter 
(or have already entered) the fax number. 

 6 In the menu that pops up, choose “home fax” or “work fax.”

 7 Click the Edit button again to set your changes. Now when you click 
the little Address Pane icon when faxing, as shown on the previous page, 
this fax number will appear in the pane. 
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 Receive a fax on your Mac
Set up your Mac to receive faxes using the “ Print & Fax” pane in System 
Preferences, as shown below. 

Check the box to “Receive faxes on this computer,” then enter your fax information. 
Choose which actions your Mac should take when you receive a fax.

Remember, if you use a broadband connection to get to the Internet, you’ll need to 
connect a phone line to your Mac (if it has a modem port) before you can send or 
receive a fax.

If you choose 
“Faxes” or “Shared 
Faxes,” your Mac 
instantly makes 
that folder for you 
and puts it in your 
Home folder.
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LESSON 18

Share One Mac 
with Multiple Users

Mac OS X is specifi cally built for what’s called a multiple  user 

environment; that is, Apple expects that more than one person is 

probably using the same computer, whether it’s in a school, offi  ce, 

or home. You can set up another user so no one else can access 

your personal letters, change your sound level, poke around in 

your fi nancial fi les, put up a dorky picture as the Desktop back-

ground, or change any of your settings. 

If you are the only user who ever has or ever will use this Mac, you 

can skip this lesson altogether. But are you really the only user? 

Perhaps your grandkids come over and want to use your computer. 

Or maybe your husband uses your machine from time to time. Or 

sometimes you have relatives staying for a week who just want to 

use your Mac to get their email. Or you’re a teacher who wants 

a place on your computer safe from your students. If so, set up 

another user. 
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Overview of Multiple Users
First, let me explain the concept and advantages of having multiple  users on 
your Mac so you can decide if you need or want to create other users. 

You already have one user, you, which was  automatically  created when you fi rst 
turned on your Mac and went through the setup process. You are the main user 
known as the Administrator. Th e password you set up when you fi rst turned on 
your new Mac or installed Leopard is your Admin     password.

You might not have noticed that you are a “user” because Apple sets a default so 
when you turn on your Mac, you are  automatically “logged in” without having to 
type in a password. Once you have other users set up, you can change this default so 
everyone must log in with a password. If others use your Mac only occasionally, like 
your  grandkids, you can leave it set to  automatically let you in daily; then when the 
kids come over, you go to the  Apple menu and  log out, which means they must then 
 log in  with their own settings and yours will be protected. 

One user, the fi rst one (which was you, if it’s your own Mac), is automatically 
created as the original, main Administrator (Admin) of the computer. If you 
are the only  user, you are still the Administrator. 

Limitations of other users
So you are the  Admin and other people are either    standard users or managed 

users. All other users are limited in certain ways: 

■ Applications can be made available to everyone, or limited to specifi c users. 
Th is means you could install a game in your child’s Home folder and it 
won’t clutter up your own Applications folder. If the game has to change the 
resolution of the monitor and the number of colors and your child cranks the 
volume way up, it won’t aff ect what you see and hear when you log back in. 
You can install your fi nancial program in your own Home folder so others 
cannot use it or access your fi les. 

 You can create managed users for young kids and grandkids, where you can 
customize their Docks so they only have access to their own programs. You can 
seriously limit with whom they chat and email and to which web sites they can go. 

■ Even if an application is available to everyone who uses the machine, 
an individual user can set his own  preferences because the preferences 
are stored in the user’s personal Library folder. 
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■ Every user can customize the  Mail program, and all of a user’s email 
is privately stored in each user’s personal Library folder.  

■ Every user can set up her own screen eff ects. Fonts, window and Desktop 
backgrounds, Sidebar, Dock placement, Spaces, and preferences are individ-
ually customizable. Preferences are also individual for the keyboard, mouse, 
web browser bookmarks, international keyboard settings,  applications that 
start up on login, and QuickTime.

■ Th e features that make the Mac easier to use for people with challenges can 
be customized by each user. Th is includes the Universal Access settings, full 
keyboard access, Speech preferences, VoiceOver (having your Mac talk you 
through doing things), etc. 

■ Users who need international settings for such things as date, time,  numbers, 
or for typing other languages, etc., can customize the Mac without bothering 
other users. If you have a laptop that you travel with, you can set up yourself 
as another user, such as “ Carmen in Paris,” and customize those settings for 
that country without aff ecting all your settings for home. 

■ Standard users cannot change the date or time (except for the menu bar 
 settings), nor can they change the preferences for energy saving, fi le sharing, 
networking, or the startup disk. Th ey cannot add new users nor can they 
change certain parts of the login process. 

■ Managed users have all of the above limitations, plus they have parental 
controls applied. You can severely limit a managed user, as explained on pages 
324–329.

■ Th e Guest account is a special and very temporary account. Everything A 
Guest user does on the Mac while logged in completely disappears as soon as 
he logs out. Th is is great for someone who says, “Can I use your Mac to check 
my web mail?” He can log in as Guest, use Safari to check his mail, and leave 
no trace.

More than one   Admin
As the Administrator, you can assign Admin status to any other user (see 
page 319). When that Admin user logs in, he can make system-wide changes that 
standard users cannot; he can create and delete other users, and do most of the 
things you can do. But your personal Home fi les are still protected from everyone 
else, including other Admins.
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Guest Account Is Already Created
Apple has already created a special Guest account for you. Th is is a very temporary 
account! It’s for those times when someone comes over to your house and wants to 
use your Mac to check their mail or write a quick TextEdit report. As soon as this 
person logs out, everything they did on the computer is completely erased.

Th ere is no password for a Guest user. As soon as you enable login (shown below), 
anyone can log in as Guest, but has no access to any of your fi les. 

To log in as Guest, from the Apple menu, log yourself out. Th e login window that 
appears has a “Guest Account” option. Just click once on it. 

To log out as Guest user, go to the Apple menu and choose “Log Out Guest 
Account.” Th ere will be a warning that all fi les that have been created will be deleted.

G
A
a

1. Click the lock to allow 
you to enable login for the 
Guest Account. If you don’t, 
a Guest can use the network 
to share public files, but 
cannot log in to your Mac.

2. Click the “Guest Account” 
on the left, above, to see this 
pane shown to the right. Put 
a check in “Allow Guests to 
log into this computer.”

3. Click the lock again.
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 Create New Users
If you are the Admin (as explained on pages 308–309), you can create standard or 
managed users (also explained on the previous pages). You’ll create the    user in the 

“Accounts” pane in the System Preferences, plus you’ll assign a password and a login 
picture. In the “Login Options” pane, you can make adjustments to the login window. 

To create a new user:

1 Go to the Apple menu and choose “System Preferences….”

2 In the System Preferences pane, single-click on “Accounts.” You’ll get the dialog 
box shown below, except it probably has only two users listed, you and Guest 
Account. Your user account is also the Admin. 

 3 Click the lock icon in the bottom-left corner. In the dialog box that appears 
after you click the lock, enter the Admin password (the one you chose when 
you set up your Mac), then click ok. Th e lock in the bottom-left corner is now 
open, as shown below.

 4 To add a new user, click the “plus” button. Th is makes a sheet drop down 
(as shown on the following page) where you will add new user information. 

—continued
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  Type the full name (or any descriptive phrase) in the “Name” edit box. 
A      short name is automatically created for you, but you can edit it. You will 
never be able to change the short name after you leave this pane! Th e only way 
to “change” it is to delete the entire user and make a new one.

  Th e short name should be short, you can’t use spaces, and you should avoid 
non-alphabet characters (like * ! ? or /).

  Mac OS X can use either the short name or long name. But the short name is 
sometimes necessary if you use ftp, Telnet, or other applications that let you 
log in to your Mac from some other location.

 5 Enter a     password for the user. Write this down somewhere. As you’ve 
probably seen before, you need to type in the password twice to make sure 
you’ve spelled it right, since you can’t see it. If you like, click on that tiny key 
icon to get some suggestions for passwords that are very secure.

  Passwords are “ case sensitive.” Th at means capital or lowercase  letters change 
the password: “ChoCho” is not the same password as “chocho.” So be darn sure 
when you write down your password somewhere that you make note of any 
capital letters.

  It is possible to leave the password   blank, but that makes the entire computer 
easier to get into. If privacy is an issue, be sure to assign a password.

Click this to get secure 
password suggestions.

For Group accounts, 
see page 316.
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  You can, if you like, enter a password  hint. On login, if a user enters the 
wrong password three times, a message appears with this hint (see the 
following pages to make sure the box is checked to make the hint appear).

 6 If you know how to use File Vault, click that option. Don’t click it if you don’t 
know how it works! (See Lesson 24). 

 7 Click the “Create Account” button. You will be asked about Automatic Login, 
whch lets you turn on your computer and automatically logs you in without a 
password. If you have security issues with your Mac, turn off  Automatic Login.

 8 To choose a  login    picture, do one of the following:
■ Single-click the existing picture you see in the window and choose another 

from the collection that appears. 
■ Or do the step above (click the picture), then choose “Edit Picture….”  

Th en skip to “Edit the image,” below.
■ Or drag a photo or other image from a Finder window and drop it 

on top of the existing picture.
■ Edit the image: Resize, reframe, take a new photo, or choose a diff erent 

image. You can edit this at any time in the future as well. 

—continued

Press-and-drag on this 
image to position it within 
the frame.

To resize the image, 
drag the blue slider.If you have a 

camera attached, 
click this button to 

take your photo.

To choose another image 
from your Mac, click here. 

When you’re happy with 
the image, click “Set.”



Lesson 18 Share One Mac with Multiple Users 

314

 9 Enter the user’s .Mac account name if she has one. 

  If you want to allow this user administration privileges so she can change 
preferences, install software, etc., check that box. 

  If you want to enable parental controls, check the box, then click the button to 
go to the Parental Controls preferences (see pages 324–329).

 10 In the Accounts window, single-click    Login Options to assign a user the ability 
to automatically  log in, as explained below. Th is pane is available only to 
Administrators (that is, standard and managed users will not be able to change 
anything on this pane).

  I just set up several new users, but my Mac will   automatically log in to 
“Robin Williams,” meaning I do not have to go through the  login screen and 
enter a password whenever the Mac starts or restarts. Th is is good for me on 
my big tower Mac in my offi  ce because I work by myself; for my laptop that I 
travel with, I disable automatic login. 

  Because the Mac will automatically log me in on my tower, the only way the 
other users can get to their Home folders is if I go to the Apple menu and 
choose “Log Out…,” or if I uncheck the automatic login on this pane. Which 
one you choose depends on how often the other user needs your machine; 
if it’s infrequent, you can let yourself automatically log in daily, then log out 
when the other user arrives to log in.
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—continued

  Only one user can be assigned the automatic login. Any time you like, open 
this pane and choose another user from the menu shown above to give that 
person the automatic login privilege.  

  Display login window as: Th e “List of users” displays a list of all accounts. 
Th e pictures that were chosen appear next to the names of the users. It’s 
really cute. At login, click a picture, then type the password. (If you have a 
very young user who can’t type and you feel your Mac is safe from strangers 
walking by, do not assign a password; she can just click her picture to log in.)

Th e “Name and password” option displays a small window with two edit boxes, 
one for the user name and one for the password. A user will have to type in 
both name and password. Th is makes it one step more secure.

Show the Restart,  Sleep, and Shut Down buttons: Th is adds a wee bit 
more security to your Mac. You see, when you log out, your computer does 
not turn off . It sits there with a little window where you can log back in again, 
and there are buttons in the window to “Sleep,” “Restart,” or “Shut Down.” If 
your Mac is set to automatically log you in on startup, then an unauthorized 
user can walk by after you have logged out, click the Restart button, and your 
Mac will restart and automatically log you in. Or someone could shut down 
your Mac, insert an OS X CD, boot up the Mac, and get access to your whole 
computer. By disabling these buttons, your Mac is one step closer to being 
protected. 

This is a login window.

If you checked the box to 
“Show password hints,” this 
button will give you the clue 
you entered for your password.

If your    password isn’t working, 
check to make sure this Caps 
Lock symbol is not in the 
field! If Caps Lock is on, your 
password will be typed in all 
caps and might not work. 

To take it off, press the 
Caps Lock key again.
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However, there is nothing to prevent anyone from pushing the Restart button 
on the Mac, so if you really don’t want people getting into your Mac, do not 
enable automatic log in, and do not leave your OS X CD laying around.

Show Input menu in login window: Th is gives you access to the  language 
options that you may have set up in the International system preferences.

Use  VoiceOver at login window: Th is turns on Apple’s built-in spoken user 
interface so a visually impaired person can log in. It reads everything on the 
login screen out loud to you and tells you what is highlighted so you know 
where to type your name and password.  

Show password  hints: If a user enters the wrong password three times, the 
hint that was provided in the password pane when the user was created is 
displayed. Or you can click the button (shown on the previous page) to provide 
the hint immediately.

Enable fast user switching: Th is is so cool—see page 318 for details.

 11 To limit what the new user can access, see pages 324–329.  

  To choose login items that automatically open, see page 321.

  When done, close the Accounts preferences pane. You can always make 
changes at any time. To make changes to other users, they must be logged out.

Create a Group 
You can create a Group account that consists of individual users. Th is makes it even 
easier to share fi les with a group of people who are all using the same network, such 
as students or co-workers. 

Simply choose the “Group” option when making a new user (see pages 311–312). 
You will get a pane in which you can add other existing users to this Group. 

To maximize the fi le sharing capabilities, use the Sharing preferences to turn on 
various sharing possibilities, then add this Group to the list of sharing users. 
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Log Out and Log In
  Automatic login allows one  selected user to use the Mac without having to enter 
a password. If  automatic login is enabled (page 314), then you must make sure to 
Log Out (not restart or shut down) before another user can log in. Th is is because 
the computer will automatically log you in again when it starts up. 

If automatic login is not  enabled, then it doesn’t matter how you turn off  the 
Mac—it will always display a Log In screen where every user, even Admins, 
will have to enter a password.

When you log out, all of your documents will close and your applications will quit. 
If this is inconvenient, read about “fast user switching” on the next page.

To log out, go to the Apple menu and choose “Log Out User….” “User” is the 
name of the currently active user. All applications will quit, the current screen will 
disappear, and the login window will appear waiting for the next user to log in.

To log in, click your name and then type your password. If the password is incorrect, 
the login window shakes back and forth, as if it’s saying “No! No! No!” After three 
wrong  passwords, it will show you the hint you assigned (see pages 312–313). Or you 
can click the “Forgot Password” button and it will provide the clue immediately.
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Switch Users with a Click
Th e Mac has a feature called fast user switching that allows multiple users to 
stay logged in at the same time without having to close fi les or quit applications. If 
you’re working on a newsletter and your teenager needs to do her homework, she 
can switch to her personal user environment, do her work, then you’ll switch the 
Mac back to your user space—with your newsletter sitting there waiting for you. 
Th e important thing is that you didn’t have to close your documents and quit your 
applications to log out.

When fast user switching is turned on, all users are listed in the top-right corner of 
your screen, next to the menu clock. Th e currently active user’s name appears in the 
menu bar. 

To see other user names and to see which ones are logged in, single-click on the 
current user name in the    menu; a menu drops down showing all users. Users in the 
list that have a checkmark next to them are already logged in. Th e  currently active 
user is grayed-out. 

To enable fast user switching, click the checkbox “Enable fast user 
switching” in the “Login Options” pane of the Accounts system  preferences 
(see page 314). 

To switch to another user, choose one from the user menu, as shown above. 
If you (the Admin) assigned a password to the chosen user, a login window 
opens so the user can type a password. Enter the correct password and the 
user’s own personal Desktop environment opens.  

If a password was not assigned to a user, that user’s Desktop opens immedi-
ately, without a password-protected login window. Actually, it doesn’t just 
open like some ordinary computer; the entire Desktop rotates like a cube to 
the new user space.
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To open the main login window, choose “Login Window…” from the user’s 
list in the menu bar, as shown on the previous page. Th is is a convenient way to 
leave the screen if you have multiple users. Th e next user that sits down at the 
Mac just clicks her name to log in and start work (or play).

Allow Other Users to be   Admins
An Admin can select another user and give that user Administrator privileges.
In the Accounts preferences, select the user in the left panel, then click the button
to “Allow user to administer this computer.” 

A standard user can give himself Admin privileges if he knows the name and 
password of an Administrator. All he needs to do is click the lock icon and enter 
the correct information.

Adjust User Settings
You, as Admin, cannot make changes to another user if that user is already logged 
in. So if you try to make changes and it won’t let you, log out that user. 

 If the   rotating-cube effect isn’t happening for you during fast user 

switching, the  graphics card installed on your Mac might not be able to handle the 

intense processing that this effect requires. Fast user switching will still take place—

it’s just not quite as sexy.
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Let Users Adjust their own Settings
Once a   standard user is logged in, she can adjust some of the login settings, even 
if she’s not the Administrator. She can change her password (she has to know 
the current password before she can assign a new one). She can change the login 
picture, apply parental controls to herself, and choose which applications open 
automatically when she logs in.

Below you see the applications that my mother likes to have open automatically 
when she comes to visit and uses my Mac. See the opposite page for details about 
Login Items.
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Set Up Login Items
In the    Login Items, any standard or Admin user (including yourself ) can choose to 
have certain items automatically open during the login process. You can open your 
favorite applications, utilities, documents, even movies or music. If you choose to 
have a document open, the application it was created in will have to open as well, 
even if you don’t have it in the list. 

Th is pane applies only to the user who is  currently logged in! No other user even has 
access to the Login Items pane for someone else.  

To add items to the Login Items list, click the “plus” button circled below. A 
dialog box opens to let you choose any fi le or application to add to the Login Items. 
To add more items, click the “plus” button again.

Th e fi les will open in the order in which they are listed. Drag any fi le in the list 
up or down to change the order. 

If you don’t want to see a certain application right away every time you turn on 
your Mac, click in the checkbox to hide it. It will still open, but its windows won’t 
be visible on the screen. Th e application icon in the Dock will have the blue bubble 
under it, though, so you know it’s open and you can access it at any time.  

The current 
user is always 
at the top of 

this list.

To delete items from the Login Items list, fi rst select the item, then click the 
“minus” button.
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Share Files with Other Users
Once users are set up, other users can only access each other’s Public folders, the 
 Drop Boxes inside the  Public folders, and the  Sites folders. But the      Shared folder 
(which is in the Users folder, which is on your main hard disk) is available to 
everyone who uses the Mac. Here’s how it works:

■ Put fi les in your own Public folder that you want others to be able to read, 
copy, or print. Th ey have to open your Public folder to do so.

■ Other users can put fi les for you into your Drop Box, which is located inside 
of your Public folder. Th ey cannot open your Drop Box, not even to see if 
their fi le successfully transferred. 

■ Put fi les in the Shared folder that you want everyone who uses the Mac 
to have access to. Th is is a good way to distribute something to everyone 
on the Mac without having to copy it to each individual’s Drop Box.

■ Th e Sites folder is where you can store a web site or fi les that you want 
people to access through the Internet. 

You can also change the sharing “privileges” for any folder in your Home. Th at is, 
you can turn off  the sharing privileges for the Public folder and the Drop Box so 
no one can access them, and you can also choose to share any or all of your other 
folders, with varying levels of access. Please see the following page for details.

Every user has a 
Drop Box located inside 

his Public folder.

All users can access items 
in the Shared folder.
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Set Permissions for Shared Files
Every fi le on your Mac has “          permission” settings. Some of these permissions you can 
change, if you like. For instance, you might want to send a memo to all users of this 
Mac, but you don’t want them to be able to edit it. So select that document and give 
the others a permission of “Read only.” Or perhaps you don’t want anyone to access 
your Sites folder; give it a permission of “No Access.” Maybe you want to share your 
Movies folder so another user can drop movie fi les into it; select the folder and 
change its permission to “Read & Write” or “Write only” (which means they can 
put fi les into your folder but can’t take them out.)

To change permissions on a file or folder:

 1 Single-click on a fi le or folder to select it.

 2 Press Command I to display the Info window, as shown below.

 3 Click the disclosure triangle next to “Sharing & Permissions.”

 4 Click the lock icon and enter your Admin password. Click OK.

 5 Click the little menu next to user names or groups to change the permissions.

 6 When you’re fi nished, just close the Info window. 

Documents and 
folders have 
different sorts 
of permissions 
available.

To revert changes 
or to apply the 
permissions to all 
items in a folder, use 
the Action menu. 

Add users or a Group to this 
list and assign permissions.
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Apply Parental Controls
Th ere are several levels of limited user access you can create. Once you apply any 
of these     parental controls, the user changes from a “Standard” user to a “Managed 
with Parental Controls” user. Choose the level of access you want to control. Each 
of these options is explained on the following pages. Only an Admin can apply 
or change parental controls. You can even manage these controls from another 
computer.

You can limit the applications a user has access to, the content of the Dictionary and 
web sites, whether or not a user can burn cds or modify their Dock, and more. You 
can set time limits and check logs to see where a user has been. 

Th e Simple Finder is the most serious limitation. Th is is appropriate for very young 
children who want to use their educational software and games on your Mac and 
really don’t know how to surf or chat anyway. It makes the Mac very easy for them 
to use and they can’t do any damage.

Set limitations on a user
 1 Set up a new user, as explained on pages 311–316, if you haven’t already.

 2 Make sure that the user is not logged in. If he is, log him out.

 3 Go to the Apple menu and choose “System Preferences….” 
Single-click on the “Accounts” icon.

 4 If the lock icon in the bottom-left corner is locked, single-click on it 
and enter the Admin name and password. Click ok.

 5 Select the user in the left-hand pane.

 6 Check the box to “Enable Parental Controls.”

 7 Click the button to “Open Parental Controls….”

 8 You’ll see the window at the top of the next page, asking you to choose the 
account to which you want to apply parental controls. 

  Choose an account and you immediately get the screen shown at the bottom 
of the opposite page.

 9 Th e rest of the process is pretty self-explanatory. Go through the next few 
pages for some clarifi cation. Essentially, you’re going to choose what you want 
to limit. Don’t choose the Simple Finder until you read page 328.

A
Th
o
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—continued

Use the back and forward buttons to go 
back and forth between panes. 

Choose which 
applications you 
will allow. 

Don’t neglect 
these options; 
uncheck any you 
do not want this 
user to access.

Click these tabs to 
limit other features.
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This is the “Mail & 
iChat” pane. You can 
add the individual 
accounts that you 
will allow, or click the 
disclosure button to 
access your Address 
Book and choose 
from there. 
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—continued

This is the “Content” 
pane where you can 
hide naughty words 
in the Dictionary and 
limit access to the web.

This is the “Logs” pane 
where you can keep 
track of every web 
page this user has 
visited, as well as with 
whom they’ve chatted 
and what applications 
they’ve used. Wow. 

Be sure to check the 
“Time Limits” pane 
where you can limit 
the amount of time 
the user can use the 
computer, and turn 
it off at a certain 
bedtime.
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Shared folder.

In Simple Finder, click an 
icon just once to open it. 

Simple Finder
Th e  Simple Finder is the most serious limitation. Th e illustration below shows what 
a user logged in using    Simple Finder might see.

■ Th e  Applications and Utilities are limited to what you allow.
■ Th e user has no access to a Desktop, hard disk, or other partitions. 
■ Th e user cannot move fi les from one folder to another.
■ Th e user has three folders in her Dock: My Applications, Documents, and 

Shared. Th e Shared folder contains items placed in it by other users of the 
computer, as explained on page 322. Anything anyone puts into the 
Shared folder (shown in the Dock) will be available even to users running 
Simple Finder.

■ Th e Finder windows have no Sidebars or Toolbars. 

My Applications folder.

Documents folder; all saved 
documents will be in this folder.
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To set up a user with Simple Finder:

 1 Follow the steps beginning on page 324 up through Step 9.

 2 Click the button to “Use Simple Finder.”

 3 In the list of applications, uncheck the boxes to deselect applications. 
Every checked item will be available to the user in Simple Finder.

  To deselect some applications, click the small disclosure triangle next to the 
diff erent sorts of applications to see an itemized list of individual applications, 
each with its own checkbox. Uncheck a box to deselect an item. 

Override the   Simple Finder
While in the  Simple Finder, an Admin user (or anyone with an Admin name and 
password) can go to the Finder menu and select “ Run Full Finder.” A dialog box 
opens that requires the Admin name and password, and then the current user has 
access to a complete menu bar, hard disks, and Finder windows with Sidebars and 
Toolbars.
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Delete a User
Any Admin can   delete a user. You have three choices about what to do with all the 
fi les that belong to a user when you delete her account:

  Save the home folder in a disk image. Th e contents of the user’s Home 
folder will be compressed as a disk image format (.dmg) and saved into a 

“Deleted Users” folder located in the Users folder. Th is is a nice safety net 
in case you need to access that  user’s fi les later—just double-click the .dmg 
fi le, it opens to a hard disk icon (as shown on the opposite page), and all 
the fi les are restored in that hard disk icon.

  Do not change the home folder. Th is stores the entire Home folder and 
all its contents in a folder called “username (Deleted).” All of the folders 
except Public and Sites are locked, however. You, as Admin, can open a 
folder’s Info window and change the permissions to give you access to it, 
as shown on page 323.

  Delete the home folder. Choose this if you’re certain you don’t need 
anything the deleted user may have in her Home folder. Th e user account 
and all fi les in the user’s Home folder will immediately disappear. 

To delete a user: 

 1 From the Apple menu, choose “System Preferences…,” then click the 
“Accounts” icon.

 2 If the lock icon in the bottom-left corner is locked, single-click on it 
and enter the Admin name and password. Click ok.

 3 Click once on the name of the user you want to delete. If the user name 
is gray and you can’t select it, that means that user is logged in. She must 
log out before you can delete the account.  

 4 After you select the user, click the “minus” button at the bottom of the list 
of users pane.

 5 A sheet drops down, shown at the top of the next page, asking what you want 
to do with the fi les belonging to this user. Make your choice based on the 
information above.
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To access the saved user fi les later, double-click the .dmg fi le. It will open to a 
hard disk icon. Open the hard disk icon and you’ll fi nd all the fi les. 

If you choose to not save the Home folder, 
this is the deleted user; the files are all in 
this folder, but they are all locked. Use the 
Info pane, as described on page 323, to 
unlock the folders.
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GOALS

Understand the different 
ways to access Spotlight 

and search your Mac

Choose or change the 
categories for searching

Prevent selected folders 
from being searched 

Expand the search with 
metadata

Add searchable keywords 
to files

Create Smart Folders

Take advantage of 
Spotlight in other 

applications
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LESSON 19

Find What You Want, 
Fast—with Spotlight

Spotlight is not just a search feature, it’s a way of working with 

your Mac. Once you get accustomed to its speed, versatility, and 

usefulness, you’ll fi nd yourself using Spotlight regularly instead of 

opening and closing folders and windows. 

If you fi nd you perform a certain search often, save it as a Smart 

Folder. Files that match the search criteria are automatically listed 

in the Smart Folder and the folder updates itself every time a 

matching fi le is created or changed. 
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The Many Faces of      Spotlight
Spotlight really has fi ve diff erent ways of working. You’ll fi nd yourself using them 
in diff erent ways at diff erent times. Experiment with each one so you’ll know which 
is the most appropriate for what you need to do. Details for each option are on the 
following pages. 

1. Spotlight menu
Click the Spotlight icon in the upper-right of the menu bar, 
or use the keyboard shortcut, Command Spacebar. 

Type your query into the fi eld that appears and Spotlight instantly starts 
presenting results. As you type more letters, the search narrows and updates. 

Access to the Spotlight menu is available no matter which application you’re 
using—you don’t have to go to the Finder to run a search. See pages 342–343 for 
all the details.
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2. Spotlight window
To get the Spotlight window below that displays more information: 

Either click the option to “Show All” at the top of the Spotlight menu after 
you’ve made a search, as shown on the previous page. 
Or use a keyboard shortcut: 
 If you’re in the Finder, press Command F.
 If you’re in an application, press Command Option Spacebar. 

See pages 345–346 for details.

3. Spotlight-powered search in the Finder
When you type into the Search fi eld in a  Finder window, Spotlight instantly kicks 
in and shows you simple results directly in that window. It automatically looks in 
the last “location” that was chosen (“Th is Mac” in the   example below). See page 
344 for details. 
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5. Spotlight-powered search in many applications
You can fi nd    Spotlight-enabled searches in many other applications. Some 
applications also let you create other forms of Smart Folders.

 Mail and Smart Mailboxes, pages 88–91.

 Address Book and Smart Groups, pages 116–117.

 Spotlight on text, page 350.

 System Preferences, page 279. 

 Open and Save As dialog boxes, page 351. 

 Safari, page 350.

4. Quick “Search For”
Th ere is a section in the Finder window sidebar called “Search For.” Apple has 
created several pre-defi ned searches for you. If you’re looking, for instance, for 
a fi le you used yesterday but you can’t remember what you called it, check the 

“Yesterday” search and see if it jumps out at you.

You can’t change these search parameters, but you can get take them out of your 
sidebar if you’re not using them. Just drag them off  to the side and let go—they’ll 
go up in a puff  of smoke. If you want them back, use the Finder preferences (go 
to the Finder menu, choose “Preferences…,” and click the “Sidebar” tab).
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But Before You Begin
Th ere are several things you might want to know before you start using Spotlight. 
In the    Spotlight preferences, you can choose which categories of items you want 
Spotlight to search through. You can also choose certain disks and folders that 
you (or anyone using your machine) cannot search through, giving you some extra 
privacy.

And on the following pages are some tips for searching.

Choose the categories for searching
 1 From the Apple menu, choose “System Preferences….”

 2 Single-click on the “Spotlight” icon.

 3 Click the “Search Results” tab if it isn’t already highlighted.

 4 Uncheck boxes for categories you don’t want Spotlight to search. 

 5 Click the Back button (the triangle in the upper-left) or “Show All” 
to go back to the main preferences pane.
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You can change these 
   keyboard shortcuts if you 
find they interfere with 
your favorite applications.

Create some privacy
 1 If you haven’t already, open the   Spotlight preferences, as explained on the 

previous page.

 2 Click the “Privacy” tab.

 3 Click the + sign to open a dialog box where you can choose any folder 
or disk on your Mac that you don’t want Spotlight to search. 

  Or drag any folder or disk icon from the Finder and drop it into this pane.

  Note:  Th is isn’t a very safe privacy feature because anyone using your 
computer can just open the preferences and remove these items. 

Keyboard shortcuts to open Spotlight
Notice in the illustration above that these preferences also include options for you to 
change the existing keyboard shortcuts or to turn them off  altogether (uncheck the 
boxes). Some applications might use those same shortcuts; Spotlight will override 
the applications’ shortcuts, so if it creates a problem for you, go to the preferences 
above and change them.
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Don’t search just file names
      Spotlight doesn’t just search fi le names. It searches the contents of email messages, 
it knows who sent you email, it can look through the contact information in your 
Address Book, images and graphics, calendars and events and to-do lists, System 
Preferences, pdf text, the contents of TextEdit pages (but not text clippings), even 
iChat logs (if you previously chose to log them). 

Expand your repertoire of searchable items
You’re not limited to searching just for words that might be found in a fi le. In the 
  Finder Spotlight search, you can use the existing parameters to fi nd particular 
categories of fi les. For instance, you can look for “music” to fi nd all your music fi les, 
or “images today” to fi nd all the images you have opened today. 

Leave the search 
field empty when 
you use these 
parameters if you 
want to find all files 
of a particular type.
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In the Find window, 
single-click any of 

these parameter 
menus in the left-
hand column and 

choose “Other…” to 
get a list of metadata 
options to search for. 

Click a plus sign 
to add another 
parameter; click 
a minus sign to 
delete that one.

Expand the search with metadata
Spotlight also looks in the  metadata that every fi le contains. Metadata includes 
information about who created the fi le, when it was created and modifi ed, the 
copyright date, the fi le type, the color space for a photo or image, even what kind 
of camera a particular photo was taken with. Diff erent kinds of fi les have diff erent 
kinds of metadata associated with them. 

To make a  metadata attribute appear in the parameter menu, check the box in 
the column labeled “In Menu.” 
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Add keywords to files
Th ere are some fi les that, even with all the options in Spotlight, still won’t be found 
because there is nothing associated with them that      Spotlight can decipher. For these 
fi les, you can add your own keywords. For instance, the example below is a music 
fi le of an Elizabethan song written in the 16th century. I can search for “music,” 

“Hecate,” and other data, but if I search for “elizabethan,” this piece of music won’t be 
found. So I added a number of keywords that I might use in a search to the Get Info 
window for this fi le and for all the other Elizabethan music I have on my Mac. Now 
Spotlight can fi nd them.

To add a keyword to a file: 

 1 Single-click on a fi le to select it. 

 2 Th en press Command I to get the Get Info window. 

 3 Type your keywords into the “Spotlight Comments” area.

If you have more than one fi le to which you want to add keywords, select 
one fi le, then press Command Option I. Now as you select other fi les, this Get Info 
window automatically displays the information for the currently selected fi le. 
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Spotlight Menu
Th e  Spotlight menu is available no matter which application you are using at the 
moment (although this is not the tool to use to search within your application, such 
as searching the text on a visible web page or in your word processor). 

To open the Spotlight menu:

 1 Simply click on the Spotlight icon in the upper-right of the menu bar, 
or press Command Spacebar to open it.

 2 A small fi eld appears. Start typing in it. 

  Results appear instantly in the Spotlight menu, as shown below. Th e more 
letters you type, the narrower the search becomes. 
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To use the Spotlight menu:

Below are callouts of the various parts of the Spotlight menu. Use the Spotlight 
menu for a quick search for something you think can be easily found. 

  Single-click the X to delete 
everything in the search field. 

Single-click “Show All” 
to display the Spotlight 
window, as shown on 
the following page.

These are the 
categories that 

Spotlight is 
searching. See page 
337 for a list of the 
categories possible.

This opens the same 
 preferences you see 
on pages 337–338.

Single-click any 
item to open it.
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  Spotlight in the  Finder
Th ere are two ways to use Spotlight in the Finder, both of which use your Finder 
window. You can do a quick search by simply typing in the search fi eld that appears 
in the upper-right corner of every Finder window, as described below. Or press 
Command F to go straight to a more specifi c  search window with options to narrow 
your search, as described on the following pages.

Quick search in a Finder window
Below are the results of a quick search for “death.” As soon as you start typing in the 
search fi eld, results appear. Also, a bar appears that tells you where Spotlight looked 
(in the example below, it searched the contents of “Th is Mac”). 

In this window, you can easily choose another location for Spotlight to search— 
just single-click one of the locations in the bar, shown below. If you select a folder 
before you begin the search, it will limit the search to that folder.

You can also click the + button that now appears (circled, below) to add more 
parameters for narrowing your search, as shown on the opposite page.

To see where a fi le is located, single-click any result; the path to that fi le 
(the folders within folders) appears at the bottom of the list. 

To  open the folder that holds the selected fi le, press Command R (or Control-
click, right-click, or use the Action menu to choose, “Open Enclosing Folder”).

To open that fi le, double-click it. 

To quickly view the fi le, click the Quick Look button (the eyeball in the toolbar).
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Specific  search in a  Finder window
On the Desktop, press Command F and the active window will switch to what you 
see below. If no window is open or active, a new one will open automatically. Th is 
window includes the search fi eld, and the location bar is already visible.  

Th e only diff erence between this window and the one on the opposite page is that 
this Find window automatically provides parameters for you to work with. 

To add more parameters to narrow your search, click the plus sign; to delete one, 
click its minus sign. 

To change the parameters, single-click on a parameter menu to choose a diff erent 
option. Start with the menu on the left, as shown below, which will change the 
specifi cs in the next menu to the right, which might then create a new fi eld for you 
to enter a new parameter, also shown below. 

As in the example on the opposite page, you can choose to search the “Contents” or 
just the “File Name.”

Choose a location 
to search and 
whether to search 
the contents or 
the file name.

You can narrow your search even further with Boolean operators, which are not as 
scary as they sound. See the next page. 
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Use a Boolean search
A Boolean search simply means that you limit the search by using the words AND, 
OR, and NOT. As you can see below, a search for “mabel” showed me three fi les. 
But a search for “mabel AND love” found exactly the one I was looking for, and only 
that one. 

Th e Boolean operator (the AND, OR, or NOT word) must be typed in all caps or it 
won’t work. 

You can also use quotation marks, just as you probably do when searching the 
web. For instance, if you search for knitting yarn without quotes, you’ll get every 
document that has the word knitting in it and every document that has the word 
yarn in it. But if you search for “knitting yarn” in quotes, you will only fi nd pages 
with that exact phrase. 
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Smart Folders
Once you do a great search in the Finder via    Spotlight, you might like to create a 
Smart Folder that automatically keeps  track of every fi le that fi ts that search. Th is 
folder doesn’t store the original fi les—the originals stay in their original folders, and 
the Smart Folder just keeps a list of everything so it’s easily accessible to you. 

For instance, you might want a Smart Folder that contains all the various presenta-
tions you’ve made so you don’t have to go looking through numerous folders to fi nd 
a particular one. If so, make a Smart Folder that just stores presentation fi les. 

Or you might have used the Labels feature on your Mac (see page 264) to color- 
code all the fi les that belong to a certain project. For instance, your newsletter might 
include a document in the application Pages, images from the last event, word 

processing fi les your authors have sent you, and a spreadsheet chart from the 
Apple spreadsheet software called Numbers. And you used the Labels to give them 
all a label color of orange. Your Smart Folder can keep track of all the orange-labeled 
fi les in one place for you, even though the fi les themselves are organized into their 
own particular folders. Th e Smart Folder updates automatically as new fi les are 
labeled or old fi les are trashed. 

To create a Smart Folder:

 1 At the Finder, press Command F to open Spotlight in a Finder window.

 2 Defi ne your parameters. Below is a simple search of all fi les in my Home 
folder that are presentations. Notice there is nothing typed into the search 
fi eld at the top of the window because I want to fi nd all presentations 
regardless of their names.

—continued
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 3 Click the “Save” button, which is just below the search fi eld. You will be asked 
to name this Smart Folder and where to save it. In the example below, I saved 
this into my Documents folder.

  If you want this folder to be visible in your Sidebar, check the box to “Add To 
Sidebar.” Click “Save.”

I saved this Smart 
Folder into my 
Documents folder.

To edit this Smart Folder search at any time, double-click on its folder and set new 
parameters. Files will automatically update.

 4 Now that the Smart Folder is saved, all you need to do is double-click on it 
and your Mac will display all the fi les that match the criteria you originally set. 
(If the Smart Folder is in the Sidebar, just single-click on it.) 
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System Preferences 
As explained in Lesson 15, Spotlight also works in   System Preferences. Th is is great 
when you know you need a System Preference to do something in particular, but 
you’re not sure which one you need. 

To search in  System Preferences, simply type into the search fi eld. As you type, 
Spotlight highlights all the possible preferences that might help you. 

When you click on one of the options in the menu that appears, Spotlight highlights 
the best preference for that option in a bright white spotlight, as shown below, then 
opens it for you automatically.

This preference is where you 
can monitor Internet activity, 
as selected in the menu above.



Lesson 19 Find What You Want, Fast—with Spotlight 

350

Spotlight in Text
In    some applications on your Mac, you can select a word or phrase and let Spotlight 
fi nd other occurrences of that word or phrase on your Mac. Th is might be useful 
when you’re browsing the web and fi nd the name of someone in the news and it 
makes you say, “Hmm, didn’t she send me an email last month?” Or if you’re in your 
word processor and you’re writing an essay and you want to fi nd the article you 
saved earlier on a topic that’s mentioned. 

For instance, try this in    Safari or   TextEdit: 

 1 On a web page, press-and-drag to select a word or phrase. 

 2 Control-click (or right-click) on that selected word or phrase.

 3 From the contextual menu that appears, choose “Search in Spotlight.” 
Remember, Spotlight searches your Mac, not the Internet!
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  Open Dialog Box
In any Open dialog box, as shown below, you can search for a fi le name.       Spotlight 
will locate all fi les that your open application thinks it can open and display, plus 
all folders with that search phrase in the name (it does not search contents or to-do 
list items, etc., in this dialog). Any Smart Folders you have placed in the Sidebar will 
also appear here.

After you start typing 
a search entry, this bar 
appears. 

Narrow or expand 
your search by clicking 
on one of these 
locations. 

Save As Dialog Box
You can do a search in the Save As dialog box and Spotlight will fi nd folders for you 
to save into. Any Smart Folders in the Sidebar will also appear here.

Click the X to delete 
the entire search string.



 

20
GOALS

Learn about Time 
Machine

Create a backup of your 
entire hard disk

Find and restore files

Search and switch
 to Time Machine
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LESSON 20

Time Machine Backup

We know we should back up important fi les every day, but really, 

“It’s just too much trouble.” Surely everything will be okay for a 

couple of days until we have time to make backups. Months later 

we fi nally have some extra time and the fi les are nowhere to be 

found. Or the original version has been overwritten by a newer 

version with unwanted changes in it. Oh, if only we had a time 

machine that could go back in time and grab earlier versions of 

fi les. And wouldn’t it be nice if the time machine did this without 

us doing anything—except maybe turning it on?

Wait . . . there is such a thing! And, amazingly, it’s called . . . 

Time Machine! 
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About Time Machine
After you set up    Time Machine, it backs up your computer regularly. For the initial 
backup, Time Machine backs up everything, including system fi les, applications, etc. 
After that, only fi les that have changed are backed up. Hourly backups are stored 
for twenty-four hours, daily backups are stored for a month, then weekly backups 
are stored until the backup disk is full. Because backups are stored by date, you can 
restore fi les or folders (or your entire system) exactly as they were at certain points 
in the past. 

When the backup disk fi lls up, Time Machine deletes the oldest backups to make 
room for new ones. It could take a long time to reach this point, but be prepared 
to either replace the Time Machine disk with another one, or to let Time Machine 
delete older fi les when necessary. 

While Time Machine is a good solution for temporary storage of backups and a 
great way to restore fi les that have been thrown away, lost, or changed, it isn’t a fi nal 
solution for creating permanent archives of your fi les. If you plan to keep using the 
same backup disk and let Time Machine delete the oldest fi les to make room for 
new backups, be sure to use other backup methods to create permanent backups of 
important fi les and folders (burn fi les to cds or dvds, copy items to your .Mac iDisk, 
or copy items to other external drives). Remember, it’s safest to create multiple 
backups of items that you absolutely cannot aff ord to lose, and be sure to store 
those multiple copies in several diff erent place—if your offi  ce burns down or fl oods, 
it won’t matter if you had sixteen backups in that offi  ce, they’re all gone. 

What kind of disk to use as backup
You must use a disk for Time Machine that is separate from the hard disk you work 
on. An extra internal hard disk is great, and peripheral hard disks work fi ne too. Th e 
disk needs to be big enough to backup the drive it’s assigned to. For best results, 
use a disk dedicated only to Time Machine backups. If you use this backup drive to 
store other fi les, you lose that storage space for Time Machine.  

Both FireWire and usb disks work with Time Machine, including most disks that 
might be available on your local network. Disks used for Time Machine backups 
must be formatted as Mac OS Extended (journaled), and have Access Control Lists 
(acls) enabled. Time Machine will erase and reformat the disk if necessary.
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See the 
next page.

Create a Time Machine Backup
It’s very easy to start the process. Make sure you have an appropriate disk installed.

To set up Time Machine backups:

 1 Once you have an extra internal hard disk installed or you’ve connected an 
empty external hard disk, open the Time Machine system preferences: Either 
click its icon in the Dock, then click the button to “Open Time Machine Prefs,” 
or go to the Apple menu, choose “Preferences…,” and click on “Time Machine.”

 2 Click the “Choose Backup Disk…” button. You’ll get a list of possible drives 
that can be used; choose one and click “Use for Backup.”

  If you’re using an external disk, Time Machine will probably automatically 
ask if you want to use that disk for backup. 

 3 Once a backup disk has been assigned, Time Machine automatically switches 
itself ON and displays information about that disk, including when the fi rst 
backup will start.  

 4 Click the Options button to display a sheet (shown on the next page) in which 
you can designate items you want to exclude from Time Machine backups.

—continued
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To stop a backup, 
click the gray X. 
Or slide the ON 
button to OFF.

Choose to receive a 
warning when Time 
Machine needs to 
start deleting the 
oldest backups.

 5 To add items to the “Do not back up” list, click the plus (+) button, circled below.

  Another sheet slides down from the title bar, covering up the one shown below. 
Select the items (drives, volumes, fi les, or folders) that you do not want Time 
Machine to back up. Click the “Exclude” button. Th is returns you to the fi rst 
sheet, shown below. 

  To remove items from this list so that Time Machine will back them up, 
select them and click the minus (–) button from the sheet shown below.

 6 Click “Done.” 

  Time Machine makes an initial backup that includes everything on your 
computer (below). Th is backup can be time consuming, depending on how 
many folders, fi les, and applications are on your Mac. Subsequent backups 
are faster since only changed fi les are backed up.
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Backup failed?
If a Time Machine message tells you the latest backup failed (see below), click that 
red info button (i) for an explanation. Th e disk may be too small or perhaps you’re 
out of room on the chosen disk. 

To switch to another disk, click the “Change Disk…” button, then select another 
connected disk. 

If Time Machine alerts you that the new disk must be erased (far below), click 
“Erase.” Th is will of course destroy everything that’s already on that disk! If you don’t 
want to lose information on that particular disk, connect another hard disk and 
click “Choose Another Disk.”
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How to Use Time Machine
Once you’ve got Time Machine all set up, as explained on the previous pages, there 
are several diff erent ways to use it to fi nd earlier versions of fi les that have changed 
or to fi nd missing fi les.

To find and restore a file:

 1 On your Desktop, single-click a fi le or folder in a Finder window to select it. 

 2 Click the Time Machine icon in the Dock. Th e Time Machine universe 
is revealed in the background. It shows the current Finder window in the 
foreground, with earlier versions of that same window receding into the recent 
(or distant) past. Th e selected fi le is prominently displayed in Cover View and 
is also shown highlighted in the List View in the bottom section.

  Notice that the bar at the bottom of the star fi eld universe is labeled “Today 
(Now).” In other words, any fi les shown or accessed through this particular 
window are the most current versions.   

 3 To go back in time and fi nd previous versions of the selected fi le, click the 
back-in-time arrow (called out, below). Th e star fi eld zooms back in time 
through the fl oating windows until it reaches a window where an earlier 
version of the selected fi le exists. 

Click “Cancel” 
to exit Time 
Machine, or 

press Escape on 
your keyboard.

These are the back-in-time and 
forward-in-time arrows.
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  Th e fi le is selected and displayed, as shown below. Notice that the bar at the 
bottom of the window now says “Today at 8:50 AM,” which is about twelve 
hours earlier than my current time. And you can see that the fi le had diff erent 
formatting in this earlier version. 

  If this isn’t the version of the fi le you’re looking for, click the back-in-time 
arrow again to fi nd earlier versions. Or drag your pointer over the timeline 
on the right edge of the screen and select a backup time or date. 

  4 To restore the version of the fi le you want, fi rst make sure it’s selected. 
Th en click the “Restore” button on the right side of the bar at the bottom. 

To go directly 
to a specific 
backup date 
or time, 
click in this 
timeline.

 5 A message asks if you want to keep the original version of the fi le (instead of 
the backup), keep both fi les, or replace the original with the backup version. 

  If you choose “Keep Both,” a restored copy of the backed-up fi le is made and 
put in its original location on your computer. Th e word “original” is added to 
the original fi le’s name (right).       



Lesson 20 Time Machine Backup

360

Do a   Spotlight Search in Time Machine
When you use Spotlight to search for items on your computer, the search naturally 
takes place in the “Now” time frame; in other words, it fi nds fi les in their current 
versions. But if you’ve lost or deleted fi les, Time Machine can zoom into the past 
and fi nd the fi les in the various states in which they were saved. 

Search, then switch to Time Machine:

 1 Start a Spotlight search in the Finder (see Lesson 19). If Spotlight doesn’t fi nd 
the item you’re looking for, click the Time Machine icon in the Dock.

  Th e Time Machine universe appears, with Finder windows receding into the 
past. Th e window in the foreground is labeled “Today (Now).” Your search term 
is in the Spotlight search fi eld, circled below.

 2 Click the back-in-time arrow. Time Machine zooms back in time until it fi nds 
the item. To look for an even earlier version of the item, click the back-in-time 
arrow again, or click in the timeline along the right edge of the screen. Notice 
that the time label in the bar at the bottom of the screen shows when the 
selected item was backed up.

 3 When you fi nd the item you want, click “Restore” on the right side of the bar at 
the bottom of the Time Machine screen.

You can also go straight to Time Machine (click Time Machine in the Dock) and 
initiate a Spotlight search—enter a search term in the foreground search fi eld.

To show a Quick 
Look of the item, 

make sure the item 
is highlighted, then 

tap the Spacebar. 

To close the Quick 
Look preview, tap 

the Spacebar again, 
or click the Close 
button in the top-
left corner of the 

Quick Look window.

Enter a search 
term here in 
this Finder 
window 
search field.
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Tech Stuff
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Troubleshoot your 
network settings

Create a new connection 

Use the Network 
Diagnostics tool

 Connect two or 
more Macs

Share files on a network

Send files to anyone 
through Bonjour or iChat 

Share the screen of 
another computer on the 

network or in the world
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LESSON 21

Get Connected 
and Share Files

On a Mac, you have various ways to connect to the Internet. You 

might have a dial-up account that goes through your phone line, 

a cable modem, a dsl modem, a wireless connection, an Ethernet 

offi  ce connection that plugs into a broadband setup, or some other 

arrangement.

And you have various ways to connect your Macs together in a 

home or offi  ce. Once your computers are on a local network, you 

can transfer fi les between them and even access your own Mac 

from another computer.

Th e feature that most amazes me is screen sharing, where you can 

connect to someone else’s computer and actually see her screen 

and use her computer!
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How your Mac Connects to the Internet
When you fi rst turned on your Mac and walked through the setup process, you 
probably fi lled in the information for your Internet connection. Th e   Network 
preferences is where your Mac stored that information and where you can change 
it, adjust it, or troubleshoot it. 

Th e Network preferences lists all of the ways that your Mac might be connected and 
displays the current status of each option. You can confi gure all interfaces for all 
your possible connections from this one window. 

To open the Network preferences, go to the Apple menu and choose “System 
Preferences….” Single-click the “Network” icon. 

When you fi rst open the window, it probably looks something like the one below, 
showing you the status of any possible connections your Mac might have access to. 

These are the 
available “network 

port configurations” 
on your Mac.

This pane instantly 
shows you how you 

are connected to the 
Internet and to the 
other computers in 

your office. 

Change the order in which 
your Mac looks for an open 
connection; see the next page.
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Check the port configurations
You might have several options for connecting. For instance, your Mac recognizes a 
modem port, if you have one (whether or not you use it), and it might fi nd a wireless 
card and an Ethernet port. Every possibility it fi nds is listed in the Network prefer-
ences, in that pane on the left side. 

As you see on the opposite page, you can click the Activity button (shown circled) 
and choose to “Set Service Order….” Th is is the fi rst place I go if there is a connec-
tion problem because the Mac goes down this list in order and chooses the fi rst 
interface that works. If you’re having problems making a connection, make sure 
your preferred connection is at the top of the list—just drag it to the top. Click ok, 
then click the “Apply” button to force the change.

Establish a new connection
If you didn’t set up your Internet connection when you fi rst installed Leopard or 
turned on your brand-new Mac, you can always do it in this Network preferences 
pane. Just click the button (circled above), “Assist me….” A sheet drops down 
from the title bar (as shown on page 367). In that sheet, click the button labeled 

“Assistant….” It will walk you through the process. 

Choose the order 
in which you want 
your Mac to try 
to connect. Drag 
these services into 
your preferred 
order. 
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Troubleshoot your Internet Connection
If your     connection doesn’t work when you fi rst turn on your Mac, perhaps the infor-
mation you entered in the setup process wasn’t correct. Or if you changed Internet 
Service Providers or changed your connection process, you might need to change 
the information. Now, most of the information is supplied automatically, but if your 
provider says you need to change a setting, this is where you’ll do it. Th ere is also a 
little trick you can do here that sometimes kicks things into gear.

 1 From the Apple menu, choose “System Preferences…,” then click 
the “Network” icon.

 2 In the left-hand pane, you can instantly tell whether or not your Mac thinks 
your connection is working. (Sometimes the Mac swears it’s working, but it 
isn’t and you know it.) Choose the connection that you need to fi x or change. 

 1   

 2

 3 First, use the technique on the previous two pages to make sure the connection 
you want to choose is the fi rst one in the list. Click “Apply.” Wait a minute or 
two and see if your browser will connect to the Internet. If not . . .

 4 Th is trick often works if all the settings are correct and there’s no major 
problem with your modem box or router (if you have one): Change any setting; 
for instance, if you see “Using dhcp,” change it to “Manually.” Th en immedi-
ately switch it back. Th is makes the “Apply” button available. Click the Apply 
button. Sometimes all it needs is a kick in the pants to make it take eff ect. 

You can always click the 
Revert button, which 
will restore the settings 
to how they were before 
you started messing 
around. 
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 5 If you think the settings need to change, do so here; you need to click the 
“Advanced…” button to get to the rest of the settings. If you’re not sure what 
the appropriate settings are, you have two choices:

 a Call your ISP (Internet Service Provider) and ask them what to enter in 
which panes. Your isp is the company to whom you pay the monthly fee 
for your connection to the Internet. Although these windows look scary, 
there are only two or three settings you need. If you use cable or dsl with 
“dhcp,” it probably sets it up for you automatically. Click “Apply.”

  To check, open Safari and see if it goes to a web page. If it does, you’re done.

 b Use the  Network Diagnostics tool, as described in the following steps. 
Th is tool automatically appears when your connection goes down, but you 
can also call on it here whenever you need it. 

 6 Click the “Assist me…” button at the bottom of the Network pane. Th is drops 
down a sheet from the title bar, as shown below. For troubleshooting help, 
click the “ Diagnostics…” button.  

Click the 
“Assistant…” 
button if 
you want to 
 create a new 
connection.

 7 Th e diagnostics tool will check all the relevant settings on your Mac and ask 
you simple questions. If it can’t fi x the problem, it will at least pinpoint it so 
you can call your isp with the specifi c issue.
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Use the AirPort Admin Utility
If your connection is through an AirPort wireless setup, use the AirPort Setup 
Assistant and the AirPort Admin Utility to see if you can fi gure out what’s wrong. 
You’ll fi nd those tools in the Utilities folder, which is inside the Applications folder. 
Use the same trick as on the previous page—make a change that you don’t need, 
immediately switch back to the one you know is correct, then click the “Apply” button.

Unplug everything and reboot
Your modem box, whether it’s a dial-up, cable, or dsl, usually has a tiny reset 

button. It’s so tiny you need to poke it with a pin. Th at can sometimes get things 
going again.

If not, do the unplug routine (I have to assume you’re got all the wires in the right 
places). If you have a number of devices in your system, such as a switch, a router, 
and a modem box, unplug the items starting with the smallest one, the dumbest 
one. Th at would be the switch, if you have one. Next the router (which might be 
your AirPort). Last unplug the modem itself. Let everything sit for at least a minute 
or two. It’s not a bad idea to shut down your Mac as well.

Th en plug everything back in again in the opposite order—start with the most 
important item fi rst, the modem box. Let it get going and make sure all the lights 
are green. If the problem is in your modem box, call your provider.

Th en plug in the router, if you’re using one, and let it get going. Th en the switch. 
Let everything get running, then turn your Mac back on. And pray.

Sometimes we go through all this and give up. Shortly thereafter it starts working 
again. Sheesh. 

Talk to your ISP; check your cables
If everything seems okay on your end and you still can’t get connected to the 
Internet, call a friend who uses the same isp and see if she is connected (actually, we 
do this fi rst). If her connection is down as well, then just let go and wait until they 
fi x it. But if her connection is working, call the isp. Th ey can check your modem 
from their offi  ce and help pinpoint the cause. Also check your cables—they might 
have wiggled loose or one might have gone bad. Th ey do that sometimes. If you’re 
setting it up for the fi rst time and using Ethernet cables, make sure they’re the right 
kind; see page 372. 
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Troubleshoot your           Mail Account
If you have problems getting your email, there are several things you can do. Make 
sure your Internet connection is working, of course (check by making sure your 
browser can get to the Internet.) Th en check your account information in Mail 
(go to the Mail menu, choose “Preferences,” and click the “Accounts” tab): 

■ Th e Incoming Mail Server is information that you have to get from whoever 
hosts that particular email account. I have more than a dozen email accounts, 
not one of which is with my isp. So I need to get the Incoming Mail Server 
of each of the hosts where I have the email coming from. Typically it’s mail.
domain.com or pop.domain.com. And as I mentioned in the Mail lesson, some 
providers don’t allow you to get your email through a mail application like 
this; see page 75.

■ Keep in mind that some isps have a diff erent User Name and Password 
for your account with them than the user name and password to get your 
email. Th is is especially true if you’ve had the account for a long time. If your 
email account is not with your isp, then of course the account information 
in your Mail window is defi nitely not the same as for your isp. You might 
have to check their web site or call your email host and ask what to enter here. 

The Description is 
anything that will tell you 
which account this is. 

The Email Address and 
Full Name describe your 
mail to those you send it 
to so they know who it’s 
coming from. 

—continued



Lesson 21 Get Connected and Share Files

370

■ Th e  Outgoing Mail Server (SMTP) is always from your isp, no matter where 
your email account is located. Well, there are exceptions, like you can use a 
mac.com smtp, but in general, you are always assured of being able to send 
mail out if you use your isp’s smtp. If you don’t know what the smtp is, call 
and ask them or check their web site—it should be listed. For all fi fteen of 
my email accounts from a variety of servers, I use the same Comcast smtp 
because that’s who connects me to the Internet.

 To change your SMTP setting, click on the smtp menu and choose “Edit 
Server List….” Click the + button to add a server. Double-click the blue bar 
to add the smtp name. Make sure that is the selected server, then click ok.

 Some cheesy companies will not give you an smtp address. For instance, 
if you get a Qwest broadband account here in New Mexico, you’ll discover 
they are in cahoots with Microsoft and provide no smtp unless you pay an 
extra fee. You cannot use the Mail application—you are forced to go to the 
msn web site and do all mail online (where Microsoft can keep track of you). 
Change providers. 

Reminder: where to get the information
Your email provider’s web site should include the information for the incoming 
mail server, user name, and password. Your isp’s web site should provide the smtp 
(outgoing mail server) information. 

If you have a         free webmail account like Yahoo or Hotmail (which is Microsoft), you 
might not be able to set up Mail to check your mail. However, the free services often 
have a paid option as well, and with the paid service you can usually get the specs to 
set up your account in the Mail program. (But if you have to pay for it, why not get 
a .Mac account?) Check this wonderful web site for details on how to set up most 
webmail accounts to appear in Mail: www.EmailAddressManager.com.

www.EmailAddressManager.com


Lesson 21 Get Connected and Share Files

371

Use the Mail Connection Doctor
If your account information is correct but email still isn’t working, check this 
utility: In Mail, go to the Window menu and choose “Connection Doctor.” You’ll 
get the window shown below; it will automatically check your accounts. If it fi nds 
a problem, the dot is red; depending on the problem, you may be able to click the 

“Assist me…” button to help pinpoint the issue further.

In this case, 
I had the wrong 
information in the 
Accounts pane. 
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Share Files on a Local Network
File  sharing on a local  network is so great—as Apple says, your Mac just “discovers” 
other Macs. But it can’t discover them unless the computers are connected in some 
way. So fi rst, a wee bit about networking.

Simple networking
         Th e Macs you want to share fi les between must be networked together—you must 
have some sort of cable connecting them to each other or both to the same printer, 
or  AirPort cards installed so they can connect to each other wirelessly. 

Networking can get very complex and specialized! I am only going to explain the 
simplest method to get a couple of Macs  talking to each other.  

Ethernet cables
You might have to buy Ethernet cables.

■ If the cables are going from the computer into a hub, router, or switcher, 
or into a cable or dsl modem, you need straight-through cables—not 
crossover. Straight-through cables are the most common.

■ If the cables go directly from computer to computer (or any two Ethernet 
devices, like a Mac to a printer), you need crossover cables (see below).

To tell if an Ethernet cable is crossover or not, hold both ends up, facing the 
same direction, with the locking clips facing up. Look at the  colored wires coming 
through the end. 

■ A straight-through cable has the colored wires in exactly the same order. 

■ A crossover cable does not  have the colored wires in the same order. 

Just two computers?
Two computers can be connected with one crossover Ethernet cable or a FireWire 
cable for easy and instant fi le sharing on two working Macs. 

If you have one Mac that is having trouble and you want to grab fi les off  of it onto a 
working machine, use a FireWire cable and Target Disk Mode, as explained on page 
412. Target Disk Mode uses the target computer as a hard disk, without having to get 
its operating system working.

F
o
w
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What else you need
If you have a number of machines in your office, you will need something called 
a switch or Ethernet hub that can connect all of your machines, including your 
modem. Th e switch/hub will have a number of Ethernet ports; you connect each 
Mac to that box  with straight (not crossover) Ethernet cables. (If you want to share 
printers, see pages 299–301; it’s easy once you have your network working.)

If you have several computers in your offi  ce, a broadband connection, and all your 
Macs get on the Internet at the same time, you’re probably using a router—you’re 
already set up for networking. An AirPort base station can function as a router.

If the router doesn’t have enough ports for the items in your offi  ce, buy the small 
hub or switch mentioned above and connect the router to it with an Ethernet cable.

Peer-to-peer network
Th is simple network in a small offi  ce is called a   peer-to-peer network, where every 
computer is  considered a “        server,” which is a computer that can “serve” fi les to 
others. Th is is  diff erent from a client-server network in a large corporation, where 
lots of computers connect to one huge, main server and everyone gets fi les from that 
main server, rather than from each other’s computers. 

Turn on Personal File Sharing
Now that your computers are connected, you need to tell them it’s okay to share 
fi les. On each Mac, go to the Apple menu and choose “System Preferences….” Click  
the “  Sharing” icon. Put a checkmark in “File Sharing.”

Give each Mac a 
 name that clearly 
identifies it. 

This is the name 
that other 
computers 
will see when 
networking.

լ
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Connect to Another Mac
Once the Macs are connected in some way and you’ve turned on File Sharing in the 
Sharing preferences (as explained on the previous pages), you’re ready to connect.

Make sure you are in the Finder (single-click on any blank space on the Desktop). 
Th en follow either Process A or B.

Process A, directly through the Finder window:

 1 Open any Finder window. Click the Column View icon (circled below). 

 2 In the Sidebar, if your “shared” group is not visible, click its triangle to display 
the other computers on the network. 

 3 Single-click the name of the computer you want to connect to. 

  You are automatically connected as a Guest. What you see in the window 
above is the Home folder of another computer, and that’s actually his Public 
folder in the second column. As a Guest, that’s all you have access to. You can 
take copies of any folder in the Public folder, and you can put fi les into his 
Drop Box.

 4 To access the rest of this other computer, you need to know its name and 
password (the same name and password that the Admin uses to log in with).  
If you have them, click the “Connect As…” button and log in.

  If there is more than one volume on that other computer, you can Command-
click on any of them that you want access to. 

Now the tricky thing is to keep straight which machine you’re working on or which 
machine you are viewing in a window! It’s a good idea to stay in Column View so 
you can always see where a folder originates.
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Process B, through the Go menu:

 1 From the Go menu, choose “   Connect to Server….” Th e little window shown 
below appears. 

—continued

  If you know the name of the Mac you want to connect to (as shown in the 
Sharing pane of the other Mac; see page 373), type it in the “Server Address” 
fi eld, with “.local” after its name. 

  Or, what usually works more consistently, enter the afp:// number that 
you see circled on page 373.

 2 Click the “Connect” button. You’ll see this window:

   To connect as a Registered User so you will have access to the whole 
computer, you need to enter a name and password. Important! Even though 
this window shows up with your name in the fi eld, it doesn’t want your name and 
password! It’s asking for the name (long or short) and password of the computer 
you’re trying to connect to! Guess how long it took me to fi gure that out.

 3 Enter the name and password of the other computer, then click “Connect.” 

To connect as a Guest, 
you don’t need a name and 
password; see page 377.
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 4 Th e next window that appears lists the hard disk, the Home folder, and any 
partitions or other hard disks attached to the other Mac. Double-click the 
name of the one you want to connect to. 

  To have access to more than one of the partitions, hold down the Command key 
and click on as many as you want to connect to, then let go of the Command 
key and click OK. You can also repeat this entire process if you decide later you 
need to connect to another volume.

 5 On the Desktop of the computer you’re working on, you’ll see a   network icon 
for each volume you’re connected to, shown below-left. Double-click that icon 
to open a window to that drive, shown below-right.

It’s not an easy task to keep track of which windows are on which machine since 
they all have the same names! Don’t open any  applications or documents from the 
window of the other Mac because you will  actually be working on the other machine 
at that point, which might aff ect the person using it. It’s best to drag the necessary 
documents to your own computer before you open them.
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Connect as a Guest
Follow Step 1 on page 375. When you get to that window shown in Step 2, click the 

“Guest” button. Th en click “Connect.”

Create Favorite    servers
In the “Connect to Server” window (choose it from the Go menu at the Finder), 
type the name you want to connect to. Click the + button to add that server to 
your favorites in the list below. Now you can just double-click on a server name 
to connect to it.

Th e Mac opens the   Public folder of the computer you are connecting to, shown 
below. Th e only things you will have access to on the other computer are the 
fi les that user has put in her Public folder for you. Th e only place you can move 
documents to on the connected Mac is the Drop Box, shown below. 
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   Bonjour— Share Files Locally
Once your Mac is on a network of computers running OS X, version 10.2 or later, 
you can send fi les back and forth to everyone through Bonjour, which is part of 
iChat (in OS X versions earlier than Tiger 10.4, it’s called Rendezvous, not Bonjour). 
Th e iChat icon should be in your Dock; if not, it’s in your Applications folder. See 
Lesson 9 for details about iChat and Bonjour.

If you didn’t turn on Bonjour the fi rst time you opened   iChat, you can do it in the 
iChat preferences, in the Accounts pane:

But you can also turn it on with this shortcut: 

 1 Open iChat. 

 2 From the Window menu, choose “Bonjour List” (or press Command 2). 
If you’re not already logged in, it will ask if you want to start it up. 

 3 Click “Login.” 

And now the Bonjour List window is open as well, as shown on the next page.
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Send a file to someone on the network
Th is is so easy it will boggle your mind. 

 1 First open the Bonjour window, if it isn’t already: Open iChat, then press 
Command 2 (or from the Window menu, choose “Bonjour List”).

 2 Now drag a fi le and drop it on someone’s name in that list. Th at person will 
get a message that she has an incoming fi le.

 3 She clicks once on that message, then she has a choice to “Decline,” in which 
case the message will disappear, or “Save File,” which downloads the fi le to the 
Downloads folder. 

 Here’s another way to send a fi le (this also works in iChat). Just open a chat with 
someone in either Bonjour or your Buddy List (double-click a name, not a phone or 
camera icon, to open a text chat). Drop a fi le in the text fi eld and hit Return. 

What’s even more amazing is the screen sharing feature through iChat and Bonjour, 
as explained on the following pages.
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Screen Sharing
Screen Sharing enables you to share not only your screen but your entire computer 
either through your Finder on the local network, or through iChat with a buddy 
anywhere in the world. Th rough iChat, you can choose to either share your own 
screen (and computer) or share the buddy’s screen (and computer). 

Th is is great for anyone who has experienced the frustration of trying to give Mac 
support and instruction over the phone or through email. Now you can just activate 
Screen Sharing and watch as you give instructions. Or control the buddy’s computer 
while she watches and listens. When Screen Sharing is activated through iChat, it 
automatically starts an audio chat so you can discuss whatever matter is at hand.

You can screen share over a local network using Bonjour or the Go 
menu; if the other user is running 10.4 Tiger, tell him to go to his 
Sharing preferences and turn on “Apple Remote Desktop.” 
You can use Screen Sharing over the Internet through iChat; 
both computers need to be running Mac OS 10.5 Leopard. 

Set up screen sharing
Before you start Screen Sharing, make sure both computers have “Screen Sharing” 
selected in the Sharing pane of System Preferences:

 1 From the Apple menu, choose “Preferences….” Click the “Sharing” icon.

 2 Put a checkmark in the option called “Screen Sharing”; see the callout on the 
opposite page.

 3 If you have other users on the network, you can choose to allow only certain 
ones: Check the button, “Only these users,” then click the + button to add the 
ones you want. 

 4 Close the preferences and carry on.

 If you need to share files on a local network regularly, you can drag a folder 

from another computer and put it on your computer and even in your Sidebar. Then you 

can move and save files directly into that folder on the other computer. You don’t even 

have to go through the connection process ——as soon as you put something in that folder, 

it acts as an alias and makes the connection.
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Check the network for local screen sharing options
Below is the simplest and fastest way to connect to another monitor in your home/
offi  ce to screen share and access the computer. 

 1 In your Sharing group, select another computer running Leopard on the 
network. 

 2 You will probably see a “Share Screen…” button, as shown here. Click it, and a 
window immediately opens displaying the other computer. Amazing. 

 3 To stop screen sharing, close the window that the other computer is in.

Now, if you don’t see the “Screen Sharing…” button, as shown above, don’t despair. 
Th e process on the following page works very well. 
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Screen Share locally through the Go menu
Th is method is a quick and easy way to get to another user’s screen who is on the 
same network. You can also use Bonjour, which looks a little diff erent, as explained 
on the following pages. Using Bonjour, you’ll be able to talk to each other as well.

 1 First make sure you get the vnc address from the computer you want to 
connect to. Th is address appears in the Sharing preferences pane when you 
turn on Screen Sharing—you can see it circled on the previous page. 

 2 At the Finder, go to the Go menu and choose “Connect to Server….” 
You’ll get the window shown below.

 3 Type in the vnc address as shown below. Hit the “Connect” button.

 4 A window will appear on your Mac and inside that window is the other 
person’s entire computer! You can open his iTunes and play a song for him, 
or open Sticky notes and leave a message. It’s freaky.

 5 To turn off screen sharing, close the window of the other computer.

If you need to go to this 
computer often, click the + 
button to make the address 
a favorite. It will appear in 
this pane under “Favorite 
Servers” whenever you open 
this window.
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In this example, the user 
chooses to share his own screen 
with his buddy instead of 
sharing his buddy’s screen.

Screen Share globally through Bonjour and iChat
Of course, the buddy whose screen you want to share must have fi rst turned on 
Screen Sharing, as explained on the previous pages.

 1 To screen share through iChat, open either your Buddy List to screen share 
with someone over the Internet, or open your Bonjour List to screen share 
with someone on your local network. 

 2 You can tell which buddies have turned on Screen Sharing: When you click 
a name in the list, the Screen Sharing button at the bottom of the Buddy List 
or Bonjour List is black (instead of gray) for those who have turned it on.

 4 When you receive and accept the invitation to share someone’s screen, the 
other (remote) screen (the fl ower Desktop in the example) appears full-size on 
your screen, while your own Desktop appears as a miniature. When you mouse 
over the miniature screen, a “Switch to My Computer” message pops up. 

  To enlarge your own Desktop to full-size and miniaturize the remote screen, 
click anywhere on the miniature screen. Meanwhile, the buddy who initiated 
Screen Sharing doesn’t see any change on his own screen, even though you 
can now control his computer, grab fi les, open applications, or do anything 
he can do. 

This is the Screen Sharing button.

 3 Click a buddy’s name. Click that Screen Sharing button and choose 
“Share My Screen…” or “Share (Buddy Name’s) Screen….”
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To copy fi les between computers: Simply drag a fi le from one screen to the other. 
If the fi le you want is on the miniature screen, just click on the miniature screen and 
it will become large enough to fi nd the fi le you need. Drag it to the [now] miniature 
other screen; as you drag, hover over the miniature screen for a few seconds until it 
enlarges to full-size, then drop the fi le wherever you want to place it.

To end a Screen Sharing session: Click the circle-x in the top-left corner of the 
miniaturized screen. Or go to the iChat icon in the menu bar and choose “End 
Screen Sharing.” 



Lesson 21 Get Connected and Share Files

385

Disconnect
Disconnect from any   connected      servers in the same way you disconnect from any 
other hard disk.

■ Click the Eject symbol next to the server name in the Sidebar.

■ Or if the server is visible on the Desktop, drag its icon to the Trash.

■ Or select the server icon. Go to the File menu and choose “Eject.”

■ Or select the server icon and press Command E for Eject. 

■ Or Control-click on a server icon to get the contextual menu; 
choose “Eject ‘disk’.”

To hide or show the servers on the Desktop:

 1 At the Finder, go to the Finder menu and choose “Preferences….”

 2 Click the “General” tab, if it isn’t already selected.

 3 Check or uncheck the box to show “Connected servers.” When it’s unchecked, 
you won’t see the server icons on the Desktop, but they will all be accessible in 
the Sidebar.

 4 However, you can go to the Sidebar pane in those same preferences, (click the 
“Sidebar” icon in the toolbar) and choose to take server icons out the Sidebar 
and leave them on the Desktop.
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LESSON 22

Upgrade your Mac
and Migrate your Files

You may have just gotten a brand-new Mac with Leopard already 

installed, in which case you can skip this chapter altogether, 

unless you need to learn about transferring your fi les from an old 

machine to your new one. 

If you just got a new dvd with the Leopard installation, Mac OS X 

version 10.5, then you have a few choices to make before you 

upgrade. Th is chapter explains the choices you will need to make 

along the way and walks you through the process. 

Remember, before you do anything serious like upgrade your 

operating system, fi rst back up your important fi les. Th e easiest 

thing to do is drag your entire hard disk onto a FireWire hard disk. 

Always create at least two backups and store them in a diff erent 

places—it won’t do any good if all your important backups are in 

the same offi  ce that gets burglarized or fl ooded! 
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The Installation Process 
Of course you need the dvd    installation disk from Apple to start the process. Put 
the dvd in. Th is is what you’ll see:

I strongly suggest you read the fi le called “Welcome to Leopard.” And the fi le called 
“Read Before You Install” has up-to-date technical details that I haven’t been able to 
include here. For instance, it might be good to know that you can’t upgrade from 
Mac OS X 10.2.8 or earlier (you can replace, but not upgrade). 

It’s always a good idea to read the “Read Me” fi les before you do something like 
install a brand-new operating system that can potentially destroy everything on 
your Mac. So I suggest you read all those fi les. In fact, I suggest you print them 

before you start to install so you can have them to refer to.

Write down the specifi cations for your Internet connections and email accounts. 
Better yet, make a screen shot of the dialog boxes with their info so you can recreate 
it. To make a screen shot of the entire screen (with your specifi cations displayed), 
press Command Shift 3. Save those fi les (named Picture.png, Picture.png, etc.) 
onto another disk. If you have a .Mac account, sync everything to the .Mac server.

If you think your machine is capable and ready to start the installation process, 
double-click the fi le “Install Mac OS X.” Th is will restart your Mac and make it boot 
up with the install disc. If you are upgrading a Mac running some version of OS X, 
you will be asked for the Administrator name and password.

Or you could do this: Insert the dvd into your Mac. Th en restart and hold down 

the C key, which will force the Mac to boot from the dvd.



Lesson 22 Upgrade your Mac and Migrate your Files

389

Welcome to the Installer
         Th e fi rst thing you will be asked to do is choose the language in which you want to 
see all the menus and dialog boxes. Choose it and then click the button to continue.

Become familiar with this fi rst Installer screen because you may need to come back 
here again someday. Check out the Utilities menu and all the options available there. 
Th is is a wonderfully useful troubleshooting stop—when things go really wrong with 
your Mac, restart from the Installer dvd and use one of these utilities. Th ey are 
described in a little more detail on pages 396–397. 

If you need to quit
If you decide you need to quit the installation process at this point—after you 
restart with the disc but before you actually click the “Install” button—you can do so 
(do not quit once you start the installation process!): 

From the Installer menu next to the Apple icon in the menu bar, choose “Quit 
Installer.” A dialog box appears with buttons labeled “Restart,” “Startup Disk,” 
and “Cancel.” Read the following before you make your choice.

Once you quit, your Mac will   restart with the install disc again because it always 
looks fi rst in a disc drive to see if it can fi nd an operating system. So you need to 
force the dvd to restart from the internal hard disk on your Mac. You can do either 
of the following:

■ Choose “Restart.” As soon as you hear the bong, hold the mouse button down 
and keep it down. (On a laptop, hold down the bar beneath the track pad.)
Th is forces a cd or dvd to pop out, at which point you can let go of the 
mouse button. Without the disc, your Mac will start as usual. 

■ Or choose “Startup Disk” before you restart. You will see at least two options 
to choose from—the internal hard disk that you’ve been using, or the dvd 
that is currently in the drive. Choose your hard disk and click “Restart.”

If you absolutely must quit the installer while it’s running, understand that all the 
fi les on your hard disk will have already been destroyed. 
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Choose an   installation option
When you click the “Continue” button in the Installer screen, you will be asked (as 
usual) to agree to the software license agreement. If you don’t, you can’t install the 
operating system. 

Once you agree, you see a screen where you can choose the hard disk on which to 
install Leopard. If you have more than one choice, your Mac will usually choose the 
best one, but make sure it’s the one you want. It must be an internal hard disk. 

Th is screen has a very important button! Click the  Options… button! You have 
several options for the installation process. 

 1 Upgrade Mac OS X or Install OS X  for the first time

If your Mac is running an earlier version of OS X, you can choose to upgrade; 
the installer will replace your earlier version with this new one, Leopard. 
Your fi les, applications, preferences, and everything else will not be touched. 
Essentially, the next time you start your Mac it will look just the same, but will 
be running the new system with the added features. 

If you’ve never installed any version of OS X before, the option you have is 
to install it for the fi rst time. If your hard disk is currently running Mac OS 9, 
that operating system will be left intact—you’ll now have both. 

 2a Archive and Install

If you choose this option, the Installer will save your existing operating 
system and its related fi les into a folder called “Previous System Folder.” Th en 
it will proceed to install a brand new operating system, but all of your own 
documents and applications and fi les will be left intact in case you need 
to copy them over later. You will not be able to start up your Mac from the 

“Previous System Folder.” 

Th is is a good choice if you’re not sure about replacing your previous operating 
system. For instance, maybe you’re not sure if you have copies of all the fonts 
in the various font folders or preferences that you need for diff erent applica-
tions. By leaving the “ Previous System Folder” on your Desktop, you can work 
in the new system for a while until you’re sure you haven’t forgotten anything 
important. Eventually, delete the “Previous System Folder” because it takes up a 
heck of a lot of room on your hard disk.
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 2b Preserve Users and Network Settings

Once you choose to “Archive and Install,” another option is available if your 
previous operating system was OS X: Preserve Users and Network Settings. 
If you created   multiple users on your Mac, this option will save them so every-
one’s Home folders and preferences will be intact. 

Even if you have no extra users on your Mac, this option is still handy because 
you won’t have to go through the Setup Assistant during the installation 
process—the Mac will pick up your Internet settings and automatically apply 
them. By the time you see your new screen, you will be connected to the 
Internet as usual. 

 3a Erase and Install

If you have backups of all your important fi les and applications, you can 
choose to      completely erase your hard disk and install a brand-new version of 
the operating system instead of updating the old one. Th is is called a “clean 
install.” Th is is particularly great, as I mentioned, if your Mac is starting to act 
a little peculiar and you’d like to just start over, fresh and clean. 

Of course, if you do a clean install, you will destroy every single thing 

on your entire hard disk! So make sure you have       backups of anything you 
want to keep. My favorite method these days for temporary backups is a little 
  FireWire drive. I have one right now from SmartDisk.com, a little FireLite that 
fi ts in a shirt pocket, plugs into the FireWire port on the back of my fl at-screen 
monitor, and holds 40 gigabytes. I love it. 

 3b Format disk as

Once you choose to “Erase and Install,” your Mac asks how you want to format 
(reformat, actually) the hard disk. Your two options are “Mac OS Extended 
(Journaled),” which is most likely what you want, or “UNIX File System.” If you 
want the UNIX File System, I highly doubt that you are reading this book. Trust 
your Mac that it is correct in already choosing Mac OS Extended for you.

Make your choice of installation option, and then click the OK button. 
Th e “Destination” screen confi rms the option you just made, so click the 

“Continue” button.
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 Customize your installation
Th e next screen you see is the “Easy Install.” But you can customize your installation, 
which lets you delete unnecessary  printer driver fi les and language fi les. Th is can 
be useful if you don’t have a lot of   room on your hard disk (which is unlikely). If you 
need lots more room, this won’t help, but if you’re worried about space, try it.

Now, you can only customize this if you did not choose to upgrade! Th at is, you 
can only customize the installation if you previously choose to “Archive and Install” 
or “Erase and Install.” 

If you chose one of those options, or if the Installer tells you there is not enough 
room on your hard disk to install, click the button to “Customize.” 

■ In the list that appears, check the “Languages” checkbox. Th is displays all the 
foreign languages your Mac is going to install in case you ever want them. If 
you feel pretty confi dent you’re not going to be needing a number of those 
languages in the near future, uncheck their boxes. 

■ Th en check the “Printer Drivers” box. You can safely uncheck the drivers for 
printers you’ve never heard of. If you ever need a driver for a printer you’ve 
unchecked, you can always fi nd it on that vendor’s web site.

Install!

Now you’re ready to actually start installing. Click the “Install” button to continue. 
Actually, this button will say “Upgrade” if you chose to upgrade the previous system.
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Customize the Setup Assistant
After your Mac installs the operating system, but before it takes you to your 
Desktop, you will go through the Setup Assistant. Well, as I mentioned on page 391, 
you will skip the Setup Assistant if you chose the options to “Archive and Install” 
and then “Preserve Users and Network Settings.”

Th e Setup Assistant asks for information that will get you connected to the Internet 
and make sure the email program, Mail, can get your email for you. 

  VoiceOver option
During the Setup Assistant, one of the options you’ll see is VoiceOver. Th is is part 
of the enhanced Universal Access capabilities of Mac OS X. VoiceOver provides a 
spoken user interface (English only), which means the computer speaks to the user 
and describes what is going on. People with visual impairments can access just 
about everything on the Mac using the keyboard instead of the mouse. It’s quite 
amazing. 

In this introductory process, VoiceOver walks a user through keyboard practice, 
moving around the screen using the keyboard, typing in text fi elds, as well as 
selecting items in pop-up menus, scrolling lists, and control panes. 

If you choose not to practice VoiceOver at this point, you can always do it later at 
your leisure. See the VoiceOver preferences. 

The welcome screen
Most of the next few screens are self-explanatory—choose your language, the time 
zone, etc. 

You will be asked if you want to transfer your fi les from another, separate Mac or 
from a separate partition on the same Mac. Th is feature, called migrating, transfers 
over most of the fi les from your old machine to your new one. You can either follow 
the simple, on-screen directions and migrate your fi les right now. Or you can skip 
to page 397 and read about migrating before you do it. Or you can skip the entire 
process right now and do it later at your leisure, using the Migration Assistant (it’s 
in the Utilities folder, which is in the Applications folder. 



Lesson 22 Upgrade your Mac and Migrate your Files

394

The     network setup
You will be asked how you connect to the Internet. If you know how you connect 
and you know all the pertinent data that needs to be entered (it’s not much), follow 
the on-screen directions. If you run across information you don’t know, call your 
Internet Service Provider (the one you pay your monthly connection fee to) and ask 
them what to enter.

If you have a .Mac account, all you need to enter is your email address and password 
and the Mac sets up everything for you instantly.

If you don’t know the information at the moment, you can skip this part of the 
process altogether. You can always set your connection up later; it only takes a 
few minutes. If you want to do it later, check the button, “My computer does not 
connect to the Internet.”

If you want to set it up now, select your connection method and then follow the 
directions. If you run across places where you need to enter information and you 
don’t know the information, call your isp or click “Continue.” Either it will work 
without that particular information, or you can fi ll it in later (see Lesson 21 for 
details on fi lling it in later).

Your Apple ID
You will be asked to enter your  Apple id. If you have a .Mac account, your email 
address and password is considered your Apple id. Use your entire .Mac email 
address, including your member name, the @ symbol, and “mac.com.” 

If you’ve ever bought songs on iTunes or photos from iPhoto, you have an Apple id.

If you do not have a .Mac account or any other Apple id that you know of, leave the 
fi elds blank and click the “Continue” button. 

Other details
Th ere are a few more screens asking for information from you, like personal details 
and where you will use this computer. It’s easy.
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 Create your account
Th is is very important! What you are creating here is your  Administrator 

account as the primary user, as well as your    Administrator password. Write 
down this password because your Mac will not let you install new software or 
upgrades or make specifi c system changes unless you can provide this password. 
Th e  hint you provide is important, also—if you forget your password and enter the 
wrong one three times, this hint will appear on the screen. 

You can leave the    password fi eld  blank if you have no worries about anyone ever 
using or stealing your Mac. But I suggest you write down that you left it blank; it is 
just as easy to forget that you did not enter a password as it is to forget which one 
you used. You might spend hours trying all kinds of diff erent passwords only to 
fi nally realize you didn’t give it one and all you needed to do was hit the Return key. 
Guess how I know this. 

Make sure the  short name is something you want to keep because you will never 
be able to change it. When asked for your Administrator name, you can usually use 
either the long name or this short name. 

Done!
It takes just another minute or two to fi nish it up. Apple will try your modem 
connection and register you instantly. (If it can’t register because your connection 
is not set up yet, it will save the information and do it the fi rst time you connect.) 
Continue on and you will see your new Desktop! 

ի
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Take Advantage of the Utilities in the Installer
When you run the Installer and get to the fi rst screen, you’ll see a menu item called 

“Utilities.” Th is menu gives you access to a number of troubleshooting features on 
your Mac. If you like, you can stop here before installing Leopard and use the Disk 
Utility to partition your Mac. 

All of the utilities mentioned below, except “Reset Password,” are in your Utilities 
folder, which is in your Applications folder. You don’t need to use the Install disk to 
access them. But if your Mac has totally crashed and you can’t get anywhere at 
all, insert the original Leopard install dvd, then restart your Mac. Immediately hold 
down the C key to make sure it boots from the dvd. Do not click any of the installa-
tion buttons, but use the tools that are available here. 

From the Utilities menu, choose the appropriate tool:
■            Startup Disk: Choose which disk you want your Mac to check fi rst when 

starting up. Only disks that contain operating systems can be used as startup 
disks.

■ Reset Password:  Here you can reset not only the    Administrator  password, 
but the passwords for every user on the Mac. You do not need to know the 
original passwords to set new ones. 

■  Firmware Password Utility: Th is option prevents others from starting your 
computer with a diff erent disk. If someone stole your laptop, this won’t get it 
back for you, but it does make it much more diffi  cult for anyone to log in and 
get your data. 

■  Disk Utility: Select your hard disk and use the “First Aid” pane to see if 
anything’s wrong with the hard disk. Th e “Repair Disk Permissions” feature 
has solved some odd problems for my Macs. Th is is where you can  partition 
the hard disk before you install. 

■  Terminal: Th e Terminal lets you use unix commands to do all sorts of things. 
If you don’t know anything about unix or how to use the Terminal, skip this 
altogether.

■  System Profi ler: Th e System Profi ler tells you all the gory details about your 
Mac, the cpu type, the audio, what kinds of devices are attached to your 
Mac, the speed of everything you can think of, and oh so much more. It will 
even tell you the  serial number of the computer. Th is is also available at your 
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Do you Now Own Two Macs? Migrate!
If you have important information on another Mac (a completely diff erent machine 
from the one you are installing Leopard onto) or a partition or volume on the new 
Mac, you can  transfer the information from the older machine, partition, or volume 
to this new Mac. You’ll use a feature called    migrating and the Target Disk Mode.

You can either use the Setup Assistant during the Leopard installation, or at any 
time in the future—open the  Migration Assistant and do it; the instructions on 
screen are easy to follow. You can choose to migrate the fi les from the Administrator 
(main user), from any individual user, or from both. Th e information on the old Mac 
or partition is not aff ected at all. 

The  migration process can automatically transfer:

■ Network and computer settings.
■ User accounts, preferences, and email.
■ Documents and other fi les.
■ Applications. 

 Some applications, however, will need to be reinstalled from their original 
disks because they install necessary fi les in diff erent system folders. All you 
can do is transfer them, then open them and see if they work. Th e more 
expensive and complex an application, the less likely it will transfer perfectly.

Desktop: Go to the Apple menu, choose “About Th is Mac,” and click the 
button labeled “More Info….”

■  Network Utility: Th is utility has a number of great tools. If you know what 
it means to  fi nger someone,  ping your modem, run a  lookup or a  port scan, 
or when to use  whois, then you’ll have fun with this utility. It’s also in your 
Utilities folder (which is in the Applications folder) in case you need it.

■ Restore System From Backup… uses Time Machine, which is a big clue that 
it can’t restore the system from a backup until you’ve fi rst put it all on Time 
Machine (see Lesson 20). But once you’ve done that, you can use this option.

—continued
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Requirements for the   Migration Assistant

Th e old Mac must: 
■ Be running Mac OS X version 10.1 or above. 
■ Have a built-in FireWire port.
■ Support “Target Disk Mode.” Apple says that “most do.” 

You’ll also need:
■ A standard FireWire cable long enough to reach between the two computers. 

Or move the computers so they can connect via the cable.
■ An Administrator name and password (unless you’re doing this during 

the Leopard installation).

Be aware that:
■ Th is process will tie up both your Macs for hours!  
■ Th is process will not automatically migrate songs that you bought from the 

   iTunes Music Store. If you want to migrate all of your songs, including 
those you bought at the Music Store, fi rst deauthorize the old Mac before you 
migrate fi les: 

 1 Open iTunes.

 2 From the Store menu, choose “Deauthorize Computer….” 

 3 Enter your account and password. Click the button to “Deauthorize,” 
then click OK. 

 4 To deauthorize any Audible content (books) to migrate over to the new 
machine, go to the “Advanced” menu and choose “Deauthorize Audible 
Account….” You’ll need your Audible.com name and password. 

 Be careful with your iPod—if iTunes on your new Mac has no music 
in it when you plug in your iPod, everything on your iPod will probably 
be erased to match your empty iTunes!
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Migrate additional users 
At any time you can migrate additional users and their fi les from other computers. 
Just follow the directions on the previous pages. 

You can also use this FireWire Target Disk Mode at any time to transfer fi les from 
one Mac to another; see page 412. Th is technique is especially useful if one Mac is 
dying, because in Target Disk Mode, the target computer does not use its operating 
system—it acts like a plain ol’ hard disk. 

What to do after  migrating
It’s a good idea to do a quick check of the fi les on your new Mac after migrating. 
Open every application to make sure it works okay—make a quick fi le and try to 
save it. If an application doesn’t work, you will just have to reinstall it from the 
original disks. 

Open sample fi les by double-clicking on them to make sure they can open 
in the correct application and that their fonts appear correctly.

Connect to the Internet, check your mail, and take a peek at your System 
Preferences to make sure things are really how you like them. 

 Do not unplug the    FireWire cable before you unmount the icon of your old 

Mac from your new Mac running Leopard! Even though it’s “ hot swappable,” which means 

you don’t have to shut down, it’s still possible to lose data if you unplug it while the icon is 

still visible on the screen.

Find the hard disk icon of your old Mac on the Desktop of the Leopard computer. Drag it to 

the Trash before you unplug the FireWire cable. 
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Other  Ways to   Transfer Files from Mac to Mac 
Th e migration process can take quite a long time because it gathers up thousands 
of fi les. If you want to transfer just selected fi les, you might want to consider these 
other options. Some you can do before you install Leopard; others are new tech-
niques that can only be accomplished in Leopard.

Use an external disk  

Use a portable hard disk with a usb or FireWire connection. It’s worth it to buy one 
just for this process. Copy the fi les onto the disks as you usually would from your 
old machine (drag them from the hard disk of your old Mac onto the disk icon). 
Th en connect the drive to the new machine and copy them onto your hard disk. 
If you have a very old Mac, the trouble, of course, is fi nding drives that work on both 
an old Mac and the new one (or fi nding software on that old Mac that will run on 
the new one). Th e actual disks should work on both Macs, even if the drives you use 
are diff erent.

Burn a CD

If your old machine can burn a cd (or a dvd) you can transfer quite a few fi les by 
burning disks and moving them to the new machine. Plus you’ll have ready-made 
backups (always the smart thing to do).

Send attachments in email

If you don’t have huge fi les, send them as attachments through email. It’s kind of 
funny to send your fi les around the world to get to the machine sitting two feet away. 

Use your .Mac account

If you have a .Mac account, put the fi les from your old Mac onto your iDisk (see 
www.Apple.com/dotmac). On your new Mac, download them from your iDisk. Also 
take advantage of syncing your Macs through .Mac—a terrifi c option.

www.Apple.com/dotmac
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Send files through the network

If both machines are on the same network, connect the two computers and copy 
fi les directly from one to the other. See Lesson 21 for all the details. It’s really easy 
and you’ll love knowing how to do it.

Use a FireWire cable

Connect a FireWire cable between two Macs. Th e other Mac will appear in the 
“Shared” group in the sidebar of a Finder window. You will probably be able to screen 
share (see pages 380–385). Or at least you can connect to each other and easily 
move fi les back and forth (see Lesson 21). Also look at the FireWire Target Disk 
Mode option; see page 412.
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LESSON 23 

Basic Troubleshooting

When things go wrong, here are a few simple troubleshooting 

techniques you can try. 
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Force Quit an Application 
Sometimes just one application has trouble and you need to force it to quit. Th ere 
are two ways to force quit any application. Th is doesn’t aff ect any other application 
or the system. If an application isn’t responding to anything you ask it to do, if it’s 
hung up and the wheel keeps spinning, or it won’t let you quit, then force quit the 
app. After you’ve force quit an application, try restarting it. It should be fi ne. 

■ Hold down the  Option key and press (don’t click) on the application’s icon 
in the Dock. A menu pops up with a choice to “Force Quit.”  Choose it.

■ Or press Command Option Esc. Th e window called “Force Quit Application” 
appears. From this window, select the application you want to force quit 
(if it isn’t already selected), then click the “Force Quit” button. 
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Restart
It’s amazing what a simple restart will fix. Especially if you rarely turn off  your 
Mac (like me), sometimes little things may start acting a bit quirky. Perhaps your 
Mac can’t find the printer you’ve been using for months, or icons for new files don’t 
appear. For little unexplainable things, restart.

■ To Restart, go to the Apple menu and choose “Restart….” 
■ On most laptops, press the Power button for one second and you’ll get 

a little message with a button to restart.

If you can’t restart, then Shut Down; see below.

Shut Down
Sometimes shutting down fi xes small problems that a restart doesn’t fi x. Th is is 
especially useful when you’re having connection problems. 

■ To Shut Down, go to the Apple menu and choose “Shut Down….” 
■ Sometimes things are so bad you can’t even get to the Apple menu. In that 

case, hold down the Power button (the one you push to turn on your Mac) 
for at least fi ve seconds. Th is forces it to shut down. 

Relaunch the Finder
You can’t force quit the Finder, but you can    relaunch it, which only takes a minute. 
If things are acting a little squirrely, try this. It doesn’t hurt anything.

■ Hold down the Option key and press (don’t click) on the Finder icon in the 
Dock. A menu pops up with a choice to “Relaunch.”  

■ Or press Command Option Escape, as explained on the opposite page, 
to open the “Force Quit Applications” window. Select the Finder in the list, 
and the button changes to “Relaunch.” Choose it.  
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Delete the Application Preference File
Another tip to troubleshoot an application that isn’t acting right is to delete that 
   application’s preference file. Th is is perfectly safe—when the application opens up 
again, it will recreate a new preference file from scratch. You will lose any prefer-
ences you had personally changed in the application, but it can be worth it because 
this works pretty well to solve inexplicable annoyances in applications.
 1 Quit the application.
 2 Open a Finder window and view it by columns, as shown below.
 3 Single-click your Home icon in the Sidebar.
 4 In the column that appears to the right, single-click the “Library” folder.
 5 In the next column to the right, single-click the “Preferences” folder.
 6 In the next column to the right, find the “.plist” file for an application that’s 

giving you trouble. Th at is the preferences file. Some vendors include their own 
preference fi les as well that might be named something else, as shown below.

 7 Drag the application’s preference file to the Trash. Empty the Trash. 
 8 Restart the application and hope it works better.

The preferences 
for Apple 
applications 
have an extension 
of .plist.

The preferences 
for non-Apple 
applications may 
also have their own 
names for their 
preferences. These 
are the prefs for 
the Mariner Write 
word processor.
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Safe Boot
Th is is one of my favorite troubleshooting techniques. During a safe boot the Mac 
actually goes in and fi xes little things. If you’ve ever used the terminal commands to 
do the fsck technique, you’ll be pleased to know the safe boot does the same thing. 
Th is is safe and easy and comfortable and fi xes lots of mysterious problems.

 1 Go to the Apple menu and choose to “Restart….” If you’re having such 
problems that you can’t even get to the Apple menu, hold down the Power 
key for fi ve seconds to shut down the machine. Th en restart.

 2 Immediately upon hearing the startup bong, hold down the Shift key and
keep it held down. Th is might take a while, like fi ve minutes or even more. 
Be patient. Keep that Shift key down. You’ll probably come to a log in screen 
that says, in red, “Safe Boot.” If not, no worries; go to the next step.

 3 When you get to the Desktop or to the log in screen, restart immediately 
(either click the restart button if you see one, or go to the Apple menu and 
“Restart”). Th e Mac needs to restart to put everything back and turn every-
thing on. See if things work a little better now. 
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Repair Permissions 
For some reason (unbeknownst to me), something called “permissions” can go bad 
and cause trouble. Repairing the permissions solves many mysterious things. 

 1 Open Disk Utility: Go to the Applications menu and open the Utilities folder. 
In the Utilities folder, fi nd the Disk Utility and open it. You’ll see this:

 2 Select the hard disk in the left pane. Make sure the “First Aid” tab is selected.

 3 Click the button to “Repair Disk Permissions.” 

  Depending on how much stuff  you have on your hard disk, this can take up 
to twenty minutes or so. If the Mac fi nds any permissions that need to be 
repaired, it will repair them.

  If it fi nds things it can’t repair, as you see above, then you need to go 
to the next step and verify and repair the disk. See the following page. 
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Verify and Repair Disk
First, go through the steps on the previous page to repair permissions, just to clear 
any little things up. Don’t quit the Disk Utility yet. 

If you think the disk might need to be repaired, or if you just want to check to see if 
the disk has a problem, click the button in Disk Utility (shown on the previous page) 
to “Verify Disk.” Th is will make sure that the disk really does have a problem that it 
might be able to repair. 

If the disk needs to be repaired, you can’t do it with this Disk Utility. You need the 
original OS X install disk because Disk Utility can’t repair the disk it’s stored on. 

So get the original install disk that came with your Mac. It’s a cd or dvd. Th en:

 1 Insert the original install disk. Double-click the “Install” icon as if you were 
going to install the system again. 

 2 At the Welcome window, do not install! Go to the Utilities menu at the top 
of the screen. Choose “Disk Utility….” 

 3 You get the window shown on the previous page. Now you can click the button 
to “Repair Disk.” Let it run through its process. It might take up to a half hour 
or more. Be patient.

 4 When it’s done, it will probably tell you it has repaired the disk. If it can’t, it 
must be a serious problem and you need to take it to a repair shop. 

 5 Quit Disk Utility and quit the installer. 

 6 It might ask you to choose a startup disk because if you don’t, when you restart 
your Mac it will boot up from the cd again. If it asks, you will see the disk 
options; single-click on your hard disk, then click the “Restart…” button.

  Or restart without choosing a disk and hold the mouse button down until it 
has restarted. Holding the mouse button down forces the cd to eject so it can’t 
be used to boot the machine. (If you’re on a laptop, hold down the bar under 
the trackpad.)
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Check for Software Updates
Make sure you are using the latest versions of all your      software. For your Mac OS 
software, use the Software Update preferences to see if everything is up to date 
(open it in the System Preferences, as described on the previous pages). It’s espe-
cially important to check for updated application software when you update your 
operating system, like when moving from any other OS to Leopard. 

M
s
(
c

 If your connection to the Internet is a dial-up through a telephone modem, 

do not check the box to “Download important updates automatically” because it will tie up 

your phone line for hours. Check for updates manually (click “Check Now”).

Create Another User and Test
If you install new software and it just won’t work right, or perhaps it won’t even 
open, one good troubleshooting technique is to create another user (see Lesson 18) 
and install the software in that user’s Home. See if it works. If it doesn’t work for 
the new user, the software itself has a problem—check the package it came in or 
with the vendor you bought it from to make sure it is the correct version for your 
operating system.

If the software does work for the other user, that indicates there is something in 
your system that is conflicting. Try throwing away the preferences, as explained 
on page 406. If it still doesn’t work, you may need to contact the vendor to find 
out what sorts of cache files or other files may be conflicting with that particular 
software. 
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If you Forgot your Password
If you forgot the     password you entered when you first set up your new Mac or 
installed your new system (called the  Admin password), you’ll have to use the 
original install cd to fix the problem. (I think someone told you that you should 
have written down your password.) If you have created more than one user for your 
Mac, you can use these steps to change the password of any     user. 

 1 Get the original cd. Put it in and double-click the “Install”  button. 
Follow the directions to restart. No, you are not really going to  re-install 
the entire system. 

 2 All you need to do is wait until the Welcome screen appears. Th en go 
to the Utilities menu at the top of the screen and choose “Reset Password….”

 3 Enter your new password—twice. And add a hint.  
  And write that password down where you can find it again. Click ok.

 4 Quit the installer from the Installer menu. Your Mac will restart (it might ask 
you to choose a startup disk—choose your hard disk).

If you did not enter a password when you first set up your Mac, then you can 
leave the  password field empty and just hit the blue “ok” or “Continue” button and 
it will work just fine (although it’s not secure at all). 

   Report Crashes
Often when an application crashes, an alert box appears and asks if you want to 
send a report to Apple. Now, Apple is not going to write you back—this is just an 
anonymous report you send in so Apple can figure out if there are common issues 
among many users, enough to warrant looking into. It’s good to go ahead and send 
in the report.
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Use Target Disk Mode
It’s not unusual to need to move lots of fi les from one computer to another. If both 
computers are working fi ne and you just need to share fi les, there are lots of ways to 
do it. Please see Lesson 21, and check the index for “sharing fi les.”

But sometimes one computer is just about defunct or maybe won’t wake from sleep 
and you’ve got to get the fi les off  quick. Use FireWire Target Disk Mode. You’ll 
need a FireWire cable that can connect to both Macs. A FireWire cable with 6-pin 
on both ends will probably fi t both computers, but check your ports before you buy.

■ Unplug all FireWire devices from both computers that you are going to 
connect to each other. 

■ If FileVault is enabled on the computer you want to take fi les from, 
turn it off  (if you can). 

■ If either machine is a laptop, it’s best to plug in its power source. 
■ Th e machine you are going to transfer fi les to is the host computer.

Th e machine you are going to take fi les from is the target computer. 

In this process, the target computer will appear as a hard disk on the host computer 
and you can move fi les to and from it.  

 1 Turn off  the target computer (the one that’s probably going bad). 
Th e host computer can stay turned on.

 2 Connect the two computers with the FireWire cable.

 3 Turn on the target computer and immediately hold down the T key and keep 
it down. Keep it held down until you see a FireWire symbol (shown above) 
moving about its screen. 

 4 On the host computer, you will see a hard disk icon representing the target 
computer. You can copy fi les from the target computer and put fi les onto it. 

  If you don’t see the target computer’s hard disk on the host screen, make sure 
all the cables are securely attached and reboot the host computer.

 5 When you’re fi nished copying fi les, eject the target hard disk icon from the 
host computer—drag it to the Trash, or select it and choose “Eject” from the 
File menu.

 6 Press and hold the target computer’s power button until it turns itself off .

 7 Unplug the FireWire cable. 

This is the 
FireWire 

symbol.
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Force a CD or DVD to Eject
If a cd or dvd is stuck in the drive and won’t come out, this trick almost always 
works:

 1 First make sure you’ve unmounted the disc: Click the eject icon on the screen, 
or drag the cd icon to the trash, or Control-click on the cd icon and choose 

“Eject disc.” 

  But you’re probably reading this page because you already did that and there is 
no icon on the screen but it won’t come out. So . . .

 2 Restart your Mac. As soon as you hear the restart tone, hold the mouse button 
down. Hold it down until the disc pops out.

  On a laptop, press the bar beneath the trackpad instead of the mouse (unless 
you have a mouse attached to your laptop). 

If that doesn’t work, see if there is a tiny hole next to the cd drive slot. Not all Macs 
have a tiny hole here. But if you see one, that hole is specially made for a paper clip 
(not the kind with the plastic coating). Unfold a metal paper clip and gently but 
fi rmly press it into the hole to snap open the mechanism.

One thing that can cause a huge problem in a cd/dvd player is a disc with a paper 
label glued to the top. If the tiniest little edge peels up, it can get stuck in the drive 
and ruin not only the disc but the drive itself. So don’t be buying those cd labels 
that you can print yourself, and don’t put any disc with a paper label into your Mac!
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Learn your security 
options

Use passwords 
to log onto your Mac

Require a password to 
wake computer and 
unlock preferences 

Securely empty the Trash

Protect information using 
Keychain Access

Use FileVault 
to secure data
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LESSON 24

Secure your Mac 
and its Files

In these days of identity theft and with so much of our personal 

and fi nancial data being stored on our computers, it’s important to 

take some precautions to make it more diffi  cult for unauthorized 

creeps to gain access to our Macs. 
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Know your Security Options
Th ere are a number of  security features on your Mac. Apple has installed lots of 
security stuff  like  Kerberos,  Secure Shell,  Wired Equivalent Privacy data encryption, 
 Virtual Private Network,  firewalls, and other features. It doesn’t matter to most 
of us what those are—they work behind the scenes. Your Software Update (one 
of the System Preferences) will automatically update    security features as Apple 
releases them. 

Th e above features work without you having to do anything. Th e features that 
require your participation are explained on the following pages:

■ Th ere are a number of password-protect options on your Mac that 
make it diffi  cult to gain casual access.

■ You might need security from humans who walk past your desk when 
you’re not there. Your Mac has a number of low-level security features 
to protect your information from the curious. Th ese are good for laptops 
as well.

■ Keychain Access stores many of your passwords in locked “keychains.” 
Th is includes passwords to your .Mac account, servers, eBay account, 
PayPal, and more. Keychain Access also lets you store passwords and 
codes for other things, such as credit card numbers you might like to 
use while shopping online. Keychain Access does double-duty—it makes 
things easier for you and harder for thieves. Please see pages 424–425 for 
details.

■ If you have highly personal or valuable stuff  on your Mac, you can use 
FileVault for maximum security. If you have a laptop, this is especially 
important to prevent thieves from accessing your data.  

■ And don’t forget about the feature to Secure Empty Trash. Th is deletes 
files from your Trash in such a way that no one can retrieve them again. 
See page 423.
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Passwords on your Mac
You have several diff erent passwords on your Macintosh. 

■ Administrator password: When you first turn on your Mac, you are 
asked to create a password. Write this down in a safe place! You will need 
this password whenever you install new software or when you make certain 
system-wide changes.

 You can choose not to have a     password. Your Mac will still ask you to enter a 
password, however—if you never entered one, just leave the password field 
blank, and click the OK or “Continue” button. But keep in mind that it’s not 
very safe to neglect this password.

 If you forget your Admin password, you will need to reset it:

 1 Insert the original Mac OS X installer cd. 

 2 Double-click the “Installer” icon to start the process of reinstalling.   
You are not really going to reinstall!

 3 When you get to the Install screen, go to the Utilities menu. 
Choose “Reset Password….”

 4 Enter your new password. Write it down in a safe place!

 5 Quit the Installer from the Installer menu.

■ Login password: If you have set up multiple users on one Mac, each user 
has her own password to log in. An Admin password is also the login password 
for that Admin user. By default, your Mac is set to auto-login the Admin so 
you don’t need your password at startup, but you can turn this off  to make 
the computer less accessible (see Lesson 18 for details about multiple users 
and log in). 

—continued



Lesson 24 Secure Your Mac and its Files

418

 If a standard user forgets his     password, the Administrator (or anyone who 
knows the Admin password) can reset the user password in the Accounts 
preferences. 

■ Keychain Access password: Th is is the same as the login password, whether 
you are a standard user or the Admin (you can change it to create a special 
keychain password). Keychain Access is the application on your Mac that 
keeps track of a variety of passwords for you. If you can remember your login 
password, then Keychain Access can show you the rest of your passwords. See 
pages 424–425.

■ Master password: An Administrator can set up a computer-wide password 
in case he forgets the login password. Master passwords are usually used in 
conjunction with FileVault; see pages 426–427. Th e Admin’s Master password 
can override a standard user’s FileVault password. 

 What to do if you forget the Master password? Well, you can scream. It won’t 
help, but you can scream. 

Password tips
■ A password should be difficult for others to guess, but easy for you to 

remember.

■ Don’t use a word that can be found in a dictionary. Some hackers use software 
that tries every word in the dictionary in a matter of minutes.

■ Combine caps and lowercase and numbers. 

■ Most passwords are case-specific, meaning a lowercase “r” is completely 
diff erent from an uppercase “R.” Take advantage of this and put capital letters 
where someone wouldn’t expect them. 
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Security System Preferences
Apple makes it easy for you to turn on a number of the low-level security features in 
one place, the Security system preferences. 

Go to the Apple menu and choose “System Preferences….” 
Click on the Security icon. 
Click the “General” tab, as shown below.

Require password to wake computer: See page 422.

Disable automatic login: See page 421.

Require password to unlock every System Preference: Th is would prevent any 
user from changing any of the preferences without a password.

Log out automatically after a certain period of time: Th is does just what it says. 
Combine this with “Disable automatic login,” so when the Mac logs 
you out after this amount of time, no one can get back in without a 
password.

Secure virtual memory: In the Mac’s process of swapping data between ram 
(random access memory) and virtual memory, it’s possible that 
sensitive information that you assumed was deleted from ram was 
actually written to the hard disk through virtual memory. Using secure 
virtual memory ensures that the sections of the hard disk that were 
used in the memory-swap process get overwritten, thus protecting 
your privacy. Th is is turned on by default.

For details on how to 
create multiple users, see 
Lesson 18. Even if you are 
the only user, you have 
what the Mac considers 
to be an “account.”
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Th e Firewall pane of the Security preferences is not something you will mess with 
very often, if at all. Th e most important thing to understand is that as you use 
Sharing features (turned on and off  in the Sharing preferences), the Mac lets down 
the fi rewall (a protective barrier) for the features you have turned on so others can 
access your machine to share. Th is means you are at a little more risk than if that 
feature was not turned on. So if you’re not using a feature, turn it off  so the fi rewall 
goes back up. 

You can’t turn any of these features off  in this pane—go to the Sharing preferences 
pane and uncheck them. When you do that, they automatically disappear from here.
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Low-Level Security Features
Here are some simple and quick features to take advantage of if you have any worry 
at all about casual access to your computer.

Auto login
■ Turn off     auto- login: Auto-login lets your Mac start up without a password 

—it automatically logs in the person who has “auto-login” turned on in the 
Accounts preferences “Login Options.” 

 So turn off  auto-login and then be sure to log out before you leave your 
computer for a while. Th is ensures that people walking by will need a 
password to log in to your account, even if they restart your Mac. Laptops 
should always require a login password.

You can also disable 
automatic login 
for all users in the 
Security preferences 
pane, as shown on 
the previous page.

■ If you don’t want to turn off auto-login, you might want to at least take 
the extra step to uncheck the box to “Show the Restart, Sleep, and Shut Down 
buttons.” Because if auto-login is on and you log out and leave your Mac, the 
login screen appears and you think you’re safe. But someone can just click the 
Restart or Shut Down button and the computer starts back up again and auto-
matically logs in to your account. By unchecking this box, no one can restart 
your computer so easily.

 Th is precaution isn’t going to help much if your laptop is stolen because 
someone can just reboot the computer. Nor will it help if the Restart button 
is accessible on your desktop machine!

—continued
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■ Mac OS X lets you have multiple users on one computer, and each user has 
a separate, private Home area (see Lesson 18 for details). Even if you are the 
only one using this Mac, you can   create another user, a standard user who 
has no administrative privileges, and regularly log in as the standard user. Th is 
is a simple step that just makes it one level more difficult for someone to get 
into your main account and make system-wide changes. It won’t protect any 
data that you create as that user, but it will make it more difficult to get into 
your Mac as the Administrator with privileges.

Require a password to wake your Mac
To prevent access to anyone walking by your computer, you can use these simple yet 
eff ective features. Open the System Preferences from the Apple menu, and then:

 1 Use the       “Security” preferences to require a password to wake up the Mac 
from sleep or from the  screen saver. 

 2 Th en go to the        “Desktop & Screen Saver” preferences to choose a  screen 
saver and tell it when to start. 

 3 Th en go to the “Energy Saver” preferences to tell your Mac to put either the 
computer and/or the display (the screen) to sleep after a certain amount of 
time. Now when the screen saver comes on or your Mac goes to sleep, you’ll 
have to enter your password to get back to it.

An alternative to the above technique is to set up your Mac so you can  lock it with 

a mouse click whenever you choose, not just when the screen saver comes on or 
when it goes to sleep. 

 1 Open Keychain Access (first open the Applications folder, then open 
the Utilities folder; Keychain Access is in the Utilities folder).

 2 From the Keychain Access  menu across the top of the screen, 
choose “Preferences….”

 3 Check the box to “Show Status in Menu Bar.” A padlock icon appears 
on the right side of your menu bar, as shown on the next page.

 4 Quit Keychain Access.
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 5 Click the padlock icon that now appears in your menu bar to get the 
menu shown below.

 6 Choose “Lock Screen.” Th e screen saver will start and no one can access 
your Mac unless they know your login password. 

Higher-Level Security Features
■ Secure Empty    Trash: You might think that after you empty the Trash, 

it’s gone. But it’s possible to recover many deleted files using special data-
 recovery software. If you are selling or giving away your Mac, you might 
want to make sure no one can recover your old, trashed files. To completely 
overwrite files so no one can ever get to them, go to the Finder menu and 
choose Secure Empty Trash. Th is might take several minutes, depending 
on how much stuff  you’ve thrown away since you got the computer!

■ Encrypt a disk image: Using the Disk Utility (found in the Utilities folder, 
which is in the Applications folder), you can protect all or part of your hard 
disk by making a selected portion of it into a password-protected “disk image,” 
which looks like a hard disk icon. It has its own password; if your Keychain 
is locked (see the following pages), this image is really safe from prying eyes 
and fi ngers because someone would need both passwords to access the disk. 
When unlocked, this disk image acts just like any other hard disk and you can 
move fi les in it, copy fi les to it, and delete fi les from it. I recommend you read 
all about this feature in the Disk Utility Help fi les before you start using it. 
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Use Keychain Access for Protection
Keychain Access provides a secure place to store information that can only be 
accessed with a user name and password. Keychain automatically and safely stores 
the passwords you create on your Mac, like those for web sites you go to, servers 
you connect to, email accounts, etc. Every time you see one of those messages that 
asks if you want your Mac to remember this password in your keychain, it gets 
stored here in Keychain Access.

You can also add your own secure collections of Keychains to store your credit card 
numbers, pins, bank card information, private notes or messages, and other things 
that you want easy access to, but you want them to be secure. Th ey won’t be entered 
automatically anywhere—it’s just a safer place to store them than on a sticky note. 

Keychain Access sets up your initial Keychain fi le, the one based on your user name 
and password, as the default Keychain. Th is default Keychain automatically opens 
when you log in. To make other Keychains more secure, such as your list of credit 
card numbers or banking passwords, be sure to make new Keychain fi les for them 
instead of adding them to your default fi le. 

To open Keychain Access, fi rst open your Applications window. Inside you’ll fi nd 
the Utilities folder. Keychain Access is inside the Utilities folder.

Click this button to show the list of Keychains, now showing 
at the top of the sidebar. Any new keychain you create will 
appear in that area.
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To access any password Keychain has been storing for you:

 1 Find the item in the list of “Passwords,” as shown on the opposite page. 

 2 Double-click that item. You will be asked for your Keychain password, which 
is the same as your login password. If you are the only user of the Mac, it’s the 
password you assigned yourself when you fi rst set up your Mac, the Admin 
password. A window like the one below appears.

 3 Click in the box to “Show password.” Your password appears!

You can create a new Keychain: Go to the File menu and choose “New 
Keychain….” Give it a descriptive name and a password you will remember. Th is 
Keychain will appear in the top portion of the sidebar, as shown on the opposite page. 
You will need to know that Keychain’s password if you want to access things in it!

With that Keychain selected, go back to the File menu and choose to create a new 
password item or a new secure note to store in it. 

Oh, Keychain is a very powerful and fairly complex application! To use it wisely and 
well, please study the Keychain Help fi les.
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Consider FileVault for Heavy-Duty Protection
FileVault     encrypts, or scrambles, the data in your Home folder so unauthorized 
people or software cannot get to it. While you are working on your Mac with 
FileVault turned on, you won’t notice anything. But everything in your Home folder 
will be safely protected from prying eyes, both in your offi  ce and from remote 
connections. Don’t ever forget the Master password, though, or you will never 
again see anything in your Home folder!

To turn on FileVault:

 1 Before you begin, make sure you have the Admin name and password, 
as well as the password for this user (if it’s separate from the Admin user).

 2 Also before you begin, make sure all other users are logged out. 

 3 Check to make sure you have enough hard disk space available for the 
process—you’ll need as much free hard disk space as there is data in your 
Home folder. 

  To check the fi le size of your     Home folder, single-click the Home icon 
in the Sidebar of any Finder window.

  Press Command Option I to display the Info window.

  Check the “Size” of the Home folder.

  Now check to see how much free hard disk space you have: Single-click the 
hard disk icon in the Sidebar. In the Info window (which has now switched 
to show you the info for the hard disk), fi nd the amount “Available.” About 
1024 megabytes fi t into one gigabyte, so unless you’ve been making movies 
on your Mac, you probably have plenty of space. 

 4 You must fi rst set a Master password. Keep in mind that once you set a Master 
password, you can never get rid of it. If you forget your login password and you 
also forget the Master password, everything in your Home folder is lost forever. 

  To set a    Master password:

  a. From the Apple menu, choose “System Preferences….”

  b. Single-click the “ Security” icon to get the Security pane shown 
  on the opposite page. Click the “FileVault” tab.

  c. Read the warning! Th en click “Set Master Password…,” 
  enter your password and hint, and click ok. 
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 5 Now click the button “Turn On FileVault….”

 6 Read the warning! If this is what you really want, click the OK button. 
It may take a few minutes. Your Mac will log itself back into this account 
and FileVault will be on. 

 7 Close the Security preferences window.
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Laptop Precautions
One out of ten laptops in this country gets stolen, which means about 600,000 a 
year. Th ey get stolen not only for the hardware, but more and more often for the 
valuable data that is stored on them. So it’s particularly imperative that if your 
laptop does happen to get stolen or lost, that the data inside of it is as safe as 
possible. Here are a few features I discussed in this lesson that you should make sure 
you take advantage of.

■ Use a password to log in. Do not set auto-login for your laptop.

■ Set a fi rmware password; see page 396. It prevents someone from booting 
your computer with another disk.

■ Password-protect the screen saver and sleep so if the screen saver turns on 
or the Mac goes to sleep, you need a password to get back in. 

■ Turn on FileVault (but never forget its password!). When your machine is off  
or sleeping, all of your data in the Home folder is encrypted until you enter 
the password to start working again. Th is is the strongest protection you can 
have for the data itself on your laptop.

■ Th ere are devices you can buy that can alert you to when your Mac is moving 
away from you. And services you can subscribe to that can track the stolen 
computer as soon as a person logs on to the Internet with it. Search the web 
for laptop security devices and services. 
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Mini-Glossary �

 active window

Th e active window is the one that is in front 
of everything else and is selected. You can tell 
if a window is active because the three little 
 buttons in the top-left corner are in color, and 
the title bar icon is not shaded. It’s important 
to become aware at all times of which window 
is active because that is the window that will 
accept any command. For instance, if you press 
Command Shift N to create a new folder, that 
new folder will appear in the active Finder 
window (or on the Desktop, if the Desktop is 
active). If you press Command W in just about 
any application or in the Finder, it will close the 
active window. To make any window active 

(or the Desktop), single-click on it. 

     alias

An alias is a “go-fer”—it goes for things and 
gets them for you. It’s nothing all by itself; it’s 
merely a representative icon (only 2k or 3k 
in fi le size) that is linked to the original. You 
double-click the alias and it goes and gets the 
real thing and opens the real thing for you. Th e 
advantage of this is that you can put aliases 
in multiple places for easy access; in fact, you 
can have as many aliases of an item as you 

want. Some applications cannot open properly 
if you move them out of their folders, but if you 
make an alias of that application, you can put it 
anywhere. 

An alias icon has a visual clue, a tiny arrow 
in the bottom-left corner of the icon (shown 
below) so you know it’s a go-fer.

You can throw away an alias and it does not 
aff ect the original at all. You can move an 
original or rename the original or the alias and 
everything still works fi ne. 

To make an alias, select a fi le; press Command 
L. Or hold down the Command and Options 
keys and drag the fi le into another folder or 
onto the Desktop. As you drag, you’ll see the 
tiny alias arrow that tells you that you are 
indeed dragging to create an alias.

colored labels 

To color-code a fi le, Control-click on it and 
choose a “Color Label” from the menu that 
pops up. Once a fi le is color-coded, you can 
search for it by its label, organize your fi les, etc. 

To change the names of the labels, use the 
Finder preferences: Go to the Finder menu and 
choose “Preferences….” Click the “Labels” menu 
and change the names. For more details, please 
see page 264, and check the index for “color 
labels.” Th is is a great organizational tool.

Most words are defi ned as I use them. Please see the index!
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default

A default is something the Mac has chosen 
for you, until you make your own choice. For 
instance, TextEdit it must have a font chosen 
to type in, so your Mac chooses one for you. A 
default window view is chosen for you. But you 
can at any time change just about anything to 
something of your own choice.  

extension

A fi le extension refers to the short code at the 
end of a fi le name. It might be from two to six 
letters. Th is extension tells the Mac what to do 
with that fi le. 

 The extension, .webloc, tells the 
Mac this is a web page location.

You might not see the extensions. If you like to 
have them visible all the time, go to the Finder 
preferences (from the Finder menu, choose 

“Preferences”). Click on the “Advanced” tab. Put 
a check in the box to “Show all fi le extensions.”

To show the extensions temporarily or to check 
to see what the extension is for a particular 
fi le, use the Info window (explained in this 
mini-glossary). You’ll see an option for “Name 
& Extension” that will tell you what it is and let 
you hide or show it for that selected fi le. 

Do not add or change the extensions yourself ! 
Th e Mac has become very fussy about these 
extensions and you run the risk that the fi le will 
not open if you change its extension without 
knowing what you are doing. 

Info window

Th e Info window, as shown on pages 323 and 341, 
has a secret Inspector mode: If you select a fi le 
and press Command I, the Info window appears 
for that one particular fi le. 

But if you select a fi le and press Command 
Option I, you get the Inspector window, which 
looks exactly like the Info window except the 
Inspector window changes depending on what 
you click. Th at is, if you display the info for 
one fi le, then select another fi le (single-click 
on another fi le), the content of the Inspector 
changes to display the next fi le. Try it.

You can also open the Inspector with a contex-
tual menu: Control-click on a fi le, then hold 
the Option key down and you’ll see “Get Info” 
change to “Show Inspector.” 
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 screenshots

To make screenshots (pictures of the screen), 
use these shortcuts:

Full screen: Command Shift 3

Selection: Command Shift 4, then let go. Use 
the target cursor that appears to select the 
area you want to capture as an image: just 
press in one spot and drag to another spot, 
catching the image inside of this invisible box.

Window: Command Shift 4, then let go. Tap 
the Spacebar and a camera icon appears. As 
you move the camera icon over diff erent 
windows, even those that are hidden, you’ll 
see that window highlight. Click on the one 
you want an image of.

Th e above screenshots land on your 
Desktop labeled “Picture 1,” ‘Picture 2,” etc. 
Th ey are in the png fi le format.

Selection you can paste: Press Command Shift 
4 and the target cursor appears. Hold down 
the Control key and drag to select the area, 
which copies that screenshot image. Now you 
can paste the screenshot somewhere else. 

 string

A string is simply a line of characters that you 
type. If someone tells you to “enter a search 
string,” all it means is to enter the words you 
want to search for. 

 Symbols
Each key has a  symbol by which it is known. Th ese are the keyboard symbols you will see in menus 
and charts:

 ⇧           Shift ⎋ Escape (esc)

 ⌘ Command ⇞ ⇟ Page Up or Page Down

 ⌥ Option ⌫ Delete

 ⌃ Control ↑↓←→ Arrow keys

 ↩ Return ⌤ Enter

 ▲ Eject
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The Index �

A
Accounts preferences

Login Options, 314
low-level security features, 421–422
multiple users, 311–316
parental controls, 324–329
security features for login, 421

Action button
what it looks like, 55
acts as contextual menu, 43
in a Finder window, 8
in Fonts panel, 234, 235
in Mail, 87

active
application, what is it? 5
document, what is it? 29
window, what is it? 431

Address Book
add an address

through a vCard, 251
with a new contact card, 109

Address panel
in iCal, 159, 252
in Mail, 79, 105, 250

backup all addresses, 120
birthdays

add fi eld to cards, 112
Birthday calendar in iCal, 157
Smart Group to gather birthdates, 115

cards
edit existing ones, 109
make new ones, 109
make your own card, “My Card,” 111

customize all cards, 112
drag-and-drop addresses, 250
edit existing contact cards, 109
envelopes, print them, 120
fax numbers must be labeled properly, 304

fields, add more to contact cards, 112
green or red circles on cards, 109
Group mailing list, 120
iCal, add names to attendees, 252
integrated with, 123
iPod, transfer data to it, 123
Library folder stores contact info, 37
mailing labels, print them, 120
My Card, 111
page proxy icon in, 28
photo, add to a card, 110
pocket address book, print pages for, 120
preferences, 118–119
printing, 120
privacy, make your own card private, 111
Safari, put Address Book in Bookmarks Bar, 123
search, 116
select more than one name, 250
sharing

share someone else’s Address Book, 119
share your entire Address Book, 118–119

show all contacts, 116
Smart Groups, 115–116
Spotlight search, 116–117
subscribe to someone’s Address Book, 119
template for cards, change it, 112
vCards

what are they? 109
how to send them through iChat, 252
how to send them through Mail, 251

web sites in, go to, 123
your card, 111

Admin, Administrator
who is it? 308, 395
can create more than one, 309, 319
delete a user, 330–331
forgot your Admin password, 411
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Admin, Administrator, continued
Keychain Access uses your 

Admin password, 418
password, where it came from, 308, 395–396
short name, where it came from, 395

Adobe InDesign
drag fi les into, 255
this book designed in, 460
Wills, Jennifer, InDesign Magazine 

cover designer, 296
AirPort

AirPort Express, 189
cards for networking in a small offi  ce, 372

aliases
what are they? 431
burn folders automatically create aliases, 212
make an alias

using a keyboard shortcut, 431
using the page proxy, 253

Sidebar items are aliases, 12–13
ampersand options, 236

Apple ID, what is it? 394
Apple menu

where is it? 4
Dock options, 260–261
Log Out, 308
Restart option, 405
System Preferences, 274

application menu
where is it? 4
preferences for applications, 53
Quit command in, 52

applications
active application, which one is it? 5
common elements of, 52–62

Action button, 55
albums, 55
Application menu, 52
bookmarks, 55
collections, 55
cut, copy, paste, undo, 52
drawers, or sidebars, 55
Edit menu, 52
File menu, 52
Help fi les, 55
mailboxes, 55

Open dialog boxes, 55
playlists, 55
preferences, 53
preview before printing, 55
Save dialog boxes, 55
search, 55
sidebars, 55
Smart Folders of diff erent sorts, 55
toolbars, 53
windows, 52

common tools in
Character Palette, 236
Colors panel, 238
Fonts panel, 234
Speech, 239
Spell Checker, 230–233

contextual menus in, 43
Dock, add an application to the Dock, 50
drag-and-drop between apps, 249–255
force quit an application, 404
move text from one app to another, 250
open a document in a diff erent application, 254
open an application

from a Finder window, 14
from the Dock, 20

open favorite applications on startup, 321
parental controls to limit available 

applications, 328
preferences

delete preferences fi le, 406
open the preferences from the application 

menu, 53
stored in Library folders, 37

quit the active application(s), 245
switch between applications, 244–245
windows in applications, 52

Applications folder
contents of this folder, 50
keyboard shortcut to open, 50
where the original folder is stored, 36

Arrow keys
select columns in Finder windows, 46
select diff erent areas of a dialog box, 44–45
symbols for, 24, 433

Atom as an rss feed, 143
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attachments
send and receive through iChat 

and Bonjour, 252, 253
send and receive through Mail, 100–103
send and receive through Notes in Mail, 99

audio chat with one or more people, 166–167
Auto-Click feature in Safari bookmarks, 144
AutoFill feature in Safari

delete saved user names, passwords, 
and forms, 128

fi ll in forms and passwords online, 128
prevent AutoFill from fi lling in forms, 136
where it gets the information, My Card, 111

B
Back and Forward triangles in Finder windows, 11
backups

Address Book data, 122
before installing a new OS, 391
iCal calendars and data, 156
portable hard disk for backups, 391
Time Machine to backup your drive, 353–360

Bahnson, Jeanne, 86

Baykal, Caner, 287

birthdays
add fi eld to Address Book, 112
automatically add to iCal, 159
Birthday fi eld in Address Book, 112
Birthday group in Address Book, 115–116

block pop-up windows in Safari, 128
blogs

example of one, 142
rss feed for, 138
what are they? 142

Bluetooth, keyboard and mouse preferences, 275
Bonjour

display the iTunes song you’re listening to, 189
screen share with, locally, 383–385
send an attachment through iChat, 253–254
share fi les locally, 378–379

bookmarks. See also Safari/bookmarks
in dvd Player, 214
in Preview, 199

browser. See Safari

burn discs
burn a cd of music from iTunes, 186
burn data discs, 212
Burn Folders, 212–213

buttons
blue, 29
green, 9
red, 9, 29
yellow, 9

C
cables

Ethernet cables for networking, 372
FireWire port icon, 412

calculator widget, 283

calendars. See also iCal
iCal widget, 282

CDs
burn a cd

how much space is available, 213
of data, 212–213
of music from iTunes, 186

disc won’t come out, 389
eject an unburned CD, 213
how much data a cd holds, 212
icon appears in Sidebar, 34
icon doesn’t appear on the Desktop, 262
music cds

burn a music cd, 186
import songs into iTunes, 183

print a cd cover, 188
Character Palette, 236–237

checkmark in Window menu, 29
check spelling, 230–231

clean install, how to do it, 391
client-server network, 373

Collections
FontBook, 221
Fonts panel, 235
Safari bookmarks, 131

rss feeds, 140
color labels, 264, 267, 431

Colors panel, 238
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Column View in Finder windows
how it works, 16–17
delete the icons, 271
preview column, show or hide it, 271
resize columns, 16
resize the text, 271
select multiple fi les in, 38

Command key
symbol for, 24, 433
select multiple items with, 39
select non-contiguous text, 69

Complete command, 62

Computer level icon in the Sidebar, 
hide or show it, 265

Connect to Server from the Go menu, 375–378
contextual menus

how to fi nd and use them, 42–43
Action button in Finder window 

does the same, 43
correct spelling, 43, 233
disconnect from a server, 385
Dock options, 261
eject an unburned cd, 213
labels, apply or remove them, 264
on the Desktop, 42

contiguous, 39

Control key
contextual menus with, 42
symbol for, 24, 433

crossover cables, 372

customize
the Desktop, 273
the Dock, 260
the Finder, 262–265
Finder windows, 266–270
the installation of Leopard, 392–393

D
Dakota the Wolf, 255
Dashboard, 282–288

example of the Dashboard, 282
open Dashboard, 282, 284
close it, 285
icon in Dock, 284

keyboard shortcut, change it, 288
two-button mouse to open Dashboard, 288
Widget Bar

example of on the screen, 282
hide or show the Widget Bar, 284
show other widgets in the Bar, 282, 284

widgets
what are they? 282, 283
add widgets to Dashboard, 282, 284
close (remove) widgets from Dashboard, 284
display more than one of a widget, 287
enter data; be sure to hit Enter key, 285
fl ip widgets over, 285
how to work with widgets, 285–286
info button, how to use it, 285
iTunes widget, 286
organize widgets on the screen, 

move them, 284
remove widgets from Dashboard, 284
see more widgets that are installed, 284
three diff erent kinds of widgets, 283
tile puzzle, change the picture, 287
visual clues in widgets, 286

X next to a widget, 284
Date & Time preferences, 278

Davis, Nancy, 85

deselect an item from a group, 39

Desktop
active Desktop, 431
alphabetize the icons, 273
change the color or image, 277
contextual menus on the Desktop, 42
Finder runs the Desktop, 4
folder for Desktop, 7
go to the Desktop, 5
icons on the Desktop, get rid of them, 262
keyboard shortcuts to navigate, 46
map of the Desktop, 4
preferences for the Desktop, 277

Desktop & Screen Saver preferences
require a password to wake from 

screen saver, 422
use iTunes album art, 189
use rss feed, 146

Diagnostics button in Network preferences, 367
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dial-up Internet connection
do not download updates in background, 410
having problems making a connection, 365

Dictionary
pane can appear in text, 241
set parental controls on, 327
widget, how to use it, 286

disclosure triangles, 28, 44, 59

disk image, .dmg, 330–331

disks. See also CDs and DVDs
boot from a cd with a system on it, 396
dvd or cd won’t come out, 389
FireWire

hard disk for backups, 391
icon for FireWire port, 412
unmount before you disconnect, 399

utilities for, 396
Disk Utility, 396

.doc fi les
make them open in Word, 58
save as Word fi les in TextEdit, 59
TextEdit opens them by default, 58

Dock
where is it? 4, 21
how to use the Dock, 20
add applications to the Dock, 50
add items to the Dock, 20–21
animate icons as they open, 261
blue light beneath icons, 20
customize the Dock, 260–261
disappeared, it’s gone!, 260
fax icon in the Dock, 303
Finder icon in the Dock

open new windows, 6
relaunch the Finder, 405

hide and show the Dock, 21, 260
hover your mouse to make labels appear, 20
icons in the Dock

what each one represents, 20
blue light under icon, 20
bounce up and down, or not, 260

magnify the icons, or not, 260
Mail icon displays a red number, 77
minimizing options, 260
missing Dock, 21

open minimized windows, 9
opens apps and documents, 20
rearrange the icons in the Dock, 20
remove icons from the Dock, 21
resize it, resize the icons, 261
spring icon in the Dock, 20–21, 251
stacks, also called folders, 20
switch applications by clicking on the Dock, 244
Trash icon, how to use it, 22
web location icon, 251, 431
yellow button to minimize windows, 9

change the way windows minimize, 260
documents

add a document to the Sidebar, 13
application opens when document opens, 14
icon of a document, example of, 14
make an alias of an open document, 253
make an copy of an open document, 253
open a document, 14, 15, 17

from the Dock, 20
preview document info, 17
send a document through iChat, 253
send to someone else through email, 254
unsaved changes, visual clues for, 29

Documents folder
what is it for? 7
iChats folder holds recorded chats, 177
stack in Dock, 20
Web Receipts folder in to save receipts, 219

dots
in red button of document window, 29, 253
in Window menu, 29
red dots under words, 232

Downloads folder
what is it? 7
also called a stack, 20, 103
for Mail attachments, 103
Home folder, access to it, 6

drag-and-drop
tip for making it work better, 249
what you can do with it, 249–255

drawers, or sidebars, 54

Drop Box, 322, 377
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DVD Player
adjust video color, sound, and zoom, 215
bookmarks, create and play them in a dvd, 214
clips, create them in a dvd, 214–215
disc image, create your own, 216
play a movie in the Dock, 216

DVDs
burn data onto a dvd, 212
disc won’t come out, 389
dvd icon appears in Sidebar, 34
how much data a dvd holds, 213
icon doesn’t appear on the Desktop, 262

E
Edit menu

common features in, 52
Complete, 62
Find, 60
Paste and Match Style, 61, 249
Special Characters, 236–237
Speech, 239
Spelling, 230

eject
an untitled cd, 213
a server to disconnect, 385
eject a cd or dvd, 34–35
eject symbol in the Sidebar, 34, 35

Elizabethan musical instruments, 341
email. See Mail

empty the Trash, 21

encrypt your Home folder, 426

Energy Saver preferences, 422

Enter key, symbol for, 24, 433
Escape key (esc), symbol for, 24, 433
Ethernet cables for networking, 372
Evans, Miss Dana, 26

Exchange server, 74

Exposé to manage your windows, 40–41
extensions

what are they? 44, 432
always show them, 265

.doc, 58, 59
hide or show from Save As dialog box, 44

.textClippings, 250

.webloc, 251, 432

F
favorites

collection in the Fonts panel, 235
servers to connect to, 377
styles in TextEdit, 61

fax to or from your Mac, 302–305
cover page, add one, 303
Dialing Prefi x, 303
fax icon in the Dock, 303
fax numbers, must be labeled properly, 304
phone cable is needed, 302
receive a fax on your Mac, 305
send a fax from your Mac, 302

send a fax directly from the document, 218
fi le extensions

what are they? 44, 432
always show them, 265

fi le formats
save a fi le in another format

graphic fi les, 209
text fi les, 59

fi le information in metadata, 339
File menu, common features in, 52
fi le permissions, 323

fi le sharing
Bonjour, share fi les locally, 378–379
iChat

iChat Th eater to show fi les, 172
iChat, share fi les globally, 252–253
page proxy, use to share fi les through iChat or 

Bonjour, 253
Public folders, share fi les through, 322
screen sharing, 380–385
set permissions for shared fi les, 323
Share folder, share fi les through, 322
simple networking, 372–377
Target Disk Mode, 372, 398, 412

FileVault, set it up, 426–427
fi nd

fi nd any fi le on your Mac. See Spotlight
fi nd text on a Safari web page, 127
fi nd text on a word processing page, 60, 70

fi nd and replace, 60
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Finder
customize it, 262–265
Desktop, customize icons and text, 273
go to the Finder, 5
icon in the Dock, 4
icons on the Desktop, get rid of them, 262
labels fi les and folders, 264
map of the Finder, 4
menu bar says “Finder,” 4
preferences for the Finder, 262–265

Advanced options, 265
General options, 262–263
Labels, 264
new Finder windows open your choice 

of folder, 262
open folders in a new window, 263
show or hide items on the Desktop, 262
spring-loaded folders, 254, 263

relaunch the Finder, 405
runs the Desktop, 4
search with Spotlight, 344–347

Finder windows
Back and Forward buttons, 9
button in upper-right of window, 9
calculate folder sizes, 268
Column View

overview of, 16–17
hide all icons in the columns, 271
resize text, 271
resize the columns, 16
turn off  preview column, 271

create new folders in, 11
examples of Finder windows

on Desktop, 4
with callouts, 8
without Toolbar or Sidebar, 9

Exposé, use it to manage windows, 40
green button, 9
Hide/Show Toolbar and Sidebar, 9
Icon View

customize it, 266–267
align icons automatically, 267
color the window or put a photo in it, 267
display information about some fi les, 267
keep icons arranged by, 267
move labels to the right or bottom of fi les, 267
resize icons, 267

resize text size of labels, 267
show icon preview, 267

keyboard shortcuts to navigate, 46
List View

alphabetize or sort columns, 270
calculate folder sizes, 268
organize items by diff erent columns, 270
resize and rearrange columns, 270
resize icons, 268
resize text labels, 268
triangles next to folders, 15
use relative dates, or not, 268

move Finder windows, how to, 8
open . . . 

more than one window, 7
to a new, separate window, 7, 9
to a new, separate window every time, 263
to the folder of your choice, 262

preview of images in windows, 16–17
Quick Look button in, 8
red button, 9
resize windows, how to, 5, 9
Sidebar, 12
Smart Folders, 347–348
Spotlight search in, 335, 344–347
triangles in, 15
view buttons, 14
views of

Column View, 16–17
Icon View, 14
List View, 15

yellow button, 9
fi nger, 397

FireLite portable hard disk, 391

fi rewalls, 416

FireWire
camera for video conference 

must be FireWire, 168
FireWire symbol, 412
hard disk for backups, 391
symbol for FireWire, 412
target disk mode for transferring fi les, 412
unmount before you disconnect, 399

Fkeys (F, F, etc.), 24
fn key, 24
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folders
add a folder to the Sidebar, 13
burn folders, 212–213
calculate folder size in List Vew, 268
contextual menus on folders, 42
create your own folders, 10
Home folders, descriptions of, 7
items in folders, how many are there, 267
open a folder, 10

in Column View, 16–17
in Icon View, 14
in List View, 15

remove a folder from the Sidebar, 13
rename a folder, 11
save a document into a particular folder, 253
spring-loaded folders, 254, 263

Font Book, 220–223
Collections, make or disable, 221
disable fonts you don’t use, 221
install fonts, 220–221

fonts
disable fonts you don’t use, 221
Fonts folders, 37
install fonts, how to, 220
preview fonts you have installed, 220, 234
preview fonts you have not installed yet, 220
stored inside Library folders, 37
Veer.com, source for fonts, 460

Fonts panel, 234–235
Action menu options, 235
Character Palette, 236–237
Collections, 235
Colors panel in, 238
eff ects, 235

if they’re missing, 234
Favorites, 235
hide or show the preview, 234
preview fonts, 234
shadow eff ects for text, 235
tool tips in Toolbar, 26
Typography option in Action menu, 235

force quit, 404

forms, fi ll in pdf forms, 206
Forstat, Brian, 192

ftp may need short name, 312

function keys, Fkeys, 24

G
gear icon

Action menu, 55
on Address Book groups, 115
on folders, 347–348
on mailboxes, 89

globe icon for local network, 376
glyph, what is it? 236

Go menu, Connect to Server, 375
Google.com

fi nd a word on a web page, 350
Google search field in Safari, 129
SnapBack feature, 128

Grab utility for screenshots, 207

grandkids
advantage of separate users for them, 308–309
parental controls, 324
passwords, easy or none, 315
Simple Finder for young users, 328–330

override the Simple Finder, 329
graphic files show pixel size in Finder windows, 

267
gray commands in menus, 25

green button in window title bar
in iTunes, 187
resize the window, 9

green dot
in Mail window, 105
on Address Book card, 123, 177

grid underlying Icon View and Desktop, 267

group fi les together, 39

H
Haney, Brianna Nora, 222

hard disk
fi le size of your hard disk, 426
free space on hard disk, how much? 426
hard disk icon

doesn’t appear on the Desktop, 262
remove it from the Sidebar, 265
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help?
Address Book contacts won’t appear, 116
can’t make changes in a document, 323
colored bars on fi les and folders (labels), 264
disk (dvd or cd) won’t come out, 389
Disk First Aid, 396
disk icons don’t appear on the Desktop, 262
Dock

accidentally lost the application icon, 50
icons are too small or too big, 260
lost the Dock, it disappeared, 260
replace an application, 50

folders pop open all by themselves, 263
font or size won’t change, 234
forgot your Admin password, 396, 411
formatting won’t apply, 70, 79
Help files, how to fi nd them, 30
if your Mac won’t boot up, 396
Internet, troubleshooting help, 366–367
keys repeat across the screen, 276

.Mac Learning Center, 30
Mail

bold, italic, etc., doesn’t appear, 86
Connection Doctor, 370

menu commands are gray, 25
passwords, if you forgot them, 396
pdfs, cropped image appears uncropped 

when fi le is reopened, 197
preferences fi le, how to delete, 406
printing, text prints really tiny, 70
relaunch the Finder, 405
Repair Disk Permissions, 396
report crashes to Apple, 411
Safari Bookmarks Bar, tiny square, 144
save changes in a document, can’t do it, 323
Simple Finder is on, override it, 329
support pages from Apple, 30
System Preferences won’t let you 

change them, 274
test on another user, 410
text stretches the entire width of the window, 70
Trash warning, get rid of it, 265
update your software, 410
utilities for all sorts of things, 396
warning before emptying Trash, off  or on, 265

Help files
keyboard shortcut for, 54
where to fi nd them, 30

hide the active application(s), 245

Hoefl er Text and Ornaments, 236

Home
Downloads folder in, 7
fi le size of your Home folder, 426
FileVault, use it to protect your Home, 426–427
folders in your Home window, 6–7
icon for Home, where is it? 5
open new windows to your Home folder, 262
users, where each user is stored, 36
view Home in column view, 36
where are all those folders really stored? 36
whose Home is it? 6

Hotmail webmail, 370

hot swap, 399

house icon in window title bar, 6
hover your mouse

over the Dock to see labels, 20
to display tool tips, 26
to open spring-loaded folders, 254

How to Change the World, 142

hub for networking, 372–373

I
iCal, 150–159

Address Book or Address panel, 
how to open it, 252

attendees list
add names and addresses to it, 159, 252
icon indicates attendees, 153

backup the entire calendar, 156
Birthdays calendar, how to create it, 152, 157
calendars

create new ones from Mail, 96
create new ones in iCal, 150

events, create, 153
example of calendar, 150
groups, organize calendars, 151
invitations, respond to, 155
Month, Week, or Day views, 153
multiple day events, 153
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iCal, continued
notify attendees of an update, 150
overlapping events, display them, 150
preferences, 152
print lists, events, details, phone numbers, more, 

158
publish calendars, 154

automatic notifi cations, 154
notify attendees of an update, 150

recurring events, 153
Send button, 252
set an alarm, 150
subscribe to calendars, 157
To Do list, 154

iChat, 163–178
Address Book data is used, 111
AIM account for screen name, 162
attachments, how to send through iChat, 

253–254
audio-chat

mute the sound, 167
one-way audio-chat, 166
requirements for multiple chat, 167
with one other person, 166
with up to ten people, 166

backgrounds, add behind your image, 171
Bonjour

screen share locally, 383–385
share fi les locally, 378–379

Buddy List
create it and add Buddies, 161
multiple telephone icons in, 166–167
multiple video camera icons in, 168
override your buddy’s image, 177

camera icons in Buddy List, 168
chat

audio-chat with one other person, 166
one-way audio chat, 166
text-chat with one other person, 165
video-chat with up to three other people, 

168–170
eff ects for video, 170
email a Buddy, 177
fi le share through iChat, 253–254
green dot

in Mail window, 105
on Address Book card, 123, 177

group text chat, 165
iChat Th eater, 172–173
iTunes, let others know what you’re listening 

to, 181
Jabber users, 162

.Mac account for screen name, 162
photos of Buddies

add to iChat through Address Book, 110
use iSight to take a photo, 177

record the chat, 176–177
Rendezvous, 174–177
screen name—how to get one, 161
screen sharing through, 383–385
search chat logs, 339
send a document through iChat, 253
send fi les to Buddies, 252–253
set up iChat, 161
text-chat with one other person, 165
video-chat

three- or four-way video chat, 168–170
video camera needed, 168

icons
are small pictures, 14
alphabetize them

in a Finder window, 267
on the Desktop, 273

are too small or too big
in Finder windows, Icon View, 267
in Finder windows, List View, 268
in the Dock, 260
on the Desktop, 273

arrow in left corner, 253
delete them from the List View, 271

Icon View of Finder windows
customize it, 266–267
add photo to the background of the window, 267
colorize the background, 267
examples of icons in, 14
keep icons arranged, 267
reposition the labels, 267
resize the icons, 267
resize the text, 267
select multiple fi les in, 38
show extra information about some fi les, 267
show previews of image icons, 267

iDisk icon, 34, 265
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InDesign application
drag fi les into, 255
this book was created in, 460
Wills, Jennifer, InDesign Magazine 

cover designer, 296
Info window

what is it? 432
Burn Folder storage available, 213
fi le sizes of Home or hard disk, 426
Inspector window for multiple fi les, 269
keywords, add to fi les for searching, 341
permission settings, 323

ink cartridges, buy them for your printer, 297
Inspector window for info on fi les, 269
install fonts, 220–221

install Leopard on your Mac, 388–395
Administrator account, 394–395
Apple id, 394
archive your existing OS, 390
clean install, 391
custom install, 392
dvd installation disk

fi les on it, 388
restart from the dvd, 388

dvd is stuck in the Mac, 389
erase your disk and install Leopard, 391
format hard disk before installing, 391
for the fi rst time, 390
languages

choose one for your system, 389
delete ones you don’t use before installing, 392

migrate fi les from your old Mac to your new one, 
397–404

network setup, 394
options for installation, 390–391
password

reset password, 396
set it up, very important, 394–395

printer driver fi les, don’t install them all, 392
quit, if you need to during installation, 389
reformat your disk and install, 391
restart keeps using dvd or cd, 389
Setup Assistant basics, 393

transfer fi les from your old Mac
how to transfer iTunes songs, 398
using the migration feature, 397–403
various other methods of transferring, 400

upgrade your existing OS, 390
VoiceOver option, 393

Internet
cable or dsl sometimes connect themselves, 

366–367
create a new connection, 367
dial up

change settings for, 364–365
preferences for, 364–367
troubleshooting help, 366–367

Internet Service Provider (ISP)
SMTP settings for, 369
troubleshooting help, 366–367

iPhone
add photos to Address Book contact, 110
ringtones, buy customized ones from iTunes, 

185
save pdf to iPhoto, open in iPhone, 218

iPhoto
add email attachments to iPhoto, 101
share photos through iChat Th eater, 173

iPod
don’t plug it in to a new system, 398
icon will appear in Sidebar, 34
transfer Address Book to, 123
transfer iCal data to, 159

iSight camera, 168

iTunes, 180–190
album art, display or print it, 181
arrow next to Playlist, 183
buy music through iTunes Music Store, 183
deauthorize the computer, 398
Equalizer button, 180
iChat, let others know what you are

 listening to, 181
import songs, 183
iPhoto uses songs for slideshows, 181
Library, 180
Music Store, 183

account to purchase music, 189
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iTunes, continued
Playlists

arrow next to Playlists, 183
burn a cd of a Playlist, 186
create a Playlist, 185

play music, 180
print a cd cover or list of songs, 181
ringtones for iPhones, 185
share your music with other computers, 183
share your Playlists on the Music Store, 183
Smart Playlists, 185
sound quality, adjust it, 183
Source pane, 180
visual eff ects from music, 185
widget for iTunes, 286
wireless connection to stream songs, 189

J
Jabber, talk with iChat users, 162
Jane the Bassett Hound, 255
junk mail, 81

K
Kawasaki, Guy

How to Change the World, 142
Truemors, 141, 145

Kerberos, 416

Keyboard & Mouse preferences, 275

keyboard shortcuts
Finder search, 345
Fkeys and shortcuts, 24
how to use shortcuts, 24–25
Info window, 341
Keyboard & Mouse preferences, 46, 275
modifi er keys for, 24
Open or Save As dialog boxes, 44
overview of, 24–27
Spotlight menu and window, 334, 338
symbols for modifi er keys, 24
to access menus and commands, 46
to select fi les in windows, 44–45, 46

Keychain Access
password for Keychain Access, 425
password to wake your Mac, 422
protect the fi les on your Mac, 424–425

L
labels

what are they? 431
apply or remove a label to a fi le, 264
change the label names, 264
organize the icons in Finder windows 

by labels, 267
organize the icons on your Desktop 

by labels, 273
language options at login window, 316
laptops

control Fkeys, 275
restart with Power button, 405
trackpad preferences, 275

Library Angels, 207

Library folders, 7, 37

List View in Finder windows
how it works, 15
alphabetize, or sort, the information 

in columns, 270
calculate fi le sizes, 268
relative dates, 268
reorganize information in, 15, 270
resize and reorganize the columns, 270
resize the icons, 268
resize the text labels, 268
select multiple fi les in, 38

locked fi le, change permissions on, 323
lock your Mac screen, 422

log in and log out
how to do it, 317
why log out? 308
log in automatically, 308, 314, 317
login options, 314–315
password doesn’t work, 315
symbol in the password fi eld, what is it? 315

lookup, 397
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M
.Mac account

screen name, how to get one, 161
share Address Books, 118–119

Macintosh HD
icon on the Desktop is the same 

as in the Sidebar, 35
Sidebar shows icon for, 34

Mac OS Extended (Journaled), 391

Mac the Pitbull, 255
Mail

accounts
account info, 369
edit your account, 77, 369
Incoming Mail Server, 75
set up a new one, 74–77

Address panel, 105
attachments

add by page proxy, 254
download an attachment, 101–103
save attachments into iPhoto, 101
send an attachment, 100–101
send in a Note, 99
send through Bonjour instead, 378
send through iChat instead, 252

blurb at bottom of messages, signature, 86
bold, italic, etc., doesn’t appear, 86
brown messages, 81
Buddy Availability column, 105
Colors panel, 238
columns, add more, 105
Complete command, 62
compose a message, 78
Connection Doctor, 370
Dock icon has a red number, 77
Downloads folder, change it, 103
email web page or link from Safari, 132
Exchange account, what is it? 74
exclamation points, what are they? 80, 104
fi lter incoming messages, 85
fi lters (Rules), 89
fi nish typing words automatically, 62
Fonts panel, 234
free webmail account like Yahoo or Hotmail, 370
green dot in window, 105, 177

group mailing list, send to everyone, 120
Hotmail account, 74
images from Preview, 193
imap account, what is it? 74
Incoming Mail Server, 75, 369
integrated with, 105
junk mail, delete it without seeing it, 81

.Mac account, 74
Mailboxes drawer, 77
mailing labels, 120
move or copy text without cut-and-paste, 249
Notes, 98–99
organize mail with mailboxes, 77
Outgoing Mail Server, 369
password, 369
pop account, what is it? 74
prioritize messages, 104
read messages, 77
red dots appear under words, 232
rss feeds, email a link to someone, 146
Rules, how to create them, 85
Rules vs. Smart Mailboxes, 89
search messages and headers, 336
send a message, 78
signatures, 86

add an image to a signature, 87
add Signature menu to window, 87
create a signature, 86–87
example of in message window, 86
menu in a message window, 87

slideshow of attachments, 101
Smart Folders, 89–91
Smart Mailboxes, 89–91
smtp, 370
sort incoming mail, 85
spell checker, 230
spoken messages: have email read aloud, 239
Spotlight and Smart Mailboxes, 336–339
stationery, how to create it, 82–83
styles, 61
text clipping of text on a page, 250
To Do items, 92–97
troubleshoot your account, 369
user name, 369
users have their own, private mail, 309
Yahoo account, 74
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Master password in FileVault, 426–427

Maximus the Rotweiller, 255
Maxwell, Sarah, 252

Meilander, Amy, 82, 252

menu bar
where is it? 4
access menus without the mouse, 46
name of user in right corner, 318–319
padlock icon in the menu bar, 422
status icons in the menu bar, 

how to put them there, 279
menus

access menus without the mouse, 46
gray vs. black commands in menus, 25
Help menu, 30
item has a checkmark, 29
make menus go away, 25
symbols in, 24, 433

mermaids in Bermuda, 379

metadata, what is it? 340
Microsoft

Hotmail webmail, 370
Qwest broadband, in cahoots with, 370
Word fi les

open in TextEdit, 58, 254
open in Word, change default to, 58
save as Word fi le in TextEdit, 59

migrate your fi les, 397–404
after migrating, check your fi les, 399
other ways to transfer fi les, 400
unmount before you disconnect, 399
what it transfers, 397
what you need before you start, 398

Migration Assistant, 397–404

modifi er keys
change their functions, 275
symbols for, 24

mouse
hover it

how to, 26
over Dock to see labels, 20
to open spring-loaded folders, 254

preferences for, 276
two-button mouse

Dashboard options, 288
Exposé controls, 40
open contextual menus, 42

Movies folder, 7

multiple users. See users

Music folder, 7

N
name your Mac for fi le sharing, 373
Nelson, Lew, 168

network diagnostics
Network Diagnostics tool, 367
Network preferences, 364–367
Network Utility, 397

network your Macs, 372–379
Connect to Server, Go menu, 375–378
connect your Macs with cables, 372
create favorite servers for quick connections, 377
disconnect from a server, 385
Ethernet cables for networking, 372
fi le sharing, turn it on, 373
name your Mac, 373
network icons

for individual volumes, 376
Shared, in the Sidebar, 34

password—it doesn’t want YOURS, 375
peer-to-peer network, 373
Personal File Sharing, turn it on, 373
servers, 373

create favorite servers, 377
disconnect from a server, 385

Sidebar icons, hide or show them, 265
newspaper, create your own customized, 143
Notes in Mail, 98–99
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O
online forms, fi ll in automatically, 128
Open dialog boxes

search for fi les within, 351
Spotlight search in, 351

Option key
symbol for, 24, 433
use in copying documents, 253
use in copying one column of text in Preview, 204
use in copying text, 249
use in Dock menus, 404
use in resizing columns in Column View, 16

orange arrows in Safari fi elds, 129
Outgoing Mail Server, 

ownership and permissions, 323

P
padlock icon in menu bar, 423

page proxy, tiny icon in title bar, 253–254
Page Up and Page Down keys

symbols for, 24, 433
parental controls

overview of and where to set, 324–329
in Safari, 137

partition your hard disk with Disk Utility, 396
passwords

Administrator password, 417
forgot your Admin password? 396, 411, 417
no password assigned, 395, 417
set it up on installation, 395–396
where it came from, 308

blank passwords can be used, 312, 395
case-specifi c, case-sensitive, 312, 418
forgot your user password? 396, 411
help for good passwords, 312
hints for user passwords

add one, 312, 395
when they appear, 316

lock your Mac, require a password to unlock, 
422

login password, 418
login password doesn’t work, 315

Master password, 426–427
no password assigned, 395, 411
online, fi ll in passwords automatically, 128
on your Mac

Administrator password, 395, 417
Keychain Access password, 425
login password, 426
login passwords for users, 312
Master password, 426–427

pdfs, password-protect them, 217
require a password to wake your Mac from sleep 

or a screen saver, 422
reset your password, 396, 411
user passwords

Admin password is user password, 395, 418
if you forget yours, 396, 411, 418

Paste and Match Style, 61, 249

PDFs
what are they? 217
create a pdf, 217–218
annotate a pdf, 200–201
bookmark multi-page documents, 199
copy text from a pdf page

to paste in another document as editable, 204
to paste in as a graphic, 204

crop pdfs in Preview (non-destructive), 196–197
fax a pdf

from your Mac, 302–305
straight from the document, 218

forms, fi ll in pdf forms, 206
iPhoto, save a pdf to, 218
links, create them in TextEdit, 68
open a pdf in Safari, 132, 254
password-protect a pdf, 217
pdf-x, save as, 218
save pdf to Web Receipts folder, 219
search a pdf, 198
view pdfs in Preview, 194

peer-to-peer network, 373

permission settings in Info window, 323
Personal File Sharing, turn it on, 373
phone cable to fax from your Mac, 302
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photographs
automatically add attached photos to iPhoto, 101
crop a photo in Preview, 195
display icon previews, 267
make icons larger so you can see them easily, 

267
preview an entire folder of photos, 192
printing to glossy photo paper, 296
send a photo to someone in iChat, 252
send as attachments in Mail, 100
show pixel size in Finder windows, 267
use photos in

Address Book contact card, 110
Desktop background, 277
email signatures, 87
login picture, 313–314
stationery in Mail, 82–83
window background, 267

Pictures folder
Desktop background from Pictures folder, 277
in your Home folder, 7

ping, 397

pop-up windows on the web, block them, 128
Portable Document Format, 217

port scan, 397

preferences. See also System Preferences
example of how to use, 53
fi les are stored in Library folder, 37
fi nd them in the application menu, 53
preferences fi le, how to delete, 406
users each have their own preferences, 

preview
documents before printing, 240
fi les in Finder window, 16
fonts that are NOT installed yet, 220
fonts that have been installed, 221, 234

Preview application
annotation tools for pdfs, 200–201
bookmark fi les to open quickly, 199
Crop Box, 197
crop pdfs (non-destructive), 196–197
email images from Action button, 193
Media Box, 197
notes, add to a pdf, 200–201
Oval Annotation tool, 200–201

pdfs
annotate a pdf, 200–201
copy text as editable or as a graphic, 204
crop a pdf, 196–197
forms, fi ll in pdf forms, 206
search a pdf, 198

red ovals on a page, 201
slideshow of images or pages, 193
Text Annotation tool, 200
tool tips in Toolbar, 26

Previous System folder, 390

Print & Fax preferences
check the Print Queue, 298
fax specifi cations, 305
supplies, 297

printing
default printer, choose one, 294
delete, hold, or resume jobs, 298
glossy photo paper, 296
ink cartridges, buy them for your printer, 297
paper choices, quality choices, 296
print:

cd jewel case inserts with album art, 188
mailing labels, envelopes, contact lists, 120
To Do lists, events, calendars, more, 158

printer name and checkbox is gray, 294
printing isn’t working, 298
Print Queue dialog box, 298
share your printer with other Macs, 299–300
software needs to be installed, 296
special features of the printer, 296
special features of your software, 297
supplies, 297
text prints really tiny, 70

privacy
Address Book: make your own card private, 111
Safari: private web browsing, 136
Spotlight: prevent folders from being searched, 

338
Public folder, 322

access the Public folder through network, 377
puzzle widget, change the picture, 287
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Q
Quick Look

button in toolbar, 8, 19
keyboard shortcuts for, 19
show preview of any fi le, 19
Time Machine, view Quick Look, 360
view found items after a search, 344

quit
active application(s), 245
force quit an application, 404

Qwest broadband, 370

R
“Read only” fi les, 323

Really Simple Syndication, 125

red button
closes the window, 9
has a dark dot in it, 29, 253

red dots under words, 232

Reilly the Briard, 255
relaunch the Finder, 405

rename a folder or fi le, 11

Rendezvous, changed to Bonjour, 378–379
report crashes to Apple, 411

reset passwords, 396

resize
columns in Finder window, 16
cropped area of a pdf, 196
cropped area of a photograph, 195
Finder windows

drag the corner, 8
with green button, 9

panes, 28
preview in Print dialog, 158
rows and columns in a table, 67
Sidebar, 8

restart
can’t because disk is stuck in the drive, 389
during OS installation, 389
laptops, use Power button to restart, 405

Return key
activates blue buttons, 44
symbol for, 24, 433

Riley, Barbara, 82

ringtones in iTunes, 185
Ritter, Roth, 168

RJ11 phone cable, 302

Rosetta the Golden Doodle, 19, 287
router for networking, 372–373
RSS feeds

what does rss stand for? 125
“All rss Feeds,” 139
Article Length slider, 138, 141
Atom as an rss feed, 143
Auto-Click checkbox, 144
bookmark your favorite feeds, 143
Collections pane, make your own folders, 143
color (highlight) unread articles, 145
customize the information display, 141
default reader, choose it, 145
directory of rss feeds, fi nd one, 142
display a full article, 141
display the rss feed page, 142
existing feeds supplied by Apple, 139
experiment with feeds, 139–141

“Mail Link to Th is Page,” 146
number next to feed or folder, 140
open an rss feed, 139

“Open in Tabs,” 140
organize the headlines, 141
preferences for rss feeds, 145
Really Simple Syndication, 125
remove articles, 145
rss icon

in Bookmarks Library, 139
in the address bar, 142
on a web page, 143

screen saver, use rss feeds as, 146
search a directory for feeds, 142
send a link to a friend, 146
sort the headlines, 141
tab, open each feed in a tabbed page, 144
updates, set time for updating, 145

“View All rss Articles,” 140
view an rss feed, 142
xml as an rss feed, 143

ruler in word processor, 64
Run Full Finder, 329
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S
Safari

Address Book, put it in Bookmarks Bar, 123
Auto-Click feature, 144
AutoFill feature, 128

enable private browsing to prevent autofi ll, 136
uses data from your card in Address Book, 111, 

147
block pop-up windows, 128
bookmarks

how to make and organize them, 130
bookmark an rss feed, 143
parental controls, limit bookmarks, 137

Bookmarks Bar
Address Book in, 123
Auto-Click checkbox, 144
pane to store bookmarks in, 140
square next to folder name, 144

Bookmarks Library, 131
advantage of, 131
Auto-Click checkbox, 144
make new folders/Collections in, 143
search the bookmarks, 131

Collections pane, 139
make new folders in, 143
rss folders for you from Apple, 140

email an entire web page or a link, 132
enlarge size of text on web pages, 128
fi nd a word or phrase on the page, 127
forms online, fi ll in automatically, 128
Google search field, 126, 129
integrated with, 147
orange curly arrow (SnapBack), 128
parental controls, 137
passwords online, fi ll in automatically, 128
pdfs, view in Safari, 132
pop-up windows, block them, 128
preferences examples

rss feeds, 145
Tabs, tabbed browsing, 53

reduce size of text on web pages, 128
Reset Safari command, 136

rss feeds
bookmark an rss feed, 143
mail link to a friend, 146
preferences for, 145
rss icon in the address fi eld, 142
view an rss feed, 142

save page of search results, 128
save web page and all graphics on it, 133
search via Google, 126
SnapBack feature, 128
Spotlight search in Safari, 350
Status Bar, 126
tabbed browsing

Auto-Click checkbox, 144
how it works, 130
preferences for, 53

text, enlarge or reduce it, 128
web location file, make one, 251

Save As dialog boxes
save into a particular folder, 253
search for fi les within, 351
Spotlight search in, 351
TextEdit, save documents as Word fi les, 58

screen saver
iTunes album art, 181
preferences for, 146, 422
require a password to wake your Mac from the 

screen saver, 422
rss feeds as a screen saver, 146

screen sharing, 380–385

screenshots
make them in Preview, 207
make them with keyboard shortcuts, 433

search
Address Book, 116–119
Finder, 344–347
Open dialog boxes, 351
Safari

search for a word or phrase on a web page, 127
search Google from a word or phrase on the 

page, 350
search the bookmarks, 131

Save As dialog boxes, 351
search and replace in word processing, 60, 70
search the System Preferences, 279, 349
TextEdit, 350
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Secure Empty Trash, 423

Secure Shell, 416

security features, 416–426
auto-login, turn it off , 314, 421
create another user, 311–316, 422
disable Restart, Sleep, Shut Down buttons, 315, 

421
fi le permissions, 323
FileVault to encrypt your Home folder, 426
lock your Mac with a mouseclick, 422
passwords

require one to open or edit a pdf, 217
require one to wake up the Mac, 422
suggestions for good passwords, 312

Safari, private browsing, 136
screen saver, require a password to wake up, 422
Secure Empty Trash, 423
sleep, require a password to wake up, 422
Spotlight, privacy feature, 338
updates with Software Update, 416
vCard, make yours more private, 111

Security preferences
FileVault, 426–427
password, require one to wake up the Mac, 422

select
fi les in a window, 46
folders, 25
multiple fi les at once, 38
non-contiguous text, 70
text in a pdf to copy and paste, 204

serial number of your Mac, 396
servers

what are they? 373
create favorite servers for quick connections, 377
disconnect from a server, 385
Sidebar icons, hide or show them, 265

Services menu
how to use it, 256
speech for iChat or Safari, 239

Shakespeare, 216, 350

The Shakespeare Papers, 75, 126

Shared folder
in Simple Finder, 328
put fi les in to share, 322

share files
between users on one Mac, 322
disconnect from server, 385
Personal File Sharing, turn it on, 373
Rendezvous for fi le transfer in a small offi  ce, 

174–177
through Bonjour, locally, 378–379
through iChat Buddy List, 253
through networking your Macs, 372–379
through Screen Sharing, 380–385
through the Shared folder, 322
tips for making it easier, 385

share your printer with other Macs, 299–300
Sharing preferences, 381

Shift key
select multiple items with, 39
symbol for, 24, 433

short name, 312, 395
as name of your Home folder, 6

Show View Options, 266–271

Shut Down
emergency Shut Down, 405
show or hide the Shut Down button on login, 

315, 421
Sidebar

where is it? 8
add or remove icons, 12–13
choose what appears in it, 265
icons in, described, 6–7, 8
icons on the Desktop, get rid of them, 262
is customizable, 12
missing in Finder window, 9
resize the Sidebar, 8
top portion of the Sidebar

what is it? 34
choose what appears in it, 265
eject symbol in, 34
hard disk icon, 34–35

Sidney, Mary, 82, 216, 350

Simple Finder, 328–330
override the Simple Finder, 329

Sites folder, 7, 322

Skia font, 236
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slideshows
Mail attachments slideshow, 102
Preview images slideshow, 193
Quick Look slideshows, 19

SmartDisk.com, 391

Smart Folders in Mail, 89–90
Smart Groups in Address Book, 115–116
Smart Mailboxes in Mail, 89–91
Smart Quotes in TextEdit, 63
SMTP, 369–370

SnapBack in Safari, 129

Software Update preferences
automatically update software, 416
check for updated software, 410

Spacebar
to open spring-loaded folders, 254
to play a dvd, 215

Spaces, 246–248

Speech option in TextEdit, 43
Speech preferences, 239

spell checker
contextual menu can correct spelling, 43, 232
how to use it, 230–233
learn spelling, 231
names, it thinks they are misspelled, 231
red dots under words, 232

Spotlight
overview of fi ve views of Spotlight, 334
what does Spotlight search? 339
Address Book search, 116–117
categories, turn on or off , 337
fi eld in the Finder window, 5
fi nd categories like “music today,” 339
Finder search, 344–347

add or delete parameters, 339
categories only search, 339
metadata search, 340
Smart Folders, 347–348

Info window to add keywords, 341
keywords, add to fi les for searching, 341
Mail Spotlight and Smart Mailboxes, 336–339
menu bar icon, 4
metadata, expand your search, 339
Open dialog boxes, 351
open the folder that holds the selected fi le, 344

preferences for Spotlight, 337–338
privacy; prevent folders from being searched, 

338
Safari, 350
Save As dialog boxes, 351
search a particular disk or folder, 345
search System Preferences, 279
Smart Folders, 347–348
Spotlight menu

how to use it, 342–343
delete everything from the fi eld, 343
keyboard shortcut

change it, 338
to open the menu, 334

Show All option, 343
Spotlight window

keyboard shortcut
to open the window, 334
change it, 338

open it from the Spotlight menu, 334
System Preferences, 349
Time Machine search, 360
web page text search, 350

spring-loaded folders, 254
customize how it works, 263

stacks
example of a stack display, 103
folders in Dock, 20

Starbuck, Joannie, 104

Startup Disk
option when installing, 389
use the utility, 396

stationery in Mail, 82–83
straight-through cables, 372

string, what is it? 433
style sheets in TextEdit, 61
switch for networking, 372–373
symbols, modifi er key symbols, 24, 433
System Preferences

how to open them, 274
alphabetize preference icons, 274
can’t change preferences? 274
global preferences vs. user preferences, 274
search fi eld in window, 279
search for the preference you need, 279, 349
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specifi c preferences:
Accounts

Login Options, 314
low-level security features, 421–422
multiple users, 311–316
parental controls, 324–329

Date & Time preferences, 278
Desktop & Screen Saver, 277, 422

rss feed as screen saver, 146
use iTunes album art, 189

Dock, 260
Energy Saver, 422
Exposé & Spaces

Dashboard keyboard shortcut, 288
Exposé prefs, 40
Spaces, 246–248

Keyboard & Mouse, 46, 275
Network, 364–367
Security, 422
Sharing, 381
Software Update, 410, 416
Speech, 239
Spotlight, 337–338

System Profi ler, 396

T
Tab key

to select fi elds in dialog boxes, 44
to set tabs and indents in text, 64

tables in TextEdit, 67
talk to people through iChat, 166–167
Target Disk Mode

Apple says most Macs have it, 398
doesn’t involve the target Mac’s OS, 372
transfer fi les using, 412

Taylor, Laura Egley, 82, 205

Telnet may need short name, 312
Terminal, 396

text
create text clippings, 250
move it or copy it without cut and paste, 

249–250
shadow, apply to text, 235

textClipping fi le, 250

TextEdit
Colors panel, 238
Complete command, 62
.doc fi les, 58
email link on a page, create one, 68
favorite styles, 61
fi nd text on the page, 60, 70
Fonts panel, 234–235
formatting, if it won’t apply, 70
integrated with, 71
links, web and email, 68
lists, automatically numbered, 66–67
move text or copy it without cut and paste, 249
page layout, how does the text look on the page? 

70
page numbers, print automatically, 70
Paste & Match Style, 61
Plain Text, 70
printing

automatic page numbers, 70
text prints really tiny, 70

quote marks, 63
read text out loud to you, 239
red dots appear under words, 232
Rich Text, choose it, 70
ruler, show it, 70
save fi les as Word documents, 58
search and replace, 60, 70
shadow eff ects on type, 235
speech—read text out loud to you, 43
Spell checker, 230–231
spell-check with contextual menu, 43
styles, 61
tables, create simple tables, 67
tabs and indents

ruler, show it to use tabs and indents, 70
text prints really tiny, 70
text stretches the entire length of window, 70
tool tips in Toolbar, 26
typographer’s quotes, 63
web link on a page, 68
Word fi les

open in TextEdit, 58, 254
save as Word fi les in TextEdit, 59
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thesaurus, 241

thumbs on columns, 16

tile puzzle widget, change the picture, 287
Time Machine, 354–360

Spotlight search in, 360
title bar

where is it? 8
icon in title bar is a house, 6
icon in title bar is gray, 29
page proxy icon and what you can do with it, 253
red button has a dot in it, 29, 253

To Do items in Mail, 92–97

Tollett, John, 169, 171

toner cartridges, buy them for your printer, 297
Toolbars

contextual menus in, 43
customize the Toolbar, 53
tool tips in, 26

tool tips, 26

trackpad preferences, 275

transfer fi les from one Mac to another
Migration Assistant, 397–403
various quick methods, 400

Trash
how to use the Trash, 22
icon in Dock, 4
recover fi les from, 423
remove items from the Trash, 21
Secure Empty Trash, 423
warning before emptying, turn it off  or on, 265

triangles
blue disclosure triangles, 44
in Bookmarks Bar item, 140
in Bookmarks Bar, triangle is a square, 144
in column headings, 15, 270
in Column View of windows, 16
in gear wheel button (Action menu), 28
in list view of windows, 15
in window Toolbar, Back and Forward, 9, 11

Truemors, 141, 145

typing, keys repeat too much 
or don’t repeat at all, 276

U
TheUnderstanders.com, 127

UNIX fi le system, format disk as, 391
users

why set up multiple users, 307
overview of multiple users, 308–309
Accounts preferences

Login Options pane, 314
login picture, add one, 313–314
make new users, 311–316

Admin, Administrator user
who is it? 308
can create more than one Admin, 309, 319
password, if you forgot it, 411
password, reset it, 411
password, where it came from, 308

applications open at startup, 321
automatically log in as, 308, 314
create another user for security, 422
delete a user, 330–331

save her fi les when deleting, 330
fast user switching, 318

rotating-cube eff ect doesn’t work, 319
forgot your Admin password, 411
log in and log out

why do it, 308
how to do it, 317
automatically log in, set up, 314
Login Window display, 315
open login window from menu, 319
Sleep, Restart, and Shut Down buttons, 315

Login Items, 321
login options

explained, 314–316
login options

change the options for greater security, 421
managed users

what are they? 308–309
overview of parental controls, 324–329

name of user in right corner, 318–319
new users, create them, 311–316
parental controls

overview of and where to set, 324–329
in Safari, 137
Simple Finder, 328–330
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passwords, 312–313
Admin password, where it came from, 308
blank passwords can be used, 312
hint, add one, 312
hint, when it appears, 313, 317
reset a password, 411

picture at login, 313–314
settings

change them, 320–321
save them when upgrading, 391

share fi les, 322. See also sharing fi les
short name, 312
Simple Finder, 328–330
standard users

change their own settings, 320–321
what are they? 308–309

switch between users quickly, 318–319
transfer from one Mac to another, 391

V
vCards

what are they? 109
icon for vCards from the Address Book, 251
send to someone through iChat, 252

Veer.com, 460

video camera
use a photo from as login picture, 313–314
video conference with iChat, 168–170

Virtual Private Network, 416

visual clues
what are they? 28–29
blue borders around edit boxes, 28, 44
blue buttons, 29, 44
blue column headings, 15, 270
blue light under Dock icons, 20
blue type eff ects button, 235
checkmark in menu, 29
disclosure triangles

in dialog boxes, 44, 59
in list view, 15

dots
in red button on window, 29, 253
in Window menu, 29
on divider bars, 28

fl ashing insertion point, 249
highlighted text, 44
Home icon in title bar, 6
icons: folder, document, application, 14
insertion point fl ashing, 28
marks in corners, 28
pointer changes icon, 28
red button has a dot in it, 29
thumbs on columns in Finder windows, 16
title bar icon, 28
triangles in column headings to sort informa-

tion, 15
triangles on blue buttons (disclosure buttons), 

28
widgets have clues, 286

visual effects from music, 185
VoiceOver login, 316

W
.webloc, web location fi le, 251, 432
web logs (blogs)

example of one, 142
rss feeds for, 138

web sites
drag images to other applications, 255
find a word on the current web page, 127
make a text clipping of text on a page, 250
private browsing in Safari, 136
support pages on Apple’s site, 30
web location file, make one, 251

West, Clara, 195

whois, 397

widgets, 282–288



Wikipedia on your Mac, 241
Williams

Ant Jean, 169, 272
Brian Forstat, 192
Brianna Nora Haney, 222
Cliff , 192, 193
Emilie, 108
Jeff rey, 272
Jerry, 192, 193
Jewels, 272
Jimmy Th omas, 110, 193, 208
Pat, 166, 169, 192–193, 208, 304
Rosetta, 169, 287
Ryan, 166, 193, 208
Scarlett, 54, 192, 208
Shannon, 166, 193, 208

Wills, Jennifer, InDesign Magazine 
cover designer, 296

Window menu
checkmark next to name, 29
dot next to name, 29

windows
Finder windows

control them with Exposé, 40
example of with callouts, 5
move them, how to, 5
open more than one, 7, 17
resize, how to, 5

manage them with Exposé, 40
title bar in

page proxy icon and what you can do with it, 
253–254

red button has a dark dot, 29, 253
tiny icon is gray, 29, 253

Wired Equivalent Privacy data encryption, 416
Word

open Word fi les in TextEdit, 58, 254
save TextEdit documents as Word fi les, 59

word processing
Colors panel to change text color, 238
complete a word automatically, 62
Find, 60
fi nd and replace, 60
font or size won’t change, 234
search and replace, 60
shadow, apply to text, 235
styles, 61
TextEdit special features

links for web and email, 68
lists, automatically generate numbered lists, 

66–67
page numbers, print them, 70
search and replace, 70
select non-contiguous text, 70
tables, create simple ones, 67
wrap the text to the page, 70

“Write only” fi les, 323

Y
Yahoo webmail, 370

yellow button to minimize the window, 9

Z
Zapfi no font, ampersand options, 236
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§ 
I wrote and indexed this book directly in Adobe InDesign on an Intel 

Mac Pro. The fonts used are Warnock Pro for body copy (9.5/14) and 

Today for the heads, subheads, and captions. I wish I could have been 

allowed to use something really sassy here and there. Some fun face from 

MyFonts.com, like Flyswim, above, or Cocktail Shaker from Veer.com, 

which is what you’re reading now. 

Although the indexing feature in InDesign is fabulous, this new version of 

CS3 broke the index. I am deeply indebted to Ole Kvern for writing 

me a script that did magical mystical things and let me get this book to 

press on time. Bless your heart, Ole –—I adore you. I hope you enjoy the 

Calvados.  :-)
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